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Part 1: quick summary

I’m not a statistics expert, so caveat emptor. If you spot any mistakes or have sug-
gestions to make this document more useful, please let me know (at
rudolf@pobox.com). Thanks to Mike Aitken (MRFA) for helpful comments!

1.1 Overview of this document

• First, in Part 1, we’ll summarize what most people want to know to get going —
how to choose and perform an ANOVA. Nobody reads ANOVA theory before
starting to analyse, much as statisticians may complain about this, so we might
as well be pragmatic. This can be combined with Part 3, which talks about
common things that are required in ANOVA analysis, and Part 5, which shows
how to perform an ANOVA in SPSS.

• Then, in Part 2, we’ll cover what ANOVA does and what it assumes — things
people should have known before running an ANOVA but probably didn’t.

• In Part 3, we’ll walk through what most people need to do to complete an
ANOVA analysis.

• In Part 4, we’ll look at experimental design and analysis issues, such as how to
analyse changes from baseline, and when and how to perform post hoc tests.

• In Part 5, we’ll look at how to use SPSS to perform different ANOVAs.

• In Part 6, we’ll cover complex theory that most people will never need.

• In Part 7, we’ll look at a variety of ANOVA models that can be used for differ-
ent experimental designs. These will range from the very simple (one-way
ANOVA) through the very useful (mixed designs with both between- and
within-subject factors) to the very complicated. This material is for reference.

• In Part 8, we’ll revise mathematics that is touched on occasionally elsewhere,
and cover very advanced mathematics that underpins computer calculations of
complex ANOVAs.

• In Part 9, there’s a glossary.

1.2 Background knowledge

This handout is aimed at graduate students who need to perform analysis of variance
(ANOVA). Covering the theory of ANOVA is one thing; putting it into practice in
psychology and neuroscience research unfortunately means using the technique at a
level at which even statisticians debate the proper methods. This is depressing to the
beginner; I hope this handout helps. It’s also a reminder to me of information I’ve
collected about different ANOVA designs. It covers simple ANOVA and also some
complex techniques that are not often used but rather powerful. It assumes a basic
knowledge of statistics. Explicit coverage of the background knowledge can be
found in my NST IB Psychology handouts, available at

www.pobox.com/~rudolf/psychology

and coverage of exploratory data analysis (EDA) and ANOVA can be found in Mike
Aitken’s NST II Psychology handouts, available at

foxfield.psychol.cam.ac.uk/stats/default.html

1.3 Quick summary: choosing and performing an ANOVA

We’ll presume your experiment was sensibly designed and free of confounds. No
amount of analysis will fix a bad design. Now, the purpose of ANOVA is to pre-
dict a single dependent variable on the basis of one or more predictor variables,
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and to establish whether those predictors are good predictors or not. Therefore
you need to do the following:

• Identify your dependent variable.
• Identify your predictor variables.
• Establish whether your predictor variables are discrete (e.g. sham/lesion,

sham/core/shell, day 1/2/3) or continuous (e.g. body mass). We will call
discrete variables factors, and continuous variables covariates. The number of
discrete values that a factor can take is known as the number of levels of that
factor.

• For most psychology designs, the key unit of ‘relatedness’ is usually the sub-
ject. It then suffices to establish whether your predictor variables are between-
subjects variables (e.g. operative group; every subject is only measured at one
level of the factor, such as ‘lesion’) or within-subjects variables (e.g. test day;
each subject is measured at more than one level of the factor, such as ‘day 1’,
‘day 2’, and so on).

• You should now be able to identify your design (e.g. ‘one between-subjects
factor and two within-subjects factors’) using this document. The sections giv-
ing detail on each design also give the SPSS syntax.

• You should check that the assumptions of ANOVA are met — for example, do
you need to transform your dependent variable (by taking the square root, arc-
sine, logarithm, etc.) before analysis?

• Run the ANOVA.
• If your ANOVA has within-subjects factors, check Mauchly’s test of spheric-

ity, which your software should have done for you. If the Mauchly test is ‘sig-
nificant’ (small p value), one of the assumptions behind within-subjects
ANOVA has been violated. Don’t use the normal df; use the corrected df — ei-
ther with the Greenhouse–Geisser (conservative) or Huynh–Feldt (better; Myers
& Well, 1995, p. 248) correction. Your software should provide both.

• Interpret the results. You may need to perform further analyses post hoc to ex-
plain main effects or interactions that you find.

I use a notation for describing ANOVA models in which factors are written with
their number of levels as a subscript, covariates are written with ‘cov’ as a subscript,
S denotes subjects, factors/covariates in brackets with ‘S’ are within-subjects pre-
dictors, and unbracketed factors/covariates are between-subjects predictors. An
ANOVA with one between-subjects factor (A) and two within-subjects factors (U,
V) might be written like this:

dependent variable = A × (U × V × S)

As a more concrete example of this notation, suppose you measured locomotor ac-
tivity (dependent variable) in two groups of rats (sham/lesion). Each rat was tested
on six occasions: following one of three drug treatments (saline/low-dose co-
caine/high-dose cocaine), and in one of two rooms (hot/cold). We assume the
testing order for within-subjects factors was appropriately counterbalanced to avoid
order effects (see handouts at www.pobox.com/~rudolf/psychology). We could
write this design as:

locomotor activity = Group2 × (Drug3 × Room2 × S)

In this document, I will try to use A, B, C… as labels for between-subjects factors
and U, V, W… as labels for within-subjects factors, since it gets hard to read other-
wise when there are both between- and within-subjects factors in a design.

Designs with both between-subjects and within-subjects factors are called ‘mixed’
or ‘nested’ designs (Keppel, 1991, p. 563): variability due to subjects is ‘nested’
within variability due to the between-subjects factor(s), because each subject is only
tested at one level of the between-subjects factor(s).
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If you have units of relatedness other than ‘subject’ (e.g. ‘plot of land’), but you only
have one level of relatedness, you can merely think of your design in the same be-
tween-/within-subject terms.

If you have multiple levels of relatedness, you will need a complex or hierarchical
design (Myers & Well, 1995, chapter 10); you should aim to understand the princi-
ples behind the designs discussed in this document. At the end we’ll cover some hi-
erarchical designs, but this is hard stuff.



2: ANOVA basics 8

Part 2: understanding the basics of ANOVA

2.1 The basic logic and assumptions of ANOVA

2.1.1 The underlying model

After Howell (1997, ch. 11). Suppose that the average height of UK adults is 175
cm, that of adult females is 170 cm, and that of adult males is 180 cm. So ‘maleness’
contributes, on average, +5 cm to an adult’s height (compared to the mean of all
adults), and ‘femaleness’ contributes, on average, –5 cm. Suppose we take a given
adult male. We could break his height down into three components: 175 cm for be-
ing an adult, 5 cm for being a male, and some other component that represents this
individual’s ‘uniqueness’, since there is of course variation in the heights of adult
men. We could write this model as

height = 175 cm + 5 cm + uniqueness

or in more general terms

individualmalemale individualheight ετµ ++=

where µ is the overall mean (175 cm), τmale is the contribution for being a male, and
εindividual is a particular individual’s unique contribution. We have written an expres-
sion for our dependent variable (height) in terms of predictor variables (the grand
mean and a factor, sex) and unpredicted variability. Let’s extend that principle.

2.1.2 An example: data and a structural model

Suppose 50 subjects are assigned to five groups. Each group reads a list of words in
a different way: one was asked to count the number of letters in each word, one to
think of a rhyme for each word, one to give an adjective that could be used with
each word, one to form a vivid image of each word, and one to memorize each word
for later recall. Later, all groups were asked to recall all the words they could re-
member. In ANOVA terminology, we have a single factor Group with five levels
(Group1, Group2, … Group5). Here are some results (Howell, 1997, p. 301):

No. words
recalled

Group1

Counting
Group2

Rhyming
Group3

Adjective
Group4

Imagery
Group5

Memorize
Total

One 9 7 11 12 10
number, 8 9 13 11 19
one 6 6 8 16 14
subject 8 6 6 11 5

10 6 14 9 10
4 11 11 23 11
6 6 13 12 14
5 3 13 10 15
7 8 10 19 11
7 7 11 11 11

total T1 = 70 T2 = 69 T3 = 110 T4 = 134 T5 = 120 ∑ x = 503
n n1 = 10 n2 = 10 n3 = 10 n4 = 10 n5 = 10 N = 50
mean

1x = 7 2x = 6.9 3x = 11 4x = 13.4 5x = 12 x = 10.06

SD s1 = 1.83 s2 = 2.13 s3 = 2.49 s4 = 4.50 s5 = 3.74 4.01
variance 2

1s = 3.33 2
2s = 4.54 2

3s = 6.22 2
4s = 20.27 2

5s = 14 2s = 16.06

For this data, we can specify a model, just as we did before. Let
• Xij represent the score of person j in condition (group) i
• µ represent the overall mean score
• µi represent the mean of scores in condition i
• τi represent the degree to which the mean of condition i deviates from the over-

all mean (the contribution of condition i), i.e. µµ −= iiτ
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• εij represent the amount by which person j in condition i deviates from the mean
of his or her group (the ‘uniqueness’ of person j in condition i), i.e.

iijij X µε −=

Since it’s obvious that

)()( iijiij XµX µµµ −+−+=

it follows that

ijiij ετµX ++=

2.1.3 The null hypothesis

We will test the null hypothesis that there is no difference between the various
groups (conditions). We can state that null hypothesis like this:

µµµµµµ ===== 543210 :H

In other words, the null hypothesis is that all means are equal to each other and to
the grand mean (µ), and that all treatment (group) effects are zero.

2.1.4 The assumptions of ANOVA

If µi represents the population mean of condition i and 2
iσ represents the population

variance of this condition, analysis of variance is based on certain assumptions about
these population parameters.

1. Homogeneity of variance

We assume that each of our populations has the same variance:

22
5

2
4

2
3

2
2

2
1 eσσσσσσ =====

The term 2
eσ (where e stands for error) represents the error variance — the variance

unrelated to any treatment (condition) differences. We would expect homogeneity of
variance if the effect of any treatment is to add or subtract a constant to everyone’s

score — without a treatment the variance would be 2
eσ , and if you add a constant to

a variable, the variance of that variable doesn’t change.

2. Normality

We assume that the scores for each condition are normally distributed around the
mean for that condition. (Since εij represents the variability of each person’s score
around the mean of that condition, this assumption is the same as saying that error is
normally distributed within each condition — sometimes referred to as the assump-
tion of the ‘normal distribution of error’.)

3. Independence of error components (≈ independence of observations)

We also assume that the observations are independent — technically, that the error
components (eij) are independent. For any two observations within an experimental
treatment, we assume that knowing how one of these observations stands relative to
the treatment (or population) mean tells us nothing about the other observation.
Random assignment of subjects to groups is an important way of achieving this. To
deal with observations that are not independent — for example, observations that are
correlated because they come from the same subjects — we need to account specifi-
cally for the sources of ‘relatedness’ to make sure that the residual error components
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are independent; this is why we need within-subjects (repeated measures) designs
for this sort of situation. But we’ll ignore that for the moment.

2.1.5 The logic of ANOVA

Since we have assumed that the distribution of the scores for each condition have the
same shape (are normally distributed) and have the same variance (homogeneity of
variance), they can only differ in their means. Now if we measure the variance of

any one condition, such as 2
1s , that variance will be an estimate of the common

population variance 2
eσ  (remember, we assumed 22

5
2
4

2
3

2
2

2
1 eσσσσσσ ===== ,

that is, homogeneity of variance). In each case, our sample variance estimates a
population variance:

2
1

2
1 s=�σ ; 2

2
2
2 s=�σ ; … 2

5
2
5 s=�σ

(where =�  denotes ‘is estimated by’). Because of our homogeneity of variance as-

sumption, each of these sample variances is an estimate of 2
eσ :

2
1

2 se =�σ ; 2
2

2 se =�σ ; … 2
5

2 se =�σ

To improve our estimate of 2
eσ , we can pool the five estimates by taking their mean

(if n1 = n2 = n3 = n4 = n5 = n), and thus

a

s
ss i

ie
∑===

2
222 �σ

where a is the number of treatments — in this case, 5. (If the sample sizes were not
equal, we would still average the five estimates, but we would weight them by the
number of degrees of freedom for each sample, so variance estimates from larger
samples would get more weight.) This gives us an estimate of the population vari-
ance that is referred to as MSerror (‘mean square error’), sometimes called MSwithin,
or MSsubjects within groups, or MSS/groups (‘mean square for subjects within groups’).
This is true regardless of whether H0 is true or false. For the example above, our

pooled estimate of 2
eσ  will be

67.9
5

00.1427.2022.654.433.32 =++++=eσ

Now let us assume that H0 is true. In this case, our five samples of 10 cases may be
thought of as five independent samples from the same population (or, equivalently,
five samples from five identical populations). The Central Limit Theorem (see
handouts at www.pobox.com/~rudolf/psychology) states that the variance of
means drawn from the same population is equal to the variance of the population di-
vided by the sample size. If H0 is true, therefore, the variance of our five sample

means estimates ne /2σ :

2
2

x
e s

n
=�σ

and so
22
xe ns=�σ

This is therefore a second estimate of 2
eσ , referred to as MStreatment or MSgroup. On

the other hand, if H0 is false, this will not be a good estimate of 2
eσ . So we have

found that MSerror estimates 2
eσ  whether H0 is true or false, but MStreatment only esti-

mates 2
eσ  if H0 is true. Therefore, if our two estimates of 2

eσ , MStreatment and MSerror,

are similar, this is evidence that H0 is true; if they are very different, this is evidence
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that H0 is false. We will compare the two variance estimates with an F test, which is
designed specifically for comparing two variances (see handouts at
www.pobox.com/~rudolf/psychology): F = MStreatment/MSerror. If our F statistic is
very different from 1, we will reject the null hypothesis that the two variances
(MStreatment and MSerror) are the same, and hence reject the null hypothesis of the
ANOVA.

2.1.6 Expected mean squares (EMS)

Let’s formalize that. We’ve defined the treatment effect τi as µi – µ, the difference
between the mean of treatment i (µi) and the grand mean (µ). We will also define

2
τσ  as the variance of the true population’s means (µ1, µ2, … µa):

11

)( 2
2

−
∑=

−
∑ −=

aa
ii τµµστ

Technically, this is not actually the variance — since we are working with parame-
ters, not statistics, we should have divided by a rather than a – 1 if we wanted the
variance. However, we can think of it as a variance without much problem.

We can then define, without proof, the expected value of the mean square terms:

22
2

2
treatment

2
error

1
)MS(

)MS(

τσστσ

σ

n
a

n
E

E

e
i

e

e

+=
−
∑+=

=

where 2
eσ  is the variance within each population and 2

τσ  is the variance of the

population means (µj). So if H0 is true, 02 =τσ , so )MS()MS( errortreatment EE = , but

if H0 is false, )MS()MS( errortreatment EE > .

2.2 The calculations behind a simple one-way ANOVA (one between-subjects factor)

Let’s go back to the results in the table we saw earlier and conduct an ANOVA.

2.2.1 Calculations with means (conceptual) or totals (for manual calculation only)

Most ANOVA calculations are based on sums of squares. Remember that a vari-
ance is a sum of squared deviations from the mean (a ‘sum of squares’) divided by
the number of degrees of freedom. We work with sums of squares because they are
additive, whereas mean squares and variances are only additive if they are based on
the same number of degrees of freedom.

Purely for convenience, Howell (1997) tends to do the calculations in terms of
treatment totals rather than treatment means. In the table above, we have defined Ti

as the total for treatment i. Totals are linearly related to means ( xnT = ). If you
multiple a variable by a constant, you multiply the variance of that variable by the
square of the constant. So since xnT = , we can see that

222
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We saw earlier that if H0 is true, 22
xe ns=�σ ; therefore, if H0 is true,

n
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e

2
2 =�σ
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On the other hand, though calculating sums of squares may be easier in terms of
treatment totals, conceptually it is much easier to think in terms of means. We’ll
present both for a while — first the definition in terms of means, and then, in brack-
ets, the formula in terms of totals. Ignore what’s in brackets unless you’re doing
the calculations by hand. Eventually we’ll just show the calculations in terms of
means. After all, you’ll be using a computer for the hard work.

2.2.2 Calculating SStotal, SStreatment, and SSerror

First, we calculate SStotal (‘total sum of squares’) — the sum of squares of all the ob-
servations (the summed squared deviations of each observation from the overall
mean), regardless of which treatment group the observations came from.
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Now we calculate SStreatment. This represents the summed squared deviations of the
treatment mean from the mean of all treatment means, summed over each data
point. (Or, in terms of totals, the summed squared deviations of each total [Tj] from
the mean of the treatment totals [ T ], all divided by the number of observations per
total.)
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where a is the number of treatments, n is the number of observations per treatment,
and N is the total number of observations (= na).

Now we can calculate SSerror. This represents the sum of the squared deviations of
each point from its group mean. Since SStotal = SStreatment + SSerror, the quick way to
obtain SSerror is by subtraction:

treatmenttotal
2

error SSSS)(SS −=∑ −= ixx

Alternatively, we could have calculated SSerror by working out an SS for each group
separately and adding them up:

5 group1 group1 grouperror

2222
222 group

2222
111 group

SSSSSSSS

)9.67()9.69()9.67()(SS

)77()78()79()(SS
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−++−+−=∑ −=
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…
…

…

…

xx

xx

Both approaches give the same answer.
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2.2.3 Degrees of freedom

If there are N observations in total, dftotal = N – 1. If there are a treatments, dftreatment

= a – 1. We can calculate the degrees of freedom for error like this:

dferror = dftotal – dftreatment

Alternatively, we could calculate dferror as the sum of the degrees of freedom within
each treatment; if there are n observations in each of a treatments, there are n – 1
degrees of freedom within each treatment, and so dferror = a(n – 1). This gives the
same answer (since dftotal – dftreatment = [N – 1] – [a – 1] = [na – 1] – [a – 1] = na – a
= a[n – 1]).

2.2.4 Mean squares

Mean squares are easy; just divide each SS by the corresponding number of df.

2.2.5 The F test

From the definitions of EMS above,
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We can therefore calculate an F statistic

error

treatment

MS

MS
=F

and it is distributed as Fa–1, a(n–1) — that is, as Ftreatment df, error df, under the null hy-
pothesis. So we can look up critical value of F in tables. If it’s ‘significant’ (unlikely
given the null hypothesis), we reject the null hypothesis and say that the treatment
did influence our dependent variable.

A very complicated aside: if H0 is true and 02 =τσ , although
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under the null hypothesis is actually ( )
2error
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FE  (Frank & Althoen, 1994, pp.

470, 513). I don’t fully understand that; I suspected that the difference was that









≠

error
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E
 because )()()( YEXEXYE =  only if X and Y are

independently distributed. MRFA has since pointed out the real reason: under the
null hypothesis, MSerror is asymmetrically distributed. For asymmetric distributions,
( ) )(11 XEXE ≠ , so ( ) )MS(1MS1 errorerror EE ≠ . It’s akin to the reasoning behind

using a t test rather than a Z test when you estimate the population standard devia-
tion σ using the sample standard deviation s: even though )()( σEsE = ,

( ) ( )σ11 EsE ≠ .

2.2.6 ANOVA summary table

ANOVA results are presented in a summary table like this:
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Source                               d.f.                   SS                    MS                              F                                  
Treatment a–1 SStreatment SStreatment/dftreatment MStreatment/MSerror

Error (S/treatments) a(n–1) SSerror SSerror/dferror

Total N–1 = an – 1 SStotal SStotal/dftotal [=
2s ]

Remember that ‘S/treatments’ denotes ‘subjects within treatments’; this is the
source of all our error variability in this example. Anyway, for our example, we can
now calculate all the SS:
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so our ANOVA table looks like this:

Source                               d.f.                   SS                    MS                              F                                  
Treatment 4 351.52 87.88 9.09
Error (S/treatments)       45                    435.30             9.67                                                                 
Total 49 786.82 16.06

Our F has (4, 45) degrees of freedom. We could write F4,45 = 9.09, and look this up
to find an associated p value (p = 0.00002).

2.2.7 SStreatment for unequal sample sizes

What if our group sizes were not equal? Previously we had defined































∑−∑=

∑−∑=
∑

∑−
=

∑ −=∑ −=∑ −=

∑ −=

N

x

n

T

na

T

n

T

n
a

T
T

n

TT

n

xnxn

n

xxn

xxn

i

ii

i
i

iii

i

22

22

2
2

2222

2
treatment

)(

)(
)(

)()()(

)(SS

which applies when all groups have n observations. If the group sizes are unequal,
we simply multiply the deviation of each score from its treatment mean by the num-
ber of scores in that treatment group (so the larger one sample is, the more it con-
tributes to SStreatment):
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2.2.8 Pictorial representation

What the ANOVA technique has done is to partition total variation from the overall
mean (SStotal) into variation from the overall mean accounted for or predicted by the
treatment or group difference (SStreatment or SSgroups) and further variation within the
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groups due to inter-subject variability (SSerror or SSS/groups). If the variation attribut-
able to the model is large, compared to the error variability, we will reject the null
hypothesis.

1
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xx

The sum of squares is the sum of the
squared lengths of the vertical lines
(deviations from the mean).
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Do you see now why we’ve been
multiplying the deviations by the
group size to find SStreatment?
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Another way to look at ANOVA is this: the hypothesis test we have performed ef-
fectively compares two models (Myers & Well, 1995, p. 440-1): one (restricted)
model allows for the effects of a mean only — all other variability is ‘error’; the
other (full) model allows for the effects of a mean and a treatment (and everything
else is error). If the full model accounts for significantly more variability than the re-
stricted model, we reject the null hypothesis that the treatment has no effect.

2.2.9 Relating SS calculations to the structural model

Note that our structural model was this:
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and our SS were these:
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See the similarity? We can prove that the one follows from the other. This is not
something we have to do routinely, but it demonstrates how the sums of squares
(SS) are derived directly from the model. Our model was this:

ijiijX ετµ ++=
or

)()( iijiij XX µµµµ −+−+=

Rearranging to express the left-hand side as a deviation of each score from the over-
all mean:

)()( iijiij XX µµµµ −+−=−
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Squaring each side:
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Summing over i and j:
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The far-right term is actually zero:
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… since the sum of deviations of all observations about their mean is zero. So we’re
left with:
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The degrees of freedom are similarly related:

dftotal = dfA + dferror

2.3 Regression ANOVA: the other way to understand the basic logic

2.3.1 Linear regression in terms of sums of squares

Suppose that in some way we can measure the risk of a heart attack (call it Y) in
many 50-year-old men. If we then want to predict the risk of a heart attack in an un-
known 50-year-old man, our best guess would be the mean risk of a heart attack

( y ). If we call our predicted variable Ŷ , and a predicted individual value ŷ , then

our best guess could be written

yy =ˆ

We could also write it like this:

ε+= yy

where ε represents ‘error variability’ or natural variation. The error in our best guess
would be the same as the natural variability in Y — it would be described by some

way by the standard deviation of Y, Ys , or the variance, 2
Ys . The sample variance

(which estimates the population variance), remember, is

1

)( 2
2

−
∑ −=

n

yy
sY

This variance, like any variance, is the sum of squared deviations about the mean
divided by the number of degrees of freedom that the variance estimate is based on.
Because they are conveniently additive, we could write the variability in our esti-
mate just in terms of the sum of squared deviations about the mean — the sum of
squares:
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∑ −== 2
totalY )(SSSS yy

This is the total variability in cholesterol, so it’s sometimes written SStotal. Now sup-
pose we also measure cholesterol levels (X) for each of our subjects. We now have
(x, y) pairs (cholesterol and heart attack risk) for each subject. We could predict Y
from X using linear regression. We would call the predicted variable Ŷ , and we’d
call an individual predicted value ŷ . A standard linear regression (see handouts at

www.pobox.com/~rudolf/psychology) will give us this equation:

bXaY +=ˆ

where a is the intercept and b is the slope. We could also write our model like this:

εε ++=+= bxayy ˆ

Now our best guess of the heart attack risk of a new subject should be rather better
than yy =ˆ ; if we measure our new subject’s cholesterol as well, we can make what

should be a better prediction:

bxay +=ˆ

The error in this prediction will related to the deviations between the predicted
value, ŷ , and the actual value, y. We could write this either in terms of a variance…

2
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2
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… or as a sum of squares:

∑ −= 2
residual )ˆ(SS yy

If cholesterol is somehow linearly related to heart attack risk, the error in our pre-
diction, which was SStotal, has now been reduced to SSerror. Therefore, the amount of
variability in Y that we have accounted for by predicting it from X, which we can
write as SSregression or SSmodel or 

Y
SS ˆ , is based on the difference between the pre-

dicted values and the overall mean:

∑ −= 2
model )ˆ(SS yy

It’s also true that

residualmodeltotal
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Since we have already calculated the overall mean, and the regression line always
passes through the overall mean, the regression model has one df (its slope). That is,
people vary in their cholesterol levels (SSX), they vary in their heart attack risk (SSY

= SStotal), a certain amount of the variability in their heart attack risk is predictable
from their cholesterol ( modelˆ SSSS =

Y
), and a certain amount of variability is left

over after you’ve made that prediction (SSresidual = SSerror). Incidentally, the propor-
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tion of the total variability in Y that’s accounted for by predicting it from X is also
equal to r2:
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We can illustrate SStotal, SSmodel, and SSresidual like this:
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What would it mean to alter SSmodel and SSresidual? If you pulled all of the scores
‘further away’ from the regression line (if a point is above the regression line, move
it up; if it’s below, move it down) without changing the slope of the regression line,
you’d increase SSerror without altering SSmodel. If you altered the slope of the regres-
sion line but moved the individual scores up or down to keep them the same distance
from the line, you’d increase SSmodel without changing SSresidual.

2.3.2 Linear regression as an ANOVA

We can use this way of writing a linear regression model to express linear regression
as an ANOVA. If there is no correlation between X and Y, then predicting Y from X
won’t be any better than using y  as our estimate of a value of y. So we could obtain

a measure of the total variability in Y:
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and we could similarly obtain
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If the null hypothesis is true and there is no correlation between X and Y, then some
of the variation in Y will, by chance, fit a linear model, and contribute to SSmodel. The
rest will not, and will contribute to SSresidual. The corresponding MS values, once we
have divided by the df, will be measuring the same thing — the variability of Y. That
is, under the null hypothesis, E(MSmodel) = E(MSerror). On the other hand, if there is a
correlation, and Y varies consistently with X, then SSmodel will contain variation due
to this effect as well as variation due to other things (error), but SSresidual will only
contain variation due to other things (error). Therefore, if the null hypothesis is false,
E(MSmodel) > E(MSerror). We can therefore compare MSmodel to MSerror with an F test;
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if they are significantly different, we reject the null hypothesis. Our ANOVA table
would look like this:

Source                         d.f.             SS              MS                        F                            
Model 1 SSmodel SSmodel/dfmodel MSmodel/MSerror

Error (residual) N–2 SSerror SSerror/dferror

Total N–1 SStotal

where N is the total number of (x, y) observations. To calculate a regression

ANOVA by hand, SStotal can be calculated as )1(2 −nsY  and SSmodel can be calculated

as total
2 SS×r .

2.4 Factors versus covariates

We’ve seen that we can perform an ANOVA to predict our dependent variable using
a discrete variable, or factor, that has several ‘levels’ — as when we asked
whether word recall differed between five groups that had read the same word list in
different ways. We saw a pictorial representation of a three-group example. We’ve
also seen that we can perform an ANOVA to predict our dependent variable using a
continuous variable, or covariate, as in our linear regression example, and we’ve
seen a pictorial representation of that.

The mathematical technique of ANOVA does not ‘care’ whether our predictor vari-
ables are discrete (factors) or continuous (covariates). We’ll see that in Part 6 when
we look at the idea of a general linear model (p. 84).

However, the way most people use covariates is slightly different from the way they
use factors. If you are running an experiment, you do not generally assign subjects
to different values of a continuous variable (covariate) — you assign subjects to dif-
ferent levels of a factor, with several subjects per level (group). Therefore, real-life
covariates are generally things that you measure rather than things that you ma-
nipulate. As a consequence, most people use covariates and analysis of covariance
(ANCOVA) as a way to increase the power of ANOVA — if you can account for
some of your ‘error’ variability by using a covariate to predict your dependent vari-
able, there is less ‘error’ variability and therefore there may be more power to detect
effects of the factors that you’re interested in.

2.5 Assumptions of ANOVA involving covariates

Take a common design involving covariates: a design with one between-subjects
factor and one between-subjects covariate. Suppose you have 100 children at your
disposal. You measure their IQ. Then you randomly assign 50 children to receive
the standard method of maths teaching, and 50 children to receive a new method.
This represents the between-subject factor Method, with two levels. After some
time, you measure their mathematical problem-solving ability. But you suspect that
their IQ may also play a part in determining their final score, not just the teaching
method — IQ may be contributing to the ‘error’ (unmeasured) variability in the
scores of your two groups. So you enter IQ as a covariate into your ANOVA model.
This covariate may therefore account for some of the previously-unmeasured vari-
ability, reducing your ‘error’ term, and increasing the power to detect an effect of
teaching method.

If you use ANCOVA in this way, there are a few assumptions (Myers & Well, 1995,
pp. 439-440; Howell, 1997, p. 587):

• that the relationship between the covariate and the dependent variable is linear;
• that the regression slopes relating the covariate to the dependent variable are the

same in both groups — homogeneity of regression.
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This is the design discussed in §7.12.1 (p. 138). The second assumption is directly
testable, and the method for testing it is discussed in §7.12.2 (p. 144).

A final assumption in this sort of design is this:

• that the covariate and the treatment are independent (Myers & Well, 1995, p.
451). If this is not the case, interpretation is very difficult. Using X as a covari-
ate removes the component of Y predictable from X. If the treatment influences
X or is otherwise predictable from X, performing an ANCOVA will not simply
remove nuisance variability from Y; it will remove part of the effect of the
treatment itself. For example, if you had measured IQ at the end of the experi-
ment and the teaching method actually influenced IQ, interpretation would be
very hard; similarly, it would be hard to interpret if you had assigned high-IQ
students to one teaching method and low-IQ students to another. This can also
be a problem in situations when you are using (for example) patient groups and
IQ (if the patients have a different IQ to the controls), or sex and body mass
(males have a higher body mass).

2.6 ANOVA with two between-subjects factors

We can extend our basic one-way ANOVA to two factors. Suppose we have two
factors, one with two levels and one with five levels; this design would be called a 2
× 5 factorial. Suppose we repeat our previous experiment (Howell, 1997, p. 403) but
for young and old subjects. Factor A is age (young versus old); factor B is task type
(counting, rhyming, adjective, imagery, intentional). Suppose our results look like
this:

No. words
recalled

B1

Counting
B2

Rhyming
B3

Adjective
B4

Imagery
B5

Memorize
Total

A1 9 7 11 12 10
old 8 9 13 11 19

6 6 8 16 14
8 6 6 11 5

10 6 14 9 10
4 11 11 23 11
6 6 13 12 14
5 3 13 10 15
7 8 10 19 11
7 7 11 11 11

total TA1B1 = 70 TA1B2 = 69 TA1B3 = 110 TA1B4 = 134 TA1B5 = 120 TA1 =503

A2 8 10 14 20 21
young 6 7 11 16 19

4 8 18 16 17
This dotted 6 10 14 15 15

line 7 4 13 18 22
encloses 6 7 22 16 16
one cell. 5 10 17 20 22
This is a 7 6 16 22 22

very 9 7 12 14 18
important 7 7 11 19 21

term to TA2B1 = 65 TA2B2 = 76 TA2B3 = 148 TA2B4 = 176 TA2B5 = 193 TA2 = 658
understand!

TB1 = 135 TB2 = 145 TB3 = 258 TB4 = 310 TB5 = 313 T = Σx = 1161

Note our definition of cell — one particular (A, B) condition, such as A2B1 (shown
here with a dotted line around it).

2.6.1 Structural model and terminology (main effects, interactions, simple effects)

Our ANOVA must allow for the effects of factor A, and factor B. It should also al-
low the possibility that A and B interact — that the effect of factor A depends on
the level of factor B, or vice versa. For example, suppose that young people are gen-
erally better, regardless of task type; we would call this a main effect of factor A
(age). A main effect is an effect of a factor regardless of (ignoring) the other fac-
tor(s). Suppose that the ‘memorize’ condition gives better recall than the ‘counting’
condition, regardless of age; we would call this a main effect of factor B (task type).
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On the other hand, perhaps young people have a particular advantage in the ‘memo-
rize’ condition but not in other conditions; this would be an interaction between A
and B, written ‘A × B’ or sometimes ‘AB’. We may also define, for later, the term
simple effect: this is an effect of one factor at only one level of another factor. For
example, if the ‘memorize’ condition gives better performance than the ‘adjective’
condition considering young people only, this is a simple effect of factor B (task
type) at the ‘young’ level of factor A (age).

We can specify a model, just as we did before:

ijkijjiijk εµX ++++= αββα

where
• Xijk = the score of person k in condition AiBj

• µ = the overall mean score
• αi = the degree to which the mean of condition Ai deviates from the overall

mean (= the contribution of condition Ai), i.e. µµα −=
iAi . By this definition,

0=∑ iα .

• βj = the degree to which the mean of condition Ai deviates from the overall
mean (= the contribution of condition Bj), i.e. µµβ −=

jBj . By this definition,

0=∑ jβ .

• αβij = the degree to which the mean of condition AiBj deviates from what you’d
expect based on the overall mean and the separate contributions of Ai and Bj (=
the interaction A × B), i.e. )( jiBAij ji

βαµµαβ ++−= . By this definition,

0=∑=∑
j

ij
i

ij αβαβ .

• εijk = the ‘error’ or amount by which person k in condition AiBj deviates from
the mean of his or her group (the ‘uniqueness’ of person k in condition AiBj),
i.e. )( ijjijijkijk X αββαµε +++−= . By our usual assumption of normal dis-

tribution of error, εijk is normally distributed with mean 0 and variance 2
eσ .

2.6.2 Expected mean squares

Although we won’t derive it, the EMS terms are:

Source E(MS)
A 22

Ae nbσσ +
B 22

Be naσσ +
AB (A × B) 22

ABe nσσ +
Error 2

eσ

(Note that these EMS values assume that the factors are fixed factors; see p. 31.) So
we should be able to form F ratios based on the error term. For example, if the null

hypothesis that factor A has no effect is true, µA1 = µA2 = 0, so 02 =Aσ  and E(MSA)

= E(MSerror). If this null hypothesis is false, E(MSA) > E(MSerror). So the ratio

2

22

error

A

)MS(

)MS(

e

Ae nb

E

E

σ
σσ +=

can be tested using an F test with dfA and dferror degrees of freedom.

2.6.3 Degrees of freedom

There are n = 10 subjects per (A, B) condition (per cell), so N = 100 observations in
all. Therefore, dftotal = 99. By our usual rules, dfA = 1 and dfB = 4 (one less than the
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number of levels). The interaction term, written ‘A × B’ or ‘AB’, represents the
possibility that the effects of factors A and B represent each other. The df for an in-
teraction term A × B is always the product of dfA and dfB — in our example, 4. So
our total df are partitioned like this:

error

errortotal

44199 df

dfdfdfdfdf ABBA

+++=
+++=

so we have 90 error df in our example.

2.6.4 Sums of squares

Similarly,

errorABBAtotal SSSSSSSSSS +++=

SStotal is calculated exactly as before: the sum of squared deviations of every obser-
vation from the grand mean.












∑

∑−=∑ −=
n

x
xxx

2
22

total
)(

)(SS

The SS for factor A is calculated exactly as we would if this were a one-way
ANOVA without the other factor. The same’s true for SSB. That is, we take the sum
of the squares of the deviations of the means of each A condition (A1, A2…) from the
overall mean, summed over every observation. (In terms of totals, it’s the sum of the
squares of the deviations of the totals of each A condition — A1, A2, … — from the
overall mean total, divided by the number of observations on which each mean was
based.) In our example, since there are 2 A conditions and each is made up of n ob-
servations per cell and 5 cells (= b = levels of B) per A condition, there are nb ob-
servations contributing to each A condition mean. So:











 ∑−∑=∑ −=∑ −=











 ∑−∑=∑ −=∑ −=

N

x

na

T

na

TT
xxna

N

x

nb

T

nb

TT
xxnb

BB
B

AA
A

222
2

B

222
2

A

)()(
)(SS

)()(
)(SS

To find the interaction term SSAB, we calculate an intermediate value, SScells, which
measures the variability of the cell means. Since cell variability can be due to A, B,
or AB, we can see that SScells = SSA + SSB + SSAB, and therefore calculate SSAB this
way. SScells is the sum of the squares of the deviations of individual cell means from
the grand mean, summed over each observation. (In terms of totals, it’s the sum of
the squares of the deviations of individual cell totals from the grand mean total, di-
vided by the number of observations that contributed to each cell mean — i.e. the
number of observations per cell.) Whew.

)SS(SSSSSS

)()(
)(SS

BAcellsAB

222
2

cells

+−=










 ∑−∑=∑ −=∑ −=
N

x

nb

T

n

TT
xxn ABAB

AB

To find the error term, we know that

errorcellserrorABBAtotal SSSSSSSSSSSSSS +=+++=

so we can find SSerror by subtraction. Alternatively, we could calculate SSerror as the
grand sum of the sums of the squares of the deviations of individual observations
from their cell means.
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2.6.5 Relating SS calculations to the structural model

Note that our structural model was this:

)(

)(

ijjiijkijk

jiBAij

Bj

Ai

ijkijjiijk

µX

εµX

ji

j

i

αββαε

βαµµαβ

µµβ
µµα

αββα

+++−=

++−=

−=

−=

++++=

and our SS were these:

)SSSSSS(SSSS

)SSSS()(SS

)(SS

)(SS

)(SS

ABBAtotalerror

BA
2

AB

2
B

2
A

2
total

++−=
∑ +−−=

∑ −=

∑ −=

∑ −=

xxn

xxna

xxnb

xx

AB

B

A

See the similarity?

2.6.6 ANOVA table

We’ve ended up with this:

Source  of variation                            d.f.                         SS                    MS                              F                                  
Between cells dfA+dfB+dfAB SScells

A a–1 SSA SSA/dfA MSA/MSerror

B b–1 SSB SSB/dfB MSB/MSerror

AB (A × B) (a–1)(b–1) SSAB SSAB/dfAB MSAB/MSerror

Within cells (= error = S/cells) ab(n–1) SSerror SSerror/dferror

Total N–1 = abn – 1 SStotal SStotal/dftotal [=
2s ]

2.7 Within-subjects (repeated measures) ANOVA

Principle: if a set of measurements are more correlated than we would expect
by chance, we must account for this correlation. We can say that these measure-
ments come from the same ‘subject’ (in psychological terminology), or that this
measure was ‘repeated’.

Suppose we have one within-subjects factor. Call it U. Let’s suppose we’ve meas-
ured all our subjects in three conditions (U1 hot, U2 warm, U3 cold), once each, and
have counterbalanced appropriately to avoid nasty order effects. All we have to do is
to partition the sum of squares so as to account for the fact that we’ve measured
subjects several times each…

2.7.1 Structural model

Our structural model is either one of these two:

ijjiijX εαπµ +++=  (Model 1: ‘additive’)

ijijjiijX επααπµ ++++=  (Model 2: ‘nonadditive’)

where
• Xij is the dependent variable for subject i in condition Uj

• µ is the overall mean
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• πi is the contribution from a particular person or subject (subject i, or Si):
µµπ −=

iSi .

• αj is the contribution from a particular level (level j) of the factor U:
µµα −=

jUj .

• παij is the contribution from the interaction of subject i with treatment j:
)( jiUSi ji

απµµπ ++−= . This interaction would reflect that the subjects re-

sponded differently to the different levels of U.
• εij is everything else (the experimental error associated with subject i in condi-

tion j). In Model 1, this will be )( jiijij X απµε ++−= . In Model 2, this will

be )( ijjiijij X πααπµε +++−= .

These two models differ in the presence or absence of παij, the interaction of U with
a particular person (Howell, 1997, pp. 452-454). Including it makes for a realistic
model — it is likely that subjects do not all respond equally to all conditions (levels
of U). However, if we measure each person in each condition once, we will not be
able to measure differences in the way subjects respond to different conditions inde-
pendently of other sources of error such as measurement error. (To do that, we’d
need to measure subjects more than once per condition, and then we’d need a differ-
ent model again!) This is another way of saying that the S × U interaction is con-
founded with — is! — the ‘error’ term.

2.7.2 Degrees of freedom

We partition the df like this:

USerror Usubjectswithin 

subjectswithin subjectsbetween total

×+=

+=

dfdfdf

dfdfdf

Therefore

subjectsbetween totalerror

U

subjectsbetween 

total

errorUsubjectsbetween total

1

1

1

dfdfdf

udf

sdf

Ndf

dfdfdfdf

−=
−=

−=
−=

++=

where s is the number of subjects, u is the number of levels of U, and N is the total
number of observations (= su). We could also write dfbetween subjects as dfS, which you
sometimes see.

2.7.3 Sums of squares

Similarly, we can partition the SS like this:

errorUsubjectsbetween total

USerror Usubjectswithin 

subjectswithin subjectsbetween total

SSSSSSSS

SSSSSS

SSSSSS

++=

+=

+=

×

We can define our SS as usual…

( )
( )
( )∑ −=

∑ −=

∑ −=

2
subjectsbetween 

2
U

2
total

SS

SS

SS

xxu

xxs

xx

S

U
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where s is the number of subjects and u is the number of levels of U. Ux  represents

the mean for a particular level of U (across subjects), and Sx  represents the mean

for a particular subject (across levels of U). Our total number of observations will be
N = su.

2.7.4 EMS and ANOVA summary table

The EMS depend on which model we use:

Source of variation Model 1: E(MS) Model 2: E(MS)
Between subjects (S) 22

Se uσσ + 22
Se uσσ +

U 22
Ue sσσ + 222

UUSe sσσσ ++
Error 2

eσ 22
USe σσ +

This means that in Model 2 it’s rather hard to do a proper F test for the ‘between
subjects’ factor, since there’s no term whose E(MS) is identical to E(MSbetween subjects)

except for the presence of 2
Sσ , the relevant variance for the between-subjects factor.

On the other hand, who cares. If this term were significant, all it would tell us is that
subjects are different, which is hardly earth-shattering. Either way, we have no
problem testing U: the proper way to test for an effect of U is to do an F test com-
paring MSU to MSerror.

If Model 1 is true — if subjects respond equally to the treatments; if the effects are
additive — we will have more power to detect effects of U, since if the null hy-
pothesis (that U has no effect) is false,

)(MS

)(MS

)(MS

)(MS

2 modelerror

2 modelU
22

222

2

22

1 modelerror

1 modelU

−

−

−

− =
+

++
>

+
=

E

Ess

E

E

USe

UUSe

e

Ue

σσ
σσσ

σ
σσ

and the bigger the ratio of MSU to MSerror, the bigger the F ratio, and the more likely
the effect is to be ‘significant’ (Myers & Well, 1995, p. 244; Howell, 1997, pp. 452-
454).

You may be thinking ‘the calculations for the two models are exactly the same in
practice, so why all this fuss?’ You’d be right — unless you wanted to estimate the
proportion of variance accounted for by a particular term (Myers & Well, 1995, pp.
242, 252-255). See p. 112.

2.8 Assumptions of within-subjects ANOVA: Mauchly, Greenhouse–Geisser, etc.

2.8.1 Short version

1. Any ANOVA involving within-subjects factors has a potential problem.
There is an assumption known as ‘sphericity [of the covariance matrix]’. If
this assumption is violated, Type I error rates will be inflated (if the null
hypothesis is true, you will get too many results that you will declare ‘sig-
nificant’ than you should).

Mauchly’s test of sphericity checks for this. A significant Mauchly’s test means that
the assumption is likely to have been violated. But it’s not a very good test (see be-
low), so we should probably ignore it.

2. Correct the df for any term involving a within-subjects factor, and the cor-
responding error df, by multiplying them both by a correction factor. The
correction factor is known as ‘epsilon’ (ε). If the sphericity assumption is not
violated, ε = 1 (so applying the correction changes nothing). You do not need to
correct any terms that have only between-subjects factors. And you can never
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violate the sphericity assumption for a within-subjects factor that has only 2
levels.

3. Use either the Greenhouse–Geisser or the Huynh–Feldt epsilon. The Green-
house–Geisser one (sometimes written ε̂ ) is probably a bit too conservative;
the Huynh–Feldt one (sometimes written ε~ ) is better (Myers & Well, 1995, p.
248; Howell, 1997, p. 465) — but more detail below.

SPSS reports Mauchly’s test and both the G–G and H–F corrections whenever you
run a within-subjects ANOVA using its menus.

Just to confuse you, there are actually several different approaches:

• NOT THE BEST: Look at the results of Mauchly’s test; apply a correction (G–
G or H–F) if and only if Mauchly’s test is significant for a factor that’s part of
the term in question, indicating a violation of the sphericity assumption. This is
not ideal, because Mauchly’s test isn’t very reliable (Myers & Well, 1995, p.
246; Howell, 1997, p. 466, and see below).

• NOT THE BEST: Always use the Greenhouse–Geisser correction. Too conser-
vative.

• Good and simple: Always use the Huynh–Feldt correction. This is not to-
tally ideal because the H–F procedure tends to overestimate sphericity (be a bit
too optimistic) (see refs in Field, 1998), but it’s pretty good; Myers & Well
(1995, p. 248) recommend it.

• OK but awkward: use the average of the ε̂  and ε~ .
• Good: Look at the estimated epsilons (G–G ε̂  and H–F ε~ ); if they’re in

the region of 0.75 or higher (in some textbooks, if ε̂  ≥≥≥≥ 0.75) use the H–F ε~ ;
if below, use the G–G ε̂  (Howell, 1997, pp. 465-466).

Of course, if you really want to avoid Type I errors, you’d be predisposed to using
the G–G correction (conservative); if you’d rather avoid Type II errors, you’d be
predisposed to using the H–F correction (more liberal).

2.8.2 Long version

Sphericity is the assumption of homogeneity of variance of difference scores (Myers
& Well, 1995, p. 244-250); see also www-staff.lboro.ac.uk/~hutsb/Spheric.htm.
Suppose we test 5 subjects at three levels of A. We can therefore calculate three sets
of difference scores (A3 – A2), (A2 – A1), and (A3 – A1), for each subject. Sphericity
is the assumption that the variances of these difference scores are the same. Here are
two examples:

Data set A: exhibiting sphericity
(homogeneity of variance of difference scores)

Subject
A1 A2 A3 difference

A3 – A2

difference
A2 – A1

difference
A3 – A1

S1 21.05 7.214 26.812 19.598 -13.836 5.762
S2 6.915 29.599 16.366 -13.233 22.684 9.451
S3 3.89 21 41.053 20.053 17.11 37.163
S4 11.975 12.401 18.896 6.495 0.426 6.921
S5 31.169 34.786 31.872 -2.914 3.617 0.703

mean 15.00 21.00 27.00 6.00 6.00 12.00
variance 124.00 132.00 100.00 208.00 208.00 208.00
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Data set B: exhibiting nonsphericity

Subject
A1 A2 A3 difference

A3 – A2

difference
A2 – A1

difference
A3 – A1

S1 1.7 3.9 6 2.1 2.2 4.3
S2 4.4 6.5 14.5 8 2.1 10.1
S3 7.8 13.3 18.6 5.3 5.5 10.8
S4 6.6 9.4 14.5 5.1 2.8 7.9
S5 9.1 15.2 23.5 8.3 6.1 14.4

mean 5.92 9.66 15.42 5.76 3.74 9.50
variance 8.56 21.79 41.46 6.38 3.65 13.92

In general, if there are a treatment levels, there are 
2

)1( −aa
 difference scores, and it

is assumed that they all have the same variance.

Obviously, the sphericity assumption cannot be violated if the within-subjects factor
has less than 3 levels.

The sphericity assumption will be met if there is no S × A interaction (if there is ad-
ditivity). In this case, any difference score is exactly the same over subjects, so there
is zero variance in the difference scores. However, sphericity can be met without ad-
ditivity, as shown above (that is to say, additivity is sufficient but not necessary for
sphericity).

Another condition that is sufficient (but not necessary) for sphericity is compound
symmetry. This requires homogeneity of the population treatment variances:

…== 2
2

2
1 AA σσ

and homogeneity of the population covariances:

…=== 323,2313,1212,1 AAAAAAAAAAAA σσρσσρσσρ

where ρA1,A2 is the population correlation between the A1 and A2 scores, and
ρA1,A2σA1σA2 is their covariance (see handouts at pobox.com/~rudolf/psychology).
The variance sum law tells us that the variance of a difference between two variables
is

YXXYYXYX σσρσσσ 2222 −+=−

and so if the two conditions above are met, the variances of the difference scores
will all be the same. Howell (1997, p. 455) explains why the term ‘compound sym-
metry’ is applied to this situation, using a matrix that illustrates variances and co-
variances between A1, A2, and A3 (this is illustrated under covariance matrix in the
Glossary on p. 214). However, the explanation is not as clear as Myers & Well’s.
Yet data set A shown above exhibits sphericity without compound symmetry (that
is, although the variances of difference scores are identical, i.e. sphericity is true, the
variances of the individual scores are not the same and nor are the covariances for
pairs of treatments).

Myers & Well (1995, p. 246) don’t like Mauchly’s test because it tends to give ‘sig-
nificant’ results (suggesting a problem) even in situations when sphericity holds —
that is, using Mauchly’s test is a conservative approach.

The three things you can do about violations of sphericity are (1) the usual F test
with adjusted degrees of freedom, as suggested above (after Box, 1954); (2) multi-
variate ANOVA (MANOVA) (see p. 92); (3) tests of planned contrasts (see p. 75).
See Myers & Well (1995, pp. 246-252).
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2.9 Missing data in designs involving within-subjects factors

If some data are lost for a particular subject, you have a problem. You can either as-
sume the ‘additive’ model discussed above — that the effect of within-subjects fac-
tors are the same for all subjects — and estimate the missing value (Myers & Well,
1995, p. 256-8). Every time you estimate a value, you reduce the df for the relevant
error term by 1. If you don’t assume the additive model, you can’t estimate the
value, and you may then have to throw out all data for that subject. SPSS does
the latter by default.

2.10 Mixed ANOVA (with both between-subjects and within-subject factors)

We will illustrate the simplest mixed design here: one between-subjects factor and
one within-subjects factor. General principles of more complicated within-subjects
models are given by Keppel (1991, pp. 491-496), and laid out in Part 7.

Suppose we take three groups of rats, n = 8 subjects per group (s = 24 subjects total).
We give one group treatment A1, one group treatment A2, and one group treatment
A3 (a = 3). One subject only experiences one treatment. Note that s = an. Then we
measure every subject’s performance at six time points U1…U6 (u = 6). We have N
= su = anu = 8 × 3 × 6 = 144 observations in total.

We first partition the total variation into between-subjects variability and within-
subjects variability.

The between-subjects variability can be attributed to either the effect of the treat-
ment group (A), or differences between subjects in the same group (‘S within A’ or
‘S/A’). (This notation indicates that there is a different group of subjects at each
level of the between-subjects factor, A; we could not measure simply ‘subject varia-
tion independent of the effects of A’ since no subjects ever serve in more than one
group, or level of A.) So we have these sources of between-subjects variability:

A
S/A

The within-subjects variability can be attributed to either the effects of the time
point (U), or an interaction between the time point and the drug group (U × A), or an
interaction between the time point and the subject-to-subject variability, which again
we can only measure within a drug group (U × S/A). So we have these sources of
within-subject variability:

U
U × A
U × S/A

2.10.1 Structural model

Following Myers & Well (1995, p. 295-6):

ijkijkikkijiijkX επβαββπαµ ++++++= //

where
• Xijk is the dependent variable for subject j in group Ai and condition Uk

• µ is the overall mean
• αi is the contribution from a particular level (level i) of factor A: µµα −=

iAi .

By this definition, 0=∑ iα .

• πj/i is the contribution from a particular person or subject (subject j), who only
serves within condition Ai (‘subject within group’, or S/A): µµπ −=

ij ASij // .
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(There is no straightforward interaction of A with S: every subject is only
measured at one level of A, so this term would be indistinguishable from
the subject-only effect πj/i.)

• βk is the contribution from a particular level (level k) of factor U:
µµβ −=

kUk . By this definition, 0=∑ jβ .

• αβik is the contribution from the interaction of Ai and Uk:
)( kiUAik ki

βαµµαβ ++−= . By this definition, 0=∑=∑
k

ik
i

ik αβαβ .

• πβjk/i is the contribution from the interaction of Uk with subject j, which can
only be measured within one level of A (it’s the ‘SU/A’ term):

)( /// kijAUSijk ikj
βπµµπβ ++−= . By this definition, 0/ =∑

k
ijkπβ .

(There is no straightforward three-way A × U × S interaction: every sub-
ject is only measured at one level of A, so this term would be indistin-
guishable from the SU/A effect πβjk/i.)

• εijk is everything else (the experimental error associated with measuring person j
— who always experiences treatment Ai — in condition Uk):

)( // ijkikkijiijkijk X πβαββπαµε +++++−= .

Note that we cannot actually measure εijk independent of the SU/A term
if we only have one measurement per subject per level of U; this term
simply contributes to the within-subjects error term (see below).

2.10.2 Degrees of freedom

We can partition the df like this:

ASUAUUsubjectswithin 

ASAsubjectsbetween 

subjectswithin subjectsbetween total

/

/

dfdfdfdf

dfdfdf
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×× ++=

+=

+=

So now we can calculate all our df. (Often, dfbetween subjects and SSbetween subjects are sim-
ply written dfS and SSS.)
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2.10.3 Sums of squares

The partitioning is always exactly the same as for the df:

ASUAUUsubjectswithin 

ASAsubjectsbetween 

subjectswithin subjectsbetween total

SSSSSSSS

SSSSSS

SSSSSS

/

/

×× ++=

+=

+=

So
SStotal = SSA + SSS/A + SSU + SSU×A + SSU×S/A

We have two different ‘error’ terms, one for the between-subjects factor and one for
the within-subjects factor (and its interaction with the between-subjects factor), so
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we can’t just label them ‘SSerror’. But we could rewrite the total like this if we
wanted:

SStotal = SSA + SSerror-between + SSU + SSU×A + SSerror-within

Now we can calculate the SS. Remember, each SS must be made up of N compo-
nents, because there are N observations. Take the example of SSA: we calculate this
by summing over a means (namely 

a
xxx AAA ,,

21
… ). But each mean is based on (or,

if you prefer, contributes to) N/a = su/a = anu/a = nu individual scores; we there-
fore multiply our deviations by nu to get the total SSA.
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Just to make it clear how many scores each mean is based on:

Subject U1 U2 U3 U4 U5 U6 u = 6

A1 S1 datum datum datum datum datum datum Ax  means are

S2 datum datum datum datum datum datum based on nu =
S3 datum datum datum datum datum datum 48 scores
S4 datum datum datum datum datum datum
S5 datum datum datum datum datum datum
S6 datum datum datum datum datum datum
S7 datum datum datum datum datum datum
S8 datum datum datum datum datum datum

A2 S9 datum datum datum datum datum datum
S10 datum datum datum datum datum datum
S11 datum datum datum datum datum datum Sx  means are

S12 datum datum datum datum datum datum based on u = 6
S13 datum datum datum datum datum datum scores
S14 datum datum datum datum datum datum
S15 datum datum datum datum datum datum
S16 datum datum datum datum datum datum

A3 S17 datum datum datum datum datum datum UAx  means are

S18 datum datum datum datum datum datum based on n = 8
S19 datum datum datum datum datum datum scores
S20 datum datum datum datum datum datum
S21 datum datum datum datum datum datum
S22 datum datum datum datum datum datum
S23 datum datum datum datum datum datum
S24 datum datum datum datum datum datum

Ux  means are based

a = 3 s = 24
au = 24

on an = s = 24 scores N = su = anu =
144
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2.10.4 ANOVA table

Source                               d.f.                                     SS                    F                      
Between subjects (S): s–1 = an – 1

A a–1 SSA MSA/MSS/A

error S/A (an–1)–(a–1) = a(n–1) SSS/A

Within subjects: (N–1)–(s–1) = an(u–1)
U u–1 SSU MSU/MSU×S/A

U × A (u–1)(a–1) SSU×A MSU×A /MSU×S/A

error U × S/A a(u–1)(n–1) SSU×S/A

Total N–1 = aun – 1 SStotal

where a is the number of levels of factor A, etc., N is the total number of observa-
tions (= aun), n is the number of subjects per group (per level of A), and s is the total
number of subjects.

2.11 Fixed and random factors

When we consider ANOVA factors we must distinguish fixed factors, which contain
all the levels we are interested in (e.g. sex: male v. female) and random factors,
where we have sampled some of the possible levels at random (e.g. subjects). Ran-
dom factors can be thought of as those whose levels might change; if we repeated
the experiment, we might pick different subjects.

Sometimes the fixed/random distinction is pretty much inherent in the factor —
Subjects is usually a random factor, for example. But sometimes whether a factor is
fixed or random really does depend on the study. Howell (1997, p. 330) uses the ex-
ample of painkillers. If we are asked to study the relative efficacy of the UK’s four
most popular over-the-counter painkillers, we have no choice in which painkillers
we study. If we were asked to repeat the study, we would use the same four painkill-
ers. Painkillers would be a fixed factor. If, on the other hand, we were asked to com-
pare several painkillers to see if ‘one brand is as good as the next’, we might select a
few painkillers randomly from the dozens on offer. In this case, where our sample is
intended to be representative of painkillers in general but where it is an arbitrary and
non-exclusive sample, we would consider Painkiller to be a random factor. Further
examples are given by Keppel (1991, p. 485 and Appendix C), and by Myers &
Well (1995, pp. 270-1).

When we test effects involving a random factor, we often have to test effects against
an interaction term. Examples are given in the consideration of within-subjects de-
signs (which involve random factors, since Subjects is a random factor). The deter-
mination of appropriate error terms is discussed later in the section on expected
mean squares (EMS) (p. 73), which are different for fixed and random factors.
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Part 3: practical analysis

3.1 Reminder: assumptions of ANOVA

1. Homogeneity of variance

We assume that each of our groups (conditions) has the same variance.

• How to check? In SPSS, Levene’s test (Levene, 1960) checks this assump-
tion. To obtain it, choose Options → Homogeneity tests from the ANOVA
dialogue box. If Levene’s test produces a ‘significant’ result, the assumption
is violated — there is heterogeneity of variance. This is a Potentially Bad
Thing. Consider transformation of the data (see below, p. 34). You can also
plot the standard deviation (and variances) versus the means of each level of
a factor by choosing Options → Spread vs. level plot.

• Unequal ns exaggerate the consequences of heterogeneity of variance — a
Bad Thing (p. 33) (see also Myers & Well, 1995, p. 105-106).

2. Normality

We assume that the scores for each condition are normally distributed around the
mean for that condition. (This assumption is the same as saying that error is nor-
mally distributed within each condition.)

• How to check? You can inspect the data to get an idea whether the data are
normally distributed in each condition. In SPSS, choose Analyze → De-
scriptive Statistics → Explore. This gives you get stem-and-left plots, box-
plots, and so on. In the dialogue box, tick ‘Both’ to get statistics and plots;
click Plots → Normality plots with tests. This produces a Q–Q plot — a
plot of each score against its expected z value (the value it would have if the
distribution were normal — calculated as the deviation of the score from the
mean, divided by the standard deviation of the scores). If this produces a
straight line, the data are normally distributed. You also get the Kol-
mogorov–Smirnov test with Lilliefors correction (Lilliefors, 1967) ap-
plied to a normal distribution, and the Shapiro–Wilk test (Shapiro & Wilk,
1965) — if these are significant, your data are not normally distributed — a
Bad Thing. Consider transformation of the data (see below, p. 34).

3. Independence of observations

We also assume that the observations are independent — technically, that the error
components (ε) are independent. For any two observations within an experimental
treatment, we assume that knowing how one of these observations stands relative to
the treatment (or population) mean tells us nothing about the other observation.
Random assignment of subjects to groups is an important way of achieving this. We
must account for any non-independence of observations — for example, observa-
tions that are correlated because they come from the same subjects — by adding
factors (e.g. Subject) that account for the non-independence. Introducing factors to
account for non-independence of observations makes the error terms independent
again, and we’re OK. However, these designs — known as within-subject or re-
peated measures designs — have their own assumptions, listed below.

• A statistics package can’t check this assumption for you! It depends on your
experiment.
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3.2 Reminder: assumption of ANOVA with within-subject factors

Sphericity

Any ANOVA involving within-subjects factors assumes sphericity (discussed ear-
lier). If this assumption is violated, Type I error rates will be inflated (if the null hy-
pothesis is true, you will get too many results that you will declare ‘significant’ than
you should). A simple plan of action:

• Look at Mauchly’s test of sphericity. A significant Mauchly’s test means
that the assumption is likely to have been violated.

• When the assumption has been violated for a particular within-subjects fac-
tor, correct the df for any term involving the within-subjects factor, and the
corresponding error df, by multiplying them both by epsilon (ε).

• Use either the Greenhouse–Geisser or the Huynh–Feldt epsilon. The Green-
house–Geisser one (sometimes written ε̂ ) is probably a bit too conservative;
the Huynh–Feldt one (sometimes written ε~ ) is better (Myers & Well, 1995,
p. 248; Howell, 1997, p. 465).

SPSS reports Mauchly’s test and both the G–G and H–F corrections whenever you
run a within-subjects ANOVA using its menus.

You never need to correct any terms that have only between-subjects factors. And
you can never violate the sphericity assumption for a within-subjects factor that has
only 2 levels.

3.3 Consequences of violating the assumptions of ANOVA

• Independence of observations. If there are correlations between scores that are
not taken account of by the ANOVA model, Type I error rates can be inflated
(Myers & Well, 1995, p. 69, 101).

• Normality. The Type I error rate is not affected much by sampling from non-
normal populations unless the samples are quite small and the departure from
normality extremely marked (Myers & Well, 1995, pp. 69, 101). This is the ef-
fect of the central limit theorem: the distribution of means and their differences
will tend to be normal as n increases, even when the distribution of the parent
population is not. Things are pretty OK even when the dependent variable is
discretely (rather than continuously) distributed (Myers & Well, 1995, p. 101).
However, there are nonparametric alternatives to ANOVA which may some-
times be better when the normality assumption is violated — such as the
Kruskal–Wallis H test (Myers & Well, 1995, p. 102-105). For repeated-

measures designs, there are others: Friedman’s chi-square ( 2
Fχ ), the rank-

transformation F test (Fr), the Wilcoxon signed-rank test, and Cochran’s Q test
(Myers & Well, 1995, pp. 271-280).

• Homogeneity of variance. If the two sample sizes are equal, there is little dis-
tortion to Type I error rates unless n is very small and the ratio of the variances
is quite large. There’s generally not a problem if the ratio of the largest to the
smallest variance is no more than 4:1, and sometimes even bigger discrepancies
can be tolerated. However, when ns are unequal, there’s more of a problem.
Whether the Type I error rate goes up or down depends on relationship between
the sample size and the population variance: if the larger group has the larger
variance, the test is conservative, but if the smaller group has the larger vari-
ance, the test is liberal — too many Type I errors — and sometimes the Type I
error rate gets really high (Myers & Well, 1995, pp. 69-71, 105-110). The two
strategies are to use an alternative test or to transform the data to improve the
homogeneity of variance (see p. 34). The alternative tests include the Welch and
Brown–Forsythe modified F tests (Myers & Well, 1995, pp. 106-109; Howell,
1997, pp. 321-323).
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• Sphericity. Violations are a problem. We’ve discussed the solutions elsewhere
(p. 25).

3.4 Exploratory data analysis, transformations, and residuals

3.4.1. Plot your data

It’s a very good idea to plot your data before analysing it. Although there are formal
tests for things like homogeneity of variance, and the other assumptions of an
ANOVA, the tests won’t describe the distribution of your data or show you if there
are outliers. See also Howell (1997, chapter 2).

In SPSS, you can choose Analyze → Descriptive Statistics → Descriptives to get
simple descriptive statistics, or Analyze → Descriptive Statistics → Explore for a
very comprehensive set of options, including descriptive statistics, histograms, stem-
and-leaf plots, Q–Q plots (see p. 9; are the data normally distributed?), boxplots
(also known as box-and-whisker plots, showing outliers), and so on — with your
data broken down by a factor. For example, to analyse ‘Post’ scores broken down by
levels of the factor ‘A’, I might do this:

3.4.2. Outliers

Outliers can cause substantial problems with parametric statistical tests (e.g. Myers
& Well, 1995, p. 15). If you find one, check that the datum has been entered cor-
rectly — if not, re-enter it, or if you can’t, throw it out. If it was entered correctly,
you may consider removing the outlier. There is a danger here — we can’t simply
throw away data we don’t like (see Myers & Well, 1995, p. 419), and maybe this is
a valid measurement, in which case we shouldn’t be chucking it out. But sometimes
it represents something we’re not interested in. If a reason for the outlier can be es-
tablished (data mis-entered, equipment broken, subject fell asleep, etc.) then it may
be corrected or removed as appropriate. We can always use nonparametric tests,
which are much less sensitive to outliers. How do we define an outlier? With a box-
plot, one convention is to regard points more than 3 box widths (3 × interquartile
range) from the box as outliers. Another is to consider points outside the whiskers as
outliers (Tukey’s original suggestion), but this throws away many — too many —
data points. Finally, another approach is to define outliers as points >2 standard de-
viations from the group mean.
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Another technique related to outlier removal is the use of trimmed samples. Rather
than transforming your data to achieve homogeneity of variance (see below), an-
other approach to ‘heavy-tailed’ samples (fairly flat distributions with a lot of obser-
vations in the tail — posh name platykurtic) is to trim the sample. For example, with
40 cases per sample, a 5% trimmed sample is the sample with the top two and the
bottom two observations removed (5% removed from each tail). When comparing
several groups, as in ANOVA, each sample would be trimmed by the same percent-
age. However, there is a special technique required for the ANOVA: the MSerror

should be based on the variance of the corresponding ‘Winsorized’ sample — one in
which the values you removed are replaced by copies of the next-most-extreme da-
tum (Howell, 1997, p. 329). To my knowledge, this isn’t a very common technique.

3.4.3. Transformations

Transformations can be used (1) to transform skewed distributions into something
closer to a normal distribution; (2) to reduce heterogeneity of variance; (3) to rem-
edy ‘non-additivity’ in within-subject designs. A transformation that achieves one
purpose well may not be equally suited to other purposes, although transformations
that equate variances do tend to give more normally distributed scores (Myers &
Well, 1995, p. 109). We’ll focus on transformations designed to achieve homogene-
ous variances. Such transformations can be derived if the relationship between jµ

(the group mean) and 2
jσ  (the group variance) is known. Here are some examples,

and a general rule (Myers & Well, 1995, pp. 109-110; Howell, 1997, pp. 323-329):

• If the data are proportions, such as ‘percent correct’, the scores in the popula-

tion are binomially distributed; the variance can be written as )1(2
jjj k µµσ −=

where k is a constant. The appropriate transformation is the arcsine transforma-

tion: YY arcsin=′ . For example, if a datum (Y value) is 0.5, the transformed

value Y ′  is D455.0arcsin = ; you would use the value 45 for analysis. (Or you
could do it in radians; it doesn’t matter: π radians = 180°.) Your data should be
in the range 0–1; if your data are percentages (97%), analyse them as propor-
tions (0.97). The arcsine transformation stretches out both tails (numbers near to
0 and 1) relative to the middle (numbers near to 0.5).

• In general… Plot )ˆlog( jσ , the log of the standard deviation of each group,

against )log( jY , the log of the mean of each group. If this relation is approxi-

mately a straight line, find its slope. The appropriate transformation would be
slope)1( −=′ YY . If 1 – slope = 0, take the log of each score instead of raising it to

a power.

• If the data are markedly skewed, or the standard deviation is proportional
to the mean, you will often find that the slope is 1 and a log transformation is
appropriate. Reaction times may be amenable to this transformation. It is also
applicable when the scores themselves are standard deviations. You can use any
base for the logarithm (10 is simple, but you could use e or anything else). You
can’t find logarithms of zero or of negative numbers, so if your data are nega-
tive it is permissible to add a constant before taking the log: )log( kYY +=′ . If

you have near-zero values, use )1log( +=′ YY  rather than )log(YY =′ .

• Variance is proportional to the mean. Consider taking the square root of each

datum: 5.0YYY ==′ . The square-root transformation compresses the upper
tail of the distribution. If your scores are small (e.g. <10), you may find that

5.0+=′ YY  or even 1++=′ YYY  works better for equating variances.

• The reciprocal transformation, 11 −==′ Y
Y

Y , is also useful if the data are

positively skewed (a few very large values at the upper end of the distribution).
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Indeed, it may often make a lot of sense to use it — particularly in the example
of transforming reaction times or latencies to reaction speeds.

Don’t apply a transformation unless you need to, or it makes theoretical sense. A
major problem with transformations is interpreting subsequent analyses. Sometimes
transformations make excellent sense, such as in the time-to-speed transformation.
Or you might have a theoretical reason to think that Y is a power function of some
variable X: Y = aXb. Then analysing log(Y) and log(X) would make sense, because
their relationship would then be linear and ANOVA techniques are built around lin-
ear relationships. And if there is a clear relationship between group means and stan-
dard deviations, the appropriate transformation will tend to give a more powerful
statistical test. But sometimes transformations that improve heterogeneity of vari-
ance don’t help you theoretically — you may discover that group 1 makes more

5.0presseslever +  than group 2, and then have to interpret that in terms of the real

world of lever presses. And if relative distances between means are of interest,
problems can crop up: Myers & Well (1995, p. 110) give the example of comparing
two teaching methods for high- and low-ability subjects. Even if the difference be-
tween the two teaching methods were the same for the high- and low-ability groups
on the original data scale, the transformation might well produce a different result on
the new scale; conversely one method might have more of an advantage for low-
ability subjects on the original data scale, but again the results might be quite differ-
ent on the transformed scale.

If you transform your data, it is only fair that you plot the transformed data in your
figures, since that’s what you analysed (especially if your figures show indices of
variability, such as error bars, and/or make some claims as to significant differences
between conditions). You may also choose to report the group means converted
back to ‘real’ units. But be aware that this can be a little misleading. For example, if
a group of six rats makes (16, 28, 38, 96, 55, 5) lever presses (mean = 39.67) and
you analyse the square-root transformed data (4, 5.29, 6.16, 9.80, 7.42, 2.24), you
will find that the mean of the transformed data is 5.82. But 5.82 is the square root of
33.87 — so converting the mean of the transformed data back to the original scale
(by applying the reverse of the transformation) doesn’t give you the untransformed
mean.

If you do need to transform, it is perfectly permissible to ‘shop around’, trying out
several transformations until you find one that does a good job of reducing hetero-
geneity of variance (Howell, 1997, p. 329). But it is not permissible to shop around
until you find a transformation that gives you a significant result! You are trying to
optimize the data so that the ANOVA is valid — you are not trying to ‘optimize’ the
ANOVA result.

3.4.4. Plot your residuals

You should always plot the distribution of the residuals from any analysis —
yy ˆ− , or what’s left over after you’ve predicted your dependent variable. Are the

residuals normally distributed? If not, you should do something. Remember that an
assumption of ANOVA was that the error variance was normally distributed (p. 9).
If your residuals are not normally distributed, your p values don’t mean what you
hope. You can

• transform your dependent variable (p. 35)
• add another predictor (p. 51)

Why might non-normal residuals suggest that adding another predictor would be a
good idea? Well, normal (Gaussian) residuals are what you’d expect if ‘error’ was in
fact made up of a load of independent things of roughly equal importance (e.g.
measurement error, room temperature fluctuations, background noise variations,
time of day variations, subject alertness…); remember that the central limit theorem
tells us that the distribution of a sum of a set of identically distributed random vari-
ables approaches the normal distribution. For a given standard deviation, the normal
distribution has the maximum uncertainty (in information-theoretic terms, conveys
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the maximum information). So normally distributed residuals help to suggest that
there’s no other major non-normally-distributed predictor you should add in.

In SPSS, you can choose Options → Residual plot for any ANOVA:

The three types of plot you get are:
• observed Y values (y) against predicted Y values ( ŷ ) — there’ll be a corre-

lation if your model is any good;
• observed Y values (y) against residuals ( yy ˆ− ) — there’ll be a correlation,

since the two aren’t independent (since residualˆ += yy );

• predicted Y values ( ŷ ) against residuals ( yy ˆ− ) — the two should be inde-
pendent.

These plots are not terribly helpful. SPSS uses standardized residuals in these
plots. (A standardized residual is a residual divided by an estimate of its standard
deviation.) In SPSS’s output there are two copies of each plot — one arranged with
one variable on the x axis and the other on the y axis, and the other flipped (mirrored
around the x = y line). Here I’ve faked some data where Y depends on two other
variables X1 and X2 (both continuous, for this example, i.e. covariates, but they could
equally be factors), which happen themselves to correlate. This is what SPSS’s re-
sidual plots look like:

Not a very useful plot. Here, only X1 is used as
a predictor variable (model: Y = constant +
b1X1). There is a correlation between observed
and predicted Y values, meaning that our model
is doing some predicting. The main thing to
look at is the ‘standardized residual’ versus
‘predicted Y’ plot. Does that look like a random
scatterplot? No. That suggests there’s a further
relationship between X1 and Y that’s not cap-
tured by a linear relationship.

Not a very useful plot. When we improve our
model by including X2 as a predictor (model: Y
= constant + b1X1 + b2X2), the ‘standardized
residual’ versus ‘predicted Y’ plot looks more
like a scatterplot. Whatever part of Y is not pre-
dicted (the residual) now appears to be uncor-
related with the predicted part, which is good —
our model is doing a better job.
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However, this residual analysis is not ideal — it doesn’t give us a very clear indica-
tion of whether the residuals are normally distributed. What you can also do is to
save the residuals from any ANOVA. Choose the Save dialogue box and choose
the appropriate option, such as the unstandardized (raw) residuals:

When the ANOVA is run, new column(s) are created with the residuals in. (If you
run an ANOVA with within-subjects factors in the usual way using Analyze → Gen-
eral Linear Model → Repeated Measures, with one subject per row, you get one re-
sidual column for every data column in your input. This dialogue box can also be
used to save the predicted values. In syntax, you can specify /SAVE = PRED RESID
to get both.) Once you’ve obtained your residuals, you can check them for normal-
ity: Analyze → Descriptive Statistics → Explore; tick ‘Both’ to get statistics and
plots; click Plots → Normality plots with tests. This produces a Q–Q plot (if this
produces a straight line, the data are normally distributed) and the Kolmogorov–
Smirnov and Shapiro–Wilk tests (if significant, your residuals are non-normal); see
p. 32 for explanation of these. To examine the residual distribution for several
groups separately, enter the grouping factor into the Factor List:

 

As an example, I created some data in which the data were created from the sum of
contributions from factor A (two levels), factor B (two levels), and random noise. If
we analyse with an ANOVA that only has factor A in it, saving and plotting the re-
siduals as described above, we get a Q–Q plot of the residuals that looks like the
left-hand side of the figure below — clearly not normal. This might suggest to us
that we need to include another predictor. If we now include factor B in the ANOVA
and replot the new residuals, we get the right-hand version, in which the residuals
are normally distributed. That meets the assumptions of the ANOVA, and we can
feel a bit happier that we haven’t ‘left anything out’ of the analysis.
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Dependent variable was caused by factors A and B, but
only factor A was entered into the analysis. Residuals are
not normally distributed.

Factors A and B are both entered into the analysis. Re-
siduals are normally distributed.

Finally, residuals that are outliers (large) for a group reflect data points that are
outliers, so residual plots are another way to spot outliers (see also Myers & Well,
1995, p. 414).

3.5 Further analysis: main effects, interactions, post hoc tests, simple effects

Plot your data. With any reasonably complex experiment, you can’t interpret the
data until you’ve plotted it…

3.5.1. Simple effects

A reminder of what main effects, interactions, and simple effects refer to (see p. 20).
It’s easiest to visualize with a two-factor ANOVA. A main effect of A means that
the A means (A1, A2, …Aa) are not all equal. Similarly for a main effect of B. An in-
teraction means that the effects of A are not the same at all levels of B (equiva-
lently, that the effects of B are not the same at all levels of A).

Suppose we have a between-subjects factor A (group: A1 = control, A2 = drugged)
and a within-subjects factor U (task condition: U1 = hot room, U2 = cold room). We
analyse our data and find an interaction. We may want to ask questions about simple
effects: was there an effect of drug on performance in a hot room (simple effect of A
at U1, also written A/U2)? Was there an effect of drug on performance in a cold
room (A/U2)? Was there an effect of room temperature on the control group (simple
effect of U at A1, written U/A1)? On the drugged group (U/A2)?

There are two ways of running simple effects analysis. The first and simplest is only
to analyse the data that’s relevant. So to ask about A/U2, we’d only analyse the
U2 (cold room) data, this time with a one-factor ANOVA — we’ve dropped out the
U factor. Similarly, if we had started with a three-way ANOVA (A × B × C), we
would have run a two-way ANOVA to establish effects such as A /C1, B/C1, and
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A×B/C1 (the last one is sometimes called a ‘simple interaction’). This is easy and
generally recommended (Myers & Well, 1995, p. 304). It can be applied to between-
and within-subjects factors.

It is possible to obtain a more powerful test of the simple effects. This involves cal-
culating the MS for the simple effect just as before, but testing it not against the
MSerror for the sub-analysis (the one-factor ANOVA in our A × U example), but
against the MSerror for the original, full ANOVA — known as the pooled error
term. If you want to do this, you have to do it by hand: Fdf-factor/df-pooled-error = MSfac-

tor/MSpooled error. Similarly, you can use the pooled error term for multiple compari-
sons between treatment means, if your factors have >2 levels. However, you
shouldn’t do this for within-subjects simple effects, as corrections for violations of
the sphericity assumption are inadequate (Howell, 1997, p. 468). Furthermore, if
there is some heterogeneity of variance, there can also be substantial problems
(Myers & Well, 1995, pp. 134-136, 304-305). So it’s simplest and probably best to
ignore this technique — just run a simpler ANOVA on a subset of your data.

3.5.2. Determining the effects of a factor with >2 levels

If you discover that you have a significant main effect of a factor A with 2 levels,
you know what it means: 

21 AA µµ ≠ . So you only have to look at the means to work

out if 
21 AA µµ >  or 

21 AA µµ < . But if you have five levels, a significant main effect

merely means that the null hypothesis

543210 : µµµµµ ====H

has been rejected. But what does that mean? There are all sorts of alternatives:

...
54321

54321

54321

µµµµµ
µµµµµ
µµµµµ

≠≠==
=≠==
≠===

This is where we would use post hoc comparisons among treatment means. There
are two types of post hoc tests. One kind tests all possible pairwise comparisons.
For 5 levels, we can compare µ1 and µ2, µ1 and µ3… up to µ4 and µ5. For 5 compari-

sons, there are 105
2 =C  possible pairwise comparisons. The other type of test groups

the means into homogeneous subsets, and tells you something like ‘µ1, µ3, and µ4

fall into one subset [are all the same]… µ2 and µ5 fall into another subset [are the
same]… the subsets differ from each other’.

But we must be careful.

3.5.3. Post-hoc tests: the problem

The upshot: if you collect your data, look at it, and wonder ‘are those two points
significantly different?’, you need to use a post hoc test — because your eye has al-
ready selected particular points to compare, which influences the likelihood of find-
ing a ‘significant difference’…

It’s beautifully put by www.statsoft.nl/textbook/stglm.html: “Sometimes we find
effects in an experiment that were not expected. Even though in most cases a crea-
tive experimenter will be able to explain almost any pattern of means, it would not
be appropriate to analyse and evaluate that pattern as if one had predicted it all
along. The problem here is one of capitalizing on chance when performing multiple
tests post hoc, that is, without a priori hypotheses. To illustrate this point, let us con-
sider the following ‘experiment’. Imagine we were to write down a number between
1 and 10 on 100 pieces of paper. We then put all of those pieces into a hat and draw
20 samples (of pieces of paper) of 5 observations each, and compute the means
(from the numbers written on the pieces of paper) for each group. How likely do you
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think it is that we will find two sample means that are significantly different from
each other? It is very likely! Selecting the extreme means obtained from 20 samples
is very different from taking only 2 samples from the hat in the first place, which is
what the test via the contrast analysis [known as an a priori test or planned contrast]
implies. Without going into further detail, there are several so-called post hoc tests
that are explicitly based on the first scenario (taking the extremes from 20 samples),
that is, they are based on the assumption that we have chosen for our comparison the
most extreme (different) means out of k total means in the design. Those tests apply
‘corrections’ that are designed to offset the advantage of post hoc selection of the
most extreme comparisons. Whenever one finds unexpected results in an experiment
one should use those post hoc procedures to test their statistical significance.”

In general, we can define the per-test Type I error rate (α, also called the error rate
per contrast) and the familywise Type I error rate (αFW), the probability of making at
least one Type I error rate when performing a ‘family’ of multiple comparisons.

3.5.4. The special case of three groups: multiple t tests are OK

There’s a special case in which multiple uncorrected t tests are OK — when you
have three groups (Howell, 1997, p. 370) and you have a significant main effect for
your factor. This isn’t widely appreciated. The ANOVA F test assesses the null hy-
pothesis:

3210 : µµµ ==H

If we have a significant main effect, then we’ve already rejected this null hypothesis.
That means that one of the following must be true:

321

321

321

µµµ
µµµ
µµµ

≠≠
≠=
=≠

If we run a complete set of (3) uncorrected t tests, we will choose one of these three
conclusions. But no conclusion involves us judging that there are more than two
inequalities (significant differences between individual means). And we know that
there is at least one inequality, since we’ve rejected the overall null hypothesis. So
we can make at most one Type I error. Therefore, the probability of making that
Type I error (choosing 321 µµµ ≠≠  when one of the other two is correct) is the

plain α for each test, and no further correction is necessary.

3.5.5. Otherwise… a variety of post hoc tests

For between-subjects factors, SPSS provides too many options in its Post Hoc box:

Equal variances assumed
• *LSD (Fisher’s least significant difference). Uncorrected multiple t tests, ex-

cept that the test is only performed when an ANOVA has rejected the over-
all null hypothesis, i.e. shown that ‘something’s going on’ (Myers & Well,
1995, p. 188; Howell, 1997, p. 369-370). αFW = 1 – (1– α)k when k inde-
pendent tests are performed, and αFW ≤ 1 – (1– α)k when the tests are not in-
dependent (Myers & Well, 1995, p. 177). Only suitable for ≤3 levels of a
factor — in which case it’s the most powerful test — but don’t use it other-
wise.

• *Bonferroni t procedure. Occasionally called the Dunn procedure. Makes
use of the Bonferroni inequality: αFW ≤ kα, or more generally, ∑≤

i
iFW αα

where αi is the probability of a Type I error for the ith contrast (Myers &
Well, 1995, p. 179). This is derived from the ‘proper’ version, αFW ≤ 1 – (1–
α)k, by noting that for small values of α (and 0.05 is small), (1–α)k ≈ 1 – kα.
Therefore, each contrast is tested at α = αFW/k. For example, if four tests are
to be performed (k = 4) and we desire αFW = 0.05, then each test is per-
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formed at α = 0.0125. Quick to do. Additionally, we don’t have to have all
the αs equal. If we’re much more interested in one of our four comparisons,
we could allocate α = 0.03 to it, and α = 0.0067 to each of the others (Myers
& Well, 1995, p. 181). Can be used for testing k planned contrasts.

• *Šidák (or Dunn–Šidák, or Sidak). Since αFW = 1 – (1– α)k, this procedure
solves for α [α = 1 – (1– αFW)1/k] so as to get αFW to be what you want (typi-
cally 0.05). Like the Bonferroni correction, but more accurate (i.e. it’s cor-
rect). See also Howell (1997, p. 364).

• *†Scheffé. See Myers & Well (1995, p. 183) and Howell (1997, p. 379).
Controls αFW against all possible linear contrasts (see p. 75), not just pair-
wise contrasts. Consequently, very conservative.

• †REGWF (Ryan–Einot–Gabriel–Welsch F test). No idea; somehow
similar to the REGWQ.

• †REGWQ (Ryan–Einot–Gabriel–Welsch) range test. A compromise
between the Newman–Keuls (liberal) and Tukey HSD (conservative)
(Howell, 1997, p. 378). This test does not require the overall F for groups to
be significant as it controls the familywise error rate independently and test
different hypotheses from the overall ANOVA, with different power
(Howell, 1997, p. 351). Recommended (Howell, 1997, p. 378) except for
unequal cell sizes (SPSS help).

• †SNK (Student–Newman–Keuls, a.k.a. Newman–Keuls). Not often used.
Poor control of αFW (Myers & Well, 1995, p. 188; Howell, 1997, p. 372-
377) unless there are only three means to be compared, in which case it’s
OK.

• *†Tukey HSD (honestly significant difference). Similar to the Newman–
Keuls test except that it fixes αFW properly (Howell, 1997, p. 377).

• †Tukey’s-b. Tukey’s test as a range test? Not sure.
• †Duncan’s multiple range test. Not often used. Poor control of αFW (Myers

& Well, 1995, p. 188).
• *†Hochberg’s GT2. Less powerful variant of Tukey’s; see SPSS help.
• *†Gabriel’s pairwise comparisons test. ‘A more powerful version of

Hochberg’s GT2 when cell sizes are unequal; may become liberal when the
cell sizes vary’ (SPSS help).

• †Waller–Duncan t test. ‘Uses a Bayesian approach. Uses the harmonic
mean of the sample size when the sample sizes are unequal’ (SPSS help).
That doesn’t tell you much.

• Dunnett’s test for comparing treatment groups with a control group.
Sometimes we are interested in comparing each of the a–1 treatment groups
to a control group, and less interested in comparing them to each other. For
this case, since no two of the set of contrasts are orthogonal, the Bonferroni
approach would be conservative (see pp. 76, 77). This test does not require
the overall F for groups to be significant as it controls the familywise error
rate independently and test different hypotheses from the overall ANOVA,
with different power (Howell, 1997, p. 351).

Equal variances not assumed
• *Tamhane’s T2. ‘Conservative pairwise comparisons, based on a t test’

(SPSS help).
• *Dunnett’s T3. No idea. Range test.
• *Games–Howell. ‘Sometimes liberal’ (SPSS help).
• *Dunnett’s C. No idea. Range test.

* Pairwise comparison test.
† Homogeneous subset test.
A range test is one based on a Studentized range statistic q, a modification of the
t statistic (Howell, 1997, p. 370-372).

The important tests are summarized by Myers & Well (1995, p. 186). You can do
most of what you want with the Sidak correction for pairwise comparisons, Dun-
nett’s test when you’re comparing treatment groups to a control group, and perhaps
the REGWQ as a homogeneous subset test.
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Pick your post hoc tests in advance: it is not valid to run all sorts of tests and
then pick the ‘most significant’. I suggest uncorrected t tests (Fisher’s LSD) for
three groups, the Sidak correction for >3 groups, and Dunnett’s test for comparing
treatment groups to a control group if you’re more interested in that comparison than
in differences between the treatment groups. If you would like a homogeneous sub-
set test, then the Tukey HSD test is popular but the REGWQ is perhaps better. Tu-
key’s HSD, REGWQ, Dunnett’s, and the Sidak test don’t even require the
overall F test from the ANOVA to be significant (Howell, 1997, pp. 351, 364,
377), although the 3-group Fisher LSD does.

SPSS doesn’t let you perform many of those tests on within-subjects factors, for
good reason — many of them aren’t valid (see Howell, 1997, p. 471). However, you
can choose ‘Display means for…’ in the Options box and tick ‘Compare main ef-
fects’ with either no correction for multiple comparisons (LSD) — only valid if the
factor has only 3 levels — or a Bonferroni or Sidak correction. The facility to com-
pare means with a Sidak correction and to run further ANOVAs on subsets of your
data is enough to analyse any between/within-subjects design, unless you also want
to run specific contrasts (see p. 75).

3.6 Drawing pictures: error bars for different comparisons

Much of this is reproduced from www.pobox.com/~rudolf/psychology, except the
section on ANOVA.

3.6.1. Error bars for t tests: between-subjects comparisons

In brief:

• The standard error of the mean (SEM) conveys the precision with which the
population mean was estimated. (It depends on the SD and the sample size,
n.) Every mean (e.g. every group) has its own SEM.

• It is appropriate to use it as an error bar for between-subjects comparisons.
• It is the most common error bar you see published.
• The convention is to plot ±1 SEM — that is, your error bars extend above

the mean by 1 SEM and below the mean by 1 SEM.

• Alternatives include the standard deviation (SD), which measures the vari-
ability of observations about their mean and is independent of n, and confi-
dence intervals (CI); these show the range of values within which the popu-
lation mean probably lies, and depend on the SD and n.

The SEM is frequently used as an index of variation when people publish data. They
may quote a measurement of ‘25.4 ± 1.2 g’, or display a datum on a graph with a
value of 25.4 units and error bars that are each 1.2 units long. These ‘variation’ indi-
ces could be one of several things — mean ± SD, mean ± 95% CI, mean ± SEM…
The paper should state somewhere which one is being used, but usually it’s the
SEM. Why? First, it’s smaller than the SD, so it conveys an impression of improved
precision (remember that accuracy is how close a measurement is to a ‘true’ value
and precision is how well it is defined; thus, 2.5000000003 × 108 m⋅s–1 is a more
precise but far less accurate measurement of the speed of light than 3.0 × 108 m⋅s–1).
In fact, using the SEM is perfectly fair and correct: the precision of an estimator is
generally measured by the standard error of its sampling distribution (Winer, 1971,
p. 7). Secondly — more importantly — if the SEM error bars of two groups overlap,
it’s very unlikely that the two groups are significantly different. (This is explained
somewhat in the figure.) The opposite isn’t necessarily true, though — just because
two sets of error bars don’t overlap doesn’t mean they are significantly differ-
ent (they have to ‘not overlap’ by a certain amount, and that depends on the sample
size, and  so on).
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3.6.2. Error bars for t tests: within-subjects comparisons

In brief:

• SEMs are misleading for within-subjects comparisons. Use the standard er-
ror of the difference (SED) for the relevant comparison instead.

• SEDs are also appropriate for between-subjects comparisons.
• SEDs are not ‘attached’ to a particular mean, so the convention is to plot a

‘free-floating’ error bar that is 2 SED long, and label it. (The reader can use
it as a mental ruler to make comparisons between the relevant means.)

For within-subjects comparisons, SEMs calculated for each condition are highly
misleading (see figure below). For this comparison — indeed, for any comparison
— the SED is an appropriate index of comparison, because that’s what the t test is
based on (t = difference between means / SED). So if the difference between two
means is greater than twice the SED, t > 2. And for a healthy n, t > 2 is significant
at the two-tailed α = 0.05 level (have a quick glance at your tables of critical values
of t).

The SED is therefore a very good index of variation that can be used to make visual
comparisons directly, particularly if you draw error bars that are 2SED long — if the
means to be compared are further apart than the length of this bar, there’s a good
chance the difference is significant. However, it’s a bit more work to calculate the
SED, which is why you don’t see it very often.
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If you want to work out an SED, just choose the appropriate t test and calculate the
denominator of the t test. For between-group comparisons where the group SEMs
are SEM1 and SEM2, you’ll see that SED = √(SEM1

2 + SEM2
2).

To summarize, for within-subject changes:

1. The mean within-subject change equals the difference of the group means.
2. The variance of the within-subject change may differ greatly from the variance

of any one condition (group).
3. Present within-subject changes when the baseline varies a lot, or you want to

show variance of the within-subject measure.
4. Present group means when the baseline matters.

3.6.3. Error bars for an ANOVA

In brief:

• SEDs are always appropriate.

• Use 
n

error2MS
SED =  if all groups are the same size.

• Use 
2

error

1

error MSMS
SED

nn
+= if there are two groups being compared and

they are of unequal size.
• This means there may be a different SED for each comparison of two

means. In SPSS, you can obtain these using pairwise comparisons for inter-
action effects (see p. 62). However, most people want to plot a ‘single’ SED.
For this purpose, if there are >2 groups of unequal size, I think the most ap-

propriate one to use is 
hn
error2MS

SED =  where hn  is the harmonic mean of

the group sizes (see p. 213 and also p. 70). For two groups, that reduces to
the formula above.

• In an ANOVA with several factors, there may be are several different SEDs,
corresponding to several different MSerror terms. Although you can plot the
most relevant one(s), the most common convention is to plot the SED from
the highest interaction shown in your graph (so if your graph shows factors
A and B, you would plot the SED from the A × B interaction).

• The convention is to plot a ‘free-floating’ error bar that is 2 SED long, and
label it as such.

A t test is directly related to an ANOVA: 2
,1 kk tF =  and kk Ft ,1= . And a t test has

this general formula:

quantity that oferror  standard

quantity
=t

For example, a one-sample t test has the formula

(SEM)mean   theoferror  standard

test valuemean −=t

and a two-sample t test has the formula

(SED) meansbetween  difference  theoferror  standard

meanmean 12 −
=t

For a single sample, the SEM (the standard deviation of all sample means of a given
sample size n) is
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n
x

σσ =  with corresponding variance 
nx

2
2 σσ =

For two independent samples, the SED (the standard deviation of the set of differ-
ences between pairs of sample means) is

2
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In an ANOVA with one factor and two groups, since we assume homogeneity of

variance, our best estimate of the variances of two groups 2
1σ  and 2

2σ  is a weighted

(‘pooled’) average of the two group variances (Myers & Well, 1995, pp. 65-66):
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So MSerror is an approximation to 2σ . In fact, we knew that already (see pp. 9, 10).
In general, the standard error of an estimate (Myers & Well, 1995, pp. 500-1), eσ̂ ,

which estimates the standard deviation of the error variability ε, is

error
error

error MS
SS

ˆ ==
dfeσ , or error

2 MSˆ =eσ

and therefore for a comparison between two groups, the SED is given by

2

error

1

error MSMS
21 nnxx +=−σ

For equal group sizes, with n observations per group, this simplifies:

nxx
error2MS

21
=−σ

SPSS provides SEM and SED estimates for any given comparison when you choose
Options → Estimated Marginal Means for a factor or set of factors, or if you use the
/EMMEANS = TABLES(factor) syntax (see illustrated example on p. 56→). But note
that there is no ‘one’ SED appropriate for all comparisons. If you have >2
groups, and their sizes are unequal, the SED for comparing group 1 to group 2 may
be different for that for comparing group 1 to group 3. And in a multi-factor
ANOVA, the SED for comparisons involving factor A will differ from the SED for
comparisons between A × B subgroups. As we saw above, the convention is to plot
the SED from the highest-order interaction.

3.7 Summarizing your methods: a guide for thesis-writing and publication

The following is an extract from my PhD thesis methods (which proved perfectly
publishable: e.g. Cardinal et al., 2003), with comments in square brackets.

Data… were… analysed with [computer package, e.g. SPSS], using principles based on
Howell (1997) [or other appropriate textbook]. Graphical output was provided by [com-
puter package, e.g. Excel 97 and Sigmaplot 2001]. All graphs show group means and er-
ror bars are ±1 SEM unless otherwise stated.

Transformations. Skewed data, which violate the distribution requirement of analy-
sis of variance, were subjected to appropriate transformations (Howell, 1997, section
11.9). Count data ([e.g.] lever presses and locomotor activity counts), for which variance
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increases with the mean, were subjected to a square-root transformation. Homogeneity of
variance was verified using Levene’s test.

Analysis of variance. Behavioural data were subjected to analysis of variance
(ANOVA) using a general linear model, using SPSS’s Type III sum-of-squares method.
Missing values were not estimated but excluded from analysis [⇒ subjects for whom
some data were missing were omitted entirely; SPSS’s default]. All tests of significance
were performed at α = .05; full factorial models were used unless otherwise stated.
ANOVA models are described using a form of Keppel’s (1982) notation; that is, depend-
ent variable = A2 × (B5 × S) where A is a between-subjects factor with two levels and B is
a within-subjects factor with five levels; S denotes subjects.

For repeated measures analyses, Mauchly’s (1940) test of sphericity of the covariance
matrix was applied and the degrees of freedom corrected to more conservative values us-
ing the Huynh–Feldt epsilon ε~  (Huynh & Feldt, 1970) for any terms involving factors in
which the sphericity assumption was violated.

[Better approach, now I’ve learned more (see p. 25): Degrees of freedom for terms
involving within-subjects factors were corrected using the Greenhouse–Geisser epsi-
lon ε̂  (Greenhouse & Geisser, 1959) where the sphericity assumption was violated

substantially ( ε̂  < 0.75) or the Huynh–Feldt epsilon ε~  (Huynh & Feldt, 1970) when

the sphericity assumption was violated minimally ( ε̂  ≥ 0.75).]
[Pretty good and simple approach (see p. 25): Degrees of freedom for terms in-
volving within-subjects factors were corrected using the Huynh–Feldt epsilon ε~
(Huynh & Feldt, 1970).]

Thus, the same analysis with and without sphericity correction would be reported as fol-
lows:

Uncorrected: F10,160 = 2.047, p = .032
Corrected: F4.83,77.3 = 2.047, ε̂ = 0.483, p = .084

[Journals used to quibble about non-integer df because they were ignorant; such quib-
bling is less common these days. If you quote non-integer df, though, state the correction
factor so people can work out the original df.]

Post-hoc tests. Significant main effects of interest were investigated using pairwise
comparisons with a Sidak correction. This is based on the observation that αfamilywise = 1 –
(1 – αeach test)

n when n tests are performed; the correction was made such that αfamilywise =
.05.

Where main effects were found for between-subjects factors with three or more levels,
post hoc comparisons were performed with the REGWQ range test (familywise α = 0.05),
or Dunnett’s test in situations where several experimental treatments were compared with
a single control group. These tests do not require the overall F for groups to be significant
as they control the familywise error rate independently and test different hypotheses from
the overall ANOVA, with different power (Howell, 1997, p. 351). [I was clearly rambling
a bit here!]

Where significant interactions were found following factorial analysis of variance,
simple effects of a priori interest were calculated by one-way ANOVA and tested by hand
against the pooled error term (F = MSfactor/MSpooled error; critical values of F based on
dffactor and dfpooled error). Multiple comparisons for simple effects were performed as de-
scribed above but using the pooled error term.

Where significant interactions were found following repeated measures analysis, a
pooled error term was used to test between-subjects simple effects of a priori interest, but
separate error terms (i.e. plain one-way ANOVA) were used for within-subjects factors as
sphericity corrections are inadequate if a pooled error term is used (Howell, 1997, p. 468).
[These days I wouldn’t use the pooled error term at all, and would just use plain one-way
ANOVA; see Myers & Well (1995, pp. 304-5).]

Add any other special procedures you used! For example, you might add this:

… dependent variables were checked for normality by inspection of Q–Q plots (which
plot scores against their expected values under a normal distribution) and using the Kol-
mogorov–Smirnov test with Lilliefors correction (Lilliefors, 1967) [and/or] Shapiro–
Wilks test (Shapiro & Wilk, 1965).
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Part 4: pitfalls and common issues in experimental design

4.1 Time in within-subjects (repeated measures) designs

There’s nothing inherently special about ‘time’ as a within-subjects factor — you
only get that impression from books that distinguish ‘repeated measures’ (implying
time) from designs that are logically equivalent to within-subjects designs, e.g. in
agriculture. As always, the sphericity assumption should be checked; time also rep-
resents a continuous factor, so that trend analysis (p. 80) involving it may be mean-
ingful. And counterbalancing is often vital to avoid order effects. That’s about it.

4.2 Analysis of pre-test versus post-test data

A very common design is as follows. Subjects are randomly assigned to groups (lev-
els of A), such as A1 and A2. They are tested; the treatment (A1 or A2) is applied;
they are retested. Since subjects were randomly assigned to groups, there are no
systematic group differences in the pre-test scores. The post-test scores reflect the
effects of the treatment. There are several ways to analyse this sort of design (Myers
& Well, 1995, pp. 305-306, p. 454; also Howell, 1997, p. 606-7):

1. Analysis of covariance (p. 138). When its assumptions are met, this is the most
powerful. Basically, this assumes that the post-test scores are linear functions of
the pre-test scores. (It is often also assumed that the slopes of these functions
are the same at each level of A, but see p. 138). The analysis takes advantage of
this relationship, reducing error variability in the post-test scores by removing
variability accounted for by the pre-test scores.

2. Analysis of difference scores. For each subject, the pre-test score is subtracted
from the post-test scores; a one-factor ANOVA (using factor A) is then per-
formed on these scores. The approach assumes that the effect of each treatment
is to add a constant to the pretest score. Because this model is less likely to be
true than that assumed by the analysis of covariance, it will generally be a less
powerful test.

3. Analysis of post-test scores only. This approach is valid, but ignores informa-
tion (the pre-test scores) that could help to reduce error variance, and therefore
will be less powerful than those above.

4. Analysis using a mixed design: A as a between-subjects factor, P as pre-test
versus post-test. This is frequently done. However, it will be a very conserva-
tive test of the main effect of A — it doesn’t take account of the information
that the pre-test scores cannot be affected by A. A better test for A would be
that given by the A × P interaction, which is identical to that obtained by per-
forming a one-way ANOVA on the difference scores — and as we saw above,
an analysis of covariance is generally better.

If the subjects haven’t been randomly assigned to levels of A, then the analysis (or
the interpretation) can be much more difficult. If you don’t understand the principles
of multiple regression with correlated variables, don’t go there — just analyse the
post-test scores (Myers & Well, 1995, p. 306). Or understand the tricky stuff (Parts 6
& 7)…

4.3 Observing subjects repeatedly to increase power

An example: low-n experiment where subjects are precious. The dependent variable
is change in blood pressure in response to a conditioned stimulus (CS). Two CSs are
used: one signalling a high-incentive, tasty food, and the other signalling a low-
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incentive, less-preferred food. Furthermore, subjects are tested following admini-
stration of a drug or placebo. The response of each subject to each CS is observed 6
times, to reduce the measurement error or increase power somehow (the experi-
menter feels that more observations should give more power, but can’t verbalize ex-
actly how). Presentation order is suitably counterbalanced. The original data layout
is shown below. How should this be analysed to maximize power?

Subject (S) Incentive (A) Drug (B) Observation (C) Dependent variable
1 Low Placebo 1 datum
1 Low Placebo 2 datum
1 Low Placebo 3 datum
1 Low Placebo 4 datum
1 Low Placebo 5 datum
1 Low Placebo 6 datum
1 High Placebo 1 datum
1 High Placebo 2 datum
1 High Placebo 3 datum
… … … … …
1 Low Drug 1 datum
1 Low Drug 2 datum
… … … … …
1 High Drug 1 datum
1 High Drug 2 datum
… … … … …
2 Low Placebo 1 datum
2 Low Placebo 2 datum
… … … … …
3 subjects 2 levels 2 levels 6 observations per level 72 observations

We have these possible factors, even if we do not use them all: subject (S), which is
a random factor (see p. 31); incentive (A), which is a fixed factor; drug (B), which is
a fixed factor; perhaps observation (C), which we’ll consider to be a fixed factor.
We seek to test the effects of A (does the response to a high incentive CS differ from
that to a low incentive CS?), B (does the response of a drugged subject differ from
that of a non-drugged subject?), and A × B (does the effect of incentive alter as a re-
sult of the drug?) with maximum power.

Consider the options:

1. A and B are used as factors. No ‘subject’ term is entered, so it’s effectively a
between-subjects design. Wrong. This is pseudoreplication; we are pretending
that we have 18 independent observations per AB combination. In fact, we have
3 subjects per AB combination with 6 observations per subject — and those ob-
servations are likely to be correlated, because they come from the same subject.
We must take account of this fact. Indeed, to do so is likely to improve our
power, by accounting for differences between subjects. Remember the key as-
sumption of ANOVA: that the error components (ε) are independent.

2. A, B, and S are used as factors. This is a design with two within-subjects fac-
tors. There are 6 observations per ‘cell’ (per ABS combination). We are as-
suming that there is no correlation between observations beyond that attribut-
able to them coming from the same subject/A/B combination. Somewhat re-
lated to within-subjects ANCOVA (Bland & Altman, 1995a) (see p. 152).
Valid.

3. A, B, C, and S are used as factors. This is a design with three within-subjects
factors. We have a factor of ‘observation number’. This may mean very little to
us (we wouldn’t be interested in effects attributable to it), but we include it in
the hope that it removes some variability, reducing our error variability and im-
proving our power. We have one observation per cell. Valid.

4. We take the mean of the 6 observations per subject per AB combination. We
now have N = 12 observations rather than N = 72, but we expect the means to
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be more accurate estimators of the true effect on each subject. We analyse them
with A, B, and S as factors. We have one observation per cell. Valid.

So of designs 2–4, which is optimal? They’ll all give identical answers! Observing a
subject more than once in the same condition simply improves the precision with
which the subject is measured in that condition. You can use that more precise mean
directly (design 4), or let the ANOVA maths work out the means for each condition
(designs 2 and 3). The variability that you reduce by measuring the subject repeat-
edly is the variability about the mean for that subject in that condition, not the vari-
ability associated with measuring the effect of factors A or B. Try it and see.

See also the CRD with subsampling and RCB with subsampling agricultural designs
(p. 186→).

4.4 ‘It’s significant in this subject…’

Words to strike fear into your heart. The scenario runs like this. An experimenter
using precious subjects assigns them to sham or lesion groups. Each is measured re-
peatedly for its response to a stimulus paired with food (CS+) and to a neutral
stimulus (CS0). Let’s say we have ten CS+ observations and ten CS0 observations per
subject.

It is, of course, completely valid to perform a t test or equivalent ANOVA to ask
whether the effect of CS (CS+ versus CS0) is significant for that subject. Note that
you might use an unpaired (‘between-subjects’) analysis, since the CS+ data and the
CS0 data are not related beyond the fact that they come from the same subject (which
is now your experimental ‘universe’) — unless there is some further factor that pairs
data points within each subject. (One such factor might be ‘trial pair’, if one trial
pair has one CS+ and one CS0 presented close to each other in time.) However, the
conclusions of such a test apply only to that subject. You could not generalize it to
others (‘subjects in general with such-and-such a lesion’).

I’ve seen arguments that run like this: “We compared a CS+ and a CS0 for each sub-
ject to obtain a measurement of CS reactivity [a single number per subject]. We
compared these CS reactivity scores pre-operatively and post-operatively. The lesion
significantly reduced CS reactivity scores in 2 out of 4 lesioned subjects [note
within-one-subject significance tests]. None of the 4 sham-operated subjects showed
a significant change in CS reactivity scores.” The implication that one is presumably
meant to draw is the lesion reduced CS reactivity. There are at least two fallacies
here:

• The significance tests for individual subjects don’t tell you that the change
was significant for a group.

• (Ignoring the previous point for a moment…) ‘The change in reactivity
scores was significant for group A but not for group B; therefore group A
differed from group B.’ This is a common statistical fallacy. There might
have been a decrease in scores for one group (p = 0.04) but not the other (p
= 0.06) — that does not mean that the two groups differed. That test would
require examination of the lesion × (pre-post) interaction — or, better (as we
saw above), an analysis of covariance with pre-operative scores as the co-
variate.

• Even if you used ‘significant or not’ as a dichotomy — and it would be an
artificial dichotomy (using a criterion p value as a cut-off, rather than a
genuine dichotomy such as sex; see Howell, 1997, p. 286), the test across
groups would then be a χ2 contingency test with two variables (sham versus

lesion; changed versus unchanged). For this specific example, 67.22
1 =χ , p

= 0.1, NS.
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4.5 Should I add/remove a factor? Full versus reduced models

Omitting relevant variables and including irrelevant variables can both alter your
estimate of effects of other variables (Myers & Well, 1995, pp. 519-521). Including
irrelevant variables isn’t too bad — this doesn’t bias the estimate of the proportion
of variability accounted for by your other predictors, but it does use up error degrees
of freedom, reducing the power to detect effects of other variables. Omitting rele-
vant variables is worse; it can substantially bias the estimates of the effects of the
other terms. As a simple example, suppose your data contain a main effect of A and
a main effect of B, but no interaction. If you were to analyse these data using a
model with just A and AB terms (and no B term), you’ve omitted a relevant vari-
able, and you can get a ‘spurious’ interaction.

There are various formal ways to work out the ‘best’ set of predictor variables to use
if you have a lot of potential predictors (e.g. forward selection, backward elimina-
tion, and stepwise regression; see Myers & Well, 1995, p. 516-518), but they are
primarily of use in descriptive (correlative, non-experimental) research and none of
them removes the need to think carefully about your experimental design.

People commonly neglect potentially important predictors (Myers & Well, 1995,
pp. 100-101, 149-151), such as who tested the subjects, because they’re not of inter-
est, or they weren’t thought about. These are poor reasons. A good reason to remove
a predictor from an ANOVA is that you have evidence that it isn’t contributing to
the prediction. If so, then by removing it, you may increase the power to detect other
effects. A good rule is to include all the potentially relevant predictors initially,
and consider removing a term if (a) you have a priori reason to think it’s irrele-
vant and (b) the term is not significant at the α = 0.25 level (Myers & Well, 1995,
pp. 100-101, 151).

Note that a non-normal distribution of residuals (p. 36) may also suggest the need to
add another predictor (or to transform the dependent variable).

For example, suppose we have a three-way ANOVA (factors A, B, and C). The ex-
perimenter is primarily interested in the effects of A and B. The analysis shows that
none of the A×C, B×C, A×B×C terms are significant at the α = 0.25 level, but the
main effect of C is significant at α = 0.25. The plan would then be to drop out those
interactions, so you’re left with A, B, A×B, and C.

Dropping out terms that are genuinely not contributing helps, because it increases
the error df (which increases power); the df and any variability attributable to the
term joins (is ‘pooled with’) the error df and error variability. You hope that the er-
ror df go up but the error variability doesn’t — which should be the case if the term
wasn’t contributing to the prediction. But if your term is actually contributing, then
pooling its variability as part of the error term also increases the E(MS) of the error
term, negatively biasing all your other F tests — making it less likely that you’ll
detect other effects that you’re interested in (Myers & Well, 1995, pp. 149-151).

This argument also applies to the experimental design technique of blocking (Myers
& Well, 1995, pp. 157-158). Suppose we want to test the effect of different types of
teaching method (A) on reading skill (Y) in children, and subjects are randomly as-
signed to the levels of A. If there is considerable individual variation (variability
among subjects within groups — the error term for the ANOVA) we may have low
power to detect effects of A. One way to deal with this is to block the subjects. We
would divide them into groups based on their performance on some variable, X
(perhaps IQ?), that we believe to be highly correlated with Y. Suppose we used five
blocks: block B1 would contain the children with the highest X scores, block B2

would have the next-highest X scores, and so on. Then we would randomly assign
the members of block B1 to the different A conditions. We have made our one-factor
ANOVA into a two-factor ANOVA; we hope that this reduces the within-block in-
ter-subject variability, and therefore increases the power to detect effects of A. In
general, blocking is intended to reduce error variability (which increases power). Of
course, it uses up error df (which reduces power). Therefore, to get the best power,
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you should choose the number of blocks based on N, a, and the correlation (ρ) be-
tween X and Y (see Myers & Well, 1995, pp. 157-158).

4.6 Should I add/remove/collapse over levels of a factor?

The key thing to remember is this:

predictorerror

errorpredictor

error

predictor

SS

SS

MS

MS

df

df
F

×
×

==

The more levels a factor has, the larger its dfpredictor, so on its own this will reduce the
F statistic, and therefore the power to detect the effect of this factor. On the other
hand, if adding a level increases SSpredictor, power goes up. And, all other things be-
ing equal, adding more observations increases power because it increases dferror.
Let’s illustrate this with a couple of examples:

4.6.1. Adding and removing levels by adding new observations

Taking new observations at further levels of a factor can reduce power:

Left: the dependent variable is
measured at only two levels of A
(n = 5 per group). There is a sig-
nificant effect of A (MSA = 4.349,
MSerror = 0.793, F1,8 = 5.486, p =
0.047). Right: three more groups
have been measured. Even
though the original data is un-
changed, the effect of A is now
not significant (MSA = 1.581,
MSerror = 0.808, F4,20 = 1.958, p
= .14). Vertical lines represent
contributions to SSA; specifically,
SSA is the sum of the squares of
these vertical lines (deviations of
group means from the overall
mean).

Equally, it’s very easy to imagine a situation in which a non-significant effect with a
few levels becomes a significant effect when subjects are measured at more levels
— a very easy example would be a drug measured at 0 and 0.1 mg doses, where 0.1
mg is below the effective dose; if 10 and 100 mg doses are added to the study, the
effect of the drug might emerge.

4.6.2. Collapsing over or subdividing levels

Collapsing over levels with similar means increases power:
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Left: there is not a significant
effect of A (SSA = 8.324, MSA =
2.775, MSerror = 1.216, F3,16 =
2.281, p = 0.118). Right: if we
collapse over levels by combining
levels 1 and 2, and levels 3 and 4,
there is a significant effect of A
(SSA = 6.118, MSA = 6.118, MSer-

ror = 1.204, F1,18 = 5.082, p =
0.037).

But collapsing over levels can have the opposite effect, if you collapse over levels
with dissimilar means:

Left: there is a significant effect
of A (SSA = 27.549, MSA =
259.613, MSerror = 20.507, F3,16 =
7.165, p = 0.003). Right: if we
collapse over levels in the same
way as before, we reduce the sum
of squares and there is no longer
a significant effect of A (SSA =
7.522, MSA = 7.522, MSerror =
2.252, F1,18 = 3.34, p = 0.084).
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Part 5: using SPSS for ANOVA

5.1 Running ANOVAs using SPSS

5.1.1 Analysis of variance

You can perform ANOVAs from the Analyze → General Linear Model menu
(below).

‘Univariate’ analyses a single dependent variable. It will easily handle between-
subjects designs.
• Fill in your between-subjects factors as fixed factors and add any between-

subjects covariates (by default these will not interact with any factors).
• It will also handle within-subjects designs if your data is in a ‘one column, one

variable’ format — simply enter Subject as a random factor and enter all the
‘real’ factors as fixed factors. However, this way of doing within-subjects
analysis may be slow and will not include Mauchly’s test or the Greenhouse–
Geisser or Huynh–Feldt corrections (explained above; see p. 25). Furthermore,
it will get the analysis of mixed models (models that have both between-subjects
and within-subjects factors) wrong unless you enter a custom model in the
‘Models’ dialogue box.

The easier way of analysing simple designs that include within-subjects factors is
with the Repeated Measures option; this requires that your data is in a ‘one row,
one subject’ format. This option also allows you to include between-subjects factors
and between-subjects covariates.

The ‘Multivariate’ option is used for analysing multiple dependent variables (mul-
tivariate analysis of variance: MANOVA), and we will not cover it.

5.1.2 Syntax

Whenever you see an ‘OK’ button to begin an analysis in SPSS, there will also be a
‘Paste’ button that will not run the analysis, but will copy the syntax for the analysis
into a syntax window (opening one if necessary). This allows you to edit the syntax,
if you want to do something complicated; it also allows you to save syntax so that
you can run large multi-step analysis time after time with the minimum of effort.
You can even include syntax to load data from a file, or retrieve it from an ODBC-
compatible database. The Run menu of a syntax window allows you to run all of a
syntax file, or part that you have selected.
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5.1.3 Plots

SPSS can produce sketch plots along with its ANOVA output. Click the Plots option
of an ANOVA dialogue box and fill in the gaps. Click Add to add your plot to the
list once you’ve assembled its components.

5.1.4 Options, including homogeneity-of-variance tests

All the ANOVA dialogue boxes also allow you to set Options. By default, no op-
tions are ticked:

I find it useful to include descriptive statistics (including means and SEMs for all
levels of factors and interactions). I tend reflexively to compare main effects using a
Sidak correction. It’s certainly worthwhile including homogeneity tests to check the
assumptions of the ANOVA; SPSS will perform Levene’s test for homogeneity of
variance (significant = heterogeneous = a problem) if you tick this box. The options
menu for the ‘Univariate’ analysis looks slightly different:
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5.1.5 Post hoc tests

SPSS will allow you to specify post hoc tests for between-subjects factors in the
‘Post hoc’ dialogue box:

It won’t allow you to specify post-hoc tests for within-subjects factors, mainly be-
cause most post hoc tests are not suitable for use with within-subjects factors
(see Howell, 1997, p. 471). SPSS tries hard not to let you do something daft. The
simplest and usually best thing to do is to run a separate within-subjects ANOVA for
the data you want to perform a within-subjects post hoc test on.

5.2 Interpreting the output

Let’s look at a real and fairly complicated analysis. It involves four factors. Rats
were received either lesions of the nucleus accumbens core (AcbC) or sham surgery.
Each group was further divided into three (delay = 0, 10, or 20 s). All rats were
placed in operant chambers with two levers present throughout each session. One
lever (Inactive) did nothing. The other (Active) delivered a single food pellet. In the
‘delay = 0’ group, that pellet was delivered immediately. For the ‘delay = 10s’
group, the pellet was delivered after a 10 s delay, and for the ‘delay = 20s’ group,
after 20 s. They were trained for 14 sessions each. These are our factors:

Factor Between-subjects (B) or within-subjects (W) Number of levels Levels
Lesion B 2 sham, AcbC
Delay B 3 0, 10, 20 s
Lever W 2 active, inactive
Session W 14 1–14
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The data is entered into SPSS in ‘one subject, one row’ format (see p. 122), like this:

Subject      Lesion       Delay        S1_Active       S1_Inactive          S2_Active       S2_Inactive …
O1 sham 0 datum datum datum datum
O2 sham 0 datum datum datum datum
…
O19 sham 10 datum datum datum datum
…
O48 AcbC 20 datum datum datum datum

We have within-subjects factors and we have the data in one-subject-one-row for-
mat, so we choose Analyze → General Linear Model → Repeated Measures:

We declare the within-subjects factors:

Now we fill in the between-subjects factors and assign individual columns to appro-
priate levels of the within-subjects factors:

It’s important to ensure that the within-subjects level assignments are correct — so
‘s5_inact’ is labelled as (5,2), and the dialogue box tells us that this refers to (ses-
sion, lever) — so it’s going to be level 5 of session and level 2 of lever. This is cor-
rect. So we proceed to set appropriate options. I’m going to tick loads of things so
we can interpret a fairly full output:
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I wouldn’t normally tick ‘estimates of effect size’, ‘observed power’, or ‘parameter
estimates’. We can also set up some plots:

SPSS doesn’t do very good graphs, and it’ll only plot three factors at once. So this
plot has session on the horizontal axis, delay on separate lines, and lever on separate
plots. (The data will be collapsed across lesion, which means this graph won’t give
us any indication of how the sham/lesion groups differed — not very helpful!)

OK. Now we could Paste the syntax for this command into the syntax editor to save
it and/or fiddle with it, or just click OK to run the analysis. Let’s run the analysis.
We get a lot of stuff…

It’s huge! Let’s look at them one by one.

• Title. Says ‘General Linear Model’.

• Notes. None.
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• Warnings. Tells you what it couldn’t do. Sometimes this information is helpful;
here, it’s not very comprehensible and we ignore it.

• Within-subjects factors. This tells you what you told it. It lists all your within-
subjects factors and tells you which column of data has been matched to each
level of the factor(s). If this is wrong, the rest of your analysis will be meaning-
less, so it’s worth checking.

• Between-subjects factors. The same, but for between-subjects factors. It also
gives you the number of subjects in each condition. Check this — it may not
always be what you expect. If a subject has missing data somewhere, SPSS will
default to chucking the subject out completely.

• Descriptive statistics. Since we asked for this in the Options, we get a long list
of cell means:

• Multivariate tests. Ignore ’em; we’re not analysing multiple dependent vari-
ables. We’re analysing one (lever-pressing), predicted by four predictors (fac-
tors). So skip this.

• Mauchly’s test of sphericity. For every within-subjects factor and interaction
of within-subjects factors, SPSS performs Mauchly’s test of sphericity. If it’s
significant (‘Sig.’ column = p < 0.05), then you should multiply your df by the
Huynh–Feldt epsilon ε~  listed by it. For example, the Session factor has vio-
lated the sphericity assumption and will have its df multiplied by 287.0~ =ε ,
while the Session × Lever interaction will have its df multiplied by 464.0~ =ε .
The Lever factor has not violated the sphericity assumption. Sometimes you can
tell because the ‘Sig.’ column has a p value that’s >0.05. Here, there’s no p
value — but since 1~ =ε , we know that there’s no problem anyway.

• Tests of within-subjects effects. This is one of the important bits. There’s a
set of rows for every within-subjects factor, or interaction involving a within-
subjects factor.
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• There’s a columns corresponding to the SS (‘Type III Sum of Squares’ —
SPSS has a few ways of calculating the SS and you almost certainly want
Type III, which is the default).

• It gives you the df. The top row (‘sphericity assumed’) gives you the normal
df. The subsequent rows give you the df multiplied by the various correction
factors listed in the results of Mauchly’s test, including the Huynh–Feldt ep-
silon ε~ .

• The MS is the SS divided by the df.
• The F ratio is the MS for the term divided by the MS for the corresponding

error term. It’s always the same, no matter whether you use the Huynh–Feldt
correction or not. For example, the F for Session (80.11) is the MS for SES-
SION (9.045, 38.99, 31.475, or 117.584, depending on the df correction) di-
vided by the MS for ‘Error(SESSION)’ (.113, .487, .393, or 1.468, depend-
ing on the df correction).

• The ‘Sig.’ column is the p value for the F ratio, assessed on the relevant
number of degrees of freedom. It may vary depending on whether or not you
need to use the Huynh–Feldt correction.

• In this example, Lever doesn’t require any correction, so we would report
F1,38 = 678, p < 0.001 for the effect of Lever. However, Session requires a
Huynh–Feldt correction, as we saw above, so we would report F3.736,141.958 =
80.11, ε~ = 0.287, p < 0.001. If you correct the df, it’s good practice to report
ε~  so readers can work out the original df (which tells them something about
your analysis).

• Partial eta-squared is a column that only appeared because we ticked Es-

timates of effect size in the Options. For details of 2
partialη , see p. 102.

• Noncent(rality) parameter and Observed power only appeared because
we ticked Observed power. The observed power is the probability that the F
test would detect a population difference between the two groups equal to
that implied by the sample difference (SPSS, 2001, p. 476). The noncentral-
ity parameter is used to calculate this (Howell, 1997, pp. 334-5).
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• Tests of within-subjects contrasts. Well, we didn’t ask for this explicitly and
we’re not interested in any specific contrasts at the moment, so we’ll ignore
this.

• Levene’s test of equality of error variances. A more important one: tests
whether the variances of the various data columns differs across groups (defined
by the between-subjects factors). This tests the homogeneity of variance as-
sumption of ANOVA. The results here aren’t ideal — we have a few violations
of this assumption (where p < 0.05). For example, the variability of ‘session 2,
active lever’ responses isn’t the same across all six between-subjects groups
(sham-0, sham-10, sham-20, AcbC-0, AcbC-10, AcbC-20). These data have in
fact already been square-root transformed to try to improve matters, but there is
still a violation of the homogeneity of variance assumption in 7 of the 28 data
columns. We have to make a judgement about the robustness of ANOVA in
these circumstances (and the alternative analytical techniques available); al-
though significant, the variances don’t in fact differ by huge amounts if you
look at the descriptive statistics (for example, the session 2/active lever re-
sponses have SDs that range from 0.407 to 1.001 — a 2.5-fold difference,
which isn’t the end of the world as ANOVA is reasonably robust to that level of
violation; see p. 33).

• Tests of between-subjects effects. The other important bit that everyone will
want to look at. And very easy to interpret. We can see that there’s a significant
effect of delay (F2,38 = 19.357, p < 0.001) and although there’s no main effect of
lesion (F < 1, NS), there is a lesion × delay interaction (F2,38 = 5.887, p =
0.006). Of course, we’d want to interpret all the within-subjects factors and the
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complex interactions too (for example, this data set has a 4-way session × lever
× lesion × delay interaction).

• Parameter estimates. Not really very useful unless we’re doing some regres-
sion analysis, so it probably wasn’t worth ticking it for this analysis!

• Estimated marginal means. These can be useful. SPSS gives the means for the
various levels of each factor (or interaction). I also ticked ‘Compare main ef-
fects… with a Sidak adjustment’ in the Options. This gives us some quick post-
hoc tests. If you have a factor with only two levels (e.g. Lesion), this tells you
nothing more than the ANOVA did. But for factors with >2 levels, it can be
useful. Here are the means for Delay, which it is certainly valid to perform post
hoc tests on (since it was significant in the ANOVA, above). We see the mean
(across all other variables) for Delay (‘Estimates’), and then it compares pairs of
delays (0 v. 10, 0 v. 20, 10 v. 20) (‘Pairwise comparisons’). We also get the
standard error of the mean (SEM) for each mean and the standard error of
the difference between means (SED) for every pairwise comparison (see p.
43→). Finally, it repeats the overall F test from the ANOVA (not very help-
fully; ‘Univariate Tests’).

Tip: pairwise comparisons for interactions

Top tip: by default, SPSS only performs pairwise comparisons for factors, and
not interactions. If we were to Paste the syntax for this analysis, we’d see this
sort of thing:

/EMMEANS = TABLES(lesion) COMPARE ADJ(SIDAK)
/EMMEANS = TABLES(delay) COMPARE ADJ(SIDAK)
/EMMEANS = TABLES(session) COMPARE ADJ(SIDAK)
/EMMEANS = TABLES(lever) COMPARE ADJ(SIDAK)
/EMMEANS = TABLES(lesion*delay)
/EMMEANS = TABLES(lesion*session)
/EMMEANS = TABLES(delay*session)
…

Note that the main effects have COMPARE and ADJ(SIDAK) on them, but the
interactions don’t. If you want, you can add that in syntax! Like this:

/EMMEANS = TABLES(lesion) COMPARE ADJ(SIDAK)
/EMMEANS = TABLES(delay) COMPARE ADJ(SIDAK)
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/EMMEANS = TABLES(session) COMPARE ADJ(SIDAK)
/EMMEANS = TABLES(lever) COMPARE ADJ(SIDAK)
/EMMEANS = TABLES(lesion*delay) COMPARE(lesion) ADJ(SIDAK)
/EMMEANS = TABLES(lesion*delay) COMPARE(delay) ADJ(SIDAK)
…

You can’t just put COMPARE, because SPSS wouldn’t know whether to compare
Lesion differences for each level of Delay, or Delay differences for each level
of Lesion. So you specify one other thing; for example, COMPARE(lesion)
would compare Lesion groups at each level of Delay. You can specify both
kinds of comparison, as I did above. The output also gives you the standard er-
ror of the difference for each comparison (see p. 45). Finally, you can specify
a Sidak correction to the tests by adding ADJ(SIDAK), or similarly for Bonfer-
roni if you really want to. This can be extended to higher-order interactions; you
specify the factor you want to be compared at all possible combinations of the
other factors.

• Observed * predicted * std. residual plots. SPSS’s residual plots are a little
bit incomprehensible; see p. 36 for explanations.

• Profile plots. Finally, we get some not-so-pretty graphs:
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5.3. Further analysis: selecting cases

In this situation, we’d want to do further analysis, especially since we have a
hugely complex 4-way interaction. We might want to find out if there are effect of
Lesion or Delay if we only consider Active lever responses — easy, we just run an-
other repeated-measures ANOVA on the Active lever data only, without the Lever
factor. We might also want to see if there is an effect of delay/session/lever in the
shams alone. For this we might want to restrict the cases analysed by SPSS.
Choose Data → Select cases:

Then click If…

We only want to select cases if the lesion variable is equal to “sham”:
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Click Continue and the condition is entered into the previous dialogue box:

Click OK. You’ll now find that all cases (rows) that don’t match your criterion are
crossed out, and won’t be analysed:

5.4 The ‘intercept’, ‘total’, and ‘corrected total’ terms

When you run an ANOVA with SPSS, by default it includes the intercept term. To
turn this on/off with the menus, click on the ‘Model’ button:
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You can then choose to ‘Include intercept in model’ or not. In syntax, you can add
the command

/INTERCEPT = EXCLUDE

or
/INTERCEPT = INCLUDE

What does this do? Let’s illustrate with some sample data for an ANOVA with a
single between-subjects factor with two levels:

A Dependent
variable Ax Overall

mean
x

2)( xx − 2)( xxA − 2)( Axx − 2x 2x 2
Ax

A1 10.00 6.55 8.77 1.51 4.93 11.90 76.91 100.00 42.90
A1 14.00 6.55 8.77 27.35 4.93 55.50 76.91 196.00 42.90
A1 8.00 6.55 8.77 0.59 4.93 2.10 76.91 64.00 42.90
A1 7.00 6.55 8.77 3.13 4.93 0.20 76.91 49.00 42.90
A1 2.00 6.55 8.77 45.83 4.93 20.70 76.91 4.00 42.90
A1 10.00 6.55 8.77 1.51 4.93 11.90 76.91 100.00 42.90
A1 1.00 6.55 8.77 60.37 4.93 30.80 76.91 1.00 42.90
A1 3.00 6.55 8.77 33.29 4.93 12.60 76.91 9.00 42.90
A1 2.00 6.55 8.77 45.83 4.93 20.70 76.91 4.00 42.90
A1 8.50 6.55 8.77 0.07 4.93 3.80 76.91 72.25 42.90

A2 14.29 10.99 8.77 30.47 4.93 10.89 76.91 204.20 120.78
A2 18.49 10.99 8.77 94.48 4.93 56.25 76.91 341.88 120.78
A2 12.46 10.99 8.77 13.62 4.93 2.16 76.91 155.25 120.78
A2 11.63 10.99 8.77 8.18 4.93 0.41 76.91 135.26 120.78
A2 6.66 10.99 8.77 4.45 4.93 18.75 76.91 44.36 120.78
A2 14.02 10.99 8.77 27.56 4.93 9.18 76.91 196.56 120.78
A2 5.66 10.99 8.77 9.67 4.93 28.41 76.91 32.04 120.78
A2 7.06 10.99 8.77 2.92 4.93 15.44 76.91 49.84 120.78
A2 6.37 10.99 8.77 5.76 4.93 21.34 76.91 40.58 120.78
A2 13.26 10.99 8.77 20.16 4.93 5.15 76.91 175.83 120.78

a = 2 n = 10 per
group

N = an

436.78
= SStotal

as usually
calculated

98.57
= SSA

338.22
= SSerror

1538.26
= SSintercept

1975.04
= SStotal

with
intercept
included

1636.83
= SSmodel

with
intercept
as part of

model

If you run this analysis with the intercept included, SPSS prints this:

Tests of Between-Subjects Effects

Dependent Variable: DEPVAR

98.568a 1 98.568 5.246 .034

1538.258 1 1538.258 81.867 .000

98.568 1 98.568 5.246 .034

338.216 18 18.790

1975.042 20

436.784 19

Source
Corrected Model

Intercept

A

Error

Total

Corrected Total

Type III Sum
of Squares df Mean Square F Sig.

R Squared = .226 (Adjusted R Squared = .183)a. 

• Here, its SStotal is ∑ 2x ; its dftotal is N.

• The intercept itself (the grand mean) has SSintercept = 2xN  with dfintercept = 1.
• The ‘corrected total’, SScorrected total = SStotal – SSintercept is what we normally

think of as SStotal, namely ∑ − 2)( xx , with the usual df of N – 1.

• The effect of A is given by ∑ −= 2
A )(SS xxn A , dfA = a – 1.

• The ‘corrected model’ models the effects of the factor(s), A, ignoring the ef-
fect of the intercept (the grand mean). If you have more than one factor, the
‘corrected model’ term is the sum of all their effects: SScorrected model = SStotal –
SSintercept – SSerror.

• The error is calculated as usual: ∑ −= 2
error )(SS Axx , dferror = (N – 1) – (a –

1).
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Incidentally, the F test on the intercept term (MSintercept/MSerror) tests the null
hypothesis that the grand mean is zero. If you run an ANOVA with no factors
other than the intercept (or with a factor with only one level, which SPSS will let
you do), it is equivalent to a one-sample t test comparing all N observations to zero;

as for any t test, 2
,1 kk tF =  and kk Ft ,1= .

If you don’t include the intercept, you get this:

Tests of Between-Subjects Effects

Dependent Variable: DEPVAR

1636.826a 2 818.413 43.556 .000

1636.826 2 818.413 43.556 .000

338.216 18 18.790

1975.042 20

Source
Model

A

Error

Total

Type III Sum
of Squares df Mean Square F Sig.

R Squared = .829 (Adjusted R Squared = .810)a. 

In other words, when you exclude the intercept, the model models the effects of the
factor(s), A, and the intercept, together, without distinguishing the two. In this case,
it calculates

• SStotal is ∑ 2x ; its dftotal is N.

• The model (intercept plus effect of A) has ∑= 2
modelSS Axn , df = a = 2 (df =

2 because there are two Ax  means and one overall x  mean).

• SSA is calculated without considering the difference between the effect of A
and the grand mean as we would usually do, so SSA = SSmodel for this one-
factor case.

• The error is calculated as usual: ∑ −= 2
error )(SS Axx , dferror = (N – 1) – (a –

1).

It should be fairly clear that you probably want to ‘include’ the intercept when
running ANOVAs in SPSS. This is the default.
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Part 6: advanced topics — harder things about ANOVA

6.1 Rules for calculating sums of squares

6.1.1 Partitioning sums of squares

Sums of squares are partitioned exactly as degrees of freedom (see below, p. 68).
This requires a structural model. We’ve seen several examples of this, and many
more are discussed in Part 7.

6.1.2 General rule for calculating sums of squares

• Every SS corresponds to a term in the structural model that represents the dif-
ference between two quantities P and Q.

• Every SS is the summed squared deviation of P from Q.
• If a term contributing to the SS is based on n observations, multiply its contri-

bution by n.

For example, for two between-subjects factors A and B, the structural model is

ijkijjiijk εµY ++++= αββα

and if there are a levels of A, b levels of B, and n subjects (independent observa-
tions) per AB combination, the SS are

Term Sum of squares
µ 2

interceptSS yN=  — generally ignored

µµα −=
iAi ∑ −= 2

A )(SS yynb A  — each Ay  mean based on nb scores

µµβ −=
jBj ∑ −= 2

B )(SS yyna B  — each By  mean based on na scores

)( jiBAij ji
βαµµαβ ++−= ∑ +−−= )SSSS()(SS BA

2
AB yyn AB  — each ABy  mean based on n

scores
)( ijjiijkijk Y αββαµε +++−= )SSSSSS(SS)SSSSSS()(SS ABBAtotalABBA

2
error ++−=∑ ++−−= yy

errorABBA
2

total SSSSSSSS)(SS +++=∑ −= yy

∑=+= 2
intercepttotalintercept including  totalgrand SSSSSS y — generally ignored

We first saw the general technique for deriving these SS equations on p. 15 (and an-
other is on p. 159): we rearrange the structural model to give µYijk −  on the left-

hand side, expand out the definition of all the terms, simplify, square both sides of
the equation (so we have SStotal on the left-hand side), and eliminate a number of
terms that sum to zero.

The expected value of the squared terms in the structural model are directly related

to the E(MS), discussed below (p. 73); for example, 22 )( eijkεE σ= ;

222 )( Aei nbE σσα += .

6.2 Rules for calculating degrees of freedom

From Keppel (1991, pp. 207-214). For any source of variance:

• The df equal the number of different observations on which each sum of
squares is based, minus the number of constraints operating on these obser-
vations. (This is the definition of df in general: the number of independent



6: Advanced topics 69

observations, or the number of observations minus the number of con-
straints.)

For between-subjects designs:

• The main effect of a factor with a levels has a – 1 df. So dfA = a – 1 and dfB

= b – 1.
• The main effect of a covariate has 1 df (since its effect is represented by a

straight line, which can be determined by two parameters, but the line is
constrained to pass through the overall mean, so the one df represents the
line’s slope; it’s thus akin to a factor with two levels).

• The df for an A × B interaction, where A has a levels and B has b levels, is
the product of the two separate dfs, i.e. dfA×B = (a – 1)(b – 1).

• The total number of dfs is the number of observations N minus 1, i.e. (N –
1).

• The error or residual df is dftotal minus the sum of everything else.

We partition dfs in exactly the same way as SSs. For example, for an A × B × S de-
sign,

SStotal = SSA + SSB + SSA×B + SSerror

dftotal = dfA + dfB + dfA×B + dferror

For within-subjects and mixed designs, most of the above still holds, but we don’t
have just a single ‘error’ term. Taking ‘groups’ to refer to groups of subjects defined
by between-subjects factors:

• dfbetween subjects = total subjects – 1
• dfwithin subjects = dftotal – dfbetween subjects

• dfsubjects within groups = dfbetween subjects – dfgroups

• dfWS factor × subjects within groups = dfwithin subjects – dfWS factor – dfWS factor × groups

If a group is defined by the between-subjects factor A, we would write ‘subjects
within groups’ as ‘S/A’. For example, if we have the design A × (U × S) with a
between-subjects factor A with 3 levels, n = 8 subjects per group (24 subjects total),
and a within-subjects factor U with 6 levels, we would be able to calculate:

dftotal = N – 1 = anu – 1 = (3 × 8 × 6) – 1 = 143
dfbetween subjects = total subjects – 1 = 24 – 1 = 23
dfA = a – 1 = 3 – 1 = 2
dfS/A = dfbetween subjects – dfA = 23 – 2 = 21
dfwithin subjects = dftotal – dfbetween subjects = 143 – 23 = 120
dfU = u – 1 = 6 – 1 = 5
dfU×A = dfU × dfA = 2 × 5 = 10
dfU×S/A = dfwithin subjects – dfU – dfU×A = 120 – 5 – 10 = 105

We partition sums of squares in exactly the same way as dfs (described for this par-
ticular design in more detail later), like this:

SStotal = SSbetween subjects + SSwithin subjects

SSbetween subjects = SSA + SSS/A

SSwithin subjects = SSU + SSU×A + SSU×S/A

You can see that this exactly mirrors the df partitioning shown above (with suitable
simple arithmetic rearrangement).

6.3 Nasty bit: unequal group sizes and non-orthogonal sums of squares

This can be very complicated. So far we’ve assumed that equal-sized experimental
groups have been sampled from equal-sized treatment populations. If this is not the
case, we can have problems. Firstly, unequal ns exaggerate the problem of heteroge-
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neity of variance (see Myers & Well, 1995, pp. 105-106) (and see p. 33). Secondly,
they can really screw up an ANOVA.

6.3.1 Proportional cell frequencies

If we have unequal population sizes and the sample sizes reflect the ratios of their
sizes — and, if there is >1 factor, the inequalities are in consistent proportions across
those factors — we’re OK. For example, suppose (Myers & Well, 1995, p. 151) we
know that Labour, Conservative, and Liberal Democrat supporters are present in our
population in the ratio 4:3:3, and we know that two-thirds of each group voted in the
last election. We could quite reasonably run experiments on them with the following
numbers of subjects:

Labour Conservative Lib Dem
Voted 24 18 18
Did not vote 12 9 9

No huge problem here. Suppose we use two between-subjects factors A and B again,
as above. Suppose there there are a levels of A and b levels of B. But now suppose
there are ni observations for condition Ai, nj observations for condition Bj, and nij ob-
servations for condition AiBj. Since every SS has a contribution from every observa-
tion it’s based on, the formulae are still very simple:

Term Sum of squares
µ 2

interceptSS yN=  — generally ignored

µµα −=
iAi ∑ −=

i
Ai yyn

i

2
A )(SS  — since 

iAy  is based on ni scores

µµβ −=
jBj ∑ −=

j
Bj yyn

j

2
B )(SS  — since 

jBy  is based on nj scores

)( jiBAij ji
βαµµαβ ++−= )SSSS()(SS BA

2
AB +−∑ −=

ij
BAij yyn

ji
 — since 

ji BAy  is based on nij

scores
)( ijjijijkijk Y αββαµε +++−= )SSSSSS(SS)SSSSSS()(SS ABBAtotalABBA

2
error ++−=∑ ++−−= yy

errorABBA
2

total SSSSSSSS)(SS +++=∑ −= yy

∑=+= 2
intercepttotalintercept including  totalgrand SSSSSS y — generally ignored

6.3.2 Disproportionate cell frequencies — a problem

Here’s an example (from Howell, 1997, p. 430): experimenters test the number of
errors made by sober and by drunk people on a simulated driving test. Two experi-
ments divide up the work, testing half the subjects in their Michigan lab and half in
their Arizona lab. They have absolutely no reason to think that the choice of state
makes any difference. These are their results:

Number of errors Sober Drunk
Michigan 13, 15, 14, 16, 12

(n = 5, mean = 14)

18, 20, 22, 19, 21,
23, 17, 18, 22, 20

(n = 10, mean = 20)

Michigan mean = 18.0

Arizona 13, 15, 18, 14, 10, 12,
16, 17, 15, 10, 14

(n = 11, mean = 14)

24, 25, 17, 16, 18

(n = 5, mean = 20)

Arizona mean = 15.9

Sober mean = 14 Drunk mean = 20

It appears that drunk subjects make more errors than sober subjects, which makes
sense, but it also looks like Michigan subjects make more errors than Arizona sub-
jects. But clearly that’s an Alcohol effect masquerading as a State effect — the
Michigan lab tested a higher proportion of its subjects while drunk. The two factors
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are correlated, thanks to disproportionate cell frequencies — if you knew whether a
subject was drunk or sober, you could guess better than chance which state the sub-
ject came from. What can we do? We can use unweighted means. When we calcu-
lated the Michigan mean, we calculated it as a weighted mean (where M = Michi-
gan, S = sober, D = drunk in the formula):

18
15

2010145

,,,,

,,

=×+×=

+
=

∑+∑
=

M

DMDMSMSM

M

DMSM
M

n

ynyn

n

yy
y

This is weighted in the sense that the contribution of individual cell means ( SMy ,

and DMy , ) is weighted by the sample sizes ( SMn ,  and DMn , ). An unweighted mean

(or, more properly, an equally weighted mean) is what you get when you simply
average the cell means, ignoring the number of subjects in each cell. That would
give us a Michigan mean of (14 + 20)/2 = 17, and an Arizona mean exactly the
same. In an unweighted-means analysis, each cell mean contributes equally to the
calculation of each of the sums of squares. In the calculation, we calculate an aver-
age cell size (the harmonic mean of the cells sizes; see revision maths chapter, p.
213) and use that average n as if every cell had that many subjects (Howell, 1997,
pp. 430-435).

This is a specific example of a general problem — when the effects of two or more
effects (or interactions) are not fully independent. The example shown above is
fairly common (the effects of one factor, State, are partly correlated with the effects
of another, Alcohol, because one state tested a higher proportion of drunks). It may
be easier to visualize the problem with an even more extreme example — one in
which two factors A and B are completely correlated. Consider this particularly stu-
pid set of data collected as part of an A2 × B2 × S design (Myers & Well, 1995, p.
153):

A1 A2

B1 no observations 18
12
11
7
14
6
7
6

B2 10
14
8
7
2
10
1
3

no observations

Let’s calculate the SS. Each observation makes one contribution to the SS, as usual,
so we should define ni as the number of observations at level Ai, nj as the number of
observations at level Bj, and nij as the number of observations at AjBj. Then
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Pretty stupid; we have a negative SSAB! The problem is that the effects of A and B in
this design are not orthogonal; the main effects of A and B are perfectly correlated
(simply because there are only observations for A1B2 and A2B1; the effects of A and
B are confounded). If we added two A1B1 and two A2B2 observations, the effects of
A and B are now not perfectly correlated, but they are still correlated. The problem
can be illustrated like this:

If we calculate SSA in the usual way, it consists of t+u+v+w. On the other hand, if
we adjust it for the contribution of the other main effect B, it would consist of t+w.
Or we could adjust it for the contribution of B and AB, in which case the adjusted
SSA would consist only of t. Similar options exist for the other sources of variance.
The appropriate choice probably depends on the importance the experimenter at-
taches to the various factors (Myers & Well, 1995, p. 155). See also Howell (1997,
pp. 578-582).

This also means that the order you enter terms into a computer analysis can af-
fect the results. On some packages, an ANOVA with the sources of variance being
A, B, and A × B gives you a different answer from an ANOVA with the sources of
variance being B, A, and A × B. The default method in SPSS does not care about
the order — it’s what SPSS refers to as the ‘Type III’ sum of squares. I think
(Myers & Well, 1995, p. 155) that this method uses area t for SSA, area x for SSB,
and z for SSAB. This is probably what you want — it is certainly appropriate for the
case when there is chance variation in cell frequencies, such as when subjects drop
out at random (Myers & Well, 1995, p. 155). It is also the method approximated by
the ‘unweighted (equally weighted) means’ solution described above (Howell, 1997,
p. 582).

In general, whenever cell frequencies (ns in each cell) are equal or proportional
(meaning that for each cell, nij = ninj/N), the sums of squares are orthogonal (unless
the experiment itself has been mis-designed and confounds two variables). But
whenever cell frequences are disproportionate, the sums of squares are nonor-
thogonal (Myers & Well, 1995, p. 154; Howell, 1997, pp. 429-435 and 578-579).

This problem occurs whenever predictor variables are themselves correlated (see
also Myers & Well, 1995, pp. 555-563). ANOVA with equal cell frequencies is ex-
actly equivalent to multiple regression with uncorrelated categorical variables
(Myers & Well, 1995, p. 536), and ANOVA with disproportionate cell frequencies
implies that the factors are correlated. This is easy to see: if our Autism × Sex ex-
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periment has 8 male autistics, 2 female autistics, 2 male controls, and 8 female con-
trols (disproportionate cell frequencies), you can make a better-than chance guess as
to whether a subject is male or female if you know whether they’re autistic or not —
the two factors are correlated. It is, of course, possible to have a middle ground —
unequal but proportionate cell frequencies (see above, p. 70, for an example), which
still involves orthogonal sums of squares.

6.4 Expected mean squares (EMS) and error terms

First we need to consider the sampling fraction for fixed and random factors (fixed
and random factors are defined on p. 31). If we have factor A with a levels and it is
a fixed factor, we have sampled all the levels. We can say that the maximum number
of levels of A is amax = a, and the sampling fraction a/amax = 1. On the other hand, if
our factor is a random factor, amax is likely to be very large, so a/amax = 0, approxi-
mately. Take the example of subjects: we presume that our s subjects are sampled
from a very large population, smax ≈ ∞, so the sampling fraction s/smax = 0.

It is possible to have sampling fractions between 0 and 1 (Howell, 1997, p. 423) —
but you will have to work out some messy EMSs yourself. Software packages such
as SPSS assume that the sampling fraction is 1 for fixed factors and 0 for random
factors.

6.4.1 Rules for obtaining expected mean squares (EMS)

From Myers & Well (1995, p. 299). Let’s list the rules with an illustrative example.
Suppose we have one between-subjects factor A with 3 levels. There are 6 subjects
per level of the between-subjects factor (n = 6). There are 4 levels of a within-
subjects factor B.

1. Decide for each independent variable, including Subjects, whether it is fixed or
random. Assign a letter to designate each variable. Assign another letter to rep-
resent the number of levels of each variable. (In our example, the variables are
designated A, B, and S; the levels are a, b, and n respectively. A and B are fixed
and S is random.)

2. Determine the sources of variance (SS) from the structural model. (We’ve al-
ready seen what this produces for our example design, when we discussed it
earlier: SStotal is made up of SSA + SSS/A + SSB + SSAB + SSSB/A. These are our
sources of variance.)

3. List 2
eσ  as part of each EMS.

4. For each EMS, list the null hypothesis component — that is, the component cor-
responding directly to the source of variance under consideration. (Thus, we add

2
Anbσ  to the EMS for the A line, and 2

/ ASbσ  to the EMS for the S/A line.) Note

that a component consists of three parts:

• A coefficient representing the number of scores at each level of the effect
(for example, nb scores at each level of A, or b scores for each subject).

• 2σ
[Myers & Well (1995, pp. 299) use 2

Aσ  if A is a random factor, and
2
Aθ  if A is a fixed factor; Howell (1997, p. 423) doesn’t, and I think

it’s clearer not to.]
• As subscripts, those letters that designate the effect under consideration.

5. Now add to each EMS all components whose subscripts contain all the letters
designating the source of variance in question. (For example, since the subscript

SB/A contains the letters S and A, add 2
/ ASBσ  to the EMS for the S/A line.)
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6. Next, examine the components for each source of variance. If a slash (/) ap-
pears in the subscript, define only the letters to the left of the slash as ‘essen-
tial’. If there are several slashes, only the letters preceding the leftmost slash are
essential. If there is no slash, all letters are essential.

7. Among the essential letters, ignore any that are necessary to designate the
source of variance. (If the source of variance is A, for example, then when con-

sidering 2
ABnσ , ignore the A. If the source is S/A, then when considering the

2
/ ASBσ  component, S and B are essential subscripts and S is to be ignored.) If

any of the remaining (non-ignored) essential letters designate fixed variables,
delete the entire component from the EMS.

An example:

Term EMS so far

Step 1: identify variables and numbers of levels.

A, a (between-subjects factor)
B, b (within-subjects factor)
S, n (number of subjects per group)

Step 2: identify sources of variance.

A
S/A
B
BA
SB/A

Step 3: List 2
eσ  as part of each EMS.

A 2
eσ

S/A 2
eσ

B 2
eσ

BA 2
eσ

SB/A 2
eσ

Step 4: list the null hypothesis component.

A 22
Ae nbσσ +

S/A 2
/

2
ASe bσσ +

B 22
Be anσσ +

BA 22
BAe nσσ +

SB/A 2
/

2
ASBe σσ +

Step 5: add all components whose subscripts contain all the letters desig-
nating the source of variance in question.

A 2
/

22
/

22
ASBBAASAe nbnb σσσσσ ++++

S/A 2
/

2
/

2
ASBASe b σσσ ++

B 2
/

222
ASBBABe nan σσσσ +++

BA 2
/

22
ASBBAe n σσσ ++

SB/A 2
/

2
ASBe σσ +
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Steps 6 and 7: for each component, define ‘essential’ letters; ignore any that
are part of the designation of the source of variance; if any remaining es-
sential letters contain fixed factors, delete the component.

A 2
/

22
ASAe bnb σσσ ++

S/A 2
/

2
ASe bσσ +

B 2
/

22
ASBBe an σσσ ++

BA 2
/

22
ASBBAe n σσσ ++

SB/A 2
/

2
ASBe σσ +

6.4.2 Choosing an error term

A mean square qualifies as an error term for testing an effect if its E(MS) matches
the E(MSeffect) in all respects except the null-hypothesis component (Keppel, 1991,
p. 568). In our example above, therefore, we’d test MSA against MSS/A, and we’d
test both MSB and MSBA against MSSB/A.

6.4.3 Pooling error terms

When we have random factors in a model, important variables are often tested
against an interaction term. Since interaction terms have few df (and since power
depends on F being large when the null hypothesis is false, and since F is the ratio
of MSeffect to MSerror, and since MSerror is SSerror/dferror), this means we may have
poor power to detect such effects.

One possibility is to test interaction terms in a full model with a conservative crite-
rion, like this (Howell, 1997, p. 425). If there is an interaction (p < 0.05), we declare
that there’s an interaction. If there isn’t (0.05 < p < 0.25), we just look at the results
for other terms. But if there is no interaction (p > 0.25), we remove the interaction
term from the model. In the example above, if we found that the AB interaction was
not significant (p > 0.25), we could remove any terms including it and its df would
contribute to the within-subjects error term, which might increase power to detect
effects of B (see p. 51).

6.5 Contrasts

See Howell (1997, pp. 354-369); Myers & Well (1995, chapter 6).

6.5.1. Linear contrasts

Linear contrasts are comparisons between linear combinations of different groups.
Suppose we want to know whether students are more bored on Wednesdays than
other weekdays, because Wednesday is statistics day, and whether they’re more
bored on weekdays than weekends. We could measure their boredom on all days of
the week, and use DayOfWeek as a factor (with 7 levels) in an ANOVA. If this
turned up significant, we would know that all days were not the same — but it
wouldn’t answer our original questions. We can do that with linear contrasts.

In general, a linear contrast is a linear combination of a set of treatment means. Each
mean µj is weighted by a weight wj:

∑=+++=
j

jjkk wwwwL µµµµ …2211

such that 0=∑
j

jw

In our example, suppose µ1 is the Monday mean, µ2 is the Tuesday mean, and so on.
Our ‘Wednesdays versus other weekdays’ question can be written as a linear con-
trast:
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Wed
FriThuTueMon

4
µµµµµ

−
+++

=L

or

SunSatFriThuWedTueMon 00
4

1

4

1
1

4

1

4

1 µµµµµµµ ++++−++=L

Equivalently (multiply everything up to get whole numbers):

SunSatFriThuWedTueMon 0011411 µµµµµµµ ++++−++=L

If the Wednesday mean is the same as the mean of the other weekdays, we expect
that L = 0. So our null hypothesis is that L = 0. If a statistical test rejects this null hy-
pothesis (shows that L deviates from 0 more than chance alone would predict), we
would conclude that Wednesdays were different from other weekdays. Our ‘week-
days versus weekends’ question could be written as a different linear contrast:

SunSatFriThuWedTueMon 2

1

2

1

5

1

5

1

5

1

5

1

5

1 µµµµµµµ −−+++++=L

Again, if the null hypothesis (weekdays the same as weekends) is true, the expected
value of L is 0. Comparisons between individual pairs of means can also be accom-
plished with linear contrasts — for example, Sunday versus Monday (the ‘back to
work’ effect?):

SunSatFriThuWedTueMon 1000001 µµµµµµµ −−+++++=L

For any contrast,

∑
=

j
jj nw

L
2

2

contrastSS

All linear contrasts have 1 df per contrast. The significance test of a contrast is given
by F = MScontrast/MSerror.

6.5.2. Type I error rates with planned contrasts

If we ran pairwise comparison post hoc tests on our days-of-the-week example,

we’d make 217
2 =C  pairwise comparisons, so if we used α = 0.05 per comparison,

our familywise αFW would be a huge 0.66. We’d run the risk of falsely declaring all
sorts of differences significant. But our experiment was only designed to answer
three questions: Wednesdays v. other weekdays, weekdays v. weekends, and Sun-
days v. Mondays. So if we only ask these questions, which we had in mind a priori,
we could never declare the ‘Monday v. Tuesday’ difference significant. Ask fewer
questions, less chance of a Type I error.

In general, the methods of controlling for Type I errors are the same in principle for
a priori and post hoc tests. The differences are simply (1) that we generally ask
fewer questions a priori, and (2) when we perform post hoc tests we often focus on
the differences that look biggest — which is logically equivalent to performing all
possible comparisons (visually) and then selecting the biggest for statistical testing.
Since this has a high likelihood of a Type I error, such data-guided post hoc tests
must be corrected as if we were making all possible comparisons (because actually
we are). As Myers & Well (1995, p. 179) put it, ‘the effective size of a family of
post hoc contrasts is determined not by the number of contrasts actually tested but
by those that conceivably might have been tested, had the data suggested it was
worth doing so’.

When we specify in advance (a priori) which comparisons we’re interested in, we
can specify the Type I error rate per contrast (EC or α) or per family of contrasts (EF
or αFW). What should constitute a ‘family’ of contrasts? All the contrasts an experi-
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menter ever runs? All that are published in a single paper? Most people would say
no; although that would result in a very low Type I error rate, it would lead to a high
Type II error rate (low power) — missing real differences. There are two serious
candidates for a ‘family’ (Myers & Well, 1995, p. 178). They are (1) all the con-
trasts made in a single experiment; (2) all the contrasts associated with a single
source of variance in a single experiment. Suppose your experiment has three fac-
tors, A, B, and C. By the first criterion, all contrasts in your A × B × C design to-
gether constitute one family. By the second criterion, there are seven families (in-
volving A, B, C, AB, AC, BC, and ABC). Myers & Well (1995, p. 178) recommend
the second criterion as a reasonable compromise between Type I and Type II errors.

Once you’ve decided how many contrasts are in a family, you can reduce your EC
(α), or increase your p values, to obtain the desired EF (αFW). For example, you
could use the Bonferroni or Sidak corrections discussed above; these are simple
(though the Bonferroni is over-conservative, so I prefer the Sidak). If you run k con-
trasts that are independent (orthogonal, see p. 77), αFW = 1 – (1– α)k, so the Sidak
correction is spot on. If your contrasts are not independent, αFW < 1 – (1– α)k (Myers
& Well, 1995, p. 177) but it is hard to calculate αFW exactly, so just use the Šidák or
Bonferroni correction and at worst your tests will be conservative.

Planned contrasts may be conducted whether or not the overall F tests from the
ANOVA are significant (Myers & Well, 1995, p. 179). In fact, you could run them
instead of the usual ANOVA, but you are recommended to run the ANOVA too
(Myers & Well, 1995, pp. 179, 196). Why? (1) Because our theories are rarely good
enough that we are willing to forgo checking whether unanticipated effects are pres-
ent in the data with post hoc tests, suitably controlled for Type I error. (2) The
ANOVA carries additional information, for example about the effect size; see p.
97→. Note also that the ANOVA may give a different result from a family of post
hoc tests, since the power of the ANOVA is that of the ‘maximum contrast’ (Myers
& Well, 1995, p. 196), which may not be obvious or interesting (e.g. it may reflect a
linear combination of groups that you wouldn’t have thought about in advance, such
as 0.3×Mon + 0.7×Tue – 0.4×Wed – 0.6×Sat).

6.5.3. Orthogonal contrasts

Contrasts are orthogonal if the questions they ask are independent. This is one set of
6 orthogonal contrasts for our days-of-the-week example, showing how you can
break down a set of means into a set of orthogonal contrasts:

(Mon, Tue, Wed, Thu, Fri) v. (Sat, Sun)
(Mon, Tue) v. (Wed, Thu, Fri) (Sat) v. (Sun)

(Mon) v. (Tue) (Wed) v. (Thu, Fri)
(Thu) v. (Fri)

All these are independent of each other. But these two are not independent:

(Mon) v. (Tue) (Mon) v. (Wed)

There are many possible sets of orthogonal contrasts (some of them involving odd
fractional combinations of day means, which might not be very meaningful experi-
mentally!). For any complete set of orthogonal contrasts, ∑= contrasttreatment SSSS ,

and ∑= contrasttreatment dfdf . So for our days-of-the-week example, we would need 6

orthogonal contrasts for a complete set; the set of 6 shown above is one complete
set.

Formally, two contrasts ∑=
j

jjwL µ)1(1  and ∑=
j

jjwL µ)2(2  are orthogonal if, for

equal sample sizes, 0)2()1( =∑
j

jj ww  (Howell, 1997, p. 361). The more general con-

dition, for unequal sample sizes, is 0)2()1( =∑
j j

jj

n

ww
 (Myers & Well, 1995, p. 176).
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There’s no reason that we should test only orthogonal contrasts — we test the con-
trasts that ask the questions we’re interested in.

6.5.4. Linear contrasts in SPSS

In SPSS, to run linear contrasts other than very specific ones (such as comparing all
groups separately to the last one), you need to specify the design in syntax using the
/CONTRAST()=SPECIAL() or /LMATRIX command. For a between-subjects ANOVA
of a dependent variable (depvar) with one factor (Day, 7 levels), you can specify
your contrasts like this:

UNIANOVA
  depvar BY day
  /CONTRAST (day)=Special(0.25  0.25 -1     0.25  0.25  0     0
                          0.2   0.2   0.2   0.2   0.2  -0.5  -0.5
                          1     0     0     0     0     0    -1)
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /PRINT = TEST(LMATRIX)
  /DESIGN = day .

The /PRINT… command makes your custom contrast matrix appear under the head-
ing Custom Hypothesis Tests, followed by the results (significance values for each
test), followed by the sum of squares for the contrast. In this example you can see
that contrast L1 is ‘Wednesdays v. other weekdays’, L2 is ‘weekdays v. weekends’,
and L3 is ‘Sundays v. Mondays’. All are significant in this example.

Alternatively, you can use the LMATRIX syntax, which allows you to specify any
linear combination of any number of factors or interactions (SPSS, 2001, pp. 478-9).
It may help to read the GLM section to understand this (p. 84→, especially p. 93→).
For our simple example the syntax would be:

UNIANOVA
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  depvar BY day
  /LMATRIX = "Wed_v_otherweekday"
             day 0.25  0.25 -1     0.25  0.25  0     0
  /LMATRIX = "weekday_v_wkend"
             day 0.2   0.2   0.2   0.2   0.2  -0.5  -0.5
  /LMATRIX = "sun_v_mon"
             day 1     0     0     0     0     0    -1
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /PRINT = TEST(LMATRIX)
  /DESIGN = day .

or to put all the tests into one matrix as before,

UNIANOVA
  depvar BY day
  /LMATRIX = day 0.25  0.25 -1     0.25  0.25  0     0;
             day 0.2   0.2   0.2   0.2   0.2  -0.5  -0.5;
             day 1     0     0     0     0     0    -1
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /PRINT = TEST(LMATRIX)
  /DESIGN = day .

If you want to obtain separate sums of squares for each contrast (reasons for which
are given below), you can use the version with several /LMATRIX commands — you
get one ‘Test Results’ box with one sum of squares for each /LMATRIX command.
(It’s also possible to work out SScontrast from the ‘contrast estimate’ L given in the re-

sults and the weight coefficients printed in the L matrix, using 
∑

=

j
jj nw

L
2

2

contrastSS ,

but this is rather a pain.)

If you specify nonorthogonal contrasts, like this:

UNIANOVA
  depvar BY a
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /LMATRIX = "contrast1" a -1 +1 0 0 0
  /LMATRIX = "contrast2" a -1 0 +1 0 0
  /LMATRIX = "bothtogether" a -1 +1 0 0 0;
                            a -1 0 +1 0 0
  /PRINT = TEST(LMATRIX)
  /DESIGN = a .

then you will find that SScontrast1 + SScontrast2 ≠ SSbothtogether. For a discussion of corre-
lated (nonorthogonal) predictors, see above and pp. 70 and 97.

6.5.5. Contrasts in multifactor designs — an overview

The same principles can be applied to any contrast, even involving multiple factors
(Myers & Well, 1995, pp. 188-185). Suppose we have two factors: therapy type (A:
control CON, analytic therapy AT, behaviour therapy BT, cognitive therapy CT) and
patient diagnosis (B: unipolar depression D, schizophrenia S, manic depression M).
We measure some sort of dependent variable. We find a main effect of A, a main ef-
fect of B, and an AB interaction. We can therefore reject these null hypotheses:

0

0

0

MCT,DCON,

MSD

CTBTATCON

===
===

====

αβαβ
βββ

αααα

…

We can ask further questions using contrasts. Does the mean of control subjects dif-
fer from the mean of all the therapy populations? That would be a single contrast:
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3
: CTBTAT

CON1
µµµµ ++−L

Call this (control) versus (all other treatments) the ‘treatment effect’. Does the
treatment effect vary over clinical populations? That would involving seeing if three
contrasts differ:

3

3

3

3

MCT,MBT,MAT,
SCON,M

SCT,SBT,SAT,
SCON,S

DCT,DBT,DAT,
DCON,D

CTBTAT
CON

µµµ
µ

µµµ
µ

µµµ
µ

µµµµ

++
−=

++
−=

++
−=

++−=

T

T

T

T

TTTTH === MSD0 :

This is harder but possible (Myers & Well, 1995, pp. 190-5); it involves testing a
sum of squares based on the deviations of TD, TS, and TM from the overall treatment
effect T. And so on. An SPSS-based example of this sort of thing is given on p.
93→.

6.6 Trend analysis: the effects of quantitative factors

6.6.1. Trends

Factors are categorical variables. But some categories are qualitative (male/female;
bipolar/schizophrenic/control) and some are quantitative (session 1/2/3…,
stimulus height 7 cm/9 cm/11 cm…). How can we ask quantitative questions about
the relationship between stimulus height and our dependent variable? Well, if the
predictor variables are continuous (covariates), you can ask things like ‘is my de-
pendent variable a linear function of the predictor?’ (simple ANCOVA = linear re-
gression, see p. 135) or ‘is my dependent variable a quadratic function of the pre-
dictor?’ (polynomial ANCOVA, see p. 88→). But with categorical predictors (fac-
tors), you use trend analysis (see Myers & Well, 1995, chapter 7; Howell, 1997, pp.
386-396). Obviously, this technique requires that the levels of the factor are in some
sort of order.

We can accomplish this using contrasts but with particular weights for our contrast
coefficients. For example, returning to our days-of-the-week example, taking just
the weekdays, we can ask:

Mon Tue Wed Thu Fri
Do people get happier during the week?
A linear trend.

–2 –1 0 +1 +2

Are people happier in the middle of the week?
A quadratic trend, an example of a non-linear (curved) trend.

+2 –1 –2 +1 +2

So for our linear example, we could test the contrast

0:

21012

0

FriThuWedTueMon

=
+++−−=

LH

L µµµµµ

The contrast coefficients shown above would be valid if (1) the values of the factor
are equally spaced, as they are for days of the week, and (2) each mean is based on
the same number of scores. If not, see below.
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One common approach to trend testing is to ask what set of trends explain the data
well (Myers & Well, 1995, pp. 209-216). Here we would be guided by our theories.
Suppose (Myers & Well, 1995, p. 204) we are performing a generalization exper-
mient; we train subjects that an 11” stimulus predicts electric shock. We might ex-
pect that an 11” stimulus would elicit a substantial skin conductance response,
which would generalize somewhat to 9” and 13” stimuli, but less so to 7” and 15”
stimuli. This would be an inverted-U-shaped curve, and such a curve can be de-
scribed by a quadratic equation (y = a + bx2, where b < 0). So the responses to
7/9/11/13/15” stimuli might be something like 1/4/9/4/1 units. We might also
expect that larger stimuli cause more of a response — a straight line relationship
between stimulus size and response, which can be described by a linear equation (y
= a + bx). So if this were the only thing influencing responding, responding for the
7/9/11/13/15” stimuli might be something like 1/2/3/4/5 units. Overall, if
these two effects are independent, we might expect an asymmetric inverted-U curve,
the sum of the other two effects (y = b0 + b1x + b2x

2) — in this example,
2/6/12/8/6 units.

We can perform an ANOVA to ask if the stimuli differ. Suppose they do — the ef-
fect of the factor is significant. We know that taking full account of our factor, A,
can explain a certain amount of variance: SSA, such that SStotal = SSA + SSerror. Ap-
plying Occam’s razor, it’s common to ask first whether a straight line (a linear
trend) can explain the data well. Suppose we obtain a sum of squares for our linear
contrast, SSlinear. We can see if this accounts for a significant amount of variability:
Flinear = MSlinear/MSerror. So does the effect of A include something over and above a
linear component? Well, SSA = SSlinear + SSnonlinear (and, of course, dfA

 = dflinear +
dfnonlinear = 1 + dfnonlinear). So we can calculate an F test to see if there’s anything
‘substantial’ in that nonlinear component: Fdf-nonlinear/df-error = MSnonlinear/MSerror. This
is an F test for the lack of fit of the linear model (see also Myers & Well, 1995, p.
411) — we know how much variability A accounts for overall; the question is, what
component of that is linear and what is not. If this isn’t significant, our linear model
does a good enough job — we stop. If it is, we can add in a quadratic trend. We
would now have SSA = SSlinear + SSquadratic + SShigher-order. We can test SShigher-order to
see if we should add any other predictors (SScubic…) and carry on until the ‘lefto-
vers’ no longer contain anything significant. However, if your theory predicts cer-
tain components (e.g. linear and quadratic), you shouldn’t perform tests that you’re
not interested in (Myers & Well, 1995, p. 216).

If you have a groups, then you can fit at most a polynomial of order a–1. So if you
have 5 groups, you can only fit a linear (x1), quadratic (x2), cubic (x3), and quartic
(x4) trend; you haven’t got enough data to fit a quintic (x5) trend. So in general, the
most complex polynomial equation that can be fitted with a groups is

1
1

2
210

ˆ −
−++++++= a

ja
p
jpjjj XbXbXbXbbY ……

To apply this technique, the trends (SSlinear, SSquadratic, …) have to be independent of
each other, or orthogonal, so that their sums of squares add up to SSA.

If (1) the values of the factor are equally spaced, as they are for days of the week,
and (2) each mean is based on the same number of scores, coefficients can easily be
generated for a set of orthogonal polynomials (Myers & Well, 1995, pp. 209-216
and Table D7; Howell, 1997, p. 391 and Appendix Polynomial). It is possible to de-
rive coefficients when the ns are not equal and/or the groups are not equally spaced
(Myers & Well, 1995, pp. 211, 227-229) but it is much simpler to use standard lin-
ear and/or nonlinear regression techniques, treating the predictor as a continuous
variable (see pp. 82, 88→, 135).

6.6.2. Trend analysis in SPSS

In SPSS, polynomial contrasts can be done easily. In the example of an ANOVA
with a factor A, specify this:

UNIANOVA
  depvar BY a
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  /CONTRAST (a)=Polynomial
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /PRINT = TEST(LMATRIX)
  /DESIGN = a .

You can also specify the contrast coefficients by hand. For a factor with five levels,
equally spaced, with equal n, you could use:

UNIANOVA
  depvar BY a
  /LMATRIX = "a linear"     a -2 -1  0  1  2
  /LMATRIX = "a quadratic"  a  2 -1 -2 -1  2
  /LMATRIX = "a cubic"      a -1  2  0 -2  1
  /LMATRIX = "a quartic"    a  1 -4  6 -4  1
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /PRINT = TEST(LMATRIX)
  /DESIGN = a .

To use the ANOVA dialogue box (Analyze → General Linear Model → …), choose
Contrasts, set the contrast for your factor to ‘Polynomial’, and click change. To get
the LMATRIX printout, choose Options → Contrast coefficient matrix. Other
forms of contrast (and the lack-of-fit test described above for ‘is there anything sig-
nificant left over that needs to be accounted for?’) can be specified by hand using the
syntax outlined above (p. 77).

For one-way ANOVA, better output is obtained from Analyze → Compare means
→ One-way ANOVA. Click Contrasts → Polynomial, and enter the order of the
polynomial. You may also want Options → Means plot. The output looks like this:

6.6.3.How trend analysis relates to multiple regression or polynomial ANCOVA

Trend analysis described how well linear, quadratic, etc., components fit the means
of each group. Suppose A is your factor (five levels: 7”, 9”, 11”, 13”, and 15” stim-
uli). Your dependent variable is Y: you have 20 observations per level (100 sub-
jects). You could treat A as a factor, as we’ve seen, or as a continuous variable.

• If you performed a linear regression or ANCOVA with your predictor vari-
able having one of the values 7, 9, 11, 13, and 15 for all the subjects, and
your independent variable being Y, you would find that your SSregression was
the same as the SSlinear from the ANOVA contrast.

• If you performed a linear regression with your predictor variable having the
values 72, 92, 112, 132, and 152 and your independent variable being Y, you
would not obtain SSquadratic. Trend analysis assumes that the centre of the
quadratic function is in the middle of your groups. In our example, the
‘middle value’ is 11. So the quadratic trend analysis calculates

2)11(ˆ −+= xbay , not 2ˆ bxay += . If you obtain SSregression with (x – 11)2 as

your predictor, you will obtain SSquadratic from the ANOVA contrast. You’ll
also obtain the same answer if you use the quadratic trend coefficients (2, –
1, –2, 1, 2) as your predictor (x2) values.

• You’d think that SScubic is the SSregression you obtain with the regression

model 3)11(ˆ −+= xbay . But the cubic trend analysis coefficients for five



6: Advanced topics 83

groups are (–1, 2, 0, –2, 1), so that’s what you need to use as your predictor
values to obtain SScubic. I’d initially thought they’d be something like (–8, –
1, 0, 1, 8) — but the problem is that these values are not orthogonal to the
other (linear, quadratic) components. Specifically, (–8, –1, 0, 1, 8) is not
orthogonal to the linear component. If you use (–1, 2, 0, –2, 1) your cubic
predictor values, you do obtain SScubic. This is the cubic component over and
above any linear component.

• If you put all these predictors into a multiple regression, you get the correct
SS for each component as long as the predictors are orthogonal; otherwise,
they start to reduce each other’s SS (see pp. 70 and 97).

• Each of the SSs should be compared to the overall MSerror from the ANOVA
to get the same F values for all the components. The multiple regression ap-
proach can never measure the ‘group means’ for different values of A in the
way the ANOVA does, so it can never measure the ‘lack of fit’. Its SSerror-

multiple-regression reduces towards SSerror-ANOVA as you put in more predictors and
the prediction gets better. To work out whether it’s worth putting another
predictor in, you would have to compare the multiple regression R2 values
for models with and without the extra predictor (see p. 86→). This is one
advantage of trend analysis — you begin by knowing how much variability
the group means of your factor account for (which the multiple regression
doesn’t), and you try to work out what polynomial components contribute to
that.
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6.7 How computers perform complex ANOVAs: the general linear model (GLM)

6.7.1 The basic idea of a GLM, illustrated with multiple regression

Following Howell (1997, p. 567), suppose we want to solve a multiple-regression
equation to predict Y with three predictors (variables X1, X2, and X3). Our equation
is:

3322110
ˆ XbXbXbbY +++=

or, written out for an individual observation:

iiiii eXbXbXbbY ++++= 3,32,21,10

where i stands for a particular observation (labelled from 1 to n) and ei is the error
associated with each observation. We could write that using vector (matrix) notation
(see revision chapter on matrices, p. 196):

exxxby 310 ++++= 3221 bbb

where y, x1, x2, x3 are n × 1 vectors of data, e is an n × 1 vector of errors, and b0 is
an n × 1 vector whose elements are the intercept. This can be further reduced to

eXby +=

where there are p predictor variables, X is an n × (p + 1) matrix of predictors, the
first column of which contains only ones, and b is a (p + 1) × 1 matrix of regression
coefficients — like this:
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Solving a multiple regression equation then becomes the problem of solving

eXby +=  for b so as to minimize the sum of squares of the residuals, ∑ − )ˆ( YYi

or ∑ 2
ie . When this is solved, b contains the correct regression coefficients.

Three things are worth noting. Firstly, the multiple regression coefficient R is the

correlation between Y and Ŷ , and its square is the proportion of variability ac-
counted for by the overall regression:

Y

R
SS

SSregression2 =

Secondly, the contribution of individual predictors may be easy to specify (if the

predictors themselves aren’t correlated, in which case 2
predictoreach r  represents the

proportion of total variation explained by each predictor and ∑= 2
predictoreach 

2 rR ) or

rather tricky to specify (if the predictors are correlated); see Myers & Well (1995,
pp. 505-508). And just as r for a sample can be adjusted (to radj) to provide a better
estimate of ρ for the underlying population, R2 can also be adjusted according to the
sample size (Myers & Well, 1995, p. 508-9) (see p. 98). Other issues regarding mul-
tiple regression are discussed by Howell (1997, ch. 15).
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Thirdly, the method of solving this matrix equation is pretty damn complicated
when there are several predictors. It’s illustrated for linear regression (and even
more complicated cases) at

www.mathworld.com/LeastSquaresFitting.html
www.mathworld.com/NonlinearLeastSquaresFitting.html

and a general proof is given on p. 204, but we’ll just leave SPSS to do it for us.

6.7.2 Using a GLM for simple ANOVA: the design matrix

How can we represent ANOVA in this way? Suppose we take our old favourite, the
one-way ANOVA with a single between-subjects factor, A. Our equation for this is

ijiij ετµY ++=

where τi is the effect of level i of factor A. This symbol τi represents τ1, τ2, τ3 … τa (if
there are a levels of factor A) but for one subject we are only interested in the con-
tribution of one level of A. We can accomplish this with something called a design
matrix. The design matrix, X, will have a + 1 columns and as many rows as there ae
subjects. Suppose (after Howell, 1997, p. 567) there are 6 subjects, 3 levels of A,
and 2 subjects per level. Then our design matrix looks like this (the ‘S’ or Subject
column is purely for explanation and isn’t part of the matrix):
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So subjects 1 and 2 experienced treatment A1, subjects 3 and 4 experienced treat-
ments A2, and subjects 5 and 6 experienced treatments A3. All subjects experienced
the effect of the overall mean, so the first column is full of ones. We can now define
our treatment matrix and write the whole thing in matrix form:

eXτy

y
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Solving this equation for τ so as to minimize ∑ 2e  gives us the treatment effects (µ,
τ1, τ2, τ3) we’re after.

However, for practical use, it’s common to alter the design matrix slightly. Firstly,
the µ column has no variance, so it can’t go into a standard multiple regression
analysis, so we remove it. Secondly, the A3 column is redundant: if a subject isn’t in
A1 or A2, we know it’s in A3 (i.e. there are only 2 df for A), so we remove that too.
Finally, to make our treatment effects matrix give treatment effects that are relative
to the overall mean (µ), the mean of each column must be zero (corresponding to the
ANOVA requirement that 0=∑ iτ ). We can achieve this by scoring a subject 1 in

column Ai if the subject is a member of treatment Ai, scoring –1 if the subject is a
member of the last (ath) treatment, and scoring 0 otherwise. (This is sometimes
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called sigma-restricted parameterization, since the columns sum to zero, while the
original form is called the overparameterized model, since it contains redundant in-
formation. It is possible to analyse using the overparameterized model; see
www.statsoft.nl/textbook/stglm.html.) Anyway, this process gives us this revised
design matrix, which carries all the necessary information:
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6.7.3 Example of a GLM for a one-way ANOVA

So suppose we have these data (one datum per subject):

A1 A2 A3 A4

8
9
7

5
7
3

3
4
1

6
4
9

To analyse them with a GLM, we use a set of matrices like this (one row per sub-
ject):
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The regression coefficient matrix can be called b (as it was for multiple regression)

or τ (as it was for ANOVA). The overall R2 will represent 
total

model

SS

SS
, and testing it for

significance is the same as testing the effect of A for significance. The intercept in
the regression model will equal the grand mean (Howell, 1997, p. 571-2).

6.7.4 GLM for two-way ANOVA and beyond

Let’s move up to a two-way ANOVA, with between-subjects factors A and B
(Howell, 1997, p. 572). Our full model is

ijkijjiijkY εαββαµ ++++=

We can easily deal with the αi and βj terms in a design matrix. To represent the in-
teraction, αβij, we use the fact that an interaction represents a multiplicative effect of
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the two variables. Let’s start with a 2 ×××× 2 design. Our design matrix, once coded us-
ing sigma-restricted parameterization, would look like this:
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This matrix has one row per AB combination, but in actual use we’d have to repli-
cate the rows so that there was one row per subject. So if there were five subjects
in the a1b2 condition, for example, there’d have to be five rows whose coefficients
were [1 –1 –1]. In this matrix the first column represents the main effect of A, as it
distinguishes those subjects who received treatment A1 and those who received A2.
The second column represents the main effect of B, distinguishing B1 from B2. The
third column is the AB interaction. Its elements are obtained by multiplying the cor-
responding elements of the first two columns. As always, we have as many columns
per effect as we have degrees of freedom for that effect (dfA = 1; dfB = 1; dfAB = 1).
There are no ‘0’ entries because with only two levels of each variable, a subject is
either in the first or the last (–1) level.

Now consider a 2 × 3 factorial (A2 × B3). We now have dfA = 1, dfB = 2, and dfAB =
2. So for the full model, we obtain the following matrix (again, we’d need to ensure
that we had one row per subject in the ‘real thing’):



























−−−
−−

−−
−−−−=

11111

10101

01011

11111

10101

01011

32

22

12

31

21

11

1211211

ba

ba

ba

ba

ba

ba
ABABBBA

X

This simply applies the principles outlined above for the A1, B1, and B2 columns; the
AB11 column is the product of the A1 column and the B1 column, while the AB12 col-
umn is the product of A1 and B2.

Running an ANOVA like this gives us an overall R2. Since we know that SSregression

= SSmodel = SSY × R2 = SSA + SSB + SSAB, and SSresidual = SSerror = SSY(1 – R2), we
can calculate our SSmodel and SSerror, we know our dfmodel (= dfA + dfB + dfAB) and dfer-

ror, and therefore we can calculate an F test for the whole model (= MSmodel/MSerror).
However, this doesn’t tell us what proportion of the effect is attributable to A, B, or
AB. To partition the variance, we must recalculate the regression for a number of
reduced models. We might call the sum of squares for the full model that we’ve just
looked at SSregression–α,β,αβ. If we dropped the interaction columns (AB11 and AB12),
we’d be deleting the predictors containing information about the interaction but
we’d retain the predictors containing information about α and β; we’d call the re-
sulting sum of squares SSregression–α,β. If we only used the A1, AB11 and AB12 columns,
our model would only account for α and αβ; we’d obtain SSregression–α,αβ. If we only
used the B1, B2, AB11 and AB12 columns, our model would only account for β and αβ;
we’d obtain SSregression–β,αβ. Once we’ve calculated these, we can say that

β,ααα,β,αβ

β,αβα,β,αβ

α,βα,β,αβ

regressionregressionB

regressionregressionA

regressionregressionAB

SSSSSS

SSSSSS

SSSSSS

−=

−=

−=

For example, if the interaction term accounts for any of the variance in Y, then re-
moving the interaction term should lead to a decrease in the variation in Y account-
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able for; that decrease is equal to the variation attributable to the interaction. And so
on for the other terms. Note that if the predictors are in some way intercorrelated,
these sums of squares may not add up to SStotal (see section above on disproportion-
ate cell means with a Venn diagram, p. 70); that’s fine (Howell, 1997, p. 583-5).
This method is the one that assigns SSA = area t, SSB = area x, SSAB = area z in the
Venn diagram above (see p. 70→), which is often what you want (Myers & Well,
1995, p.155).

Finally, to test these effects (to obtain F statistics for the effects of A, B, and AB),
we need to know how to compare one model to another. And this is very simple
(Myers & Well, 1995, p. 441 and 512-4; Howell, 1997, p.578). We can use any of
the following equivalent statements. If we have a Full and a Reduced model (with f
and r predictors respectively),

( )
( ) ( )

error(F)error(F)

error(F)error(R)error(F)error(R)
, SS

SSSS
error(F)error(F)error(R) df

dfdf
F dfdfdf ÷

−÷−
=−

( )
( ) ( )

error(F)error(F)

model(R)model(F)model(R)model(F)
, SS

SSSS
error(F)model(R)model(F) df

dfdf
F dfdfdf ÷

−÷−
=−

( )( )
( )( )2

22

1,
1

1

f

rf
fNrf

Rrf

RRfN
F

−−

−−−
=−−−

The second formulation is perhaps the clearest from the point of view of ANOVA;
the third is the most useful when you have a multiple regression coefficient R2 for
each model. So to test the effect of A, we calculate the full model to obtain SSregres-

sion–α,β,αβ, a reduced model to obtain SSregression–β,αβ, and test the difference between
them as above. But this simplifies a bit — for example, take the effect of A:

( )
( ) ( )

error(F)

A

error(F)error(F)

AA
,

error(F)error(F)

model(R)model(F)model(R)model(F)
,

(reduced)regression(full)regression

regressionregressionA

MS

MS

SS

SS

SS

SSSS

SSSS

SSSSSS

error(F)A

error(F)model(R)model(F)

=

÷
÷=

÷
−÷−

=

−=

−=

−

df

df
F

df

dfdf
F

dfdf

dfdfdf

β,αβα,β,αβ

6.7.5 An overview of GLM designs

We’ve seen that a one-way ANOVA uses this design matrix:

















−−

=

111

101

011

3

2

1

210

A

A

A
XXX

X

This form of the matrix keeps the first ‘grand mean’ column (X0) but uses sigma-
restricted coding for the A factor. As usual, the duplication of rows necessary to get
‘one datum, one row’, is not shown — if there were one subject (S1) in condition
A1, two subjects (S2, S3) in condition A2, and one subject (S4) in condition A3 that
would make the final matrix look like this:
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

















−−

=

111

101

101

011

4S,3

3S,2

2S,2

1S,1

210

A

A

A

A
XXX

X

If we used the overparameterized model to represent A, the matrix is simpler. This is
the reduced form (ignoring the fact that we’ll eventually need one row per subject):
















=

1001

0101

0011

3

2

1

A

A

A
X

A two-way ANOVA with no interaction terms might look like this (left-hand ver-
sion in sigma-parameterized form; right-hand version in overparameterized version):



















−−
−

−=

111

111

111

111

22

12

21

11

BA

BA

BA

BA

X  or 



















=

10101

01101

10011

01011

22

12

21

11

BA

BA

BA

BA

X

A two-way ANOVA with the usual interaction term looks like this, with an X3

column (the interaction term) that is the product of the X1 (A) and X2 (B) columns:



















−−
−−
−−=

1111

1111

1111

1111

22

12

21

11

3210

BA

BA

BA

BA
XXXX

X  or 



















=

100010101

010001101

001010011

000101011
 

22

12

21

11

BA

BA

BA

BA

X

In the overparameterized form, there’s a grand mean column, then two columns for
the two levels of A, then two columns for the two levels of B, then four columns for
the possible values of the AB interaction.

In a fractional factorial design, columns are omitted from a full factorial design.
We saw an example above, in which the interaction was omitted from a 2 × 2 facto-
rial design. Similarly, you might choose to run a 2 × 2 × 2 ANOVA but to ignore the
3-way interaction. The appropriate matrix is shown below (overparameterized ver-
sion); it has 1 grand mean column, 2 columns for A, 2 columns for B, 2 columns for
C, 4 columns for AB, 4 columns for AC, and 4 columns for BC.

































=

1000100010001010101

0100010010000110101

0010100001001001101

0001010001000101101

1000001000101010011

0100000100100110011

0010001000011001011

0001000100010101011
 

222

122

212

112

221

121

211

111

CBA

CBA

CBA

CBA

CBA

CBA

CBA

CBA

X

In a nested design, variability due to one factor is ‘nested’ within variability due to
another factor. For example, if one were to administer four different tests to four
school classes (i.e. a between-groups factor with four levels), and two of those four
classes are in school A, whereas the other two classes are in school B, then the levels
of the first factor (four different tests) would be nested in the second factor (two dif-
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ferent schools). In the design, nested variables never appear as main effects. For ex-
ample, if we have a factor A (3 levels) and a factor B (2 levels) nested within A, our
overparameterized matrix has one grand mean column, 3 columns for A, and 6 col-
umns for the effect of B nested within A [‘B/A’ or ‘B(A)’].



























=

1000001001

0100001001

0010000101

0001000101

0000100011

0000010011
 

23

13

22

12

21

11

BA

BA

BA

BA

BA

BA

X

Overparameterized models are always used to represent nested designs, as the
sigma-restricted coding method has difficulty dealing with the design (see
www.statsoft.nl/textbook/stglm.html).

A simple regression design, with a single continuous predictor variable, is easy to
code. If there were three Y data points (dependent variable) and the corresponding
values of the predictor variable X were 7, 4, and 9, then the design matrix for the re-
gression Y = b0 + b1X would be:
















=

91

41

71
10 XX

X

A simple quadratic regression such as Y = b0 + b1X
2 would be coded simply by

squaring the relevant values:
















=

811

161

491
10 XX

X

Multiple regressions, such as Y = b0 + b1P + b2Q + b3R, are coded just as simple re-
gressions. In a factorial regression design, combinations (products) of the predic-
tors are included in the design. If the predictors are P and Q, then the full factorial
design would include P, Q, and their interaction (P by Q), represented by the prod-
uct of P and Q scores for each case. So the equation would be Y = b0 + b1P + b2Q +
b3PQ. Factorial regression designs can also be fractional, in which you omit some
of the higher-order effects from the design. An example would be a design with
three predictors that omitted the three-way interaction: Y = b0 + b1P + b2Q + b3R +
b4PQ + b5PR + b6QR. Polynomial regressions contain main and higher-order ef-
fects for the predictors but do not include interactions. For example, the second-
degree polynomial design for three predictors would include main (first-order) ef-
fects, quadratic (second-order) effects, but not interactions: Y = b0 + b1P + b2P

2 +
b3Q + b4Q

2 + b5R + b6R
2. There are many other possible designs.

Analysis of covariance refers to a design containing both categorical predictors
(factors) and continuous predictors (covariates). Traditionally, however, the term has
referred specifically to designs in which the first-order effects (only) of one or more
continuous predictors are taken into account when assessing the effects of one or
more factors. For example, suppose a researcher wants to assess the influence of a
factor A with 3 levels on some outcome, and measurements on a continuous predic-
tor C, known to covary with the outcome, are available. If the data are:
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



















































3

3

2

2

1

1

     

8

6

3

9

4

7

A

A

A

A

A

A
groupC

then the design matrix would be



























−−
−−

=

1181

1161

1031

1091

0141

0171
3210 XXXX

X  or 



























=

10081

10061

01031

01091

00141

00171
43210 XXXXX

X

In the left-hand (sigma-restricted) model, the equation is Y = b0 + b1X1 + b2X2 + b3X3

and the coefficients b2 and b3 represent the effects of A, controlling for the effects of
C. The b1 coefficient represents the effects of C controlling for A.

This traditional analysis is inappropriate when the categorical and continuous pre-
dictors interact in influencing the dependent variable. The appropriate design is the
separate slope design, which includes the factor × covariate interaction. For the
situation above, the overparameterized matrix that includes the main effect of A and
the A × C interaction would be:



























=

8001001

6001001

0300101

0900101

0040011

0070011

X

Separate slope designs omit the main effects of C. Overparameterized matrices are
always used for separate slope designs, since the sigma-restricted model runs into
problems (www.statsoft.nl/textbook/stglm.html). The homogeneity of slopes de-
sign can be used to test whether the covariate and factor interact, and thus whether
the traditional ANCOVA or the separate slope design is better. This one does in-
clude the main effect of C:



























=

80010081

60010061

03001031

09001091

00400141

00700171

X

‘Mixed’ ANOVA and ANCOVA models are those that contain random effects,
rather than fixed effects, for one or more factors. The difference is only in how ef-
fects are tested. When computers perform tests for designs that include random
(rather than fixed) factors, they have to work out the appropriate error term for every
effect in the model. In a fixed-effect design, between-subjects effects are always
tested using the mean squared residual as the error term. But in mixed-model de-
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signs, between-subjects effects are tested using relevant error terms based on the co-
variation of random sources of variation in the design. Computers do this with
something called the ‘denominator synthesis’ approach of Satterthwaite (1946); de-
tails are at

www.statsoft.nl/textbook/stglm.html [covers much GLM theory]
www.statsoft.nl/textbook/stvarcom.html

Remember, a mean square qualifies as an error term for testing an effect if its E(MS)
matches the E(MSeffect) in all respects except the null-hypothesis component
(Keppel, 1991, p. 568).

Within-subjects (repeated measures) designs can be analysed by coding ‘Subject’
as a set of columns (Myers & Well, 1995, pp. 569-572). If there are n subjects, there
must be n–1 ‘S’ columns (sigma-restricted parameterization form of the matrix) or n
columns (overparameterized form); similarly, any interactions involving S can be
coded.

Within-subjects (repeated measures) designs can also be analysed by constructing
new dependent variables — for example, if subjects are tested at time 1 and time 2, a
new ‘difference between the two times’ variable can be constructed and analysed.
These techniques can be extended to multiple levels of a within-subjects factor and
multiple factors using special techniques based on multivariate analysis (see below),
or by considering ‘Subjects’ as a (random) factor in its own right and working out
the relationship between the other factors. For example, a very common example is
a design with one between-subjects factor and one within-subjects factor, written A
× (U × S); variation due to subjects is nested within variation due to A (or, for short-
hand, S is nested within A), because each subject is only tested at one level of the
between-subjects factor. The disadvantage with the latter technique is that it does
not take account of the potentially major problem of correlation between differences
between levels of a within-subjects factor, known as the sphericity problem (see
below and p. 25→).

6.7.6 A hint at multivariate analysis: MANOVA

The Y matrix, so far an n × 1 vector of n observations of a single Y variable, can be
replaced by an n × m matrix of n observations of m different Y variables. In this case,
the b vector similarly has to be replaced by a matrix of coefficients. The advantage
is that you can then analyse linear combinations of several dependent variables,
which may themselves be correlated; one application is to measure the strength of
the relationships between predictor and dependent variables independent of the de-
pendent variable interrelationships. For example, if we give students one of two
textbooks and measure their performance on maths and physics (two dependent
variables), we might want to ask whether the textbooks affected performance, and if
so, whether a textbook improved maths, physics, or both — yet students’ perform-
ance on maths and physics tests may be related. Some of the theory is discussed at

www.statsoft.nl/textbook/stglm.html [general GLM theory]
www.statsoft.nl/textbook/stanman.html#multivariate

A multivariate approach can also be used for within-subjects (repeated measures)
designs. The bonus is that the sphericity problem (q.v.) is bypassed altogether. Es-
sentially, the problem of sphericity relates to the fact that the comparisons involved
in testing within-subjects factors with >2 levels may or may not be independent of
each other, and if they’re not, then the ANOVA results will be wrong unless we ac-
count for this. For example, if subjects learn some material and are tested at times 1,
2, and 3, then subjects who learn most between time 1 and time 2 (contrast: time 2 –
time 1) may learn least between time 2 and time 3 (contrast: time 3 – time 2), so the
two contrasts are not independent. ANOVA assumes that all contrasts are independ-
ent (orthogonal). It’s easy to see what that means if you had a factor A: ‘male or not’
and a factor B: ‘female or not’ — if you entered both factors into an ANOVA, both
factors would account for equal variance (since they ask the same question — are
not orthogonal) and if you partitioned out this variance you’d get the wrong answer
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(since you’d be partitioning out the same thing twice). This is the problem that
within-subjects contrasts can run into. Correction procedures such as the Green-
house–Geisser and Huynh–Feldt procedure attempt to deal with this. But a multi-
variate analysis automatically deals with correlations between dependent variables,
so you don’t have to worry about the problem. Sometimes MANOVA can’t be used
because it requires a bit more data. Sometimes repeated-measured ANOVA and
MANOVA give different answers — but this means that the differences between
levels of the repeated-measures factors (e.g. time 1 v. time 2; time 2 v. time 3) are
correlated across subjects in some way, and that may itself be of interest.

6.7.7 Linear contrasts with a GLM

GLMs make it easy to specify linear combinations of effects to test as contrasts. For
example, if you had measured subjects on each of the 7 days of the week, and you
wanted to ask whether the dependent variable was different on weekdays and week-
ends, you could use the contrast

Sun
2

1
Sat

2

1
Fri

5

1
Thu

5

1
Wed

5

1
Tue

5

1
Mon

5

1 ++−−−−−

This contrast would be zero if the mean weekend score and the mean weekday score
were the same, so it’s an appropriate contrast. If your design matrix looked like this:





























=

10000001

01000001

00100001

00010001

00001001

00000101

00000011

Sun

Sat

Fri

Thu

Wed

Tue

Mon

X

then a suitable contrast matrix might look like this:





 ++−−−−−=

2

1

2

1

5

1

5

1

5

1

5

1

5

1
0L

This would be equally appropriate:

[ ]55222220 −−=L

It works like this: you solve the usual GLM, eXbY += , to find the parameter es-
timates b. Then you calculate Lb=L  to estimate the value of your contrast. You
can then test it for significance; its sum of squares is given by the usual

∑
=

j
jj nw

L
2

2

contrastSS  where wj are the weights in the L matrix and nj are the corre-

sponding group sizes, and MScontrast = SScontrast is compared to MSerror. For details, see

www.statsoft.nl/textbook/stglm.html#testing

6.7.8. GLMs in SPSS

If you run an ANOVA in SPSS, how can you see the design matrix? SPSS doesn’t
show you this directly, but it will show you parameter estimates — that is, the b
matrix. And it labels each row of the b matrix with a description of the relevant col-
umn of the corresponding design matrix (X). To obtain this, either use the

/PRINT = PARAMETER
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option or, from the menus, Options → Parameter estimates. You’ll get something
like this:

The design matrix is specified by the /DESIGN command — try clicking Paste in-
stead of OK when youre about to run any ANOVA and you will see the /DESIGN
command it was going to use. Similarly, if you add /PRINT=TEST(LMATRIX), you see
a contrast for every term in the design matrix, which shows you the columns present
in the design matrix. For example, with a two-way ANOVA, A2 × B2, you get this:

Rather than simply using the null hypothesis 0=Lb , SPSS can also test custom hy-
potheses with non-zero expected values for the contrast: k=Lb , or for multiple
contrasts simultaneously, with more than one row for the L matrix, KLb = . This
can be specified with the /LMATRIX and /KMATRIX subcommands (SPSS, 2001, p.
478-481).

For an A3 × B3 ANOVA, the default contrasts look like this:

The contrasts shown above — the default contrasts that examine the main effects of
A and B and the AB interaction — could be specified by hand like this:

GLM DEPVAR BY A B
/LMATRIX = "Intercept"
                   all  1
                        1/3    1/3    1/3
                        1/3    1/3    1/3
                        1/9    1/9    1/9
                        1/9    1/9    1/9
                        1/9    1/9    1/9



6: Advanced topics 95

/LMATRIX = "A"
                     a  1      0     -1
                     b  0      0      0
                   a*b  1/3    1/3    1/3
                        0      0      0
                       -1/3   -1/3   -1/3;
                     a  0      1     -1
                     b  0      0      0
                   a*b  0      0      0
                        1/3    1/3    1/3
                       -1/3   -1/3   -1/3
/LMATRIX = "B"
                     a  0      0      0
                     b  1      0     -1
                   a*b  1/3    0     -1/3
                        1/3    0     -1/3
                        1/3    0     -1/3;
                     a  0      0      0
                     b  0      1     -1
                   a*b  0      1/3   -1/3
                        0      1/3   -1/3
                        0      1/3   -1/3
/LMATRIX = "AxB"
                     a  0      0      0
                     b  0      0      0
                   a*b  1      0     -1
                        0      0      0
                       -1      0      1;
                     a  0      0      0
                     b  0      0      0
                   a*b  0      1     -1
                        0      0      0
                        0     -1      1;
                     a  0      0      0
                     b  0      0      0
                   a*b  0      0      0
                        1      0     -1
                       -1      0      1;
                     a  0      0      0
                     b  0      0      0
                   a*b  0      0      0
                        0      1     -1
                        0     -1      1
/DESIGN = A, B, A*B.

(You have to use 1/3 rather than 0.333 to avoid rounding errors; if the coefficients
don’t add up to 1 for each contrast matrix you won’t get an answer.) Having seen
how the general technique works, we can test advanced contrasts:

/LMATRIX = "B1 vs B2 at A1"
                     B  1     -1      0
                   A*B  1     -1      0
                        0      0      0
                        0      0      0

This would be more powerful than just analysing the A1 data and applying a B1 v. B2

contrast — the MScontrast would be the same, but the contrast specified above uses the
overall (pooled) MSerror, making it more powerful (more error df).

/LMATRIX = "B1 vs (B2+B3)"
                     A  0      0      0
                     B  1     -1/2   -1/2
                   A*B  1/3   -1/6   -1/6
                        1/3   -1/6   -1/6

                           1/3   -1/6   -1/6

Finally, a really complex one. Suppose B1 is a control condition and B2 and B3 are
two different selective serotonin reuptake inhibitor drugs. Therefore, (B1) versus (B2

and B3) might represent an ‘SSRI treatment effect’ (call it T) that we’re interested in.
Suppose that A1 and A2 are depressives and schizophrenics. If we want to compare
the SSRI effect between depressives (TA1) and schizophrenics (TA2), we could follow
this logic:
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Having calculated our null hypothesis, we can specify the contrast:

/LMATRIX = "(B1 vs (B2+B3)) – at A1 versus A2"
                   A*B  1     -1/2   -1/2
                       -1      1/2    1/2

                           0      0      0

Hope I’ve got that right; it seems to work.
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6.8 Effect size

Whether a contribution is significant or not does not tell you whether that significant
contribution is large. If you have high power (large n), you may be able to measure
significant small effects. And if you have lower power (small n), you may ‘miss’
(fail to declare as significant) large effects. To ask about effect size is to ask not
just whether the effect of a predictor variable is statistically significant, but how
big (important) its effect is.

In general, when we are predicting a dependent variable Y by one or more predictor
variables, be they continuous (ANCOVA, multiple regression) or discrete (ANOVA
factors), we can ask to what extent a given term (main effect, interaction, etc.) con-
tributes to the prediction of the dependent variable. We’ve already seen that this can
be complicated, especially if the predictors are themselves correlated — effect size
is a fairly complex topic (Winer, 1971, pp. 405-415; Keppel, 1991, pp. 64-68, 221-
224, 437-440; Myers & Well, 1995, pp. 111-113, 252-256, 504-509; Howell, 1997,
pp. 330-334, 426-429, 544-546).

We’ll start by examining effect size in the context of multiple regression (predicting
Y from X1, X2, and so on), because it’s the simplest conceptually. In general, effect
size can refer to the size of the change in Y that follows a certain change in a
predictor (regression slope) or the proportion of variation in Y explicable by a
predictor (equivalent to r2 in simple linear regression).

6.8.1. Effect size in the language of multiple regression

A reminder of what the ‘significance’ of a predictor means

Assuming you use the usual (SPSS Type III) way of partitioning sums of squares
with correlated predictors, the significance test of each predictor reflects whether
that predictor contributes to the prediction over and above all the other predic-
tors in the model (see also sections on correlated predictors earlier: p. 70→ and p.
86→). This is not effect size.

Interpreting the effects of individual predictors: the regression slope, b

The computerized results will give us individual slope parameters for each of the ef-
fects in our model (in SPSS, tick Options → Parameter estimates). Remember that
a multiple regression equation looks like this:

…+++= 22110
ˆ XbXbbY

eXby +=

The parameters are the values of b. The first, b0, is the intercept (grand mean). The
others reflect the effects of all the other predictors. However, there are problems of
interpretation of the individual slope parameters bj (Myers & Well, 1995, p. 522;
Howell, 1997, pp. 510-532 and 544-546). It is tempting to think that if we were to
change Xj by one unit, Y would change by bj units — this would be true of simple
linear regression (with one predictor). However, a regression coefficient bj does not
reflect the total effect of Xj on Y. Rather, it reflects the direct effect of Xj on Y — the
rate of change of Y with Xj holding all of the other variables in the equation con-
stant. If the various predictors (X1, X2, …) are mutually correlated (known as
collinearity or multicollinearity), it may often not make a great deal of sense to ask
this question — for example, if we were predicting car crash fatalities by drivers’
annual mileage and drivers’ annual fuel consumption, it’s not clear what it would
mean to change annual mileage while holding fuel consumption constant. When we
ask about the consequences of changing Xj, we must be concerned not only with the
direct effect but also with the indirect effects — the effects on Y that occur because
of changes in the other variables. Given a valid causal model, path analysis can be
used to calculate the total effect (direct + indirect effects) of changing a variable.
However, if the model is incomplete or invalid, we would have to establish the ef-
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fects of changing Xj experimentally, by manipulating it without confounding it with
the other variables, and observing the results.

Standardized regression slope, β (= r)

The standardized regression slope, βj, is simply the bj that you would obtain if both
the dependent variable Y and the predictor Xj were standardized — that is, trans-
formed so that they have a mean of 0 and a standard deviation of 1 (Howell, 1997,
pp. 244, 517-8, 544-6). If b = 0.75, then a one unit increase in X would be reflected
in an 0.75 unit increase in Y. If β = 0.75, then a one standard deviation increase in X
would be reflected in an 0.75 standard deviation increase in Y. It’s easy to calculate
β. If bj and sj are the regression slope and standard deviation of a predictor Xj, then

Y

jj
j s

sb
=β

Bear in mind that slopes are related to r: for simple linear regression,

X

Y

s

s
rb =

and so b = r when both variables are standardized (Howell, 1997, p. 242), and β = r
at all times.

However, with multiple predictors, the problem with βj is just the same as for bj: it
reflects the change in Y associated with a change in Xj holding all other predictors
constant, and if the predictors are correlated this may not make much sense.

Overall R2 and 2
adjR : how good is the whole model?

The computerized results of an ANOVA, ANCOVA, or other GLM will give an
overall R2, which reflects the proportion of total Y variance predicted by all the pre-
dictors together, i.e. SSregression/SStotal. (Alternatively, we could say that R is the cor-
relation between the dependent variable and the best linear combination of the pre-

dictors.) R2 can also be adjusted (downwards) to give 2
adjR , a better estimate of the

corresponding population parameter (Myers & Well, 1995, p. 508-509; Howell,
1997, p. 521), and SPSS will do that automatically. If there are N observations and p
continuous predictors:









−−
−−−=

pN

N
RRadj 1

1
)1(1 22

If you are using predictors with >1 df per predictor (e.g. factors with >2 levels), you
need a more general form of this equation, which I believe is









−−=

error

total22 )1(1
df

df
RRadj

Assessing the importance of individual predictors: 2
lsemipartiar  — a good one

Let’s move on to a better measure (Myers & Well, 1995, pp. 505-508; Howell,
1997, pp. 528-531, 544-546). When we predict Y from p predictor variables,

2
2,1. pYR …  (or simply R2) is the proportion of variability in Y accounted for by the re-

gression on all p predictors. If the p predictors are not mutually correlated (Myers &
Well, 1995, p. 505), SSregression can be partitioned into nonoverlapping components
from each of the predictors:
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where 1.SSY  is the proportion of variability of Y accounted for by the predictor Xj,

and 2
. jYr  is the correlation between Xj and Y. Since

YpYR SSSS 2
2,1.regression …=

it follows that for uncorrelated predictors,
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If the predictors are correlated, we must use this (Myers & Well, 1995, p. 506):

Y
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jjjY

pY
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R
σ

σ
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ˆ2
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2
2,1.

∑
=…

where bj is the regression coefficient of Xj in the multiple regression equation and

jσ̂  and Yσ̂  are the standard deviations of Xj and Y, respectively. The increase in R2

when X2 is added to a regression equation that already contains X1 is 2
)1|2.(Yr , the

square of the semipartial correlation coefficient (Myers & Well, 1995, p. 486 and
507). Here’s a visual interpretation, in which the area of each circle represents the
total variability of a given variable:
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You could also say that the semipartial correlation )1|2.(Yr is the correlation of Y with

that part of X2 that is independent of X1 (Howell, 1997, p. 528). In general,
2

)2,1|1.( ppYr …+  is the increase in R2 that follows from adding Xp+1 to a regression

equation that already includes X1, X2, … Xp. That is,

2
2,1.

2
12,1.

2
)2,1|1.(

2
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2
2,1.

2
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This would seem to be a useful measure. Howell (1997, p. 544-6) agrees, stating that
‘when the main goal is prediction rather than explanation, this is probably the best
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measure of “importance”.’ If the computer package doesn’t give it directly (and
SPSS doesn’t), it can easily be calculated (Howell, 1997, p. 546):

1

)1( 2
2,1.2

)except  everything2,1|.( −−
−

=
pN

RF
r pYi

piiY
…

……

where p is the total number of predictors, 2
)except  everything2,1|.( piiYr ……  is the squared

semipartial correlation for predictor i, iF  is the F test for predictor i (use F = t2 if

your stats package reports t instead), 2
2,1. pYR …  is the overall R2 (with predictor i in-

cluded), and N is the total number of observations. Note that this means that the F
statistics in an ANOVA are in the same order as the the squared semipartial correla-
tion coefficients (within an ANOVA, you could say that ‘bigger F ⇒ more impor-
tant’). If you’re using factors as predictors (i.e. predictors with >1 df per predictor), I
rather suspect that Howell’s formula should be rewritten like this:

error

2
2,1.2

)except  everything2,1|.(

)1(

df

RF
r pYi

piiY
…

……
−

=

But if you’re having trouble working out a formula, you can always fall back to the
position of running the ANOVA with and without a particular term, and calculating
the difference between the two overall R2 values.

Partial and semipartial correlations

It’s easy to be confused by the difference between partial and semipartial correla-
tions. We’ve just seen what the semipartial correlation is (Howell, 1997, pp. 526-
531). Let’s go back to the Venn diagram:

The squared semipartial correlation coefficient 2
)1|2.(Yr  is the proportion of the vari-

ability in Y explained by X2 over and above what’s explained by X1. The squared

partial correlation coefficient 2
1|2.Yr  is the proportion of the variability in Y explained

by X2 relative to that not explained by X1. In our Venn diagram, the two look like
this:

Overall prediction of models Squared semipartial Squared partial
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Suppose that 4.02
2. =YR , the squared semipartial 2.02

)1|2.( =Yr  and the squared partial

3.02
1|2. =Yr . That would mean that X2 explains 40% of the variability in Y if it’s the

only predictor, that X2 explains 20% of the variability in Y once X1 has been taken
into account (semipartial), and that X2 explains 30% of the variability in Y that X1
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failed to explain (partial). That would reflect this situation (areas denote variability;
figures are proportions of the total variability of Y; sorry if it’s not quite to scale):

Another definition of partial correlation

If rxy is the correlation between X and Y, then rxy|z, the partial correlation between X
and Y with the effects of Z partialed out, is the correlation between X|Z and Y|Z,

where XXZX ˆ| −=  is the residual that results when X is regressed on Z, and

YYZY ˆ| −=  is the residual that results when Y is regressed on Z (Myers & Well,

1995, p. 483). It’s possible to obtain rxy|z from the simple correlations between each
of the variables:

)1)(1( 22
|

yzxz

yzxzxy
zxy

rr

rrr
r

−−

−
=

For example, suppose we look at 48 US states and measure population, motor vehi-
cle deaths, and whether or not the state has enacted seat belt legislation — the last
being a dichotomous variable, but that’s OK (Myers & Well, 1995, p. 483). There’s
a positive correlation between deaths and belt legislation (+0.309), which might
seem worrying. However, rdeaths,population = +0.928 and rbelts,population = +0.345 — larger
states have more deaths, and larger states are more likely to have seat belt legisla-
tion. The partial correlation rdeaths,belts|population = –0.032, indicating a small but nega-
tive relationship between seat belt laws and motor vehicle deaths once the effects of
population have been partialled out.

Another definition of semipartial correlation

The semipartial correlation coefficient ry(x|z) is the correlation between Y and X|Z,

where XXZX ˆ| −=  is the residual that results when X is regressed on Z. It too can

be calculated from the simple regression coefficients:
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6.8.2. Effect size in the language of ANOVA

The effect size in the context of ANOVA is the same thing as the effect size in mul-
tiple regression (since both are simply instances of a GLM), but people tend to use
different terminology. A helpful discussion of some different measures of effect size
is given at web.uccs.edu/lbecker/SPSS/glm_effectsize.htm.

Difference between level means

This is simple. If you have a factor (e.g. Sex: Male/Female) and you establish
through an ANOVA that its effect is significant, you have an instant measure of its
effect: the difference between µmale and µfemale. You can extend this approach to mul-
tiple factors and to interactions. For example, for the data shown below, we can state
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the effect sizes very simply. Overall mean: The overall mean (‘being a male or fe-
male 10- or 10-year-old’) is 137 cm. Main effects: Maleness contributes +3.5 cm
and femaleness contributes –3.5 cm (or, maleness contributes +7 cm compared to
femaleness). Being a 10-year-old contributes –33.5 cm; being a 20-year-old contrib-
utes +33.5 cm (or, being a 20-year-old contributes +67 cm relative to being a 10-
year-old). Interactions: if the overall mean contributes 137 cm, being a male con-
tributes +3.5 cm, and being a 20-year-old contributes +33.5 cm, we’d expect 20-
year-old males to be 174 cm, but in fact they’re 177 cm, so the interaction term (be-
ing a male 20-year-old) contributes an extra +3 cm on top of the main effects. And
so on.

Height Male Female mean
10-year-old 104 cm 103 cm 103.5 cm
20-year-old 177 cm 164 cm 170.5 cm
mean 140.5 cm 133.5 cm 137 cm

Effect size measures related to the difference between means — perhaps best to skip this bit!

There are lots of these, most designed to facilitate calculation of power. For a situa-
tion with two groups with the same standard deviation, we can measure the differ-
ence between means 12 µµ − . We can ‘standardize’ that by dividing by the standard

deviation to produce d, often called the ‘effect size’:

σ
µµ 12 −=d

This number d can be combined with knowledge of the sample size n to calculate

nd=δ , which in turn can be used to calculate power (Myers & Well, 1995, pp.
113-116; Howell, 1997, p. 216-226). Cohen (1988) more or less arbitrarily called d
= 0.2 a small effect (the means differ by 0.2 of a standard deviation), 0.5 a medium
effect, and 0.8 a large effect. Similar principles can be applied to ANOVA (Howell,
1997, p. 334-340), but the notation is a bit different. If there are k levels for a factor,
the standardized measure of effect size is

2
error

2

error

treatment

)(

σ

µµ

σ
σφ kf

i i∑ −

===′

This can then be combined with knowledge of the sample size to calculate

nφφ ′= , which in turn can be used to calculate power. This can be extended to

factorial designs (Myers & Well, 1995, pp. 147-149). And just as correlation slopes
b were related to r2 in the language of regression, φ′  (also written f) is related to η2

(see below) in the language of ANOVA (Winer et al., 1991, p. 124):

2

2
2

1 η
η
−

=f

δ  and φ are also known as noncentrality parameters (Winer et al., 1991, pp. 126-
140; Howell, 1997, pp. 220, 334-5). This refers to the fact that if there is an effect (if
the null hypothesis is false), the distribution of F statistics isn’t the plain F distribu-
tion (as it would be if the null hypothesis were true), but a shifted (noncentral) F
distribution. The noncentrality parameters measure effect size by how much the dis-
tribution is shifted.

Assessing the importance of individual predictors: η2

Eta-squared is given by
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total

effect2

SS

SS=η

η2 represents the proportion of total variation accounted for by a factor; equivalently,
the proportion by which error is reduced when you use the factor to predict the de-
pendent variable (Howell, 1997, p. 332). Eta itself, η, is called the correlation ratio
(Winer et al., 1991, p. 123), although η2 is also sometimes called the correlation ra-
tio (Howell, 1997, p. 331).

If you only have one predictor, η2 = R2. If you have more than one predictor and
they’re correlated, η2 depends on how you calculate SSeffect. Assuming you use the
usual (SPSS Type III) method (see p. 70→), the SS for predictor X2 in the diagram
below is area c, and SStotal (SSY) is area a + b + c + d.

So for our usual (SPSS Type III) sums-of-squares method, the η2 for X2 is

2
)1|2.(

total

effect2
2 SS

SS
Yrc

dcba

c ==
+++

==η

so η2 is the squared semipartial correlation coefficient, it seems to me. If you calcu-
late η2 by hand in SPSS, remember that what we normally refer to as SStotal,

∑ − 2)( yy , is labelled ‘corrected total’ by SPSS. (Its ‘total’ is ∑ 2y , which we’re
not interested in.)

Assessing the importance of individual predictors: 2
partialη  — not very helpful

One measure of the importance of individual predictors is the partial eta-squared
coefficient, which is something that SPSS gives you (tick Options → Estimates of
effect size). We’ve just seen what η2 is (above). The partial eta-squared is ‘an over-
estimate of the effect size in an F test’ (SPSS, 2001, p. 475). Specifically, it’s this:

effectfor that  error termeffect

effect

erroreffect

effect2
partial

SSSS

SS

+
=

+×
×=

dfFdf

Fdfη

The top formula is from SPSS (2001, p. 475) and the second from
web.uccs.edu/lbecker/SPSS/glm_effectsize.htm. I’m not sure if it’s particularly
useful, especially as the partial eta-squared terms sum to more than one

( 12
partial >∑η ), which is pretty daft. In terms of our Venn diagram, the 2

partialη for X2

is:

2
1|2.

errortreatment
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SSSS
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2 Ypartial r

dc
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=
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=η
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so 2
partialη  is the squared partial correlation coefficient, it seems to me. Therefore, I’ll

ignore it.

Another one: ω2

When a factor A predicts a dependent variable Y, omega-squared (ω2) for A is de-
fined as the proportion of the total variance in Y attributable to the effects of A

(Myers & Well, 1995, p. 113). In general, the estimated ω2, written 2ω̂ , is

2
Y

2
A2

ˆ

ˆ
ˆ

σ
σω =

For a fixed (not a random) effect A, ω2 is estimated by

totalerror

errorAA2

SSMS

MSSS
ˆ

+
×−

=
dfω

(Formula from web.uccs.edu/lbecker/SPSS/glm_effectsize.htm.) For random ef-

fects, such as in within-subjects (repeated measures) designs, the definition of 2ω̂
depends on the specific ANOVA model (Myers & Well, 1995, pp. 252-256; Howell,
1997, pp. 426-429), and sometimes it cannot be estimated exactly (Myers & Well,
1995, p. 254).

And another: the intraclass correlation ρI

The intraclass correlation coefficient is a measure of association between the inde-
pendent and dependent variables for a random-effects model (Howell, 1997, p. 334)
(web.uccs.edu/lbecker/SPSS/glm_effectsize.htm); for an effect A, it’s

errorAA

errorA

MSMS

MSMS

×+
−

=
dfIρ

The squared intraclass correlation, 2
Iρ , is a version of ω2 for the random model.

Which one to use?

Although η2 is perhaps the simplest, it does have a problem (Howell, 1997, pp. 333-
334). When it’s applied to population data, it’s correct; when applied to samples (as
we normally do), it’s biased as a measure of the underlying population effect size.

So 2ω̂  is generally preferred when we want an estimate of the effect size in the
population — the way it’s calculated takes account of sample size appropriately (so

2ω̂  will always be smaller than η2 or 2
partialη ). On the other hand, SPSS doesn’t pro-

duce it, which is a bit of a shame, and it’s laborious to calculate by hand. So for a

quick idea, η2 is perhaps easiest. This also has an advantage over 2
partialη  in that it’s

additive (the η2 values sum to 1, while the 2
partialη  values can sum to >1) and is

therefore perhaps easier to conceptualize and interpret.
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Part 7: specific designs

For designs 1–17, all factors other than ‘subject’ factors are assumed to be fixed. If
you wish to use other random factors, see Myers & Well (1995, p. 262) or just tell
SPSS that’s what you want and trust it to sort out the maths.

Design (BS = between-subjects; WS =
within-subjects)

Description (in most eco-
nomical format; S = sub-
jects; ‘cov’ subscript = co-
variate)

Between-subjects
factor(s) or co-
variate(s)

Within-subjects
factors(s) or co-
variates)

1 – One BS factor

Includes step-by-step instructions for
performing between-subjects analysis
in SPSS

A × S A –

2 – Two BS factors A × B × S A, B –

3 – Three BS factors A × B × C × S A, B, C –

4 – One WS factor (U × S) – U

5 – Two WS factors (U × V × S) – U, V

6 – Three WS factors (U × V × W × S) – U, V, W

7 – One BS and one WS factor

Includes step-by-step instructions for
performing within-subjects (repeated
measures) analysis in SPSS

A × (U × S) A U

8 – Two BS factors and one WS factor A × B × (U × S) A, B U

9 – One BS factor and two WS factors A × (U × V × S) A U, V

10 – Higher-order designs along the same
principles and summary of designs 1–9

See text See text See text

11 – One BS covariate

(linear regression)
Ccov × S Ccov –

12 – One BS covariate and one BS factor Ccov × A × S Ccov, A –

13 – One BS covariate and two BS factors Ccov × A × B × S Ccov, A, B –

14 – Two or more BS covariates

(multiple regression)
Ccov × Dcov × … × S Ccov, Dcov, … –

15 – Two or more BS covariates and one
or more BS factors

e.g. Ccov × Dcov × A × B × S Ccov, Dcov, A, B,
etc.

–

16 – One WS covariate (Ccov × S) – Ccov

17 – One WS covariate and one BS factor A × (Ccov × S) A Ccov

18 – Hierarchical designs See text (complex) See text (complex) See text (complex)

19 – Latin square designs See text (complex) See text (complex) See text (complex)

20 – Agricultural designs See text (complex) See text (complex) See text (complex)
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7.1 One between-subjects factor

Alternative names • One-way ANOVA
• Completely randomized design (CRD)

Example Subjects are assigned at random to drug treatments A1, A2, or A3 (completely randomized de-
sign; single factor with three levels) and their reaction time is measured on some task (depend-
ent variable). Does the drug treatment affect performance?

A researcher wishes to test the effectiveness of four fertilizers (A1, A2, A3, A4). He divides his
field into sixteen plots (equivalent to ‘subjects’ or ‘replications’) and randomly assigns fertilizer
A1 to four replications, A2 to four replications, and so on.

Notes For two levels of the factor, this is equivalent to an unpaired (independent sample) t test. Treat-
ments (levels of the factor) are assigned at random to subjects (replications). For full details, see
Howell (1997, chapter 11).

Model description
(S = subjects)

depvar = A × S

Model ijiijY εαµ ++=

where
• Yij is the dependent variable for subject j experiencing level i of the factor
• µ is the overall mean
• αi is the contribution from a particular level (level i) of the factor: µµα −= ii  and

0=∑
i

iα . The null hypothesis is that all values of αi are zero.

• εij is everything else (the ‘uniqueness’ of subject j in condition i, ‘error’, ‘individual varia-
tion’, etc.): iijij Y µε −= . We assume εij is normally distributed with mean 0 and variance

2
eσ .

Sources of variance Analysis of variance discards constant terms (like µ) and examines the sources of variability
(variance). Writing this in terms of sums of squares (SS),

SStotal = SSA + SSerror

where SStotal is the total variability, SSfactor is the variability attributable to the factor, and SSerror

is the ‘error’ variability (everything that’s left over). Alternatively, we could write

SStotal = SSA + SSS/A

because our total variability is made up of variability due to factor A, and variability due to in-
ter-subject differences within each level of A (‘S within A’, or ‘S/A’).

ANOVA table In all cases, the mean square (MS) is the sum of squares (SS) for a particular row divided by the
degrees of freedom (d.f.) for the same row. Assuming the same number of subjects n for each
level of factor A, we have

Source                         d.f.                                     SS                    F                      
A a–1 SSA MSA/MSerror

Error (S/A) a(n–1) SSerror

Total N–1 = an – 1 SStotal

where a is the number of levels of factor A, N is the total number of observations (subjects), and
n is the number of subjects (or ‘replications’) per level of factor A. Note that the error is some-
times written ‘S/A’, i.e. ‘subjects within A’.

SPSS technique Data layout:
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depvar       A          
datum level_1
datum level_1
datum level_1
datum level_2
datum level_2
…

Syntax:

UNIANOVA
  depvar BY A
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = A .

Using the menus, choose Analyze → General Linear Model → Univariate.

We now see this:

Our dependent variable is depvar; our (fixed) factor is A:

Once everything else is OK, click ‘OK’ to run the analysis, or ‘Paste’ to copy the syntax for the
analysis to a syntax window.
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7.2 Two between-subjects factors

Alternative names Two-way ANOVA
• Factorial ANOVA
• a × b factorial ANOVA (where a and b are the number of levels of factors A and B; e.g. ‘2

× 5 factorial’)
• Factorial, completely randomized design ANOVA

Example Subjects are assigned at random to a high-arousal (A1) or a low-arousal (A2) situation, and are
also given drug (B1) or placebo (B2) (completely randomized design; 2 × 2 factorial ANOVA).
Their performance is measured on a task (dependent variable). Does the arousal situation (A) or
the drug (B) affect performance, and does the effect of the drug depend on arousal (A × B inter-
action)?

Notes A factorial design is one in which every level of every factor is paired with every level of every
other factor (Howell, 1997, p. 401).

Model description
(S = subjects)

depvar = A × B × S

Model ijkijjiijkY εαββαµ ++++=

where
• Yijk is the dependent variable in condition Ai, Bj for subject k
• µ is the overall mean
• αi is the contribution from level i of factor A (Ai): µµα −=

iAi  and 0=∑ iα .

• βj is the contribution from level j of factor B (Bj): µµβ −=
jBj  and 0=∑ jβ .

• αβij is the contribution from the interaction of level i of factor A and level j of factor B —
that is, the degree to which the mean of condition AiBj deviates from what you’d expect
based on the overall mean and the separate contributions of Ai and Bj (= the interaction A ×
B), i.e. )( jiBAij ji

βαµµαβ ++−= . By this definition, 0=∑=∑
j

ij
i

ij αβαβ .

• εijk is everything else (the ‘uniqueness’ of subject k in condition i of factor A and condition j
of factor B, ‘error’, ‘individual variation’, etc.): )( ijjijijkijk Y αββαµε +++−= . By our

usual assumption of normal distribution of error, εijk is normally distributed with mean 0

and variance 2
eσ .

Sources of variance As before, we consider only the sources of variation for the ANOVA analysis:

SStotal = SSA + SSB + SSA×B + SSerror

where
• SStotal is the total variability
• SSA is the variability attributable to factor A
• SSB is the variability attributable to factor B
• SSA×B is the variability attributable to the interaction
• SSerror is the ‘error’ variability (everything that’s left over). This is sometimes written

SSS/AB (indicating variability due to inter-subject variation within A × B combinations).

ANOVA table In all cases, the mean square (MS) is the sum of squares (SS) for a particular row divided by the
degrees of freedom (d.f.) for the same row. Assuming the same number of subjects n for each
cell (combination of one level of factor A and one level of factor B), we have

Source                         d.f.                                     SS                    F                            
A a–1 SSA MSA/MSerror

B b–1 SSB MSB/MSerror

A × B (a–1)(b–1) SSA×B MSA×B/MSerror

Error (S/AB) ab(n–1) SSerror
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Total N–1 = abn–1 SStotal

where a is the number of levels of factor A, N is the total number of observations (subjects), and
n is the number of subjects (or ‘replications’) per cell.

SPSS technique Data layout:

depvar       A                B                
datum level_1 level_1
datum level_1 level_1
datum level_1 level_2
datum level_1 level_2
datum level_2 level_1
datum level_2 level_1
datum level_2 level_2
datum level_2 level_2
…

Syntax:

UNIANOVA
  depvar BY a b
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = a b a*b .

Using the menus, choose Analyze → General Linear Model → Univariate. Enter A and B as
between-subjects factors.
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7.3 Three between-subjects factors

Alternative names • a × b × c factorial ANOVA (where a, b and c are the number of levels of factors A, B, and
C; e.g. ‘2 × 5 × 3 factorial’)

• Factorial, completely randomized design ANOVA

Example Subjects have their prefrontal cortex destroyed (A1) or not (A2) or have a special prefrontal
cortex augmenter fitted (A3), are assigned at random to a high-arousal (B1) or a low-arousal
(B2) situation, and are also given drug (C1) or placebo (C2) (completely randomized design; 3 ×
2 × 2 factorial ANOVA). Their performance is measured on a task (dependent variable). Do
factors A, B, or C affect performance? Do they interact?

Notes

Model description
(S = subjects)

depvar = A × B × C × S

Model ijklijkjkikijkjiijklY εαβγβγαγαβγβαµ ++++++++=

where
• Xijkl is the dependent variable in condition Ai, Bj, Ck for subject l
• µ is the overall mean
• αi is the contribution from level i of factor A: µµα −=

iAi

• βj is the contribution from level j of factor B: µµβ −=
jBj

• γk is the contribution from level k of factor C: µµγ −=
kCk

• αβij is the contribution from the interaction of level i of factor A and level j of factor B:
)( jiBAij ji

βαµµαβ ++−=

• αγik is the contribution from the interaction of level i of factor A and level k of factor C:
)( kiCAik ki

γαµµαγ ++−=

• βγjk is the contribution from the interaction of level j of factor B and level k of factor C:
)( kjCBjk kj

γβµµβγ ++−=

• εijkl is everything else (the ‘uniqueness’ of subject l in condition i of factor A and condition j
of factor B and condition k of factor C, ‘error’, ‘individual variation’, etc.):

)( jkikijkjiijkijk Y βγαγαβγβαµε ++++++−= .

Sources of variance As before, we consider only the sources of variation for the ANOVA analysis:

SStotal = SSA + SSB + SSC + SSA×B + SSA×C + SSB×C + SSA×B×C + SSerror

where
• SStotal is the total variability
• SSA is the variability attributable to factor A
• SSB is the variability attributable to factor B
• SSC is the variability attributable to factor C
• SSA×B is the variability attributable to the A × B interaction
• SSA×C is the variability attributable to the A × C interaction
• SSB×C is the variability attributable to the B × C interaction
• SSA×B×C is the variability attributable to the A × B × C interaction
• SSerror is the ‘error’ variability (everything that’s left over). This is sometimes written

SSS/ABC (indicating variability due to inter-subject variation within A × B × C combina-
tions).

ANOVA table In all cases, the mean square (MS) is the sum of squares (SS) for a particular row divided by the
degrees of freedom (d.f.) for the same row. Assuming the same number of subjects n for each
cell (combination of one level of factor A, one level of factor B, and one level of factor C) we
have
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Source                         d.f.                                     SS                    F                            
A a–1 SSA MSA/MSerror

B b–1 SSB MSB/MSerror

C c–1 SSC MSC/MSerror

A × B (a–1)(b–1) SSA×B MSA×B/MSerror

A × C (a–1)(c–1) SSA×C MSA×C/MSerror

B × C (b–1)(c–1) SSB×C MSB×C/MSerror

A × B × C (a–1)(b–1)(c–1) SSA×B×C MSA×B×C/MSerror

Error (S/ABC) abc(n–1) SSerror

Total N–1 = abcn–1 SStotal

where a is the number of levels of factor A (etc.), N is the total number of observations (sub-
jects), and n is the number of subjects (or ‘replications’) per cell.

SPSS technique Data layout:

depvar       A                B                C                
datum level_1 level_1 level_1
datum level_1 level_1 level_1
datum level_1 level_2 level_1
datum level_1 level_2 level_1
datum level_2 level_1 level_1
datum level_2 level_1 level_1
datum level_2 level_2 level_1
datum level_2 level_2 level_1
datum level_1 level_1 level_2
datum level_1 level_1 level_2
datum level_1 level_2 level_2
datum level_1 level_2 level_2
datum level_2 level_1 level_2
datum level_2 level_1 level_2
datum level_2 level_2 level_2
datum level_2 level_2 level_2
…

Syntax:

UNIANOVA
  depvar BY a b c
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = a b c a*b a*c b*c a*b*c .

Using the menus, choose Analyze → General Linear Model → Univariate. Enter A, B, C as
between-subjects factors.
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7.4 One within-subjects factor

Alternative names • Repeated-measures ANOVA (with one factor)
• Randomized complete block (RCB) design (with one factor)
• Single-factor within-subjects design

Examples Twenty students have their digit span tested on dry land (U1) and then those same students have
a further digit span test when they are diving in a dry suit in the Pacific Ocean (U2). Does their
location affect performance?

A researcher wishes to test the effectiveness of four fertilizers (U1, U2, U3, U4). He divides his
orchard into four blocks (equivalent to ‘subjects’) to account for variations across the orchard
(e.g. southern sunny block, northern cool block, eastern morning sun block, western evening
sun block). He divides each block into four plots and assigns fertilizers U1–U4 to each plot at
random, so that each block has all four fertilizers in it.

Notes Described in detail by Howell (1997, chapter 14). Total variation is first partitioned into varia-
tion between subjects and variation within subjects. Variation within subjects is then subdivided
into variation between treatments (levels of our factor) and error.

We’re not particularly interested in variation between subjects, but accounting for it allows us to
isolate the effect of our factor more accurately.

If our factor has only two levels, this is equivalent to a two-sample paired t test.

Model description
(S = subjects)

depvar = (U × S)

Model Either

ijjiijY εαπµ +++=  (additive model)

where
• Yij is the dependent variable for subject i in condition Uj

• µ is the overall mean
• πi is the contribution from a particular person or subject (subject i, or Si): µµπ −=

iSi

• αj is the contribution from a particular level (level j) of the factor U: µµα −=
jUj

• εij is everything else (the experimental error associated with subject i in condition j):
)( jiijij X απµε ++−= .

or, perhaps better,

ijijjiijY επααπµ ++++=  (nonadditive model)

where
• παij is the contribution from the interaction of subject i with treatment j:
• in this case, εij would be redefined as )( ijjiijij Y πααπµε +++−= .

However, if we measure each person in each condition once, we will not be able to measure
differences in the way subjects respond to different conditions (παij) independently of other
sources of error (εij). (To do that, we’d need to measure subjects more than once, and then we’d
need a different model again!) This is another way of saying that the S × U interaction is con-
founded with — is! — the ‘error’ term. Therefore, the calculations do not differ for the two
models (Myers & Well, 1995, p. 242); the only difference is if you want to estimate ω2, the pro-
portion of variance accounted for by a particular term (Myers & Well, 1995, pp. 252-255).

Sources of variance Analysis of variance discards constant terms (like µ) and examines the sources of variability
(variance). Writing this in terms of sums of squares (SS),

SStotal = SSsubjects + SSU + SSerror
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where SStotal is the total variability, SSU is the variability attributable to the (within-subjects)
factor U, and SSerror is the ‘error’ variability (everything that’s left over).

This equation can be used to represent both models described above (with or without the subject
× factor interaction), since, to repeat, the subject × factor interaction is the error term in this
design (with only one score per cell) and cannot be separated from ‘error’; see Howell (1997, p.
452-4).

ANOVA table In all cases, the mean square (MS) is the sum of squares (SS) for a particular row divided by the
degrees of freedom (d.f.) for the same row. Assuming one observation per cell, we have

Source                               d.f.                                     SS                    F                      
Between subjects (S) n–1 SSsubjects MSsubjects/MSerror

U u–1 SSU MSU/MSerror

Error (S × U) (n–1)(u–1) SSerror

Total N–1 = un – 1 SStotal

where u is the number of levels of factor U, N is the total number of observations (= un), and n
is the number of subjects.

SPSS technique 1 One row, one subject:

Ulevel1     Ulevel2     Ulevel3     …
datum datum datum …
datum datum datum …
datum datum datum …
…

Syntax:

GLM
  u1 u2 u3
  /WSFACTOR = u 3 Polynomial
  /METHOD = SSTYPE(3)
  /CRITERIA = ALPHA(.05)
  /WSDESIGN = u .

SPSS won’t report the ‘between-subjects’ effects (the one based on SSsubjects, which we’re not
particularly interested in). It’ll report something else (I’m not sure what…) as ‘Between-
Subjects Effects: Intercept’, and the within-subjects effect that we are interested in as ‘Within-
Subjets: U’.

It will also report Mauchly’s test of sphericity of the covariance matrix, together with Green-
house–Geisser and Huynh–Feldt corrections for use if the assumption of sphericity is violated.

Using the menus, choose Analyze → General Linear Model → Repeated Measures. Define
the within-subjects factor (with its number of levels). Then you can assign individual variables
(e.g. Ulevel1) to appropriate levels of the factor. For a worked example, see p. 122.

SPSS technique 2 One column, one variable:

depvar       subject       U               
datum subj_1 level_1
datum subj_1 level_2
datum subj_1 level_3
datum subj_2 level_1
datum subj_2 level_2
datum subj_2 level_3
datum subj_3 level_1
datum subj_3 level_2
datum subj_3 level_3
…



7: Specific designs 114

Syntax:

GLM depvar BY subject u
  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = subject u .

SPSS will report the within-subjects effect as ‘Between-Subjects: U’ (since it doesn’t know that
anything’s a within-subjects effect!). It’ll report the SSsubjects term (the difference between sub-
jects) as ‘Between-Subjects: SUBJECT’. It’ll report the same ‘Intercept’ term as before.

Mauchly’s test is not reported; neither are the G–G and H–F corrections. To obtain these, use
technique 1 instead.

You could also use this:

GLM depvar BY subject u
  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = subject u subject*u .

… but as we’ve said, the Subject × U interaction is confounded with error in this design, and
SPSS simply won’t give you a result for it. All other answers will be the same.

Using the menus, choose Analyze → General Linear Model → Univariate. Enter U as a fixed
factor; enter Subject as a random factor.
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7.5 Two within-subjects factors

Alternative names • Repeated-measures ANOVA (with two factors)
• Randomized complete block (RCB) design (with two factors)
• Two-factor within-subjects design
• Split-block design

Example Twenty students have their digit span tested on dry land when sober (U1 V1) and then those
same students have a further digit span test when they’re on dry land and sober (U1 V2), when
they are diving in a dry suit in the Pacific Ocean and sober (U2 V1) and when they’re drunk and
diving (U2 V2). Don’t try this at home, kids. Does their location or sobriety affect performance?
Do these two factors interact?

A researcher wishes to test the effectiveness of three fertilizers (U1, U2, U3) and three tree
thinning techniques (V1, V2, V3). He divides his national park forest into four blocks (equiva-
lent to ‘subjects’) to account for variations across the park (e.g. mountainous conifers, lowland
deciduous, timber-harvested forest, volcanic ash area). He divides each block into nine plots and
assigns fertilizers U1–U3 and thinning techniques V1–V3 to each plot at random but such that
every block contains every combination of fertilizer and thinning treatment once.

Notes

Model description depvar = (U × V × S)

Model There are two alternative models (see Howell, 1997, p.486-7, which describes the problem for
three within-subjects factors; this is merely a simpler case). The first, simpler model, is this, in
which the Subject term doesn’t interact with anything:

ijkkijjiijkY επαββαµ +++++=
where
• Yijk is the dependent variable for subject k in condition Ui, Vj

• µ is the overall mean
• αi is the contribution from a particular level (level i) of factor U: µµα −=

iUi

• βj is the contribution from a particular level (level j) of factor V: µµβ −=
jVj

• πk is the contribution from a particular person or subject (subject k): µµπ −=
kSk

• εijk is everything else (the experimental error associated with subject k in condition UiVj):
)( kijjiijkijk Y παββαµε ++++−=

The second, probably better model, is this, which allows the Subject term to interact with the
other variables (i.e. accounts for the fact that different treatments may affect different subjects
in different ways):

ijkijkjkikkijjiijkY εαβπβπαππαββαµ ++++++++=
where
• απik is the contribution from the interaction of subject k with treatment Ui:

)( kiUSik ik
παµµαπ ++−=

• βπjk is the contribution from the interaction of subject k with treatment Vj:
)( kjVSjk jk

πβµµβπ ++−=

• αβπijk is the contribution from the interaction of subject k with the treatment combination
UiVj: )( jkijkijjiVUSijk jik

βπαππαββαµµαβπ ++++++−=

• in this case, we would redefine the error term:
)( ijkjkikkijjiijkijk Y αβπβπαππαββαµε +++++++−=

However, this more complex model does have a problem: since we have included the Subject
term as a variable that interacts with everything, we now only have one score per cell, and we
have no residual left for estimating error (εijkl). However, as it happens (Howell, 1997, pp. 487-
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8), we can use the sum of squares for the U × S term (απil) as an error estimate for the U term
(αi), the sum of squares for V × S as an error estimate for the V term, and so on. The full model
is usually preferable (Howell, 1997, p. 487).

Sources of variance Either the reduced model

SStotal = SSsubjects + SSU + SSV + SSU×V + SSerror

or the full model

SStotal = SSsubjects + SSU + SSV + SSU×V + SSU×S + SSV×S + SSU×V×S

ANOVA table In all cases, the mean square (MS) is the sum of squares (SS) for a particular row divided by the
degrees of freedom (d.f.) for the same row. Assuming one observation per cell, we have either

Source                               d.f.                                     SS                    F                      
Between subjects n–1 SSsubjects

U u–1 SSU MSU/MSerror

V v–1 SSV MSV/MSerror

U × V (u–1)(v–1) SSU×V MSU×V/MSerror

Error (n–1)(uv–1) SSerror

Total N–1 = uvn – 1 SStotal

or, with the full model:

Source                               d.f.                                     SS                    F                      
Between subjects (S) n–1 SSS

U u–1 SSU MSU/MSU×S

error U × S (u–1)(n–1) SSU×S

V v–1 SSV MSV/MSV×S

error V × S (v–1)(n–1) SSV×S

U × V (u–1)(v–1) SSU×V MSU×V/MSU×V×S

error U × V × S (u–1)(v–1)(n–1) SSU×V×S

Total N–1 = uvn – 1 SStotal

where u is the number of levels of factor U, etc., N is the total number of observations (= uvn),
and n is the number of subjects.

SPSS technique 1 One row, one subject:

U1V1        U2V1        U1V2        U2V2
datum datum datum datum
datum datum datum datum
datum datum datum datum
…

Syntax:

GLM
  u1v1 u1v2 u2v1 u2v2
  /WSFACTOR = u 2 Polynomial v 2 Polynomial
  /METHOD = SSTYPE(3)
  /CRITERIA = ALPHA(.05)
  /WSDESIGN = u v u*v .

This will give you the ‘full model’ answer (see above), in which the ‘Subject’ factor is allowed
to interact with everything in full.

Using the menus, choose Analyze → General Linear Model → Repeated Measures. Define
the within-subjects factors (with their numbers of levels). Then you can assign individual vari-
ables (e.g. U1V1) to appropriate levels of the factors. For a worked example, see p. 122.

SPSS technique 2 One column, one variable:
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Subject      U         V          depvar
1 1 1 datum
1 2 1 datum
1 1 2 datum
1 2 2 datum
2 1 1 datum
2 2 1 datum
2 1 2 datum
2 2 2 datum
…

To get the ‘reduced’ model (see above):

GLM depvar BY subject u v
  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /CRITERIA = ALPHA(.05)
  /DESIGN = u v u*v subject .

To get the ‘full’ model, matching SPSS’s usual within-subjects technique (see above):

GLM depvar BY subject u v
  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /CRITERIA = ALPHA(.05)
  /DESIGN = u v u*v subject u*subject v*subject u*v*subject .

As usual with this technique, Mauchly’s test is not reported; neither are the G–G and H–F cor-
rections. To obtain these, use technique 1 instead.

Using the menus, choose Analyze → General Linear Model → Univariate. Enter U, V as
fixed factors; enter Subject as a random factor.
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7.6 Three within-subjects factors

Alternative names • Repeated-measures ANOVA (with three factors)
• Randomized complete block (RCB) design (with three factors)
• Three-factor within-subjects design

Example Oh, it gets boring making these up. A set of subjects are all tested in every combination of three
treatments (U1…Uu, V1…Vv, W1…Ww).

Notes In the agricultural version, this is what an RCB design might look like:

In our terminology, the agricultural ‘block’ is the psychological ‘subject’: each subject experi-
ences each combination of the factors U, V, and W.

Model description depvar = (U × V × W × S)

Model There are two alternative models (see Howell, 1997, p.486-8). The first, simpler model, is this,
in which the Subject term doesn’t interact with anything:

ijkllijkjkikijkjiijklY επαβγβγαγαβγβαµ +++++++++=

where
• Yijkl is the dependent variable for subject l in condition Ui, Vj, Wk

• µ is the overall mean
• αi is the contribution from a particular level (level i) of factor U
• βj is the contribution from a particular level (level j) of factor V
• γk is the contribution from a particular level (level k) of factor W
• αβij, αγik, βγjk, and αβγijk are the contributions from the UV, UW, VW, and UVW interaction

terms
• πl is the contribution from a particular person or subject (subject l)
• εijkl is everything else (the experimental error associated with subject l in condition

UiVjWk).

The second, probably better model, is this, which allows the Subject term to interact with the
other variables (i.e. accounts for the fact that different treatments may affect different subjects
in different ways):

ijklijkljkliklijl

kljkillijkjkikijkjiijklY

εαβγπβγπαγπαβπ
γπβπαππαβγβγαγαβγβαµ

++++

++++++++++++=
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where
• απil is the contribution from the interaction of subject l with treatment Ui

• βπjk is the contribution from the interaction of subject l with treatment Vj

• γπkl is the contribution from the interaction of subject l with treatment Wk

• αβπijl is the contribution from the interaction of subject l with the treatment combination
UiVj

• αγπikl is the contribution from the interaction of subject l with the treatment combination
UiWk

• βγπjkl is the contribution from the interaction of subject l with the treatment combination
VjWk

• αβγπijkl is the contribution from the interaction of subject l with the treatment combination
UiVjWk

For exact specification of each of these components (e.g. µµα −=
iUi ) see the previous model

(p. 115→); it’s just the same but with more terms.

However, this more complex model does have a problem: since we have included the Subject
term as a variable that interacts with everything, we now only have one score per cell, and we
have no residual left for estimating error (εijkl). However, as it happens (Howell, 1997, pp. 487-
8), we can use the sum of squares for the U × S term (απil) as an error estimate for the U term
(αi), the sum of squares for V × S as an error estimate for the V term, and so on. The full model
is usually preferable (Howell, 1997, p. 487).

Sources of variance Either the reduced model

SStotal = SSsubjects + SSU + SSV + SSW + SSU×V + SSU×W + SSV×W + SSU×V×W + SSerror

or the full model

SStotal = SSsubjects + SSU + SSV + SSW + SSU×V + SSU×W + SSV×W + SSU×V×W

+ SSU×S + SSV×S + SSW×S + SSU×V×S + SSU×W×S + SSV×W×S + SSU×V×W×S

ANOVA table In all cases, the mean square (MS) is the sum of squares (SS) for a particular row divided by the
degrees of freedom (d.f.) for the same row. Assuming one observation per cell, we have either

Source                         d.f.                                     SS                    F                      
Between subjects n–1 SSsubjects

U u–1 SSU MSU/MSerror

V v–1 SSV MSV/MSerror

W w–1 SSW MSW/MSerror

U × V (u–1)(v–1) SSU×V MSU×V/MSerror

U × W (u–1)(w–1) SSU×W MSU×W/MSerror

V × W (v–1)(w–1) SSV×W MSV×W/MSerror

U × V × W (u–1)(v–1)(w–1) SSU×V×W MSU×V×W/MSerror

Error (n–1)(uvw–1) SSerror

Total N–1 = uvwn – 1 SStotal

or in the ‘full’ version:

Source                         d.f.                                     SS                    F                      
Between subjects n–1
U u–1 SSU MSU/MSU×S

error U × S (u–1)(n–1) SSU×S

V v–1 SSV MSV/MSV×S

error V × S (v–1)(n–1) SSV×S

W w–1 SSW MSW/MSW×S

error W × S (w–1)(n–1) SSW×S

U × V (u–1)(v–1) SSU×V MSU×V/MSU×V×S

error U × V × S (u–1)(v–1)(n–1) SSU×V×S

U × W (u–1)(w–1) SSU×W MSU×W/MSU×W×S

error U × W × S (u–1)(w–1)(n–1) SSU×W×S
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V × W (v–1)(w–1) SSV×W MSV×W/MSV×W×S

error V × W × S (v–1)(w–1)(n–1) SSV×W×S

U × V × W (u–1)(v–1)(w–1) SSU×V×W MSU×V×W/MSU×V×W×S

error U × V × W × S (u–1)(v–1)(w–1)(n–1) SSU×V×W×S

Total N–1 = uvwn – 1 SStotal

where u is the number of levels of factor U, etc., N is the total number of observations (= uvwn),
and n is the number of subjects.

SPSS technique 1 One row, one subject:

U1V1W1   U2V1W1   U1V2W1   U2V2W1   U1V1W2   U2V1W2   U1V2W2   U2V2W2 (etc.)
datum datum datum datum datum datum datum datum
datum datum datum datum datum datum datum datum
datum datum datum datum datum datum datum datum
…

Syntax:

GLM
  u1v1w1 u1v1w2 u1v2w1 u1v2w2 u2v1w1 u2v1w2 u2v2w1 u2v2w2
  /WSFACTOR = u 2 Polynomial v 2 Polynomial w 2 Polynomial
  /METHOD = SSTYPE(3)
  /CRITERIA = ALPHA(.05)
  /WSDESIGN = u v w u*v u*w v*w u*v*w .

This will give you the ‘full model’ answer (see above), in which the ‘Subject’ factor is allowed
to interact with everything in full. This layout doesn’t allow you to use the ‘reduced’ model, as
far as I can see.

Using the menus, choose Analyze → General Linear Model → Repeated Measures. Define
the within-subjects factors (with their numbers of levels). Then you can assign individual vari-
ables (e.g. U1V1W1) to appropriate levels of the factors. For a worked example, see p. 122.

SPSS technique 2 One column, one variable:

Subject      U         V          W         depvar
1 1 1 1 datum
1 2 1 1 datum
1 1 2 1 datum
1 2 2 1 datum
2 1 1 1 datum
2 2 1 1 datum
2 1 2 1 datum
2 2 2 1 datum
1 1 1 2 datum
1 2 1 2 datum
1 1 2 2 datum
1 2 2 2 datum
2 1 1 2 datum
2 2 1 2 datum
2 1 2 2 datum
2 2 2 2 datum
…

To get the ‘reduced’ model (see above):

GLM depvar BY subject u v w
  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /CRITERIA = ALPHA(.05)
  /DESIGN = u v w u*v u*w v*w u*v*w subject .

To get the ‘full’ model, matching SPSS’s usual within-subjects technique (see above):

GLM depvar BY subject u v w
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  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /CRITERIA = ALPHA(.05)
  /DESIGN = [subject]

  u u*subject
v v*subject
w w*subject
u*v u*v*subject
u*w u*w*subject
v*w v*w*subject
u*v*w subject u*v*w*subject .

As usual with this technique, Mauchly’s test is not reported; neither are the G–G and H–F cor-
rections.

Using the menus, choose Analyze → General Linear Model → Univariate. Enter A, B, C as
fixed factors; enter Subject as a random factor.
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7.7 One between- and one within-subjects factor

Alternative names • Split-plot design (Keppel, 1991)
• Mixed two-factor within-subjects design (Keppel, 1991)
• Repeated measures analysis using a split-plot design (SPSS, 2001, p. 464)
• Univariate mixed models approach with subject as a random effect (SPSS, 2001, p. 464)

Example We take three groups of rats, n = 8 per group (s = 24). We give one group treatment A1, one
group treatment A2, and one group treatment A3. (One subject only experiences one treatment.)
Then we measure every subject’s performance at six time points U1…U6.

Notes We first partition the total variation into between-subjects variability and within-subjects vari-
ability.

The between-subjects variability can be attributed to either the effect of the treatment group (A),
or differences between subjects in the same group (‘S within A’ or ‘S/A’). (This notation indi-
cates that there is a different group of subjects at each level of the between-subjects factor, A;
we could not measure simply of ‘subject variation independent of the effects of A’ since no
subjects ever serve in more than one group, or level of A. SPSS uses the alternative notation of
S(A).) So we have these sources of between-subjects variability:

A
S/A

The within-subjects variability can be attributed to either the effects of the time point (U), or an
interaction between the time point and the drug group (U × A), or an interaction between the
time point and the subject-to-subject variability, which again we can only measure within a drug
group (U × S/A). So we have these sources of within-subject variability:

U
U × A
U × S/A

Model description depvar = A × (U × S)

Model Following Myers & Well (1995, p. 295-6):

ijkijkikkijiijkY επβαββπαµ ++++++= //

where
• Yijk is the dependent variable for subject j in group Ai and condition Uk

• µ is the overall mean
• αi is the contribution from a particular level (level i) of factor A: µµα −=

iAi

• πj/i is the contribution from a particular person or subject (subject j), who only serves
within condition Ai (‘subject within group’, or S/A): µµπ −=

ij ASij //

• (There is no straightforward interaction of A with S: every subject is only measured at one
level of A, so this term would be indistinguishable from the subject-only effect πj/i.)

• βk is the contribution from a particular level (level k) of factor U: µµβ −=
kUk

• αβik is the contribution from the interaction of Ai and Uk: )( kiUAik ki
βαµµαβ ++−=

• πβjk/i is the contribution from the interaction of Uk with subject j, which can only be meas-
ured within one level of A (it’s the ‘SU/A’ term): )( /// kijAUSijk ikj

βπµµπβ ++−=

• (There is no straightforward three-way A × U × S interaction: every subject is only meas-
ured at one level of A, so this term would be indistinguishable from the SU/A effect πβjk/i.)

• εijk is everything else (the experimental error associated with measuring person j — who
always experiences treatment Ai — in condition Uk):

)( // ijkikkijiijkijk Y πβαββπαµε +++++−= .

Note that we cannot actually measure εijk independent of the SU/A term if we only have one
measurement per subject per level of U.
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Sources of variance SStotal = SSbetween subjects + SSwithin subjects

SSbetween subjects = SSA + SSS/A

SSwithin subjects = SSU + SSU×A + SSU×S/A

So

SStotal = SSA + SSS/A + SSU + SSU×A + SSU×S/A

We have two different ‘error’ terms, one for the between-subjects factor and one for the within-
subjects factor (and its interaction with the between-subjects factor), so we can’t just label them
‘SSerror’. But we could rewrite the total like this if we wanted:

SStotal = SSA + SSerror-between + SSU + SSU×A + SSerror-within

ANOVA table Source                               d.f.                                     SS                    F                      
Between subjects (S): s–1 = an – 1

A a–1 SSA MSA/MSS/A

error S/A (an–1)–(a–1) = a(n–1) SSS/A

Within subjects: (N–1)–(s–1) = an(u–1)
U u–1 SSU MSU/MSU×S/A

U × A (u–1)(a–1) SSU×A MSU×A /MSU×S/A

error U × S/A a(u–1)(n–1) SSU×S/A

Total N–1 = aun – 1 SStotal

where a is the number of levels of factor A, etc., N is the total number of observations (= aun), n
is the number of subjects per group (per level of A), and s is the total number of subjects (= an).

SPSS technique 1 One subject, one row:

A          U1             U2
1 datum datum
1 datum datum
1 datum datum
…
2 datum datum
2 datum datum
2 datum datum
…

Using the menus, choose Analyze → General Linear Model → Repeated Measures. Define
the within-subjects factor (with its number of levels). Then you can assign individual variables
(e.g. U1) to appropriate levels of the factors, and assign the between-subjects factor.

Here’s where we fill in the list of within-subjects factors and the number of levels. Type them in
and click ‘Add’.
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They appear in the list.

If we had more within-subjects factors, we could add them too. Once we’ve finished, we click
‘Define’.

We can now fill in the variables (U1, U2) corresponding to the levels of factor U; we can also
define A as a between-subjects factor.
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Once everything else is OK, click ‘OK’ to run the analysis, or ‘Paste’ to copy the syntax for the
analysis to a syntax window. This analysis produces the following syntax:

GLM
  u1 u2 BY a
  /WSFACTOR = u 2 Polynomial
  /METHOD = SSTYPE(3)
  /CRITERIA = ALPHA(.05)
  /WSDESIGN = u
  /DESIGN = a .

SPSS technique 2 One column, one variable:

A          Subject      U         depvar
1 1 1 datum
1 1 2 datum
1 2 1 datum
1 2 2 datum
1 3 1 datum
1 3 1 datum
…
2 14 1 datum
2 14 2 datum
2 15 1 datum
2 15 2 datum
…

Syntax:

GLM depvar BY A subject U
  /RANDOM = subject
  /DESIGN = A subject*A

U U*A U*subject*A.

or alternatively

GLM depvar BY A subject U
  /RANDOM = subject
  /DESIGN = A subject(A)

U U*A U*subject(A).

(This syntax is an example on page 464 of the SPSS 11.0 Syntax Reference Guide PDF.) It tests
MSA against MSsubject×A, and it tests the others (MSU and MSU×A) against what it simply calls
MSerror. As usual with this technique, Mauchly’s test is not reported; neither are the G–G and H–
F corrections. The underlined bit is optional, since this is the same as the residual error and
won’t be fully calculated, but including it won’t change the answers for any other factor.
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Not entirely trivial to accomplish with the SPSS menus. Using the menus, choose Analyze →
General Linear Model → Univariate. Enter A, U as fixed factors; enter Subject as a random
factor. Since SPSS will get the model wrong for ‘mixed’ models (by including S and U × S
terms), you then need to edit the Model directly before running the analysis. Untick ‘Full facto-
rial’ by ticking ‘Custom’. Enter the desired terms (in this case the between subjects term A, the
error term S/A which you enter as S × A, the within-subject bits U, U × A, and if you want, the
error term U × S/A which you enter as U × S × A, though that’s optional).
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7.8 Two between-subjects factors and one within-subjects factor

Alternative names

Example Fat men, thin men, fat women, and thin women (A1B1, A2B1, A1B2, and A2B2) all have their
blood pressure measured in the morning (U1) and in the evening (U2). Does blood pressure de-
pend on any of these factors, or on a combination of them? Obesity and sex are between-
subjects variables; time of day is a within-subject variable.

Notes We first partition the total variation into between-subjects variability and within-subjects vari-
ability.

The between-subjects variability can be attributed to either the effect of the between-subjects
factors (A, B, A × B), or differences between subjects in the same group (‘S within group’, or in
Keppel’s notation, since a group is specified by a unique combination of A and B, ‘S/AB’). So
we have these sources of between-subjects variability:

A
B
A × B
S/AB (between-subjects error)

The within-subjects variability can be attributed to either the effects of the within-subjects fac-
tor (U), or some form of interaction between U and the between-subjects factors (U × A, U × B,
U × A × B), or an interaction between U and the subject-to-subject variability, which again we
can only measure within a ‘group’ (U × S/AB). So we have these sources of within-subject
variability:

U
U × A
U × B
U × A × B
U × S/AB (within-subjects error)

Model description depvar = A × B × (U × S)

Model I made this up, but I got it right for a change (Myers & Well, 1995, p. 308):

ijklijklijljlill

ijkijjiijklY

επγαβγβγαγγ
παββαµ

++++++

++++=

/

/

where
• Yijkl is the dependent variable for subject k in condition Ai, Bj, Uk

• µ is the overall mean
• αi is the contribution from a particular level (level i) of factor A: µµα −=

iAi

• βj is the contribution from a particular level (level j) of factor B: µµβ −=
jBj

• αβij is the contribution from the interaction of Ai and Bj: )( jiBAij ji
βαµµαβ ++−=

• πk/ij is the contribution from a particular person or subject (subject k), who is measured only
in condition AiBj (this is the S/AB term): µµπ −=

jij BASijk //

• γl is the contribution of level l of factor U: µµγ −=
lUl

• αγil, βγjl, and αβγijl represent the Ai/Ul, Bj/Ul, and Ai/Bj/Ul interaction contributions, re-
spectively: )( liUAil li

γαµµαγ ++−= ; )( ljUBjl lj
γβµµβγ ++−= ; and

)( jlillijjiUBAijl lji
βγαγγαββαµµαβγ ++++++−= .

• πγkl/ij represents the interaction of Ul with subject k (who only experiences condition AiBj)
— the U×S/AB term:

)( /// ijljlillijkijjiBAUSijkl jilk
αβγβγαγγπαββαµµπγ ++++++++−=

• εijk is everything else (the experimental error associated with measuring person k, who al-



7: Specific designs 128

ways experiences treatment Ai, in condition Uj):
)( // ijklijljlillijkijjiijklijkl Y πγαβγβγαγγπαββαµε +++++++++−= . Of course,

this cannot be measured independently of the U×S/AB term (since there is only one obser-
vation in condition AiBjSkUl).

Sources of variance SStotal = SSbetween-subjects + SSwithin-subjects

SSbetween-subjects = SSA + SSB + SSA×B + SSerror-between

SSwithin-subjects = SSU + SSU×A + SSU×B + SSU×A×B + SSerror-within

ANOVA table Source                               d.f.                                     SS                    F                      
Between subjects (S): abn–1

A a–1 SSA MSA/MSS/AB

B b–1 SSB MSB/MSS/AB

A × B (a–1)(b–1) SSA×B MSA×B/MSS/AB

error S/AB ab(n–1) SSS/AB

Within subjects: abn(u–1)
U u–1 SSU MSU/MSU×S/AB

U × A (u–1)(a–1) SSU×A MSU×A /MSU×S/AB

U × B (u–1)(b–1) SSU×B MSU×B /MSU×S/AB

U × A × B (u–1)(a–1)(b–1) SSU×A×B MSU×A×B /MSU×S/AB

error U × S/AB ab(u–1)(n–1) SSU×S/AB

Total N–1 = abun – 1 SStotal

where a is the number of levels of factor A, etc., N is the total number of observations (= abun),
and n is the number of subjects per group (where a group is defined by the combination of fac-
tors A and B).

SPSS technique 1 One subject, one row:

A          B          U1       U2       U3…
1 1 datum datum datum…
1 1 datum datum datum…
1 2 datum datum datum…
1 2 datum datum datum…
2 1 datum datum datum…
2 1 datum datum datum…
…

Syntax:

GLM
  u1 u2 u3 BY a b
  /WSFACTOR = u 3 Polynomial
  /METHOD = SSTYPE(3)
  /CRITERIA = ALPHA(.05)
  /WSDESIGN = u
  /DESIGN = a b a*b .

Using the menus, choose Analyze → General Linear Model → Repeated Measures. Define
the within-subjects factor (with its number of levels). Then you can assign individual variables
(e.g. U1) to appropriate levels of the factors, and assign the between-subjects factors.

SPSS technique 2 One column, one variable:

A          B          Subject      U         depvar
1 1 1 1 datum
1 1 1 2 datum
1 1 1 3 datum
1 1 2 1 datum
1 1 2 2 datum
1 1 2 3 datum
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1 2 3 1 datum
1 2 3 2 datum
1 2 3 3 datum
…

Syntax:

GLM depvar BY a b subject u
  /RANDOM = subject
  /DESIGN = a b a*b subject*a*b

u u*a u*b u*a*b u*subject*a*b.

An alternative syntax is this:

GLM depvar BY a b subject u
  /RANDOM = subject
  /DESIGN = a b a*b subject(a*b)

u u*a u*b u*a*b u*subject(a*b).

As usual with this technique, Mauchly’s test is not reported; neither are the G–G and H–F cor-
rections. The underlined bit is optional, since this is the same as the residual error and won’t be
fully calculated, but including it won’t change the answers for any other factor.

Not entirely trivial to accomplish with the SPSS menus. Using the menus, choose Analyze →
General Linear Model → Univariate. Enter A, B, U as fixed factors; enter Subject as a random
factor. Since SPSS will get the model wrong for ‘mixed’ models (by including S and all sorts of
terms in which the between-subjects factors interact with S), you then need to edit the Model
directly before running the analysis. Untick ‘Full factorial’ by ticking ‘Custom’. Enter the de-
sired terms (in this case the between-subjects bits A, B, A × B, the error term S/AB which you
enter as S × A × B, the within-subjects bits U, U × A, U × B, U × A × B, and optionally the er-
ror term U × S/AB which you enter as U × S × A × B).
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7.9 One between-subjects factor and two within-subjects factors

Alternative names

Example Rats are given a brain lesion (A1) or a sham operation (A2). They are repeatedly offered two
levers; one delivers small, immediate reward, and the other delivers large, delayed reward.
Their preference for the large, delayed reward is assessed (dependent variable) at different de-
lays (U1, U2, … U5). Furthermore, they are tested hungry (V1) or sated (V2). All subjects experi-
ence all combinations of U and V, suitably counterbalanced, but one subject is only ever in one
A group.

Notes We first partition the total variation into between-subjects variability and within-subjects vari-
ability.

The between-subjects variability can be attributed to either the effect the between-subjects fac-
tor (A), or differences between subjects in the same group (‘S within group’, or ‘S/A’). So we
have these sources of between-subjects variability:

A
S/A (between-subjects error)

The within-subjects variability can be attributed to either the effects of the within-subjects fac-
tors (B, C, B × C), or some form of interaction between the within-subjects factors and the be-
tween-subjects factor (B × A, C × A, B × C × A), or an interaction between the within-subjects
factors and the subject-to-subject variability (B × S/A, C × S/A, B × C × S/A) where ‘S/A’
again refers to subject variability within a ‘group’ (defined by the between-subjects factor, A).
So we have these sources of within-subject variability:

U
U × A
U × S/A (within-subjects error term for the preceding two factors)
V
V × A
V × S/A (within-subjects error term for the preceding two factors)
U × V
U × V × A
U × V × S/A (within-subjects error term for the preceding two factors)

Model description depvar = A × (U × V × S)

Model This would be rather tedious to write out (see Myers & Well, 1995, p. 312); follow the princi-
ples in the previous model, which was for A × (U × S). The models always start with the overall
mean (µ). Then the between-subject factors (here, α), and their interactions (here, none), are
added. Then there’s subject term (π), which is nested within levels of A. Then there are the
within-subject factors (β, γ), and their interactions (βγ). Then for the full model all within-
subject factors and interactions interact with the subject term, which itself is nested within A (to
give βπ, γπ, βγπ). Finally there’s the ε term.

Sources of variance SStotal = SSbetween-subjects + SSwithin-subjects

SSbetween-subjects = SSA + SSerror-between

SSwithin-subjects = SSU + SSU×A + SSU×S/A

+ SSV + SSV×A + SSV×S/A

+ SSU×V + SSU×V×A + SSU×V×S/A

ANOVA table Source                               d.f.                                     SS                    F                      
Between subjects: an–1

A a–1 SSA MSA/MSS/A

error S/A a(n–1) SSS/A

Within subjects: an(uv–1)
U u–1 SSU MSU/MSU×S/A

U × A (u–1)(a–1) SSA×U MSA×U/MSU×S/A

error U × S/A a(u–1)(n–1) SSU×S/A
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V v–1 SSV MSV/MSV×S/A

V × A (v–1)(a–1) SSV×A MSV×A /MSV×S/A

error V × S/A a(v–1)(n–1) SSV×S/A

U × V (u–1)(v–1) SSU×V MSU×V /MSU×V×S/A

U × V × A (v–1)(a–1)(u–1) SSU×V×A MSU×V×A /MSU×V×S/A

error U × V × S/A a(u–1)(v–1)(n–1) SSU×V×S/A

Total N–1 = auvn – 1 SStotal

where a is the number of levels of factor A, etc., N is the total number of observations (= auvn),
and n is the number of subjects per group (where group is defined by factor A).

SPSS technique 1 One row, one subject:

A          U1V1        U1V2        U2V1        U2V2
1 datum datum datum datum
1 datum datum datum datum
1 datum datum datum datum
2 datum datum datum datum
2 datum datum datum datum
2 datum datum datum datum
…

Syntax:

GLM
  u1v1 u1v2 u2v1 u2v2 BY a
  /WSFACTOR = u 2 Polynomial v 2 Polynomial
  /METHOD = SSTYPE(3)
  /PRINT = DESCRIPTIVE HOMOGENEITY
  /CRITERIA = ALPHA(.05)
  /WSDESIGN = u v u*v
  /DESIGN = a .

Using the menus, choose Analyze → General Linear Model → Repeated Measures. Define
the within-subjects factors (with their numbers of levels). Then you can assign individual vari-
ables (e.g. U1V1) to appropriate levels of the factors, and assign the between-subjects factor.

SPSS technique 2 One column, one variable:

A          Subject      U         V          depvar
1 1 1 1 datum
1 1 1 2 datum
1 1 2 1 datum
1 1 2 2 datum
1 2 1 1 datum
1 2 1 2 datum
1 2 2 1 datum
1 2 2 2 datum
…
2 3 1 1 datum
2 3 1 2 datum
2 3 2 1 datum
2 3 2 2 datum

Syntax:

UNIANOVA
  depvar BY a subject u v
  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /PRINT = DESCRIPTIVE HOMOGENEITY
  /CRITERIA = ALPHA(.05)
  /DESIGN = a subject*a

u u*a u*subject*a
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v v*a v*subject*a
u*v u*v*a u*v*subject*a .

Incidentally, the notation Subject(A) will be accepted as equivalent to Subject*A in these sorts
of designs; feel free to use this alternative form if it seems clearer:

UNIANOVA
  depvar BY a subject u v
  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /PRINT = DESCRIPTIVE HOMOGENEITY
  /CRITERIA = ALPHA(.05)
  /DESIGN = a subject(a)

u u*a u*subject(a)
v v*a v*subject(a)

u*v u*v*a u*v*subject(a) .

Not entirely trivial to accomplish with the SPSS menus. Using the menus, choose Analyze →
General Linear Model → Univariate. Enter A, B, U as fixed factors; enter Subject as a random
factor. Since SPSS will get the model wrong for ‘mixed’ models (by including S and all sorts of
terms in which the between-subjects factors interact with S), you then need to edit the Model
directly before running the analysis. Untick ‘Full factorial’ by ticking ‘Custom’. Enter the de-
sired terms, as listed above; the method is explained further in the section on the ‘two-between,
one-within’ model.
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7.10 Other ANOVA designs with between and/or within-subjects factors

The models above can be extended along the same principles. See Keppel (1991), pp. 491–496. A full map of all the
‘error’ terms is given on p. 493; an expanded version showing all terms is presented here. For any term, the appropriate
error term is the next error term in the list. The different error terms needed for partial and full within-subjects models
are discussed by Howell (1997, pp. 487-488). Only full models are presented for designs involving between-subject
factors.

Between-subjects factors

None 1 factor (A) 2 factors (A, B) 3 factors (A, B, C)

N
on

e

Design:

Terms:

–

–

A ×××× S

A
error [= S/A]

A ×××× B ×××× S

A
B
A × B
error [= S/AB]

A ×××× B ×××× C ×××× S

A
B
C
A × B
A × C
B × C
A × B × C
error [= S/ABC]

1 
fa

ct
or

 (
U

)

Design:

Terms:

(U ×××× S)

between subjects term [S]
U
error [= U × S]

A ×××× (U ×××× S)

between subjects:
A
error S/A

within subjects:
U
U × A
error U × S/A

A ×××× B ×××× (U ×××× S)

between subjects:
A
B
A × B
error S/AB

within subjects:
U
U × A
U × A × B
error U × S/AB

A ×××× B ×××× C ×××× (U ×××× S)

between subjects:
A
B
C
A × B
A × C
B × C
A × B × C
error S/ABC

within subjects:
U
U × A
U × B
U × C
U × A × B
U × A × C
U × B × C
U × A × B × C
error U × S/ABC

W
it

hi
n-

su
bj

ec
ts

 fa
ct

or
s

2 
fa

ct
or

s 
(U

, V
)

Design:

Terms:

(U ×××× V ×××× S)

simpler model:

between-subjects term [S]
U
V
U × V
error

full model (preferable):

between-subjects term [S]
(no corresponding error
term)

U
error U × S
V
error V × S
U × V
error U × V × S

A ×××× (U ×××× V ×××× S)

between subjects:
A
error S/A

within subjects:
U
U × A
error U × S/A
V
V × A
error V × S/A
U × V
U × V × A
error U × V × S/A

A ×××× B ×××× (U ×××× V ×××× S)

between subjects:
A
B
A × B
error S/AB

within subjects:
U
U × A
U × B
U × A × B
error U × S/AB
V
V × A
V × B
V × A × B
error V × S/AB
U × V
U × V × A
U × V × B
U × V × A × B
error U × V × S/AB

A ×××× B ×××× C ×××× (U ×××× V ×××× S)

between subjects:
A
B
A × B
A × B × C
error S/ABC

within subjects:
U
U × A
U × B
U × A × B
error U × S/AB
V
V × A
V × B
V × A × B
error V × S/AB
U × V
U × V × A
U × V × B
U × V × A × B
error U × V × S/AB
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3 
fa

ct
or

s 
(U

, V
, W

)

Design:

Terms:

(U ×××× V ×××× W ×××× S)

simpler model:

between-subjects term [S]
U
V
U × V
U × W
V × W
U × V × W
error

full model (preferable):

between-subjects term [S]
(no corresponding error
term)

U
error U × S
V
error V × S
W
error W × S
U × V
error U × V × S
U × W
error U × W × S
V × W
error V × W × S
U × V × W
error U × V × W × S

A ×××× (U ×××× V ×××× W ×××× S)

between subjects:
A
error S/A

within subjects:
U
U × A
error U × S/A
V
V × A
error V × S/A
W
W × A
error W × S/A
U × V
U × V × A
error U × V × S/A
U × W
U × W × A
error U × W × S/A
V × W
V × W × A
error V × W × S/A
U × V × W
U × V × W × A
error U × V × W ×

S/A

A ×××× B ×××× (U ×××× V ×××× W ×××× S)

between subjects:
A
B
A × B
error S/AB

within subjects:
U
U × A
U × B
U × A × B
error U × S/AB
V
V × A
V × B
V × A × B
error V × S/AB
W
W × A
W × B
W × A × B
error W × S/AB
U × V
U × V × A
U × V × B
U × V × A × B
error U × V × S/AB
U × W
U × W × A
U × W × B
U × W × A × B
error U × W × S/AB
V × W
V × W × A
V × W × B
V × W × A × B
error V × W × S/AB
U × V × W
U × V × W × A
U × V × W × B
U × V × W × A × B
error U × V × W × S/AB

A ×××× B ×××× C ×××× (U ×××× V ×××× W ×××× S)

between subjects:
A
B
C
A × B
A × C
A × B × C
error S/ABC

within subjects:
U
U × A
U × B
U × C
U × A × B
U × A × C
U × B × C
U × A × B × C
error U × S/ABC
V
V × A
V × B
V × C
V × A × B
V × A × C
V × B × C
V × A × B × C
error V × S/ABC
W
W × A
W × B
W × C
W × A × B
W × A × C
W × B × C
W × A × B × C
error W × S/ABC
U × V
U × V × A
U × V × B
U × V × C
U × V × A × B
U × V × A × C
U × V × B × C
U × V × A × B × C
error U × V × S/ABC
U × W
U × W × A
U × W × B
U × W × C
U × W × A × B
U × W × A × C
U × W × B × C
U × W × A × B × C
error U × W × S/ABC
V × W
V × W × A
V × W × B
V × W × C
V × W × A × B
V × W × A × C
V × W × B × C
V × W × A × B × C
error V × W × S/ABC
U × V × W
U × V × W × A
U × V × W × B
U × V × W × C
U × V × W × A × B
U × V × W × A × C
U × V × W × B × C
U × V × W × A × B × C
error U × V × W × S/ABC
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7.11 One between-subjects covariate (linear regression)

Alternative names • Analysis of covariance (ANCOVA) — though traditionally this term isn’t applied to a de-
sign with no other factors

• Linear regression

Example You measure subjects’ income (dependent variable) and want to predict it in the basis of their
IQ. Every subject contributes an single (IQ, income) pair of values. This is basic linear regres-
sion. In regression terminology we would be trying to predict the dependent variable Y from the
another, predictor variable X — i.e. solving the regression equation

abXY +=ˆ

where 
X

Y

X

Y

X

XY

SS

SS
r

s

s
r

s
b ===

2

cov

and xbya −=

where Ŷ  is the predicted value of Y (see also Myers & Well, 1995, p. 387). Alternatively, we
could write this:

ε++= abXY

where ε symbolizes the error or residual. The equation represents, of course, this:

Or we could lay out the equation so as to be extensible to multiple regression (which we’ll look
at later):

XbbY 10
ˆ +=

ε++= XbbY 10

In ANCOVA terminology, the predictor variable is the covariate, which we’ll call C. So we
could first rewrite the simple linear regression equation with the letters we’ll use from now on:

bCaY +=ˆ  where CbYa −=

and now write it as a prediction for specific values of Y and C, namely Yi and Ci:

ε++= ii bCaY  where CbYa −=

and now write it terms of the means of Y ( µ== Y ) and C ( C ):

εµ
εµ

+−+=

++−=

)( CCb

bCCbY

i

ii

(Compare Myers & Well, 1995, p. 436.) We’ll use this below. It helps to distinguish between

the predicted value of Y based on the covariate [which is )(ˆ CCbbCaY iii −+=+= µ ] and

the contribution of the covariate, which is the deviation of the covariate-predicted value of Y
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from the overall mean of Y [which is therefore )( CCbc ii −= ]. Obviously, µ−= ii Yc ˆ .

Note also that the proportion of the total variability in Y that’s accounted for by predicting it
from C is equal to r2:

total

modelˆ2

SS

SS

SS

SS
==

Y

Yr

and the SS attributable to the model (SSmodel or SSregression or SSreg) can be written

C

Y

i

b

r

YY

SS

SS

)ˆ(SS

2

2

2
reg

=

=

∑ −=

Notes

Model description depvar = Ccov + S

(I’ve made that up, as Keppel doesn’t have a specific notation for models including covariates.)

Model iii cY εµ ++=

where
• Yi is the dependent variable for subject i
• µ is the overall mean

• ci is the contribution of the covariate for subject i: µ−=−= iii YCCbc ˆ)(  where b is the

regression coefficient, Ci is the value of the covariate for subject i, C  is the overall mean

value of the covariate, and iŶ  is the value of Yi predicted by on the basis of the covariate.

• εi is everything else (the error, residual, ‘individual variation’, etc.): )( iii cY +−= µε

Sources of variance SStotal = SSreg + SSerror

The SSreg is given by C
2

Y
22

reg SSSS)ˆ()()(SS brYCCbc iii ==∑ −=∑ −=∑= µ  (Myers &

Well, 1995, p. 393). It’s the sum of the squared contributions of the covariate, which is to say
the sum of the squared deviations between the covariate-predicted value and overall mean.

ANOVA table Covariates have 1 degree of freedom.

Source                         d.f.                                     SS                    F                      
Ccov (regression) 1 SSC MSC/MSerror

Error N–2 SSerror

Total N–1 SStotal

where N is the number of subjects.

SPSS technique Data layout:

C                depvar
datum datum
datum datum
datum datum
…

Either run the analysis as a regression:

REGRESSION
  /MISSING LISTWISE
  /STATISTICS COEFF OUTS R ANOVA
  /CRITERIA=PIN(.05) POUT(.10)
  /NOORIGIN
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  /DEPENDENT depvar
  /METHOD=ENTER c .

… or as an ANCOVA (note use of WITH for covariates, rather than BY for factors):

UNIANOVA
  depvar  WITH c
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /PRINT = PARAMETER
  /DESIGN = c .

This will also give you r2 for the model. The /PRINT = PARAMETER syntax also gives you b; you

can combine 2r  with the sign of b to calculate r.

Using the menus, choose Analyze → General Linear Model → Univariate; enter the depend-
ent variable and the covariate in the appropriate boxes.

To get parameter (b) estimates as well, choose Options → Parameter estimates.
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7.12 One between-subjects covariate and one between-subjects factor

7.12.1. The covariate and factor do not interact

Alternative names • Analysis of covariance (ANCOVA)
• Analysis of covariance (ANCOVA) assuming homogeneity of regression
• Traditional ANCOVA

Example After Howell (1997, p. 585). Suppose we are interested in whether small cars are easier to han-
dle. We can compare driving proficiency using three cars: small, medium, and large (A1, A2,
A3). One driver is tested in only one car. We have three groups of drivers to test, but they vary
considerably in their driving experience (Ccov). We have arranged matters so the mean driving
experience is the same in each group. If driving experience has a very large effect on perform-
ance, we may be unable to detect an effect of car type. So we can ‘partial out’ the effect of
driving experience (Ccov), increasing our power to detect an effect of car type (A).

More controversially, suppose that the mean level of driving experience was not the same for
the three groups. Then performing an analysis of covariance is like asking what the effect of car
type was had the groups not differed on the covariate. This may not make sense; see Howell
(1997, pp. 596-7) and Myers & Well (1995, pp. 449-454). For example, if you measure the ef-
fect of a drug on three-year-old and five-year-old children and covary for body weight, it may
make little sense to ask what the effect on three-year-olds would be if they weighed the same as
five-year-olds — they don’t. Statistically controlling for the covariate is not the same as ex-
perimentally controlling for the covariate (Myers & Well, 1995, p. 452).

Even worse is the situation when you measure the covariate after the treatment (factor) has been
applied and the treatment has affected the covariate; it’s then pretty difficult to interpret an
analysis of covariance meaningfully. See Howell (1997, pp. 596-7).

Notes Howell tends to refer to covariates as things that are accounted for or partialled out in advance
of consideration of other factors (Howell, 1997, p. 587; p. 606). This implies that the covariate
× factor interaction is not included, except to check the assumption of homogeneity of regres-
sion. This is a traditional meaning of ANCOVA; see the GLM section (p. 88→) for a full ex-
planation. SPSS refers to covariates in the sense of ‘continuous predictor variables’ (as opposed
to factors, which are discrete predictor variables) but does follow Howell’s approach when you
use covariates in its ‘full model’ mode. I will refer to covariates in the sense of continuous pre-
dictor variables and try to make it explicit when covariates interact with factors or do not.

This model assumes that the covariate is independent of the experimental treatments. (If not, see
the ‘interacting’ version below.)

Let’s take these data:

A A1 A1 A1 A1 A1 A2 A2 A2 A2 A2

depvar (Y) 1.1 3 4.9 7.2 9 3.1 5 6.5 8 11

We might run a one-way ANOVA on it, using our standard partitioning of variance:
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But suppose we also have information about a covariate C:

A A1 A1 A1 A1 A1 A2 A2 A2 A2 A2

C 1 3 5 7 9 2 4 6 8 10
depvar (Y) 1.1 3 4.9 7.2 9 3.1 5 6.5 8 11

We might be able to get a much more powerful test of the effects of A if we removed the effect
of C. We could, for example, correlate Y with C for all 10 data points, obtain predicted values
of Y based on C, obtain the residuals and see what effect A has on those. We could therefore
split the SS like this:

SStotal = SSregression(overall) + SSresidual

where SSresidual = SSA + SSerror

That’d look like this:

This is almost what one-way ANCOVA does. However, the regression line used is not quite the
‘overall’ regression (Myers & Well, 1995, pp. 436-439). To see why, consider these data:

A A1 A1 A1 A1 A1 A2 A2 A2 A2 A2

C 1 3 5 7 9 2 4.3 6 8 10
depvar (Y) 1.1 3.5 4.9 6 9 8.1 10.5 11.5 16 16

Here, if we calculated the regression line using all the data lumped together, we wouldn’t get as
good a fit as if we fitted separate regression lines for each A group (one line for A1, another for
A2). But the ANCOVA model we are using assumes homogeneity of regression — that is, that
the A1 and A2 data may have different intercepts but they have the same slope. How do we es-
timate this slope? Apparently (Myers & Well, 1995, p. 438) the best estimate of what’s called
the pooled within-group slope is this:

…++=∑=
2

2

1

1

)(/

/

)(/

/

)(/

/
/ SS

SS

SS

SS

SS

SS
A

CAS

AC
A

CAS

AC

i
A

CAS

AC
AS bbbb

i

i

where 
iAb  is the slope calculated just for observations in group Ai

and 
iAC /SS  is the variance of C for observations in group Ai
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and ∑=
i

ACCAS i/)(/ SSSS

For example, with the data set above,

915.0
1
=Ab ; 081.1

2
=Ab

40SS
1/ =AC ; 872.38SS

2/ =AC

872.78872.3840SS )(/ =+=CAS

997.0081.1
872.78

40
915.0

872.78

40
/ =+=ASb

We can then calculate the sum of squares for linear regression within groups, SSreg(S/A), by
summing the variabilities accounted for by the regressions with the common slope in each of
the groups (Myers & Well, 1995, p. 439):

)(/
2

/

/
2

//
2

/)/(reg

SS

SSSSSS
21

CACAS

ACASACASAS

b

bb

=

++= …

… in this case, SSreg(S/A) = (0.997)2 × 78.872 = 78.377. Since the within-group regression line
will pass through the within-group mean points },{

ii AA YC , we can sketch the situation:

Finally, we can partition the variance like this:

SStotal = SSoverall regression + SSadjusted total

SStotal = SSA + SSS/A

SSS/A = SSwithin-group regression, reg(S/A) + SSadjusted S/A

SSadjusted total = SSadjusted A + SSadjusted S/A

which looks like this (!):
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As a result, the quoted SScovariate (= SSreg(S/A)), quoted SSA (= SSA,adjusted), and quoted error (=
SSadjusted S/A) won’t add up to SStotal.

Model description depvar = Ccov + A × S

(I’ve used the notation ‘+’ to separate out things that don’t interact with anything… this seems
reasonably consistent.)

Model Essentially, the model is

ijjiij cY εαµ +++=
where
• Yij is the dependent variable for subject i in condition Aj

• µ is the overall mean of Y
• ci is the contribution of the covariate for subject i
• αj is the contribution from a particular level (level j) of factor A
• εij is everything else (the error in measuring subject i in condition j, residual, ‘individual

variation’, etc.): )( jiii cY αµε ++−=

And everyone claims this is their model (Myers & Well, 1995, p. 436; Howell, 1997, pp. 588-
590); see also Keppel (1991, pp. 308-317). However, what’s actually going on is a bit more
sophisticated — there’s are two definitions for ci and αj, depending on what we want to test.
What actually happens is this (best explained by Myers & Well, 1995, pp. 440-444; but also by
Howell, 1997, pp. 590-1):

• We can view any ANOVA hypothesis test as a comparison of two models. For example, a
simple one-way ANOVA is a comparison of a full model that incorporates the effect of a
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factor A ( ijiijY εαµ ++= ) with a restricted model that doesn’t — in this case, the re-

stricted model is iiY εµ += .

• Contrasting two models. The correct way of contrasting a full (F) model and a restricted
(R) model is to use this F test (Myers & Well, 1995, p. 441):

( )
( ) ( )

error(F)error(F)

error(F)error(R)error(F)error(R)
, SS

SSSS
error(F)error(F)error(R) df

dfdf
F dfdfdf ÷

−÷−
=−

Or, we could rewrite that, since SStotal = SSmodel + SSerror and dftotal = dfmodel + dferror:

( )
( ) ( )

error(F)error(F)

model(R)model(F)model(R)model(F)
, SS

SSSS
error(F)model(R)model(F) df

dfdf
F dfdfdf ÷

−÷−
=−

For a one-way ANOVA, this formula reduces to F = MSA/MSS/A, our usual formula for
testing the effects of A — see p. 86→ in the section on GLMs. An alternative formulation
uses the R2 values for each model (Howell, 1997, p. 578): if f and r are the number of pre-
dictors in the full and reduced models,

( )( )
( )( )2

22

1,
1

1

f

rf
fNrf

Rrf

RRfN
F

−−

−−−
=−−− .

• Now we apply that principle to ANCOVA.
• To test the effects of the factor A, one model is calculated testing just the effect of the

covariate C. That model is our usual regression ANOVA model, iii cY εµ ++= , where µ is
the overall mean and ci is the contribution of the covariate, calculated using the overall re-

gression ( )( CCbc ii −= ) — since in this model we have no information about which level

of A a given subject is at, so we can’t calculate the pooled within-groups slope yet. Then
we calculate another model including the factor A. That model is ijjiij cY εαµ +++= ,

where αj is the extra contribution of the factor. And knowledge of that factor allows us to
improve our regression as well, because it allows us to calculate two regression lines with
the same slope (the pooled within-groups slope, bS/A) but different intercepts (Myers &

Well, 1995, p. 442). So the extra contribution is )()(/ iAijASAj cCCb
jj

+−−+= µµα . We

compare those two models.
• To test the effects of the covariate C, one model is calculated testing just the effect of the

factor A. That model is our usual one-way ANOVA model ijjijY εαµ ++= , where µ is the

overall mean and αj is the contribution from a particular level (level j) of the factor
( µµα −=

jAj ). Then we calculate another model including the covariate C. That model is

ijjiij cY εαµ +++= , where ci is the extra contribution of the covariate, using the pooled

within-groups slope (i.e. using the information about which subject is at which level of

factor A), i.e. )(/ iAijASi CCbc −= . We compare those two models.

• The complicated picture above shows this. The top row — partitioning SStotal into SSoverall

regression, SSA(adjusted), and an error term, corresponds to testing the effects of A over and
above those of the covariate. The middle row — partitioning SStotal into SSA, SSwithin-group re-

gression, and an error term, corresponds to testing the effects of C over and above those of the
factor.

• Since the covariate and the factor may be correlated (provide mutual information),
the questions ‘what does A do?’ and ‘what does C do?’ are not independent; we there-
fore ask ‘what does A do, over and above the effects of C?’ and ‘what does C do, over and
above the effects of A?’

Sources of variance See above.
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ANOVA table Covariates account for 1 degree of freedom.

Source                         d.f.                                     SS                    F                      
Ccov 1 SSreg(S/A) MSreg(S/A)/MSS/A,adjusted

A a – 1 SSA, adjusted MSA,adjusted/MSS/A,adjusted

Error N – a – 1 SSS/A,adjusted

Total N – 1 SStotal

where N is the number of subjects and a the number of levels of factor A.

Note that the SS components for C, A, and error do not add up to SStotal. This is confusing;
the method of partitioning is described above.

Correlation
coefficient from
ANCOVA

See discussion under the ‘one within-subjects covariate’ model (p. 152) for details of how to
obtain correlation coefficients (r, r2) and parameter estimates (b) from ANCOVA.

SPSS technique Data layout:

C                A          depvar
datum 1 datum
datum 1 datum
datum 1 datum
datum 2 datum
datum 2 datum
datum 2 datum
…

Syntax:

UNIANOVA
  depvar BY a  WITH c
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = c a .

Using the menus, choose Analyze → General Linear Model → Univariate. Enter A as a fixed
factor. Enter Ccov as a covariate.

Note that the interaction term (Ccov × A) is not included in this model — see below for a version
with the interaction.
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7.12.2. The covariate and factor interact

Alternative names • Analysis of covariance (ANCOVA) allowing covariate × factor interaction
• Analysis of covariance (ANCOVA): full model to check homogeneity of regression
• Homogeneity of slopes design ANCOVA (see p. 88→)

Example Rats receive sham surgery (A1) or lesions of the nucleus accumbens core (A2). They are then
trained in a task in which they may press a lever freely; each lever press produces a pellet some
time later. For each rat, we measure the mean time between pressing the lever and receiving the
pellet (Ccov; one value per subject). This is a continuous variable. We also measure their learn-
ing speed (dependent variable). Does the learning speed depend on the delay each rat experi-
enced (main effect of Ccov)? Does the learning speed depend on the group they were in (main
effect of A)? Does the way the learning speed depends on the delay depend in turn on which
group they were in (Ccov × A interaction)?

Note the interpretative difficulties (discussed above) that can plague any ANCOVA if you don’t
think things through very carefully.

Notes Allows the covariate to interact with the factor — that is, allows for the possibility that the ef-
fects of the factor differ depending on the value of the covariate, or (equivalently) that the ef-
fects of the covariate differ depending on the level of the factor. See above for a non-interaction
version.

Howell (1997, pp. 587-590) discusses the approach to a standard ANCOVA that assumes ho-
mogeneity of regression (that the regression coefficients are equal across levels of the factor, i.e.
that there is no covariate × factor interaction). We discussed this ‘reduced model’ ANCOVA in
above (p. 138). Howell (1997, pp. 587-590) uses the ‘full’ model, which includes the interaction
term, to test the assumption of homogeneity of regression before using the ‘reduced model’.
However, there are times when we are interested in the interaction term for its own sake (see
Example above).

Model description depvar = Ccov × A × S

Model ijijjiij ccY εααµ ++++=

where
• Yij is the dependent variable for subject i in condition Aj

• µ is the overall mean
• ci is the contribution of the covariate for subject i
• αj is the contribution from a particular level (level j) of factor A
• cαij is the interaction of the covariate for subject i with level j of factor A
• εij is everything else (the error in measuring subject i in condition j, residual, ‘individual

variation’, etc.): )( ijjiii ccY ααµε +++−=

Just as before, we can’t define ci, αj and so on in just one way, since they may be correlated.
We’ll have to ask what the covariate contributes over and above the factor, and so on.

The test for the interaction term (Myers & Well, 1995, p. 447; Howell, 1997, p. 588-590) in-
volves the comparison of a full model in which the regression slopes can differ for each group,
or level of A (so the regression slopes are 

jAb ):

ijAijAjij jj
CCbY εαµ +−++= )(

and a restricted model in which each group has the same slope:

ijAijjij j
CCbY εαµ +−++= )(

Approach 1: testing the homogeneity of regression assumption. Test the interaction term as
above (i.e. perform an ANCOVA including the factor × covariate assumption). If the interaction
term is not significant, the slopes don’t differ. Drop the interaction term out of the model and
perform your usual ANCOVA (factor, covariate, no interaction) safe in the knowledge that the
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assumption of homogeneity of regression is valid. This is why most textbooks test this interac-
tion (Myers & Well, 1995, p. 450; Howell, 1997, p. 588-590).

Approach 2: asking about the factor ×××× covariate assumption for its own sake. Perform the
full analysis with the interaction; interpret that directly. Interpretation of any main effects in the
presence of an interaction may be tricky, as it is in factorial ANOVA (Myers & Well, 1995, p.
450).

Sources of variance SSC, SSA, SSC×A, SSerror… but these may not be independent, so they won’t necessarily add up
to SStotal — see above.

ANOVA table Covariates account for 1 degree of freedom.

Source                         d.f.                                     SS                    F                      
Ccov 1 SSC MSC/MSerror

A a – 1 SSA MSA/MSerror

Ccov × A a – 1 SSC×A MSC×A/MSerror

Error N – 2a SSerror

Total N – 1 SStotal

where N is the number of subjects and a the number of levels of factor A.

Correlation
coefficient from
ANCOVA

See discussion under the ‘one within-subjects covariate’ model (p. 152) for details of how to
obtain correlation coefficients (r, r2) and parameter estimates (b) from ANCOVA.

SPSS technique Data layout:

C                A          depvar
datum 1 datum
datum 1 datum
datum 1 datum
datum 2 datum
datum 2 datum
datum 2 datum
…

Syntax:

UNIANOVA
  depvar BY a  WITH c
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = c a c*a .

Note that the interaction term (Ccov × A) is included.

Not entirely trivial to accomplish with the SPSS menus. Using the menus, choose Analyze →
General Linear Model → Univariate. Enter C as a covariate. Enter A as a fixed factor. By de-
fault, SPSS will not include the Ccov × A interaction. So you need to edit the Model directly be-
fore running the analysis. Untick ‘Full factorial’ by ticking ‘Custom’. Enter the desired terms
(in this case C, A, C × A).
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7.13 One between-subjects covariate and two between-subjects factors

Alternative names • Factorial analysis of covariance (factorial ANCOVA)

Example Suppose we are again interested in whether small cars are easier to handle. We can compare
driving proficiency using three cars: small, medium, and large (A1, A2, A3). One driver is tested
in only one car. We have three groups of male drivers (B1), and three groups of female drivers
(B2), which we assign to our three cars in a standard factorial design. We also want to account
for variation in driving experience (Ccov; one value per subject).

Notes There’s nothing to stop you including covariate × factor interactions in your model, though we
won’t present them here.

The general linear model will also be perfectly happy for you to include covariate × covariate
interactions, if you think that’s meaningful. Think carefully, though; this would be a complex
design! We won’t present that here.

More detailed discussion of this design is given by Myers & Well (1995, pp. 457-459).

Model description
(S = subjects)

depvar = Ccov + A × B × S

Model ijkjkkjiijk cY εαββαµ +++++=

where
• Yijk is the dependent variable for subject i in condition Aj, Bk

• µ is the overall mean
• ci is the contribution from covariate C for subject i
• αj is the contribution from a particular level (level j) of factor A
• βk is the contribution from a particular level (level k) of factor B
• αβjk is the contribution from the interaction of level j of factor A and level k of factor B
• εijk is everything else (the ‘uniqueness’ of subject i in condition j of factor A and condition k

of factor B, ‘error’, ‘individual variation’, etc.).

However, since the predictors may be correlated, there is no ‘unique’ way to define the contri-
butions of each of these components (see above).

Sources of variance As the sources of variance may not be independent, the components (SSC, SSA, SSB, SSAB, SSer-

ror) may not add up to SStotal; see above.

ANOVA table Source                         d.f.                                     SS                    F                            
Ccov 1 SSC MSC/MSerror

A a–1 SSA MSA/MSerror

B b–1 SSB MSB/MSerror

A × B (a–1)(b–1) SSA×B MSA×B/MSerror

Error ab(n–1)–1 SSerror

Total N–1 = abn–1 SStotal

where a is the number of levels of factor A, etc., N is the total number of observations (sub-
jects), and n is the number of subjects (or ‘replications’) per cell.

Correlation
coefficient from
ANCOVA

See discussion under the ‘one within-subjects covariate’ model (p. 152) for details of how to
obtain correlation coefficients (r, r2) and parameter estimates (b) from ANCOVA.
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SPSS technique Data layout:

depvar       A                B                C                
datum level_1 level_1 datum
datum level_1 level_1 datum
datum level_1 level_2 datum
datum level_1 level_2 datum
datum level_2 level_1 datum
datum level_2 level_1 datum
datum level_2 level_2 datum
datum level_2 level_2 datum
…

Syntax:

UNIANOVA
  depvar BY a b  WITH c
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = c a b a*b .

Using the menus, choose Analyze → General Linear Model → Univariate. Enter A and B as
between-subjects factors. Enter C as a covariate.
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7.14 Two or more between-subjects covariates (multiple regression)

Alternative names • Multiple regression
• Multiple linear regression

Example Suppose we want to predict marks in undergraduate exams on the basis of A-Level points (Acov)
and IQ (Bcov).

Notes See Howell (1997, p. 510 on) for a discussion of multiple regression, and Howell (1997, pp.
605-606) for a discussion of the use of multiple covariates.

A standard multiple regression solves the equation

pp XbXbXbbY ++++= …22110
ˆ

where b0 is the intercept and b1, b2, … bp represent the regression coefficients (slopes) for the
predictors X1, X2, … Xp respectively. In general, as for linear regression, this equation is solved
so as to perform least-squares regression, i.e. to minimize

∑ − 2)ˆ( YY

However, if the two covariates are themselves correlated, there will be a problem of interpreta-
tion of effects involving one or other of them (because we will have non-orthogonal sums of
squares, as discussed earlier in the context of unequal group sizes; see p. 70→ and p. 97→).

Model description
(S = subjects)

Ccov + Dcov + … × S
For the two-covariate case, Ccov + Dcov + S.

Model To achieve standard multiple regression, in the two-predictor case, the multiple regression
equation above leads us to this model in our usual ANOVA notation:

iiii dcY εµ +++=
where
• Yi is the dependent variable for subject i
• µ is the overall mean
• ci is the contribution from covariate C for subject i
• dj is the contribution from covariate D for subject i
• εi is everything else (the error in measuring subject i, residual, ‘individual variation’, etc.).

However, since the predictors may be correlated, there is no ‘unique’ way to define the contri-
butions of each of these components (see above).

The Ccov × Dcov interaction is not included for conventional multiple linear regression.

Sources of variance For the two-covariate case, if the covariates are independent, then SStotal = SSC + SSD + SSerror.
But if the covariates are themselves correlated, the contributions of each won’t necessarily add
up to the total (Myers & Well, 1995, pp. 505-508).

ANOVA table Covariates account for 1 degree of freedom each. For the two-covariate case,

Source                         d.f.                                     SS                    F                      
Ccov 1 SSC MSC/MSerror

Dcov 1 SSD MSD/MSerror

Error N – 3 SSerror

Total N – 1 SStotal

where N is the number of subjects.
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Correlation
coefficients and
parameter esti-
mates

See discussion under the ‘one within-subjects covariate’ model (p. 152) for details of how to
obtain correlation coefficients (r, r2) and parameter estimates (b) from ANCOVA. See discus-
sion of effect size (p. 97→) to see how to interpret them.

SPSS technique Data layout:

C                D               depvar
datum datum datum
datum datum datum
datum datum datum
datum datum datum
datum datum datum
datum datum datum
…

Either perform the analysis as a multiple linear regression (Analyze → Regression → Linear;
enter C and D as the independent variables), which gives this syntax:

REGRESSION
  /MISSING LISTWISE
  /STATISTICS COEFF OUTS R ANOVA
  /CRITERIA=PIN(.05) POUT(.10)
  /NOORIGIN
  /DEPENDENT depvar
  /METHOD=ENTER c d .

Or run it as an ANOVA (Analyze → General Linear Model → Univariate; enter C and D as
covariates), which gives this syntax:

UNIANOVA
  depvar  WITH c d
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = c d .

Note that the interaction term (Ccov × Dcov) is not included. You could include it if you wanted
— the software won’t complain — but you’d have to think very carefully about its interpreta-
tion.
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7.15 Two or more between-subjects covariates and one or more between-subjects factors

Alternative names • Factorial analysis of covariance (factorial ANCOVA) with multiple covariates

Example Modifying Howell’s (1997, pp. 605-6) example slightly, suppose we want to look at the effect
of two teaching styles (A) and two classroom temperatures (B) on student performance using a
factorial design. We might also want to partial out the effect of age (Ccov) and IQ (Dcov). No
problem — statistically, at least.

Notes There’s nothing to stop you including covariate × factor interactions in your model, though we
won’t present them here.

The general linear model will also be perfectly happy for you to include covariate × covariate
interactions, if you think that’s meaningful. Think carefully, though; this would be a complex
design! We won’t present that here.

As in the previous design, if the two covariates are correlated, there will be a problem of inter-
pretation (because we will have non-orthogonal sums of squares, as discussed earlier in the
context of unequal group sizes; see p. 70→ and p. 97→).

Designs with more than one covariate are briefly discussed by Myers & Well (1995, p. 459), as
is polynomial ANCOVA (Myers & Well, 1995, p. 460); see also p. 88→.

Model description
(S = subjects)

Following our example, we’ll illustrate a two-covariate, two-factor model:
depvar = Ccov + Dcov + A × B × S

Model ijkjkkjiiijk dcY εαββαµ ++++++=

where
• Yijk is the dependent variable for subject i in condition Aj, Bk

• µ is the overall mean
• ci is the contribution from covariate C for subject i
• di is the contribution from covariate D for subject i
• αj is the contribution from a particular level (level j) of factor A
• βk is the contribution from a particular level (level k) of factor B
• αβjk is the contribution from the interaction of level j of factor A and level k of factor B
• εijk is everything else (the ‘uniqueness’ of subject i in condition j of factor A and condition k

of factor B, ‘error’, ‘individual variation’, etc.).

However, since the predictors may be correlated, there is no ‘unique’ way to define the contri-
butions of each of these components (see above).

Sources of variance As the sources of variance may not be independent, the components (SSC, SSD, SSA, SSB, SSAB,
SSerror) may not add up to SStotal; see above.

ANOVA table Source                         d.f.                                     SS                    F                            
Ccov 1 SSC MSC/MSerror

Dcov 1 SSD MSD/MSerror

A a–1 SSA MSA/MSerror

B b–1 SSB MSB/MSerror

A × B (a–1)(b–1) SSA×B MSA×B/MSerror

Error ab(n–1)–2 SSerror

Total N–1 = abn–1 SStotal

where a is the number of levels of factor A, etc., N is the total number of observations (sub-
jects), and n is the number of subjects (or ‘replications’) per cell.

Correlation
coefficients and
effect sizes

See discussion under the ‘one within-subjects covariate’ model (p. 152) for details of how to
obtain correlation coefficients (r, r2) and parameter estimates (b) from ANCOVA. See discus-
sion of effect size above (p. 97→) to see how to interpret them.
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SPSS technique Data layout:

depvar       A                B                C                D         
datum level_1 level_1 datum datum
datum level_1 level_1 datum datum
datum level_1 level_2 datum datum
datum level_1 level_2 datum datum
datum level_2 level_1 datum datum
datum level_2 level_1 datum datum
datum level_2 level_2 datum datum
datum level_2 level_2 datum datum
…

Syntax:

UNIANOVA
  depvar BY a b  WITH c d
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = c d a b a*b .

Using the menus, choose Analyze → General Linear Model → Univariate. Enter A and B as
between-subjects factors. Enter C and D as covariates.
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7.16 One within-subjects covariate

Alternative names • Multiple regression with the covariate and Subject as predictors

Example We measure gastric pH and PaCO2 (partial pressure of arterial carbon dioxide) for a group of 8
subjects, making several measurements on each subject so we end up with 47 measurements
(see Bland & Altman, 1995a). Is there a relationship between PaCO2 and pH? We must not
analyse this as if there were 47 independent observations. Subjects may vary widely in their
gastric pH and arterial PaCO2, yet there may be a consistent relationship within each subject
between the two, and this is what we want to look at.

Notes I’ve largely made up the model and sources of variance here, so I hope it’s correct. It does
match Bland & Altman’s answer. Note that it is logically identical to the model we looked at
earlier with one between-subjects covariate and one between-subjects factor (the version in
which the covariate and the factor do not interact), except that our factor is now ‘subjects’ itself;
the only difference is that subjects is a random, not a fixed, factor. Data from Bland & Altman
(1995a); originally from Boyd et al. (1993).

Model description
(S = subjects)

depvar = (Ccov + S)

Model iiii cY επµ +++=

where
• Yi is the dependent variable for subject i
• µ is the overall mean
• ci is the contribution from covariate C for subject i
• πi is the average contribution from a particular subject (subject i)
• εijk is everything else (measurement error, intra-subject variation, etc.).

Sources of variance SStotal = SSsubjects + SSC + SSerror

ANOVA table Source                         d.f.                                     SS                    F                                  
Between subjects s – 1 SSsubjects MSsubjects/MSerror

C 1 SSC MSC/MSerror

Error N – 1 – s SSerror

Total N – 1 SStotal

where N is the total number of observations and s is the number of subjects.
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Correlation
coefficient from
ANCOVA

Note also that since if we are predicting a variable Y (calling the prediction Ŷ ) we can express
r2 in terms of sums of squares:

residualY

Y

Y

Y

SSSS

SS

SS

SS
r

+
==

ˆ

ˆˆ2

 (see Correlation & Regression handout at www.pobox.com/~rudolf/psychology). If we re-
write this for our present case, C is the thing that makes the prediction. The total within-subjects
variation is what we’re left with after we’ve accounted for between-subjects variation (= SStotal

– SSsubjects = SSC + SSerror) and the variation accounted for by the prediction from C is SSC. So
the proportion of the within-subjects variation accountable for by C is:

errorC

C

SSSS

SS
r

+
=2

This allows us to work out the within-subjects correlation coefficient from the ANCOVA table.
To obtain r itself, take the square root of r2 and combine it with the sign of the regression coef-
ficient. To obtain regression coefficients in SPSS, tick Parameter estimates in the ANOVA
Options dialogue box, or add /PRINT = PARAMETER to your SPSS syntax. The regression coef-
ficient (slope) will appear in the ‘B’ column and the row corresponding to the covariate.

SPSS technique Data layout:

subject       C                depvar       
1 datum datum
1 datum datum
1 datum datum
2 datum datum
2 datum datum
3 datum datum
3 datum datum
3 datum datum
3 datum datum
3 datum datum
4 datum datum
…

Syntax:

UNIANOVA
  depvar BY subject  WITH c
  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /PRINT = PARAMETER
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = c subject .

Using the menus, select Analyze → General Linear Model → Univariate. Enter Subject as a
random factor and C as a covariate.
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7.17 One within-subjects covariate and one between-subjects factor

7.17.1. The covariate and factor do not interact

Alternative names

Example We give a drug (A1) or placebo (A2) to two groups of subjects to see if it affects their secretion
of growth hormone (dependent variable). The drug’s effects are known to last for days, and we
know that time of day (C) also affects growth hormone secretion — we believe there is a linear
relationship between time of day measured in a certain way and growth hormone levels. Each
subject only experiences either the drug or the placebo, but we measure each subject repeatedly
at several different time points. We wish to ‘partial out’ the effects of time of day to have a bet-
ter chance of finding an effect of the drug.

(Note that our experimental design must ensure that there is no systematic relationship between
A and C, or interpretation will be well-nigh impossible — for example, it would be vital not to
measure the drug group in the evening and the placebo group in the morning.)

Notes

Model description
(S = subjects)

depvar = A × (Ccov + S) [but with no Ccov × A term in the model]

Model I would guess either this:

ijjijiij cY επαµ ++++= /

where
• Yij is the dependent variable for subject j in condition Ai

• µ is the overall mean
• αi is the contribution from level i of factor A
• πj/i is the average contribution from a particular subject (subject j), who is only measured in

condition Ai

• cjk is the contribution from covariate C for subject j
• εij is everything else (measurement error, intra-subject variation, etc.).

or this:

ijijjijiij ccY εππαµ +++++= //

where
• πcj/i is the interaction of the covariate C with subject j (who is only measured in condition

Ai)

• εij is redefined as ‘everything else’ in this new model

Should we include the subject × covariate interaction, C × S/A (allowing a different regression
slope for the covariate for each subject)? Maybe that depends on the situation. Obviously, to
include it, we must have multiple measurements for each subject. One approach, I suppose,
would be to test the full model and proceed to the simpler model if the subject × covariate inter-
action doesn’t contribute significantly. Including it will improve the power to detect effects of C
probably at the expense of power to detect effects of A (see below).

Sources of variance The sources of variation (SSA, SSerror-between, SSC, perhaps SSC×S/A, and SSerror-within) may not be
independent and may therefore not add up to SStotal.

ANOVA table If the effects of A and C are uncorrelated, the ANOVA table will look like this:

Source                               d.f.                                     SS                    F                      
Between subjects: s–1 = an–1

A a–1 SSA MSA/MSS/A

error (S/A) a(n–1) SSS/A

Within subjects: (N–1)–(s–1) = N–s
Ccov 1 SSC MSC/MSerror-within
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error-within N–s–1 SSerror-within

Alternative for within subjects (in the model with the C × S/A term):
Ccov 1 SSC MSC/MSerror-within

Ccov × S/A a(n–1) SSC×S/A MSC×S/A/MSerror-within

error N–s–a(n–1)–1 SSerror-within

Total N–1 SStotal

where a is the number of levels of factor A and N is the total number of observations (= aun), n
is the number of subjects per group (where ‘group’ is defined by factor A), and s is the total
number of subjects.

SPSS technique Data layout:

A          Subject            C                depvar       
1 1 datum datum
1 1 datum datum
1 1 datum datum
1 2 datum datum
1 2 datum datum
1 2 datum datum
…
2 7 datum datum
2 7 datum datum
2 7 datum datum
2 7 datum datum
2 8 datum datum
2 8 datum datum
…

Syntax (using the notation subject(a) rather than the functionally equivalent subject*a for the
term S/A):

GLM
  depvar BY a subject  WITH c
  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /PRINT = DESCRIPTIVE HOMOGENEITY
  /CRITERIA = ALPHA(.05)
  /DESIGN = a subject(a) c c*subject(a) .

or not…

Choose whether or not to include the C × S/A term… If you do include it, the C × S/A term is
calculated and itself assessed against the residual MSerror, whereas otherwise C × S/A is part of
the error term. This inevitably reduces the residual MSerror and will therefore improve power to
detect effects of C (either as an effect of C or a C × S/A interaction), probably at the expense of
power to detect the effect of A.

One thing worth noticing: SPSS assesses MSA against a linear combination of MSS/A and the
residual (what it calls MSerror). You might think that it should be assessed only against MSS/A —
and this is what it will do if A and C are totally uncorrelated. It’s possible to force SPSS to do
this at any time with a custom hypothesis test using the syntax /TEST = a VS subject(a). But
this may not be a good idea, because if A and C are partially correlated, SPSS tries to sort things
out. It calculates its error terms using Satterthwaite’s (1946) denominator synthesis approach. If
A and C are pretty much uncorrelated, you’ll find that the linear combination it uses as its error
term is heavily weighted towards MSS/A (e.g. 0.97 × MSS/A + 0.03 × MSerror). If they’re corre-
lated, the weighting will change (e.g. 0.239 × MSS/A + 0.761 × MSerror). And if A and C are
substantially correlated, your interpretation may be very difficult in any case.

In any case, the easiest way to think about the calculations going on in this sort of analysis is to
view each test as a comparison of two models (see section on GLMs, p. 84→). For example,
assuming we’re using the usual method (SPSS’s Type III sums of squares) for partialling out



7: Specific designs 156

the effects of mutually correlated predictors, the test of the effect of C is a test of the difference
between a full model, including C, and a restricted model including every effect but C, and so
on for all the other terms.

Not entirely trivial to accomplish with the SPSS menus. Using the menus, choose Analyze →
General Linear Model → Univariate. Enter A as a fixed factor; enter Subject as a random fac-
tor; enter C as a covariate. Since SPSS will not give you the correct model by default (it will
include S), you then need to edit the Model directly before running the analysis. Untick ‘Full
factorial’ by ticking ‘Custom’. Enter the desired terms as listed in the ANOVA table.

7.17.2. The covariate and factor interact

Alternative names

Examples • One of my examples, so I do hope it’s appropriate. Subjects are assigned to two groups (A1

brain lesion, A2 sham). They are given a task in which they have a choice between two lev-
ers. Lever A delivers a single food pellet with probability p = 1. Lever B delivers four pel-
lets, but with a probability that ranges from 1 to 0.0625; the probability changes in steps
and the rats have an opportunity to experience the probability currently in force before they
choose between levers A (small, certain reward) and B (large, uncertain reward). The de-
pendent variable is the proportion of trials on which they choose lever B. We could analyse
these with two factors: A (group: lesion/sham; between subjects) and B (probability:
1/0.5/0.25/0.125/0.0625; within subjects). But since delivery of the large reward is un-
der the control of a random process, the probability experienced by the subjects may not
always match the programmed probability (e.g. if they have 10 trials and the programmed
probability is 0.5, it’s perfectly possible that they get 3 rewarded and 7 unrewarded trials,
giving an experienced probability of only 0.3). So rather than using programmed probabil-
ity as a within-subjects factor, we could use experienced probability as a within-subjects
covariate (call it C). We can then ask whether the probability influenced choice (main ef-
fect of C), whether the lesion influenced choice (main effect of A), and whether the lesion
influenced the effect of probability (A × C interaction).

• Subjects are assigned to two groups (A1 brain lesion, A2 sham). They respond freely on two
levers, left and right, to receive food pellets. Both levers deliver food with an element of
randomness. Rats are tested for several sessions. Across sessions, the relative number of
pellets delivered by each lever varies. For each session, we calculate the proportion of re-
sponses allocated to the left lever — the relative response distribution (dependent variable)
— and the proportion of the total number of pellets that were earned by responding on the
left lever — the relative reinforcer distribution (C). Both are continuous, rather than dis-
crete, variables. Did the reinforcer distribution influence responding (main effect of C)?
Did the lesion influence responding (main effect of A)? Did the lesion influence the way
the animals responded to the reinforcer distribution (interaction between C and A)?

Notes In terms of the model, this is logically equivalent to the ‘one between-subjects factor, one
within-subjects factor’ design discussed earlier (q.v.). The computerized ANOVA process used
by SPSS, based on a general linear model (GLM), does not care whether predictor variables are
discrete (factors) or continuous (covariates), except in the way that it builds its default model
(which we need to override here).

Model description
(S = subjects)

depvar = A × (Ccov × S)

Model Well, I’m making this up again; I would guess the full model would be essentially the same as
the ‘one between, one within’ design discussed earlier (q.v.):

ijkijkikkijiijk cccY επαπαµ ++++++= //

where
• Yijk is the dependent variable for subject j in condition Ai

• µ is the overall mean
• αi is the contribution from a particular level (level i) of factor A
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• πj/i is the contribution from a particular person or subject (subject j), who only serves
within condition Ai (‘subject within group’, or S/A)

• (There is no straightforward interaction of A with S: every subject is only measured at one
level of A, so this term would be indistinguishable from the subject-only effect πj/i.)

• ck is the contribution from the covariate C for subject j (call it Cj for the moment)
• αcik is the contribution from the interaction of Ai and Cj

• πcjk is the contribution from the interaction of Ck with subject j (who only serves within
condition Ai) — if you choose to include it (see above)

• εijk is everything else (the experimental error associated with measuring person j, who al-
ways experiences treatment Ai, with covariate contribution Ck).

Sources of variance If A and C are uncorrelated, we could partition the variance like this:

SStotal = SSbetween subjects + SSwithin subjects

SSbetween subjects = SSA + SSS/A

SSwithin subjects = SSC + SSC×A + SSC×S/A + SSerror

or if you don’t include SSC×S/A, you’d just write the within-subjects bit like this:

SSwithin subjects = SSC + SSC×A + SSerror

However, if A and C are correlated, the sources of variance will not be independent and will not
add up to SStotal.

ANOVA table If A and C are uncorrelated, the ANOVA table would look like this:

Source                               d.f.                                     SS                    F                      
Between subjects: s–1 = an–1

A a–1 SSA MSA/MSS/A

error S/A a(n–1) SSS/A

Within subjects: N–s
Ccov 1 SSC MSC/MSerror-within

Ccov × A a–1 SSC×A MSC×A/MSerror-within

Ccov × S/A a(n–1) SSC×S/A MSC×S/A/MSerror-within

error-within N–s–an SSerror-within

Within subjects in a model that doesn’t include Ccov × S/A:
Ccov 1 SSC MSC/MSerror-within

Ccov × A a–1 SSC×A MSC×A/MSerror-within

error-within N–s–a SSerror-within

Total N–1 SStotal

where a is the number of levels of factor A and N is the total number of observations (= aun), n
is the number of subjects per group (where ‘group’ is defined by factor A), and s is the total
number of subjects.

SPSS technique Data layout:

A          Subject            C                depvar       
1 1 datum datum
1 1 datum datum
1 1 datum datum
1 2 datum datum
1 2 datum datum
1 2 datum datum
…
2 7 datum datum
2 7 datum datum
2 7 datum datum
2 7 datum datum
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2 8 datum datum
2 8 datum datum
…

Syntax:

GLM
  depvar BY a subject  WITH c
  /RANDOM = subject
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /PRINT = DESCRIPTIVE HOMOGENEITY
  /CRITERIA = ALPHA(.05)
  /DESIGN = a subject(a)
            c c*a c*subject(a) .

 or not…

Choose whether or not to include the C × S/A term… If you do include it, the C × S/A term is
calculated and itself assessed against the residual MSerror, whereas otherwise C × S/A is part of
the error term. This inevitably reduces the residual MSerror and improves power to detect terms
involving C (that is, C, C × A, and C × S/A), probably at the expense of power to detect the
effect of A.

Note that SPSS calculates its error terms using appropriate linear combinations to deal with any
correlation between A and C (see above).

Not entirely trivial to accomplish with the SPSS menus. Using the menus, choose Analyze →
General Linear Model → Univariate. Enter A as a fixed factor; enter Subject as a random fac-
tor. Since SPSS will not give you the correct model by default (it will include S and not include
C × A), you then need to edit the Model directly before running the analysis. Untick ‘Full facto-
rial’ by ticking ‘Custom’. Enter the desired terms as above.
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7.18 Hierarchical designs: two or more levels of ‘relatedness’ in measurement

7.18.1. Subjects within groups within treatments (S/G/A)

Alternative names • Split-split plot design
• Double-split design
• Doubly-nested design
• Hierarchical design
• Bloody complicated

Example The simplest hierarchical design (Myers & Well, 1995, pp. 321): subjects (S) are tested in
groups (G). Different groups are assigned to different levels of some treatment (A). One subject
is only ever in one group, and one group is only ever in one treatment. This design can be writ-
ten S/G/A (subjects within groups within treatments). Specific examples:

• Primary school pupils are taught in classes. We assign several classes to one teaching
method, several other classes to a different teaching method, and so on. One pupil is only
ever in one class; one class only ever uses one teaching method. The design is pupils
within classes within teaching methods. Pupil and class are random factors.

• Different methods of rearing rats might be compared, with each rearing method being
applied to several litters of rats. (Rats within a litter are related genetically, so we should
take into account this potential source of correlation between scores of rats from the
same litter. Stating the same thing in a different way, two randomly-selected rats may
differ not only because they are different individuals, or because they experienced differ-
ent treatments, but because they come from different litters.) The design is rats within
litters within rearing methods. Rat and litter are random factors.

Model An individual score might be represented as Yijk, where
i = 1, 2, … a (number of treatment levels)
j = 1, 2, … g (number of groups within a treatment level)
k = 1, 2, … n (number of subjects in a group)

Then

ijkjiijkY εγαµ +++=
or

)()()(

)()()(

ijijkiijiijk

ijijkiijiijk

YY

YY

µµµµµµ
µµµµµµ

−+−+−=−

−+−+−+=

where
• Yijk is the dependent variable in condition Ai, Gj for subject k
• µ is the overall mean
• αi is the contribution from level i of factor A (Ai): µµα −=

iAi  and 0=∑ iα .

• γj is the contribution from level j of group G in condition Ai (Gij) relative to the mean of Ai:

ij AGj µµγ −=  and 0=∑ jγ .

• εijk is everything else (the deviation of subject k from its group mean Gij): ijijkijk Y µε −= .

If we sum and square both sides (and eliminate cross-product terms that sum to zero), we get:
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Sources of variance Subject and group are random factors; A is a fixed factor. We’d write the model like this:

SStotal = SSbetween-groups + SSwithin-groups

SSbetween-groups = SSA + SSG/A

SSwithin-groups = SSS/G/A

so
SStotal = SSA + SSG/A + SSS/G/A
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We would state G/A as ‘group within A’, and S/G/A as ‘subject within group within A’, or
simply ‘subject within group’. Similarly,

dftotal = dfA + dfG/A + dfS/G/A

ANOVA table Source                                           d.f.                                     SS                    F                      
Between groups: ag–1

A a–1 SSA MSA/MSG/A

G/A a(g–1) SSG/A MSG/A/MSS/G/A

Within groups:
S/G/A ag(n–1) SSS/G/A

Total N–1 = agn – 1 SStotal

where N is the total number of observations and a, g, and n are as defined above. Note that the
error term for A is G/A, and the error term for G/A is S/G/A.

SPSS technique A          G               Subject      depvar
1 1 1 datum
1 1 2 datum
1 1 3 datum
1 1 4 datum
1 2 5 datum
1 2 6 datum
1 2 7 datum
1 2 8 datum
2 3 9 datum
2 3 10 datum
2 3 11 datum
2 3 12 datum
2 4 13 datum
2 4 14 datum
2 4 15 datum
2 4 16 datum
…

It doesn’t matter if you use the same identifiers to code groups within different levels of A. For
example, you can call the A1 groups ‘1’ and ‘2’ and the A2 groups ‘3’ and ‘4’, as I’ve done
above — or you can call the A1 groups ‘1’ and ‘2’ and the A2 groups ‘1’ and ‘2’ again. Since
the design ‘knows’ that groups are nested within levels of A, it doesn’t care about how you label
them. (Of course, each group must have a unique name within each level of A.)

GLM depvar BY a g subject
  /RANDOM = g subject
  /DESIGN = a g(a) subject(g(a)) .

Further notes It’s a common mistake to use an experiment with this kind of design but not to put the ‘Group’
factor into the analysis. People often analyse these kinds of data only taking into account the A
factor. That will generally overestimate the F ratio for A (give a lower p value than it should)
(Myers & Well, 1995, pp. 325-7). On the other hand, if Group has few df, the value of MSG (=
SSG / dfG) will be large and we will have low power to detect effects of A. The alternative
model is to ignore the effect of G (what most people do without thinking about it):

SStotal = SSA + SSS/A

where SSS/A is the pool of G/A and S/G/A. This is what you get when you run a one-way
ANOVA, ignoring the effect of G. In general, E(MSS/A) is less than E(MSG/A), so you’re more
likely to find a ‘significant’ effect of A (Myers & Well, 1995, p. 326). Myers & Well (1995, pp.
151, 327) recommend that you only pool (ignore the effect of G) when you’ve already run an
analysis with G included and this preliminary test of the effect of G was not significant at the α
= .25 level, and you have prior reason to believe that the things you’re pooling over reflect only
chance variability (in this case, that you have prior reason to think that groups don’t differ sys-
tematically).
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As Myers & Well (1995, p. 339) put it, ‘wishing some variance component [e.g. G] to be zero
does not make it so, and the price of wrongly assuming that the component is zero is ordinarily
a Type 1 error in testing treatment effects of interest [i.e. declaring the effect of A to be signifi-
cant when it isn’t].

If you can’t legitimately pool, then you need to have a high value of g (many groups), so you
get high dfG/A and therefore low MSG/A, and therefore good power to detect effects of A (which
uses MSG/A as its error term). This should be fairly obvious, although many people fail to real-
ize it: if one primary school class is taught using one method and another is taught using another
method, is a difference in class means due to different methods (A) or to difference in the per-
sonal interactions within the two classes (G)? They’re confounded.

7.18.2. Groups versus individuals

If you need to compare the effects of being in a group (‘group’ condition) to the ef-
fect of not being in a group (‘individual’ condition), there is a special analytical
technique (Myers & Well, 1995, pp. 327-9). For example, if 15 students study a
topic individually, while another 15 students study the topic in five discussion
groups of three, you can analyse the effect of being in a group. This is a fairly com-
mon problem in social psychology.

7.18.3. Adding a further within-group, between-subjects variable (S/GB/A)

Example Subjects (S) are part of groups (G). Within each group, subjects are either anxious or not (anxi-
ety: B). Sets of groups are given different treatments (A). So G is crossed with B (all groups
have anxious and non-anxious subjects; anxious and non-anxious subjects are found in all
groups) but subjects are nested within GB (a subject is only part of one group and is either anx-
ious or not) and groups are nested within treatments. The model can be written S/GB/A (or
S/BG/A).

Model An individual score might be represented as Yijkl, where

i = 1, 2, … a (number of A treatment levels)
j = 1, 2, … b (number of B levels within a group, or within a treatment level)
k = 1, 2, … g (number of groups within a treatment level)
l = 1, 2, … n (number of subjects in a group)

Then

ijklikjijjijiijkY εγβαββγαµ ++++++= //

There are no interactions involving subjects (because subjects cross with none of the other three
variables: one subject only ever experiences one level of G, B, and A). G does not cross with A,
so there is no AG or ABG term.

Sources of variance Subject and group are random factors; A and B are fixed factors. We’d write the model like this:

SStotal = SSbetween-groups + SSwithin-groups

SSbetween-groups = SSA + SSG/A

SSwithin-groups = SSB + SSAB + SSGB/A + SSS/GB/A

so
SStotal = SSA + SSG/A + SSB + SSAB + SSGB/A + SSS/GB/A

We would state G/A as ‘group within A’, and S/G/A as ‘subject within group within A’, or
simply ‘subject within group’. Similarly,

dftotal = dfA + dfG/A + dfB + dfAB + dfGB/A + dfS/GB/A
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ANOVA table Source                                           d.f.                                     SS                    F                      
Between G: ag–1

A a–1 SSA MSA/MSG/A

G/A a(g–1) SSG/A

Within G: ag(bn–1)
B b–1 SSB MSA/MSGB/A

AB (a–1)(b–1) SSAB MSAB/MSGB/A

GB/A a(g–1)(b–1) SSGB/A MSGB/A/MSS/GB/A

S/GB/A gba(n–1) SSS/GB/A

Total N–1 = agbn – 1 SStotal

where N is the total number of observations and a, g, and n are as defined above. Note that the
error term for A is G/A, and the error term for G/A is S/G/A.

SPSS technique A          G         B          Subject      depvar
1 1 1 1 datum
1 1 1 2 datum
1 1 2 3 datum
1 1 2 4 datum
1 2 1 5 datum
1 2 1 6 datum
1 2 2 7 datum
1 2 2 8 datum
2 3 1 9 datum
2 3 1 10 datum
2 3 2 11 datum
2 3 2 12 datum
2 4 1 13 datum
2 4 1 14 datum
2 4 2 15 datum
2 4 2 16 datum
…

See the notes about group coding above.

GLM depvar BY a g b subject
  /RANDOM = g subject
  /DESIGN = a g(a)
            b a*b g*b(a) subject(g*b(a)) .

That seems to work (Myers & Well, 1995, p. 332, but note their typo for the F value for the
effect of B).

7.18.4. Adding a within-subjects variable (US/GB/A)

Example We take the previous model to begin with: subjects (S) are part of groups (G). Within each
group, subjects are either anxious or not (anxiety: B). Sets of groups are given different treat-
ments (A). Now we measure each subject four times (trial: U). U is crossed with S (since every
subject experiences all four trials). So our design can be written US/GB/A (Myers & Well,
1995, p. 333).

Model See sources of variance below, which follow directly from the model and are easier to grasp.

Sources of variance The previous model describes the between-subjects variability. We just need to add within-
subjects terms — U, and the interaction of U with each of the between-subjects sources from
the last model:

SStotal = SSbetween-groups + SSwithin-groups

SSbetween-groups = SSA + SSG/A

SSwithin-groups = SSwithin-groups-between-subjects + SSwithin-subjects

SSwithin-groups-between-subjects = SSB + SSAB + SSGB/A
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SSwithin-subjects = SSU + SSUA + SSUG/A + SSUB + SSUAB + SSUGB/A + SSUS/GB/A

ANOVA table We have g groups at each of a levels of A. Within each group, there are b levels of B and n
subjects at each of those levels. So we have bn subjects in each of ag groups, for a total of agbn
subjects. Each subject provides one score at u levels of U — agbnu scores in all.

Source                                           d.f.                                     SS                    F                      
Between G: ag–1

A a–1 SSA MSA/MSG/A

G/A a(g–1) SSG/A

Within G, between S: ag(bn–1)
B b–1 SSB MSA/MSGB/A

AB (a–1)(b–1) SSAB MSAB/MSGB/A

GB/A a(g–1)(b–1) SSGB/A MSGB/A/MSS/GB/A

S/GB/A gba(n–1) SSS/GB/A

Within S: agbn(u–1)
U u–1 SSU MSU/MSUG/A

UA (u–1)(a–1) SSUA MSUA/MSUG/A

UG/A (u–1)a(g–1) SSUG/A MSUG/A/MSUGB/A

UB (u–1)(b–1) SSUB MSUB/MSUGB/A

UAB (u–1)(a–1)(b–1) SSUAB MSUAB/MSUGB/A

UGB/A (u–1)a(g–1)(b–1) SSUGB/A MSUGB/A/MSUS/GB/A

US/GB/A (u–1)gba(n–1) SSUS/GB/A

Total N–1 = agbnu – 1 SStotal

Top tip: to check your df add up to the total, it’s quick to use Mathematica®. For example, Sim-
plify[(u-1) + (u-1)(a-1) + (u-1)a(g-1) + (u-1)(b-1) + (u-1)(a-1)(b-1) + (u-

1)a(g-1)(b-1) + (u-1)g*b*a(n-1)] gives a b g n (-1 + u). When you really can’t work
out the appropriate error terms, you can enter the model into SPSS and see what it used.

SPSS technique A          G         B          Subject      U         depvar
1 1 1 1 1 datum
1 1 1 1 2 datum
1 1 1 1 3 datum
1 1 1 1 4 datum
1 1 1 2 1 datum
1 1 1 2 2 datum
1 1 1 2 3 datum
1 1 1 2 4 datum
1 1 2 3 1 datum

… and so on. Just the same as the previous example but with the new U column.

See the notes about group coding above.

GLM depvar BY a g b subject u
  /RANDOM = g subject
  /DESIGN = a g(a)
            b a*b g*b(a) subject(g*b(a))
            u u*a u*g(a) u*b u*a*b u*g*b(a) u*subject(g*b(a)) .

7.18.5. Nesting within-subjects variables, such as V/US/A

Example We have five experienced subjects and five novice subjects (factor A for experience; between-
subjects factor; fixed factor; a = 2; n = 5; total of an = 10 subjects). Every subject is required to
solve 12 problems, of which 4 are easy, 4 are of intermediate difficulty, and 4 are hard (factor U
for difficulty; factor V for problem; u = 3; v = 4). This is almost the same as a one between,
two within design except that V is nested within U, not crossed with it (Myers & Well, 1995, p.
334-338).

Model See sources of variance below, which follow directly from the model and are easier to grasp.

Sources of variance We start by partitioning into between-subjects and within-subjects variability:
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SStotal = SSbetween-subjects + SSwithin-subjects

SSbetween-subjects = SSA + SSS/A

To partition the within-subjects variability, we can first view the design as involving uv levels
of ‘stimuli’. That is, in general, we begin partitioning within-subjects variability by using our
smallest experimental units. We also cross stimuli with all the between-subject sources:

SSwithin-subjects = SSstimuli + SSstimuli × A + SSstimuli × S/A

We now partition the variability due to stimuli and its interactions:

SSstimuli = SSU + SSV/U

… and cross those with A and S/A in turn:

SSstimuli × A = SSAU + SSAV/U

SSstimuli × S/A = SSSU/A + SSSV/AU

We can partition the df in the same way. Actual values for the dfs are in square brackets:

dftotal [abcn–1] = dfbetween-subjects [an–1] + dfwithin-subjects [an(uv–1)]
dfbetween-subjects = dfA [a–1] + dfS/A [a(n–1)]
dfwithin-subjects = dfstimuli [uv–1] + dfstimuli × A [(a–1)(uv–1)] + dfstimuli × S/A [a(n–1)(uv–1)]

dfstimuli = dfU [u–1] + dfV/U [u(v–1)]
dfstimuli × A = dfAU [(a–1)(u–1)] + dfAV/U [u(a–1)(v–1)]
dfstimuli × S/A = dfSU/A [a(n–1)(u–1)] + dfSV/AU [au(n–1)(v–1)]

A way of checking the design is to list all factors, random and fixed, noting any nesting. We
have four: A, S/A, U, V/U. Now we consider all possible cross products of these factors. We
write ‘no’ next to them if it’s not legitimate to cross them — for example, if S is nested in A, it
cannot also cross with it.

A × S/A No
A × U AU
A × V/U AV/U
S/A × U SU/A
S/A × V/U SV/AU
C × V/U No

The four factors we started with plus the four cross-products generated above are the terms of
interest. We should also consider crossing more than two factors, but in this design no legiti-
mate terms would turn up (for example, A × U × V/U is not legitimate because V cannot be
nested within U and still cross with it). Once we’ve specified our factors, we can enter them into
SPSS’s design syntax.

ANOVA table Source                                           d.f.                                     SS                    F                      
Between S: an–1

A a–1 SSA MSA/MSS/A

S/A a(n–1) SSS/A MSS/A/MSSU/A

Within S: an(uv–1)
U u–1 SSU MSU/MSSU/A

AU (a–1)(u–1) SSAU MSAU/MSSU/A

V/U u(v–1) SSV/U MSV/U/MSSV/AU

AV/U u(a–1)(v–1) SSAV/U MSAV/U/MSSV/AU

SU/A a(n–1)(u–1) SSSU/A MSSU/A/MSSV/AU

SV/AU au(n–1)(v–1) SSSV/AU

Total N–1 = abcn–1 SStotal

The F ratios depend on which factors are treated as fixed and which as random (because that
determines the EMS values); the ratios presented above are for when S is random and A, V, and
U are all fixed. Actually, our example suggests that V, which we write in full as V/U (‘specific
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problem of a certain difficulty’) should be random; in that situation, the appropriate error term
must be synthesized as a linear combination of other terms. It seems that SPSS and BDMP8V
do this in slightly different ways (Myers & Well, 1995, p. 337, versus SPSS analysis of the
same data).

SPSS technique A          Subject      U         V                depvar
1 1 1 1 datum
1 1 1 2 datum
1 1 1 3 datum
1 1 1 4 datum
1 1 2 1 datum
1 1 2 2 datum
1 1 2 3 datum
1 1 2 4 datum
1 1 3 1 datum
1 1 3 2 datum
1 1 3 3 datum
1 1 3 4 datum
1 2 1 1 datum
1 2 1 2 datum
1 2 2 3 datum
1 2 2 4 datum
…
2 6 1 1 datum
2 6 1 2 datum
2 6 1 3 datum
2 6 1 4 datum
…

GLM depvar BY a subject u v
  /RANDOM = subject
  /DESIGN = a subject(a)
            u v(u) a*u a*v(u) subject*u(a) subject*v(a*u) .

If V is a random factor too, you’d want /RANDOM = subject v, and so on.

7.18.6. The split-split plot design

Alternative names • Split-split plot, completely randomized design
• Pretty awful

Example (1) An agricultural example (Winer et al., 1991, pp. 368-9). An orchard is divided into plots.
Each level of factor A is assigned at random to n plots, so there are an plots in total. Each
of the plots is then divided into b subplots, and the b levels of factor B are assigned to them
at random. Finally, each of the subplots is divided into c sub-subplots, and the c levels of
factor C are assigned to them at random. Thus the experimental unit for A is the whole plot,
the experimental unit for B is the subplot, and the experimental unit for C is the sub-
subplot.

Since the sub-subplots are nested within the subplots, and the subplots are nested within the
whole plots, factor C is nested under the subplots and factor B is nested under the whole
plots. Factor A is partially confounded with groups of whole plots.

(2) A rat example. Rats are implanted with dialysis probes in either the medial prefrontal cor-
tex (A1) or orbitofrontal cortex (A2). They are then assigned to triplets. One rat in each
triplet chooses between two levers offering alternative reinforcers in a task (B1). Another
(B2) is offered only the lever chosen by the master rat. A third (B3) is given the reinforcer
chosen by the master rat, without any opportunity to press a lever. Finally, all rats are dial-
ysed at five time points (C1…C5).

Data from different levels of factor A (probe site) are unrelated. Data from different levels
of factor B (choice type) may be related to each other, because they all come from the same
triplet. Data from different levels of factor C (time) may be related to each other, because
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they all come from the same rat. However, we cannot wholly distinguish rat individuality
from the effects of choice type.

This design is equivalent to the agricultural one: Triplet ≡ Plot, and Rat ≡ Subplot. As be-
fore, A (lesion) is the whole-plot factor (a triplet either gets medial prefrontal or orbito-
frontal probes), B (choice type) is the subplot factor (within a triplet, a rat is either a master,
lever-yoked or reinforcer-yoked rat), and C (time) is the sub-subplot factor (every rat gets
dialysed at five time points, so the ‘sub-subplot’ is the combination of a particular rat at a
particular time).

Model ijkmijkmijkikikkijmijjimiijkmY επαβγβγαγγπαββπαµ +′′+++++′+++++= )()()(

where
• Yijkm is the value of an observation in condition Ai, plotm, Bj, and Ck

• µ is the grand mean
• αi is the contribution of Ai

• βj is the contribution of Bj

• γk is the contribution of Ck

• αβij, αγik, βγjk and is the contribution of the AiBj, AiCk, and BjCk interactions, respectively
• )(imπ  is the contribution of plot m (which only ever experiences Ai)

• )(ijmπ ′  is the contribution of the subplot in plot m that experiences AiBj

• )(ijkmπ ′′  is the contribution of the sub-subplot in plot m that experiences AiBjCk

• εijkm is everything else (error)

Sources of variance For our rat example, we’d call triplet ‘plot’ and rat ‘subplot’ (and consider them as random
factors, while the others are fixed factors). We’d write the model like this:

SStotal = SSbetween-plots + SSwithin-plots

SSbetween-plots = SSA + SSplot×A

SSwithin-plots = SSbetween-subplots-within-plots + SSwithin-subplots

SSbetween-subplots-within-plots = SSB + SSB×A + SSB×plot/A

SSwithin-subplots = SSC + SSC×A + SSC×B + SSC×A×B + SSwithin-subplot error C×plot/AB

ANOVA table Source                                           d.f.                                     SS                    F                      
Between plots: an–1

A a–1 SSA MSA/MSplot×A

error plot × A a(n–1) SSplot×A

(‘whole-plot residual’)

Within plots, between subplots:an(b–1)
B b–1 SSB MSB/MSB×plot/A

B × A (b–1)(a–1) SSA×B MSA×B/MSB×plot/A

error B × plot/A a(b–1)(n–1) SSB×plot/A

(‘subplot residual’)

Within subplots: abn(c–1)
C c–1 SSC MSC/MSC×plot/AB

C × A (c–1)(a–1) SSC×A MSC×A/MSC×plot/AB

C × B (c–1)(b–1) SSC×B MSC×B/MSC×plot/AB

C × A × B (c–1)(a–1)(b–1) SSC×A×B MSC×A×B/MSC×plot/AB

error C × plot/AB ab(c–1)(n–1) SSC×plot/AB

(‘sub-subplot residual’)

Total N–1 = abcn – 1 SStotal

where a is the number of levels of factor A, etc., N is the total number of observations (= abcn),
and n is the number of subjects. The F ratios above assume that Plot is random and A, B, C are
fixed.

For the rat example, simply read ‘triplet’ instead of ‘plot’ and ‘rat’ instead of ‘subplot’.
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Result! Agrees with Winer (1991, p. 369, although there are typos in his ANOVA table; ‘within
sub-subplots’ is certainly a mistake).

SPSS technique A          Plot           B          C          depvar
1 1 1 1 datum
1 1 1 2 datum
1 1 1 3 datum
1 1 1 4 datum
1 1 1 5 datum
1 1 2 1 datum
1 1 2 2 datum
1 1 2 3 datum
1 1 2 4 datum
1 1 2 5 datum
1 1 3 1 datum
1 1 3 2 datum
1 1 3 3 datum
1 1 3 4 datum
1 1 3 5 datum
1 2 1 1 datum
1 2 1 2 datum
1 2 1 3 datum
1 2 1 4 datum
1 2 1 5 datum
…
2 8 1 1 datum
2 8 1 2 datum
2 8 1 3 datum
2 8 1 4 datum
2 8 1 5 datum
…

It doesn’t matter whether you specify unique labels for nested factors or not — what I mean by
this is that you can code ‘plot’ from 1, 2… for the A1 condition and carry on counting (8, 9, …)
for the A2 condition, or you can start numbering ‘plot’ from 1 again in the A2 condition. Since
the design ‘knows’ that plot is nested within A (one plot only gets one level of A), it won’t get
confused.

GLM depvar BY plot a b c
  /RANDOM = plot
  /DESIGN = a plot*a
            b b*a b*plot(a)
            c c*a c*b c*a*b .

Top tip: when faking data to analyse complex models, ensure that you don’t over- or under-
specify your model! MRFA pointed out that I had been stupid in my initial attempt at this exam-
ple, which included a ‘rat’ (subplot) term: because a triplet × B [choicetype] combination
uniquely specifies a rat in this example, there’s no ‘room’ in the design for a ‘rat’ term.

7.18.7. Three levels of relatedness

Alternative names • Split-split plot, randomized complete block (RCB) design
• Horrendous

Examples (1) The standard agricultural example: a randomized complete block design (RCBD) with
blocks (also known as replicates), plots (A), subplots (B), and sub-sub-plots (C). Suppose
A has two levels, B has two levels, and C has three levels. This would be a description of a
field laid out like this:
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Compare the RCB three-factor agricultural design illustrated in our consideration of the
three-within-subject-factor design (U × V × W × S) (p. 118). ‘Similarity’ or ‘relatedness’ in
agriculture often refers to geographical nearness; in the (U × V × W × S) design discussed
earlier, adjacent mini-plots of land were likely to be similar by virtue of coming from the
same block, but there was no other consistent relationship between geographical nearness
and the factors U, V, or W. This design is a bit different. You can see here that two adjacent
individual experimental units (the sub-sub-plots) are most likely be related by virtue of
coming from the same Block, quite likely to be related by virtue of having the same value
of the A factor, not quite as likely to be related on the B factor, and least likely to be related
on the C factor.

Another way of putting it: blocks are crossed with A (all blocks experience all levels of A).
Plots are nested within A (one plot only gets one level of A). Plots are crossed with B (all
plots experience all levels of B). Subplots are nested within B (one subplot only gets one
level of B). Sub-subplots are nested within C (one sub-subplot only experiences one level
of C).

(2) Another agricultural example (Prescott et al., 1999). Four blocks were used, spread across a
forest (top-level factor: Block); the experiment was replicated across these blocks. Each
block was divided into four plots, which were each fertilized with a different fertilizer, as-
signed to the plots at random. Small bags of leaf litter are placed in these plots (litter
placement factor, or ‘fertilizer that the litter is placed in’: A1, A2, A3, A4). The bags them-
selves came either from the same plot or one of the other three plots in the same block (lit-
ter source factor, or ‘fertilizer that the litter came from’: B1, B2, B3, B4). The litter mass is
then measured at different time points (C1…C5).

Notes • This is different to a split-split plot design based on a completely randomized design
(CRD), which doesn’t have the ‘block’ factor.

• See www.ndsu.nodak.edu/ndsu/horsley/spspplot.pdf, the only worked example I’ve been
able to find. That also says:

‘The split-split plot arrangement is especially suited for three-or-more-factor experiments
where different levels of precision are required for the factors evaluated. Three plot sizes
correspond to the three factors: the largest plot for the main factor, the intermediate size plot
for the subplot factor, and the smallest plot for the sub-subplot factor. There are three levels
of precision with the main plot factor receiving the lowest precision, and the sub-subplot
factor receiving the highest precision.’

Sources of variance Let’s call blocks (replicates) R, the plot treatment A, the subplot treatment B, and the sub-
subplot treatment C. Replicate will be a random factor; the others will be fixed. We’d write the
model like this:

SStotal = SSbetween-replicates + SSwithin-replicates
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SSbetween-replicates = SSR

SSwithin-replicates = SSbetween-plots-within-replicates + SSwithin-plots

SSbetween-plots-within-replicates = SSA + SSR×A

SSwithin-plots = SSbetween-subplots-within-plots + SSwithin-subplots

SSbetween-subplots-within-plots = SSB + SSB×A + SSR×B/A

SSwithin-subplots = SSC + SSC×A + SSC×B + SSC×A×B + SSwithin-subplot-error C×R/AB

ANOVA table Source                                           df                                       SS                    F                      
Between replicates (R):

R r–1 SSR MSR/MSR×A

Within replicates, between plots:
A a–1 SSA MSA/MSR×A

error R × A (r–1)(a–1) SSR×A

Within plots, between subplots:
B b–1 SSB MSB/MSR×B/A

B × A (b–1)(a–1) SSB×A MSB×A/MSR×B/A

error R × B/A a(r–1)(b–1) SSR×B/A

Within subplots:
C c–1 SSC MSC/MSR×C/AB

C × A (c–1)(a–1) SSC×A MSC×A/MSR×C/AB

C × B (c–1)(b–1) SSC×B MSC×B/MSR×C/AB

C × A × B (c–1)(a–1)(b–1) SSC×A×B MSC×A×B/MSR×C/AB

error R × C/AB  ab(r–1)(c–1) SSR×C/AB

Total rabc–1 SStotal

SPSS technique Rep      A          B          C         depvar
1 1 1 1 datum
1 1 1 2 datum
1 1 1 3 datum
1 1 2 1 datum
1 1 2 2 datum
1 1 2 3 datum
1 2 1 1 datum
1 2 1 2 datum
1 2 1 3 datum
1 2 2 1 datum
1 2 2 2 datum
1 2 2 3 datum
2 1 1 1 datum
2 1 1 2 datum
…

You don’t even need explicit ‘plot’, ‘subplot’, or ‘sub-subplot’ labels; all that information is
contained in the design and the A/B/C factor labels.

GLM depvar BY r a b c
  /RANDOM = r
  /DESIGN = r a r*a
            b b*a b*r(a)
            c c*a c*b c*a*b .
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7.19 Latin square designs

There are two approaches to Latin squares. One (the simplest) is to use a Latin
square as an experimental design technique to ensure that some factor (e.g. time,
order) is not confounded with experimental treatments. The other (more advanced
but far preferable) is to do this, but also to use information about this factor (e.g.
time, order) in the analysis — to take account of variability attributable to this factor
to reduce the error variability and increase the power to detect effects of the treat-
ment of interest. This can be much more complicated than I first thought!

For this section, I will abandon my previous convention of A, B… representing be-
tween-subjects factors and U, V… representing within-subjects factors, because this
makes it easier to compare complex designs to the original sources.

7.19.1. Latin squares in experimental design

Here’s an example of the ‘novice’ (experimental design only) approach that I’ve
used (e.g. Cardinal et al., 2003). Rats had intracranial cannulae implanted in their
nucleus accumbens. They responded on a lever that delivered a stimulus previously
paired with reinforcement (a conditioned reinforcer). Before the session, they were
given intra-accumbens amphetamine at one of four doses (0, 3, 10, 20 µg per hemi-
sphere). As I put it:

Doses were counterbalanced in a Latin square design to eliminate differential
carryover effects and separated by 24 h. The Latin square was of a digram-
balanced design (Keppel, 1991, p. 339), in which each condition immediately
precedes and follows the other conditions once (e.g. 1234, 3142, 2413, 4321).

What I meant was that if ‘1’ represents one dose (0 µg), ‘2’ represents the second,
‘3’ the third, and ‘4’ the fourth, the design looked like this:

Day 1 Day 2 Day 3 Day 4
Pattern 1 1 2 3 4
Pattern 2 3 1 4 2
Pattern 3 2 4 1 3
Pattern 4 4 3 2 1

There were more than 4 subjects, so I allocated them to the four patterns at random.
The idea is that the order of treatments 1–4 was counterbalanced appropriately. The
square is a Latin square — an n by n grid containing the numbers 1 to n arranged in
such a way that no row and no column contains the same number twice. If I had
given all the subjects the treatments in the order 4, 3, 2, 1, and I found that treatment
4 gave higher responding than treatment 1, I wouldn’t know if that was due to the
difference in drug doses or the fact that with time, responding declines generally
(extinction), or some other effect left over from the previous day’s dose. So the
Latin square counterbalances for order. There are good and bad Latin squares. The
one above is ‘digram-balanced’, which is good — every condition immediately
precedes and follows the other conditions once. The one below is cyclic, which isn’t
so good:

Day 1 Day 2 Day 3 Day 4
Pattern 1 1 2 3 4
Pattern 2 2 3 4 1
Pattern 3 3 4 1 2
Pattern 4 4 1 2 3

because in this design dose 1 is nearly always preceded by dose 4, and nearly always
followed by dose 4 — clearly not as good as the digram-balanced one. The digram-
balanced version controls for sequence effects better. However, digram balancing
can only be done if there is an even number of treatment conditions (Keppel, 1991,
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p. 339). Otherwise, there are procedures for selecting a random Latin square (Winer
et al., 1991, p. 674; Myers & Well, 1995, p. 346).

Anyway, back to the example. When I analysed these data, I ignored the ‘day’ fac-
tor. I simply took all the ‘dose 1’ scores, all the ‘dose 2’ scores, and so on, and en-
tered the data with a within-subjects factor of Dose. This wasn’t optimal — I could
have used information about the Day factor as well. That could be more efficient
(Myers & Well, 1995, p. 351), because it would remove variability attributable to
Days to give better power to detect effects of Dose. Let’s see how that can be done.

7.19.2. The analysis of a basic Latin square

Example We test five monkeys (Myers & Well, 1995, p. 344) on discrimination learning under five dif-
ferent drug doses on five different test days. We use this Latin square (S = subject = R = row, C
= column = day in this example, A = drug dose).

C1 C2 C3 C4 C5

S1 A1 A2 A4 A3 A5

S2 A3 A1 A5 A2 A4

S3 A4 A3 A1 A5 A2

S4 A2 A5 A3 A4 A1

S5 A5 A4 A2 A1 A3

Notes See Myers & Well (1995, chapter 11); Winer (1991, chapter 11).

The Latin square analysis is potentially more efficient than the simple within-subjects analysis
(ignoring Day) for the following reasons (Myers & Well, 1995, p. 351). The error term for the
within-subjects (A × S) analysis, MSS×A, will be larger than the error term for the Latin square
analysis as long as MSC is larger than the Latin-square error term MSerror. However, the Latin
square error term has fewer df, which reduces power. The relative contribution of the two ef-
fects can be calculated (Myers & Well, 1995, pp. 351-2).

When using Latin squares to counterbalance for order, it is vital that the position in the order
(Day, in the example) does not interact with the treatment (Drug, in the example) (Keppel,
1991, p. 336-9; Winer et al., 1991, p. 682). If one dose has a different effect when it’s given
first in the order to when it’s given third in the order, we’d have to be very careful of the inter-
pretation. It’s worth plotting treatment means against order to check this assumption. If the
effect of different doses reverses on different days, it’s very hard to analyse or interpret
(Keppel, 1991, p. 338) and we may be reduced to analysing only the data from the first test,
which is uncontaminated by any prior effects, but which may have rather low statistical power.

We’ve seen that one major use of Latin squares is to counterbalance order effects, as shown
here. But they have other uses. Latin squares were first used in agriculture to control for two
nuisance variables (assigned to the rows and columns, with the assumption that the treatment
effects do not interact with the row and column effects) (Winer et al., 1991, p. 680). They may
be extended to deal with three nuisance variables using a Greco–Latin (Graeco–Latin) square, in
which two orthogonal Latin squares (Winer et al., 1991, p. 674) are used; one is given Greek
letters, the other Roman (Latin) letters, and the two are superimposed (Winer et al., 1991, pp.
680-1). This principle can be extended to four or more nuisance variables. It’s also possible to
use Latin squares to extract partial information from confounded factorial designs (Winer et
al., 1991, p. 682). Latin squares are a special case of fractional factorial designs (Winer et al.,
1991, pp. 585, 683), in which not all the treatment conditions of a factorial design are examined
(see also GLM notes about fractional factorial designs, p. 88→).

Model An additive model assumes that main effects are additive, and don’t interact — i.e. that the A
and C do not interact. The model is:

ijkkjiijkY εγαηµ ++++=

where µ  is the grand mean, iη  is the effect of row i (in this example, subject Si), jα  is the
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effect of treatment Aj, and kγ  is the effect of column k (in this example, day k).

Sources of variance For this additive model, SStotal = SSrow + SScolumn + SSA + SSerror

ANOVA table Since the number of rows, columns, and treatments is the same,

Source                         d.f.                                     SS                    F                      
Row (subject) a–1 SSR MSR/MSerror

Column a–1 SSC MSC/MSerror

A a–1 SSA MSA/MSerror

Error (a–1)(a–2) SSerror

Total N–1 = a2–1 SStotal

SPSS technique Data layout:

S    C   A    depvar
1 1 1 datum
1 2 2 datum
1 3 4 datum
1 4 3 datum
1 5 5 datum
2 1 3 datum
2 2 1 datum
2 3 5 datum
2 4 2 datum
2 5 4 datum
…

Syntax:

UNIANOVA
  depvar BY s c a
  /RANDOM = s
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = s c a .

If C is a random factor, simply add it to the /RANDOM list. In general, substitute Row for Subject
for any suitable Latin square.

Missing values If we assume the additive model, then it’s possible to estimate missing scores (Myers & Well,
1995, p. 352) to allow analysis. Of course, our error df are reduced when we do that.

Nonadditive model If the additivity assumption (above) isn’t realistic, you can use a nonadditive model. The full
model adds in the S × C, S × A, A × C, and S × C × A terms. However, it is what we might call
very complex indeed (Myers & Well, 1995, pp. 352-356); I certainly don’t understand it.
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7.19.3. A ×××× B interactions in a single Latin square

Example We assign not only an A treatment but also a B treatment to each cell of the Latin square. This
can be analysed provided that all possible AB combinations appear exactly once in each row
and column. For example (Myers & Well, 1995, pp. 356-7):

C1 C2 C3 C4

S1 A1B2 A2B1 A1B1 A2B2

S2 A2B1 A2B2 A1B2 A1B1

S3 A2B2 A1B1 A2B1 A1B2

S4 A1B1 A1B2 A2B2 A2B1

Notes

Model ijkmmjkkjiijkmY εγαββαηµ ++++++=

where µ  is the grand mean, iη  is the effect of row i (in this example, subject Si), jα  is the

effect of treatment Aj, kβ  is the effect of treatment Bk, jkαβ  is the A × B interaction, and mγ  is

the effect of column m.

Sources of variance SStotal = SSrow + SScolumn + SSA + SSB + SSAB + SSerror

ANOVA table Since the number of rows, columns, and AB conditions is the same,

Source                         d.f.                                     SS                    F                      
Row (subject) ab–1 SSR MSR/MSerror

Column ab–1 SSC MSC/MSerror

A a–1 SSA MSA/MSerror

B b–1 SSB MSB/MSerror

A × B (a–1)(b–1) SSAB MSAB/MSerror

Error (a–1)(a–2) SSerror

Total N–1 = (ab)2–1 SStotal

SPSS technique Data layout:

S    C   A    B    depvar
1 1 1 2 datum
1 2 2 1 datum
1 3 1 1 datum
1 4 2 2 datum
2 1 2 1 datum
2 2 2 2 datum
2 3 1 2 datum
2 4 1 1 datum
…

Syntax:

UNIANOVA
  depvar BY s c a b
  /RANDOM = s
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = s c a b a*b .

If C is a random factor, simply add it to the /RANDOM list.
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7.19.4. More subjects than rows: (a) using several squares

Example In the first example above, we had five treatments and were therefore limited to five rows (sub-
jects). If we want to run more subjects, which will increase power, one way is to use several
different squares. This approach has an advantage: if there are interactions with order, using
several different squares increases the chance that positive and negative interaction effects will
cancel each other. Suppose (Myers & Well, 1995, p. 357) we have 12 subjects being tested on
four tasks (A1–A4) requiring different types of motor skill. Each task is performed on a different
day (C). Three 4 × 4 Latin squares are constructed (see Myers & Well, 1995, pp. 346-348), and
subjects are assigned at random to the 12 rows. The design looks like this:

Square
C1 C2 C3 C4

S1 A1 A3 A4 A2

Q1 S2 A3 A4 A2 A1

S3 A4 A2 A1 A3

S4 A2 A1 A3 A4

C1 C2 C3 C4

S5 A2 A1 A3 A4

Q2 S6 A4 A3 A1 A2

S7 A3 A2 A4 A1

S8 A1 A4 A2 A3

C1 C2 C3 C4

S9 A2 A1 A4 A3

Q3 S10 A1 A2 A3 A4

S11 A4 A3 A1 A2

S12 A3 A4 A2 A1

Notes Subjects (S) are nested within squares (Q). We assume that S and Q are random factors, while A
and C are fixed.

Model Either this model:

ijkmkmjmmkjmiijkmY εγπαππγαηµ +++++++= /

where µ  is the grand mean, mi /η  is the effect of subject i (within square m), jα  is the effect of

Aj, kγ  is the effect of column k, jmαπ  allows for the possibility that treatment effects depend

on the square (AQ interaction), and kmγπ  allows for the possibility that column effects depend

on the square (CQ interaction)…

… or, if the full model produces no evidence for AQ or CQ interactions, this reduced model,
which pools the AQ and CQ terms into the error term to increase power:

ijkmmkjmiijkmY επγαηµ +++++= /

Sources of variance Either this (for the first model):

SStotal = SSS/Q + SSA + SSC + SSQ + SSAQ + SSCQ + SSerror

or this (for the reduced model):

SStotal = SSS/Q + SSA + SSC + SSQ + SSerror

ANOVA table For the full model:

Source                         d.f.                                     SS                    F                      
Squares (Q) q–1 SSQ MSQ/MSS/Q

S/Q q(a–1) SSS/Q MSS/Q/MSerror

C a–1 SSC MSC/MSerror

A a–1 SSA MSA/MSerror
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C × Q (a–1)(q–1) SSCQ MSCQ/MSerror

A × Q (a–1)(q–1) SSAQ MSAQ/MSerror

Error q(a–1)(a–2) SSerror

Total N–1 = qa2–1 SStotal

For the reduced model:

Source                         d.f.                                     SS                    F                      
Squares (Q) q–1 SSQ MSQ/MSS/Q

S/Q q(a–1) SSS/Q MSS/Q/MSerror

C a–1 SSC MSC/MSerror

A a–1 SSA MSA/MSerror

Error (qa–2)(a–1) SSerror

Total N–1 = qa2–1 SStotal

SPSS technique Data layout:

Q   S    C   A    depvar
1 1 1 1 datum
1 1 2 3 datum
1 1 3 4 datum
1 1 4 2 datum
1 2 1 3 datum
1 2 2 4 datum
1 2 3 2 datum
1 2 4 1 datum
…
2 5 1 2 datum
2 5 2 1 datum
2 5 3 3 datum
2 5 4 4 datum
…

Syntax for the full model:

UNIANOVA
  depvar BY q c a s
  /RANDOM = s q
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = q s(q) c a c*q a*q .

For the reduced model:

UNIANOVA
  depvar BY q c a s
  /RANDOM = s q
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = q s(q) c a .
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7.19.5. More subjects than rows: (b) using the same square several times (replicating a single Latin square)

Example As above, but now you decide to use a single 4 × 4 square and assign n subjects to each row of
the square. If n = 3, your design might look like this:

Subjects C1 C2 C3 C4

S1, S2, S3 A2 A4 A3 A1

S4, S5, S6 A1 A3 A2 A4

S7, S8, S9 A4 A2 A1 A3

S10, S11, S12 A3 A1 A4 A2

Notes See Myers & Well (1995, pp. 364-368, 374-375), who point out that this design is frequently
used but frequently analysed improperly.

Should you use replicated squares, or several squares (as on p. 174)? Myers & Well (1995, p.
371) suggest that several squares is better — experimenters tend to replicate squares purely for
simplicity. Anyway, let’s see how you analyse replicated squares now.

Model This is the simple way:

ijkmkjmimijkmY εγαηπµ +++++= /

where µ  is the grand mean, mπ  is the effect of row m, mi /η  is the effect of subject i (within

row m), jα  is the effect of Aj, and kγ  is the effect of column k.

Sources of variance That would give these sources of variance:

SStotal = SSbetween-subjects + SSwithin-subjects

SSbetween-subjects = SSrow + SSsubjects-within-row(S/R)

SSwithin-subjects = SSA + SSC + SSA×S/R

Complicated bit However, there are some extra finesses: we can partition the data another way.

• There are a2 cell means in the Latin square. If you account for main effects of A, C, and R,
you’re left with what’s called the between-cells error or residual. It has (a2–1) – (a–1) – (a–
1) – (a–1) = (a–1)(a–2) df.

• Then you have the within-cells residual, which is equivalent to S × A (nested within R), or
S × C (nested within R), which are the same thing (since within one row, a subject’s level
of A completely determines its level of C). This has a(n–1)(a–1) df.

Now…
• Variation among row means (SSR) reflects different effects of A × C combinations. In other

words, if there is an A × C interaction, part of its effect will be reflected in MSR.
• Part of any A × C interaction effect will also be reflected in what’s left in the cell mean

variability after you’ve accounted for main effects of A, C, and R — the between-cells er-
ror (MSbce). So any A × C interaction would contribute to MSbce.

• So both MSR and MSbce partially reflect effects of A × C.

This picture would give this model:

ijkmjkkjmiijkmY εαγγαηµ +++++= /

and this partitioning:

SStotal = SSbetween-subjects + SSwithin-subjects

SSbetween-subjects = SSsubjects-within-row(S/R) + some-part-of-SSAC

SSwithin-subjects = SSA + SSC + some-part-of-SSAC + SSA×S/R

ANOVA table This is for the simple way of doing things:
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Source                         d.f.                                     SS                    F                      
R a–1 SSR MSQ/MSS/R

S/R n(a–1) SSS/R MSS/R/MSerror

C a–1 SSC MSC/MSerror

A a–1 SSA MSA/MSerror

Error (a–1)(an–2) SSerror

Total N–1 = na2–1 SStotal

This is for the complex way:

Source                         d.f.                                     SS                    F                      
R (AC′) a–1 SSR MSQ/MSS/R

S/R n(a–1) SSS/R MSS/R/MSwce

C a–1 SSC MSC/MSwce

A a–1 SSA MSA/MSwce

Between-cells error (a–1)(a–2) SSbce MSbce/MSwce

(AC′)
Within-cells error a(n–1)(a–1) SSwce

= S×A/R = S×C/R
Total N–1 = na2–1 SStotal

The rows labelled AC′ give estimates for the effect of the AC interaction, based on partial in-
formation. The between-cells error SSbce is calculated as SSRC – SSA (that is, calculate the row ×
column interaction and subtract SSA).

SPSS technique Data layout:

R    S    C   A    depvar
1 1 1 2 datum
1 1 2 3 datum
1 1 3 4 datum
1 1 4 1 datum
1 2 1 2 datum
1 2 2 3 datum
1 2 3 4 datum
1 2 4 1 datum
…
2 5 1 2 datum
2 5 2 1 datum
2 5 3 3 datum
2 5 4 4 datum
…

… simple but less
powerful way

Run this:

UNIANOVA
  depvar BY r c a s
  /RANDOM = s
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = r s(r) c a .

That’s it.

… complex and
more powerful way

This is pretty complicated. First, run this to get the R × C interaction sum of squares (all the
sums of squares are correct, but this is the only one you need).

UNIANOVA
  depvar BY r c s
  /RANDOM = s
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
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  /DESIGN = r s(r) c r*c .

Then, run this to get everything else. (This gives you correct answers for all sums of squares,
dfs, and MSs. But you can improve on the F ratios by using a different error term…)

UNIANOVA
  depvar BY r c a s
  /RANDOM = s
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = r s(r) c a .

Next, calculate

SSbetween-cells-error = SSR×C – SSA

SSwithin-cells-error = SSerror-from-second-ANOVA-in-which-A-was-included – SSbetween-cells-error

Calculate the corresponding MS by hand. The df for these error terms (which you need to work
out the MS) are in the ANOVA table above.

Finally, test MSC and MSA against MSwithin-cells-error by hand.

If you want, you can also test MSR (against MSS/R) and MSbetween-cells-error (against MSwithin-cells-

error) as estimates of the effect of the A × C interaction, based on partial information.

Complex caveat If C is a random, rather than a fixed factor (Myers & Well, 1995, pp. 366-7), things become
more complicated, since C should be tested against MSwce but A must be tested against MSbce,
but this has poor power; Myers & Well recommend that if the effect of MSbce isn’t significant
itself that you use MSwce or the pooled MSerror to test A and C.
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7.19.6. Between-subjects designs using Latin squares (fractional factorial designs)

Example Suppose (Winer et al., 1991, p. 687; Myers & Well, 1995, p. 372) we want to compare the ef-
fects of three teaching methods (A1–A3). To increase the power, we decide to block subjects on
the basis of previous experience with the subject (R) and on the basis of ability as measured by
a pretest (C). For this full-factorial design, we would need 3 × 3 × 3 = 27 cells with n subjects in
each. Instead, we reduce the labour by using a Latin-square design with only 9 cells: R would
be the rows, and C the columns. The design might look like this, with n subjects per cell:

C1 C2 C3

R1 A2 A3 A1

R2 A3 A1 A2

R3 A1 A2 A3

Notes This is very similar to the usual agricultural use of Latin squares.

See also Winer (1991, p. 687-691).

Model If it assumed that there are no interactions between R, C, and A:

ijkmmkjijkmY εγβαµ ++++=

where µ  is the grand mean, jα  is the effect of treatment Aj, kβ  is the effect of treatment Rk,

and mγ  is the effect of column m.

Sources of variance SStotal = SSA + SSR + SSC + SSbetween-cell-error + SSwithin-cell-residual

where SSbetween-cell-error includes all sources of variation due to treatment effects which are not
predictable from the sum of main effects (e.g. interactions… which you hope aren’t there; see
below).

ANOVA table Source                         d.f.                                     SS                    F                      
R a–1 SSR MSR/MSwce

C a–1 SSC MSC/MSwce

A a–1 SSA MSA/MSwce

Between-cells error (a–1)(a–2) SSbce MSbce/MSwce

Within-cells error a2(n–1) SSwce

= S/ABC
Total N–1 = na2–1 SStotal

The between-cells error SSbce is calculated as SSRC – SSA (that is, calculate the row × column
interaction and subtract SSA).

Caveat This model is appropriate if additivity can be assumed (if there are no interactions between R,
C, and A). And if so, SSbetween-cell-error will not be substantially larger than SSwce. One way to test
this (Winer et al., 1991, p. 687-8) is to look at the F test on MSbce. If it’s significant, then the
assumptions behind the model are not appropriate, and if this is not an appropriate model — if
there are interaction effects — then it’s very hard to analyse the data (Winer et al., 1991, p. 690;
Myers & Well, 1995, p. 373).

SPSS technique Data layout (with an unnecessary Subject column to make things clearer):

R    C   A    S          depvar
1 1 2 1 datum
1 1 2 2 datum
1 1 2 3 datum
1 1 2 4 datum
1 2 3 5 datum
1 2 3 6 datum
1 2 3 7 datum
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1 2 3 8 datum
…
2 1 3 13 datum
2 1 3 14 datum
2 1 3 15 datum
…

Run this:

UNIANOVA
  depvar BY r c a
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = r c a .

That gives you SSR, SSC, SSA, and SStotal. But to get SSbce and SSwce, you have to run this to
obtain SSRC:

UNIANOVA
  depvar BY r c
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = r c r*c .

Then calculate SSbce = SSRC – SSA and SSwce = SSerror-from-first-ANOVA-including-A-factor – SSbce by hand
and complete the ANOVA table.
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7.19.7. Several-squares design with a between-subjects factor

Example We saw how to use a design with several Latin squares above (p. 174). We had a within-
subjects factor A. Let’s add a between-subjects factor B with b levels. We have q squares per
level of B, and a subjects in each squares with a scores for each subject. If a = 4, b = 2 and q =
2, we might have this:

Square
C1 C2 C3 C4

S1 A4 A1 A3 A2

B1  Q1 S2 A3 A2 A4 A1

S3 A1 A3 A2 A4

S4 A2 A4 A1 A3

C1 C2 C3 C4

S5 A4 A3 A2 A1

B1 Q2 S6 A2 A1 A4 A3

S7 A1 A4 A3 A2

S8 A3 A2 A1 A4

C1 C2 C3 C4

S9 A1 A4 A3 A2

B2 Q3 S10 A3 A2 A4 A1

S11 A4 A1 A2 A3

S12 A2 A3 A1 A4

C1 C2 C3 C4

S13 A2 A1 A3 A4

B2 Q4 S14 A1 A2 A4 A3

S15 A4 A3 A2 A1

S16 A3 A4 A1 A2

This example based on Myers & Well (1995, p. 361), though their original has several numeri-
cal errors in their fourth square, which isn’t even Latin (some A values appear twice in a col-
umn).

Notes

Model ijkmpkmpkjpkmjkmjkpikpkijkmY εγπαπβγαβγαηπβµ ++++++++++= /////

where i index subjects (within squares within levels of B), j indexes the level of A, k indexes the
level of B, m indexes the level of C, and p indexes the square (within a level of B).

Subject and Square are assumed to be random; A, B, and C are assumed to be fixed effects.

Sources of variance I think it’s this (based on Myers & Well, 1995, p. 362):

SStotal = SSbetween-squares + SSwithin-squares

SSbetween-squares = SSB + SSQ/B

SSwithin-squares = SSbetween-subjects-within-squares + SSwithin-subjects

SSbetween-subjects-within-squares = SSS/Q/B

SSwithin-subjects = SSA + SSC + SSAB + SSBC + SSAQ/B + SSCQ/B + SSwithin-subject-error

We could also note that SSbetween-subjects = SSB + SSQ/B + SSS/Q/B (Myers & Well, 1995, p. 363).

But if p > .25 for the interaction terms AQ/B and CQ/B, it would be reasonable to pool those
error terms:

SSwithin-subjects = SSA + SSC + SSAB + SSBC + SSpooled-within-subject-error

ANOVA table For the full model (note that Myers & Well, 1995 cock the df right up):
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Source                         d.f.                                     SS                    F                      
B b–1 SSB MSB/MSQ/B

Q/B b(q–1) SSQ/B MSQ/B/MSS/Q/B

S/Q/B bq(a–1) SSS/Q/B MSS/Q/B/MSerror

A a–1 SSA MSA/MSAQ/B

C a–1 SSC MSC/MSCQ/B

AB (a–1)(b–1) SSAB MSAB/MSAQ/B

BC (b–1)(a–1) SSBC MSBC/MSCQ/B

AQ/B b(a–1)(q–1) SSAQ/B MSAQ/B/MSerror

CQ/B b(a–1)(q–1) SSCQ/B MSCQ/B/MSerror

Error bq(a–1)(a–2) SSerror

Total bqa2–1 SStotal

For the pooled error model:

Source                         d.f.                                     SS                    F                      
B b–1 SSB MSB/MSQ/B

Q/B b(q–1) SSQ/B MSQ/B/MSS/Q/B

S/Q/B bq(a–1) SSS/Q/B MSS/Q/B/MSerror

A a–1 SSA MSA/MSerror

C a–1 SSC MSC/MSerror

AB (a–1)(b–1) SSAB MSAB/MSerror

BC (b–1)(a–1) SSBC MSBC/MSerror

Error (pooled) b(a–1)(aq–2) SSerror

Total bqa2–1 SStotal

SPSS technique Since Myers & Well’s (1995, pp. 361-3) numerical example is wrong, I have no way of verify-
ing this against some gold standard.

Data format:

B    Q   S    C    A          depvar
1 1 1 1 4 datum
1 1 1 2 1 datum
1 1 1 3 3 datum
1 1 1 4 2 datum
1 1 2 1 3 datum
1 1 2 2 2 datum
1 1 2 3 4 datum
1 1 2 4 1 datum
…
1 2 5 1 4 datum
1 2 5 2 3 datum
1 2 5 3 2 datum
1 2 5 4 1 datum
…
2 3 9 1 1 datum
2 3 9 2 4 datum
2 3 9 3 3 datum
2 3 9 4 2 datum
…

Full model syntax:

UNIANOVA
  depvar BY b q s c a
  /RANDOM = q s
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = b q(b) s(q(b)) a c a*b b*c a*q(b) c*q(b) .

Pooled error model syntax, I presume, is this:
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UNIANOVA
  depvar BY b q s c a
  /RANDOM = q s
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = b q(b) s(q(b)) a c a*b b*c .
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7.19.8. Replicated-squares design with a between-subjects factor

Example We saw how to use a design with a replicated Latin square above (p. 176). We had a within-
subjects factor A. Let’s add a between-subjects factor B with b levels. We have one Latin
square with a rows, with n subjects for each row and therefore bn subjects per level of B. If a =
4, b = 2 and n = 2, we might have this:

B1 B2

Subjects Subjects C1 C2 C3 C4

S1, S2 S9, S10 A4 A2 A1 A3

S3, S4 S11, S14 A3 A1 A4 A2

S5, S6 S13, S15 A2 A4 A3 A1

S7, S8 S15, S16 A1 A3 A2 A4

Notes See Myers & Well (1995, pp. 368-370, 374-375), who point out that this design is frequently
used but frequently analysed improperly.

Model ijkmpjkmkmjmjkmkjkpiijkmY εαβγβγαγαβγβαηµ ++++++++= /

where i indexes the subject (within a row × B combination; i = 1…n), j indexes the level of A (j
= 1…a), m indexes the level of C (m = 1…a), and p indexes the row within the square (p =
1…a).

Subject is assumed to be a random factor; the rest are fixed.

Sources of variance SStotal = SSbetween-subjects + SSwithin-subjects

SSbetween-subjects = SSB + SSR + SSBR + SSS/BR

SSwithin-subjects = SSC + SSA + SSAB + SSBC

+ SSbetween-cell-residual + SSB × between-cell-residual + SSwithin-cell-residual

where SSbetween-cell-residual = SSCR – SSA

and SSB × between-cell-residual = SSBCR – SSAB.

ANOVA table Source                         d.f.                                     SS                    F                      
B b–1 SSB MSB/MSS/BR

R (AC′) a–1 SSR MSR/MSS/BR

BR (ABC′) (b–1)(a–1) SSBR MSBR/MSS/BR

S/BR ab(n–1) SSS/BR MSS/BR/MSwce

C a–1 SSC MSC/MSwce

A a–1 SSA MSA/MSwce

AB (a–1)(b–1) SSAB MSAB/MSwce

BC (a–1)(b–1) SSBC MSBC/MSwce

Between-cells error (a–1)(a–2) SSbce MSbce/MSwce

(AC′)
B × betw.-cells error (a–1)(a–2)(b–1) SSB×bce MSB×bce/MSwce

(ABC′)
Within-cells error ab(a–1)(n–1) SSwce

= S×A/BR = S×C/BR
Total N–1 = bna2–1 SStotal

As before, some terms give estimates of interactions based on partial information; they’re la-
belled with a prime (′) symbol above. Again, there’s a df error in Myers & Well (1995, p. 370).

SPSS technique Data layout:

B    R    S    C    A    depvar
1 1 1 1 4 datum
1 1 1 2 2 datum
1 1 1 3 1 datum
1 1 1 4 3 datum



7: Specific designs 185

1 1 2 1 4 datum
1 1 2 2 2 datum
1 1 2 3 1 datum
1 1 2 4 3 datum
1 2 3 1 3 datum
1 2 3 2 1 datum
1 2 3 3 4 datum
1 2 3 4 2 datum
…
2 1 9 1 4 datum
2 1 9 2 2 datum
2 1 9 3 1 datum
2 1 9 4 3 datum
…

SPSS syntax:

UNIANOVA
  depvar BY b r c a s
  /RANDOM = s
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = b r b*r s(b*r)
            c a a*b b*c .

That’ll give you all the SS except SSbce, SSB×bce, and SSwce. To get those, obtain SSCR and SSBCR

from this syntax:

UNIANOVA
  depvar BY b r c s
  /RANDOM = s
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = b r b*r s(b*r)
            c c*b c*r b*c*r .

and calculate
SSbce = SSCR – SSA

and
SSB×bce = SSBCR – SSAB

Finally, calculate
SSwce = SSerror-from-first-ANOVA-including-A – SSbce – SSB×bce

and use it to test the relevant terms by hand.
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7.20 Agricultural terminology and designs, compared to psychology

In psychology, the most important factor in experimental design is often the subject,
because this accounts for much correlation between observations. If you have two
groups of subjects and give the two groups the two treatments, you account for
much (you hope all) of the expected correlation between any two subjects by speci-
fying the ‘treatment’ factor in your analysis. (Of course, that may not be the case —
if one group were all men and the other all women, you’d have confounded sex and
treatment; another way of saying that is that correlations between individual sub-
jects’ scores may be due to them being members of the same sex rather than having
experienced a particular treatment.) On the other hand, if you measure subjects more
than once, you can expect high correlations between observations from the same
subject — much more so than between observations from different subjects. So you
need to account for intra-subject correlation, which you do by specifying a Subject
factor (by performing a within-subjects analysis). Much psychological research boils
down to asking ‘is this a between-subjects or a within-subjects factor?’

However, many ANOVA techniques originated in agricultural research, so it often
happens that when you want an example of an advanced design, the only ones you
find are agricultural. And in agriculture, sources of correlation don’t come from
‘subjects’, but from things like geographical proximity. If you want to see whether
fertilizer A works better than fertilizer B, you’d want to give fertilizer A to a set of
plants (obviously not just one) and fertilizer B to another set of plants. But it would
be pretty daft to spray fertilizer A on the sunny south-facing side of your field and to
fertilizer B under the shady oak tree. Agricultural designs and analyses revolve
around these sorts of ideas.

This overview of agricultural teminology is principally from Tangren (2002).

Completely randomized
design (CRD)

Your smallest experimental unit (sometimes called the ‘subject’ or ‘replication’) is a small
plot of land with a plant or plants in it. Each experimental unit produces a single value of
the dependent variable.

You have four fertilizers (A–D; factor T for treatment; t = 4). You give each to four ex-
perimental units (‘subjects’) (n = 4 per group) at random. Adjacent subjects could poten-
tially have the same treatment. Here’s one possible layout, where A–D are treatments and
1–4 are subjects within each treatment (a single ‘subject’ is underlined):

A1  B1  C1  A2
D1  A3  D2  C2
B2  D3  C3  B3
C4  A4  B4  D4

The appropriate ANOVA is equivalent to a design with one between-subjects factor (p.
106). If t is the number of treatments and r is the number of replications per treatment:

Source                                     df                           SS              F                                        
T t–1 SST MST/MSerror

error t(r–1) SSerror

Total tr–1 SStotal

CRD with subsampling The same as a CRD, except that you take three samples per plant (or small plot of plants,
or whatever your previous basic unit was; plant = replication). Treatments are assigned at
random to the plants. For example, if the treatments are A–D, the plants (replications) are
1–4 and the subsamples are a–c, we could get this:

A1a A1b A1c B2a B2b B2c C3a C3b C3c B4a B4b B4c
B1a B1b B1c A2a A2b A2c C2a C2b C2c A4a A4b A4c
C1a C1b C1c B3a B3b B3c A3a A3b A3c C4a C4b C4c

A single plant/plot/whatever is underlined. The idea is that you get a better idea of your
measurement error (within-plant variability), so you can remove this to get a better esti-
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mate of your between-plant variability. The ANOVA looks like this:

SStotal = SST + SSbetween-plant-variability + SSwithin-plant-variability

Source                                     df                           SS              F                                        
T t–1 SST MST/MSE

experimental error E t(r–1) SSE MSE/MSS

= replication/T
sampling error S tr(s–1) SSS

= ‘error’
Total trs–1 SStotal

where r is the number of replications per treatment and s is the number of subsamples per
replication. For example, see

www.stat.wisc.edu/~clayton/stat850/Handouts/crdwsubsamp.pdf

No routine psychology equivalent? Except that it is a way to analyse situations in which
you have one between-subjects factor and you have multiple observations per subject.

To run this analysis in SPSS, the data can be laid out like this:

T          Rep            depvar                         
1 1 subsample_1_datum
1 1 subsample_2_datum
1 1 subsample_3_datum
1 2 subsample_1_datum
1 2 subsample_2_datum
1 2 subsample_3_datum
…
2 5 subsample_1_datum
2 5 subsample_2_datum
2 5 subsample_3_datum
…

and analysed using this syntax:

UNIANOVA
  depvar BY trt rep
  /RANDOM = rep
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = trt rep(trt) .

To achieve this using the SPSS menus, you have to enter a custom model (because you
don’t want the Replication factor in there as a main effect; you just want replication/T).

You might think this was a good way to analyse designs in which you measure a subject
(replication) several times. And indeed, this is a valid way to analyse such data. Except…
this design gives identical answers to taking a mean for every subject (replication) and
analysing those means by one-way ANOVA using T as the only factor! See p. 48.

Randomized complete
block (RCB) design

‘The standard design for agricultural experiments’ (Tangren, 2002). The orchard is di-
vided into units called blocks to account for any variation across the field (sunny bit,
shady bit, etc.). Treatments are then assigned at random to the plants in the blocks, one
treatment per plant (or small plot of plants). Each block experiences each treatment. If the
blocks are I–IV and the treatments are A–D, we might have this:

Block I     A   B   C   D
Block II    D   A   B   C
Block III   B   D   C   A
Block IV    C   A   B   D
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Source                                     df                           SS              F                                        
Block B b–1 SSB MSB/MSE

Treatment T t–1 SST MST/MSE

error E (t–1)(b–1) SSE

Total tb–1 SStotal

Equivalent to a design with one within-subjects factor (p. 112) (Block ≡ Subject; Treat-
ment ≡ WS factor).

RCB with subsampling The layout is the same as an RCB, but each plant (or plot) is sampled several times. For
example (a single plant — subsampled basic unit — is underlined):

Aa Ab Ac  |  Ba Bb Bc  |  Ca Cb Cc  |  Ba Bb Bc
Ba Bb Bc  |  Aa Ab Ac  |  Ba Bb Bc  |  Aa Ab Ac
Ca Cb Cc  |  Ca Cb Cc  |  Aa Ab Ac  |  Ca Cb Cc
------------------------------------------------
Block I   |  Block II  |  Block III |  Block IV

Source                                     df                           SS              F                                        
Block B b–1 SSB MSB/MSE

Treatment T t–1 SST MST/MSE

experimental error E (t–1)(b–1) SSE MSE/MSS

sample error S tb(s–1) SSS

Total tb–1 SStotal

where b is the number of blocks, t is the number of treatments and s is the number of sub-
samples per plot. For example, see

www.stat.wisc.edu/~clayton/stat850/Handouts/crdwsubsamp.pdf

No routine psychology equivalent? Except that it is a way to analyse situations in which
you have one within-subjects factor (p. 112) (Block ≡ Subject; Treatment ≡ WS factor)
and you have multiple observations per level of the within-subjects factor per subject.

To run this analysis in SPSS, the data can be laid out like this:

Block         T          depvar                         
1 1 subsample_1_datum
1 1 subsample_2_datum
1 1 subsample_3_datum
1 2 subsample_1_datum
1 2 subsample_2_datum
1 2 subsample_3_datum
…
2 5 subsample_1_datum
2 5 subsample_2_datum
2 5 subsample_3_datum
…

and analysed using this syntax:

UNIANOVA
  depvar BY t block
  /RANDOM = block
  /METHOD = SSTYPE(3)
  /INTERCEPT = INCLUDE
  /CRITERIA = ALPHA(.05)
  /DESIGN = t block t*block .

To achieve this using the SPSS menus, choose Analyze → General Linear Model → Uni-
variate. Enter T as a fixed factor and Block as a random factor.

You might think this was a good way to analyse designs in which you measure a subject
(replication) several times at each level of a within-subjects factor. And indeed, this is a
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valid way to analyse such data. Except… this design gives identical answers to taking a
mean for every subject/factor combination and analysing those means using a straight-
forward within-subjects design with T as the only factor! Compare p. 48.

Latin square Used to control for variation in two different directions, the row direction and the column
direction. Each treatment appears once per row and once per column. There are the same
number of rows as columns as treatments (call that number r). For example:

Column    1   2   3   4

Row I     A   B   C   D
Row II    C   D   A   B
Row III   D   C   B   A
Row IV    B   A   D   C

Source                                     df                           SS              F                                        
Row R r–1 SSR MSR/MSE

Column C r–1 SSC MSC/MSE

Treatment T r–1 SST MST/MSE

experimental error E (r–1)(r–2) SSE

Total r2–1 SStotal

Directly equivalent to Latin square designs used in psychology (p. 170→).

CRD factorial Two treatments are combined — for example, fertilizer (of type A or B) and pesticide (of
type a or b) are combined to give treatment combinations Aa, Ab, Ba, Bb. Each combina-
tion is then randomly assigned to replications, with r replications per treatment combina-
tion. For example, with a 2 × 2 design and 4 replications (plants, plots, whatvever) per
treatment, you might have the following layout (a single plant/plot is underlined):

Aa1  Ba1  Ab1  Aa2
Bb1  Aa3  Bb2  Ab2
Ba2  Bb3  Ab3  Ba3
Ab4  Aa4  Ba4  Bb4

Equivalent to a design with two between-subjects factors (p. 108). So the table is obvi-
ous:

Source                                     df                           SS              F                                        
first factor F f–1 SSF MSF/MSE

second factor S s–1 SSS MSS/MSE

F × S (f–1)(s–1) SSFS MSFS/MSE

error E fs(r–1) SSE

Total fsr–1 SStotal

RCB factorial Orchard is divided into blocks. Every block gets all possible combinations of the two fac-
tors, as above (assigned at random within each block). For example:

Block IV     Aa  Ba  Ab  Bb
Block III    Bb  Aa  Ba  Ab
Block II     Ba  Bb  Ab  Aa
Block I      Ab  Aa  Ba  Bb

Equivalent to a design with two within-subjects factors (p. 115) (Block ≡ Subject;
Treatment A and Treatment B are WS factors).

Source                                     df                           SS              F                                        
Block B b–1 SSB MSB/MSE

first factor F f–1 SSF MSF/MSE

second factor S s–1 SSS MSS/MSE

F × S (f–1)(s–1) SSFS MSFS/MSE

error E (fs–1)(b–1) SSE

Total fsb–1 SStotal
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RCB 3-way factorial Simply an extension of an RCB 2-way factorial (see above) to 3 factors. Therefore
equivalent to a design with three within-subjects factors (p. 118) (Block ≡ Subject). If
our factor levels are A–C (first factor), 1–2 (second factor), a–b (third factor), we might
have this:

              Block I     Block II     Block III
C1a  B2a    C2a  C1a     B2a  B1a
B1a  A2a    C1b  B1a     B2b  A2a
A2b  A1a    B2b  A2a     A2b  A1a
B1b  B2b    A1b  A1a     C1b  C2b
A1b  C2a    B1b  A2b     C1a  A1b
C2b  C1b    C2b  B2a     B1b  C2a

Source                                     df                           SS              F                                        
Block B b–1 SSB MSB/MSE

first factor X x–1 SSX MSX/MSE

second factor Y y–1 SSY MSY/MSE

third factor Z z–1 SSZ MSZ/MSE

X × Y (x–1)(y–1) SSXY MSXY/MSE

X × Z (x–1)(z–1) SSXZ MSXZ/MSE

Y × Z (y–1)(z–1) SSYZ MSYZ/MSE

X × Y × Z (x–1)(y–1)(z–1) SSXYZ MSXYZ/MSE

error E (xyz–1)(b–1) SSE

Total xyzb–1 SStotal

Here’s a picture (partly for comparison to a split–split plot, see below):

Split plot on a CRD The main experimental units of a CRD (termed main plots) are divided further into sub-
plots to which another set of treatments are assigned at random. For example, suppose we
have pesticides A–C (main treatment), four plots (replications) per treatment (12 plots in
total), each divided into three subplots, and three fertilizers a–c (subplot treatment). We
could have this:

A1a A1b A1c B1c B1b B1a A2b A2c A2a C1a C1c C1b
C2c C2a C2b A3b A3c A3a B2c B2a B2b C3b C3a C3c
B3b B3c B3a A4a A4c A4b C4c C4a C4b B4a B4b B4c

One plot (a plot is underlined) only experiences one main treatment, but experiences all
three subplot treatments.

Source                                     df                           SS              F                                        
plot treatment T t–1 SST MST/MSEm

error, main plots (Em) t(r–1) SSEm
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subplot treatment S s–1 SSS MSS/MSEs

S × T (t–1)(s–1) SSST MSST/MSEs

error, subplots (Es) t(r–1)(s–1) SSEs

Total trs–1 SStotal

Equivalent to a design with one between-subjects factor and one within-subjects factor
(p. 122) (plot treatment ≡ BS factor, subplot treatment ≡ WS factor; ‘plot’ ≡ Subject).

Split plot on an RCB The orchard is divided into units called blocks to account for any variation across the field
(sunny bit, shady bit, etc.). The blocks are then divided into plots. Treatments (e.g. pesti-
cides) are then assigned at random to the plots in the blocks, one treatment per plot. Each
block experiences each treatment. The plots are then divided into subplots and a further
set of treatments (e.g. fertilizer) are applied to the subplots, assigned at random. If the
blocks are I–IV, the main plot treatments are A–C, and the subplot treatments are a–c, we
might have this:

Block-I   Block-II   Block-III   Block-IV
Aa Ab Ac  Bc Bb Ba   Ab Ac Aa    Ca Cc Cb
Cc Ca Cb  Ab Ac Aa   Bc Ba Bb    Aa Ac Ab
Bb Bc Ba  Cb Ca Cc   Cc Ca Cb    Ba Bb Bc

A main plot is underlined. The number of blocks is the number of replications.

Source                                     df                           SS              F                                        
block B b–1 SSB MSB/MSEm

plot treatment T t–1 SST MST/MSEm

error, main plots (Em) (t–1)(b–1) SSEm

subplot treatment S s–1 SSS MSS/MSEs

S × T (t–1)(s–1) SSST MSST/MSEs

error, subplots (Es) t(b–1)(s–1) SSEs

Total tbs–1 SStotal

This is a hierarchical design (p. 159→). The ‘relatedness’ factors are Block (plots are
related if they come from the same block) and Plot (subplots are related if they come from
the same plot).

Split-split plot on an
RCB

The orchard is divided into blocks. The blocks are then divided into plots. Treatments (T,
e.g. pesticides) are then assigned at random to the plots in the blocks, one treatment per
plot. Each block experiences each treatment. The plots are then divided into subplots (or
split plots) and a further set of treatments (S, e.g. fertilizer) are assigned at random to the
subplots. The subplots are then further subdivided into split-subplots (or sub-subplots, or
split-split plots) and a third set of treatments (U, e.g. pruning technique) are assigned at
random to the split-subplots. If the blocks are I–III, the main plot treatments are A–B, the
subplot treatments are 1–2, and the split-subplot treatments are a–c, we might have this:

     Block I        Treatment A    +    Treatment B
                 1a 1b 1c 2c 2b 2a + 2b 2c 2a 1a 1c 1b
     Block II       Treatment B    +    Treatment A
                 1c 1a 1b 2b 2c 2a + 2c 2a 2b 1b 1a 1c
     Block III      Treatment A    +    Treatment B
                 2b 2c 2a 1a 1c 1b + 1c 1a 1b 2a 2b 2c

Here’s a picture:
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Compare this to an RCB 3-way factorial (see above).

Source                                     df                           SS              F                                        
Between blocks:
block B b–1 SSB MSB/MSEm

Within blocks, between plots:
plot treatment T t–1 SST MST/MSEm

error, main plots (Em) (t–1)(b–1) SSEm

Within plots, between subplots:
subplot treatment S s–1 SSS MSS/MSEs

S × T (s–1)(t–1) SSST MSST/MSEs

error, subplots (Es) t(b–1)(s–1) SSEs

Within subplots:
split-subplot treatment U u–1 SSU MSU/MSEu

U × T (u–1)(t–1) SSUT MSUT/MSEu

U × S (u–1)(s–1) SSST MSST/MSEu

U × S × T (u–1)(s–1)(t–1) SSUST MSUST/MSEu

error, split-subplots (Eu) ts(b–1)(u–1) SSEs

Total tbs–1 SStotal

This is a hierarchical design with three levels of ‘relatedness’ (p. 159→). They are
Block (plots are related if they come from the same block), Plot (subplots are related if
they come from the same plot), and Subplot (split-subplots are related if they come from
the same subplot). This is one hierarchical level more than the basic split-split plot design
(based on a CRD rather than an RCB), discussed above.

Split block Two sets of treatments are randomized across each other in strips in an otherwise RCB
design. So the orchard is divided into blocks, and the blocks are divided in an North–
South direction and an East–West direction. One treatment (pesticide, A–C) is assigned
randomly to the blocks in the North–South direction, so each block experiences all treat-
ments. The other treatment (fertilizer, 1–2) is assigned randomly to the blocks in an East–
West direction; again, each block experiences all treatments. It might look like this:

                Block I   Block II   Block III
A1  A2    C2  C1     B1  B2
B1  B2    A2  A1     C1  C2
C1  C2    B2  B1     A1  A2

Source                                     df                           SS              F                                        
block B b–1 SSB MSB/MST×B

treatment T t–1 SST MST/MST×B
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T × B (t–1)(b–1) SST×B

cross-treatment C c–1 SSC MSC/MSC×B

C × B (c–1)(b–1) SSC×B

C × T (c–1)(t–1) SSC×T MSC×T/MSE

error, E (t–1)(c–1)(b–1) SSE

Total tcb–1 SStotal

Equivalent to a design with two within-subjects factors (Block ≡ Subject). Compare the
full model for two within-subjects factors discussed earlier (p. 115).

Pseudoreplication The researcher applies one treatment to all the trees in a row, the next treatment to all the
trees in the next row, etc. There are (say) 4 trees per row.

Row I     A  A  A  A
Row II    B  B  B  B
Row III   C  C  C  C
Row IV    D  D  D  D

The researcher hoped that the experiment was being replicated by having four trees per
row, but the researcher has cocked up. Row is confounded with treatment, so we can’t
analyse this. (The split-block design is one way of applying treatments to whole rows,
properly.)

There are frequent psychology equivalents, but that’s not a good thing.

Regression applied to a
CRD

The orchard is divided into plots. Each plot has a certain amount of fertilizer applied —
treated as a continuous variable. Treatments are assigned to plots at random. If the ex-
perimenter uses 0, 1, 2, and 5 kg of fertilizer, and has four plots per fertilizer condition
(replicates a–d), the orchard might look like this:

5a  2a  0a  5b
1a  5c  1b  0b
2b  1c  0c  2c
0d  5d  2d  1d

The researcher expects a linear relationship between fertilizer amount and the dependent
variable.

Source                                     df                           SS              F                                        
regression R 1 SSR MSR/MSE

error E tr–2 SSE

Total tr–1 SStotal

My comment: of course, there is no absolute requirement to have four plots with 0 kg,
four plots with 2 kg, and so on; you could have one plot with 0 kg, one with 0.5 kg, one
with 1 kg…

Equivalent to simple (i.e. between subjects) linear regression (see p. 135).

Regression, comparing
trends from different
treatments (applied to a
CRD)

The orchard is divided into plots. One treatment factor (pesticide A or B) is crossed with a
continuously-measured treatment (fertilizer: 1, 2, 5 kg). There are four plots (replications
a–d) per pesticide/fertilizer combination. So we might have this:

5Aa   2Aa   5Ba   5Ab   2Ba   1Ba
1Bb   1Aa   2Bb   2Ab   1Bc   1Ab
5Ac   2Bc   2Ac   1Ac   5Bb   5Bc
1Ad   5Bd   5Ad   1Bd   2Bd   2Ad

Source                                     df                           SS              F                                        
treatment T t–1 SST MST/MSE

regression R 1 SSR MSR/MSE

T × R t–1 SSTR MSTR/MSE

error E t(qr–2) SSE



7: Specific designs 194

Total tqr–1 SStotal

where q is the number of levels of the continuously-measured thing that you’re using as a
linear predictor (fertilizer, in this example). The T × R interaction measures whether the
regression slope differs across treatments.

Equivalent to ANCOVA with one between-subjects covariate and one between-subjects
factor, in which the covariate and factor interaction is included (p. 144).

ANCOVA (applied to a
CRD)

The orchard is divided into plots, and treatments A–D are applied to the plots at random
(this is a CRD). Then an independent factor (e.g. soil nitrogen) will be measured for each
plot. Suppose there are four replications (1–4; four plots for each level of the treatment).
We might then have this layout:

A1  B1  C1  A2
D1  A3  D2  C2
B2  D3  C3  B3
C4  A4  B4  D4

We’ll also measure the covariate (nitrogen) in each plot. This is the ANOVA table:

Source                                     df                           SS              F                                        
covariate C 1 SSC MSC/MSE

adjusted treatment T t–1 SST MST/MSE

error E t(r–1)–1 SSE

Total tr–1 SStotal

where r is the number of replications per treatment. The treatment effect is adjusted for
the effects of the covariate.

Equivalent to ANCOVA with one between-subjects covariate and one between-subjects
factor, in which the covariate and factor interaction is not included (p. 138).

RCB repeated at loca-
tions

We have three orchards, widely separated — a location factor. We divide each orchard
into blocks. We assign the levels of our treatment to plots within those blocks, each treat-
ment once per block. (The number of blocks is the number of replications.) For example,
if our treatments are A–C, we might have this:

    Location 1          Location 2
    Block I  II  III    Block I  II  III
          A   B   C           B   C   B
          B   A   B           A   B   C
          C   C   A           C   A   A

                   Location 3
                   Block I  II  III
                         A   C   A
                         C   B   C
                         B   A   B

Source                                     df                           SS              F                                        
location L l–1 SSL MSL/MSEl

error for locations, El l(b–1) SSEl

treatment T t–1 SST MST/MSE

T × L (t–1)(l–1) SSTL MSTL/MSE

error E l(t–1)(b–1) SSE

Total ltb–1 SStotal

Comment: this is again equivalent to a design with one between-subjects factor and one
within-subjects factor (p. 122) (Block ≡ Subject). Location is the ‘between-blocks’ factor
and Treatment is the ‘within-blocks’ factor. Therefore, it’s also analytically equivalent to
the ‘split plot on a CRD’ design above.
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RCB repeated in time Merely one example of repeating a design in time… The orchard is divided into blocks;
treatments are assigned at random to plots within those blocks (each treatment once per
block, so the number of blocks is the number of replications) and everything is measured
three times.

     t=1       Block I    A  B  C  D  E  F
               Block II   F  A  E  B  D  C
               Block III  C  B  F  A  D  E

     t=2       Block I    A  B  C  D  E  F
               Block II   F  A  E  B  D  C
               Block III  C  B  F  A  D  E

     t=3       Block I    A  B  C  D  E  F
               Block II   F  A  E  B  D  C
               Block III  C  B  F  A  D  E

The appropriate ANOVA depends on the effect of time. The following assumes that there
is no more correlation between samples taken closer together in time than between those
taken further apart in time (a ‘split-plot in time’).

Source                                     df                           SS              F                                        
block B b–1 SSB MSB/MSEm

treatment T t–1 SST MST/MSEm

error, main (Em) (t–1)(b–1) SSEm

time Z z–1 SSZ MSZ/MSE

time × block (Z × B) (z–1)(b–1) SSZB MSZB/MSE

time × treatment (Z × T) (z–1)(t–1) SSZT MSZT/MSE

error, E (z–1)(t–1)(b–1) SSE

Total btz–1 SStotal

where z is the number of times that measurements are taken.

Comment 1: equivalent to a design with two within-subjects factors (p. 115). If Block ≡
Subject, then Treatment is a within-subjects factor and Time is another within-subjects
factor. The ‘error, main (Em)’ term is Treatment × Block, and the ‘error, E’ term is Time
× Treatment × Block. The design above is the same as the full model for two within-
subjects factors discussed earlier (p. 115), except that the agricultural design as quoted
here (Tangren, 2002) tests Z against Z×T×B rather than Z×B, which is a bit odd. Compare
the split-block design above.

Comment 2: the assumption that there is ‘no more correlation between samples taken
closer together in time than between those taken further apart in time’ is a (strong) version
of the assumption of sphericity that we’ve met before in the context of within-subjects
designs (p. 25). Time is a within-subjects factor that frequently leads to violations of the
sphericity assumption.
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8 Mathematics, revision and advanced

8.1 Matrices

Before we can examine a general linear model, it helps to understand matrix nota-
tion.

8.1.1 Matrix notation

OK, a quick reminder… This is mostly from Myers & Well (1995, Appendix C)
with some additional notes from www.mathworld.com. A plain number, or a symbol
that represents one, is called a scalar (e.g. 12, –3.5, c, x). A vector is a one-
dimensional array of elements, e.g.























−
=

17

4

2

13

5

u or [ ]40819283 −=v

Here, we would call u a column vector and v a row vector. A matrix is a two-
dimensional array:


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



















=

569

327

142

613

852

Y

(More generally, a scalar is a 0-rank tensor; a vector is a 1-rank tensor, having one
‘index’; a matrix is a 2-rank tensor; and so on.)

Matrices are frequently denoted with bold-face type. The number of rows and col-
umns is referred to as the order of the matrix; the matrix Y has order 5 × 3 (rows ×
columns). So u is a 5 × 1 matrix and v is a 1 × 6 matrix. We can refer to an element
by using subscripts in the format elementrow,column. For example, if we take this ma-
trix:
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


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
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
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"
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A

then ar,c refers to the element in the rth row and the cth column of A. Sometimes the
comma is missed out (arc).

The transpose of matrix A is written A′′′′ or AT. The transpose of a matrix is obtained
by swapping the rows and columns. So the transpose of Y is
















=

53168

62415

97232
TY
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A matrix with equal numbers of rows and columns is called a square matrix. A
matrix A such that A = AT is called a symmetric matrix. In a symmetric matrix,
like this:

















438

392

827

for every element, aij = aji. If this is true, then the elements are symmetrical about
the major (leading) diagonal of the matrix, which is the diagonal that extends from
the top left to the bottom right. Matrices that have nonzero elements along their
major diagonals but only zeros as off-diagonal elements are called diagonal matri-
ces.

The identity matrix is a special square, diagonal matrix that has 1s along the major
diagonal and 0s elsewhere, such as the 3 × 3 identity matrix:
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







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
=

100

010

001

I

8.1.2 Matrix algebra

• Equality. A = B if aij = bij for all i and j. That is, for two matrices to be equal
they must have the same order and identical elements.

• Addition. Two matrices may be added if and only if they are of the same order.
C = A + B if cij = aij + bij for all i and j. For example,
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• Subtraction. Two matrices may be added if and only if they are of the same or-
der. C = A – B if cij = aij – bij for all i and j. For example,
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• Scalar multiplication. To multiply a matrix by a scalar, multiple every element
in the matrix by the scalar. For example,
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• It is not possible to add a scalar to a matrix or to subtract a scalar from a matrix.

• Matrix multiplication. To multiply matrix A by matrix B, giving the result AB
= A ×××× B, there must be the same number of columns in A as there are rows in B.
The simplest case is multiplying a row by a column vector, which gives a scalar
product:

[ ] cfbead

f

e

d

cba ++=

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






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


×
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In general, the product C of two matrices A and B is defined by

cik = aijbjk

where j is summed over for all possible values of i and k (this short-hand nota-
tion is known as Einstein summation). We could expand that formula:

∑=
j

jkijik bac

The number of columns in A must equal the number of rows in B. If you
multiple an x × y matrix by a y × z matrix, you get an x × z matrix. For example,
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Not all matrices may be multiplied by each other. Matrix multiplication is not
commutative: AB is not necessarily the same as BA. (If A and B are inter-
preted as linear transformations, then AB is the linear transformation in which B
is applied first, and then A.) In fact, if AB is defined, BA may not even be de-
fined, if the number of rows and columns do not match appropriately.

However, matrix multiplication is associative: A(BC) = (AB)C = ABC.

Matrix multiplication is also distributive: A(B+C) = AB + AC.

Multiplication by the identity matrix leaves the original matrix unchanged: IA =
AI = A. Note that the order of the identity matrix that premultiplies A (IA) does
not have to be the same as the order of the identity matrix that postmultiplies it
(AI), as in this example:
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Matrix multiplication is useful in expressing systems of simultaneous equations.
Suppose
















=
















=
















=

944

1281

7119

7

4

1

D

k
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y

x

then the matrix equation Dx = k indicates that

7944

4128

17119

=++
=++
=++

zyx

zyx

zyx

so the matrix equation represents a set of three simultaneous scalar equations.
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• More obscure ways of multiplying matrices. There are, of course, other ways
to multiply matrices; the one discussed above is the ‘ordinary’ matrix product
(www.sciencedaily.com/encyclopedia/matrix_multiplication). Another is the
Hadamard product. For two matrices of the same dimension (m × n), the
Hadamard product A⋅B is given by (A·B)i,j = Ai,j × Bi,j. It’s rarely used in linear
algebra. There’s another, too; if A is an n × p matrix and B is an m × q matrix,
the Kronecker product A⊗⊗⊗⊗B (also known as the direct product or the tensor
product) is an mn × pq matrix:





















=⊗

BBB

BBB

BBB

BA

pnnn

p

p

aaa

aaa

aaa

,2,1,

,22,21,2

,12,11,1

"
####

"
"

We won’t mention these further.

8.1.3 The inverse of a matrix

Dividing a scalar b by another scalar a is equivalent to multiplying b by 1/a or a–1,
the reciprocal or inverse of a. The product of a and its inverse, a–1⋅a = a⋅a–1 = 1.
Analogously, a square matrix A is said to have an inverse if we can find a matrix
A–1 such that

AA–1 = A–1A = I

This is handy for solving systems of simultaneous equations; if the equation Ax = k
represents a system of scalar equations (discussed above), then we can solve the
equations by premultiplying both sides of the equation by A–1:

A–1Ax = A–1k
Ix = A–1k
x = A–1k

Not all matrices have inverses. Matrices that have inverses are called nonsingu-
lar; matrices that do not have inverses are called singular. Only square matrices
can have inverses, but not all square matrices do.

A matrix will have an inverse only if its rows and columns are linearly independ-
ent. This is true if no row can be expressed as a linear combination of the other
rows, and no column can be expressed as a linear combination of the other columns.
(If one row is twice another, for example, the rows are linearly dependent and the
matrix will have no inverse.)

Calculating the inverse of a matrix can be hard. To find the inverse of a 2 × 2 matrix,
there is a simple formula:
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where |A| is called the determinant of A; clearly, the inverse is only defined if the
determinant is non-zero. So a matrix is singular if its determinant is zero. To find the
determinant or inverse of a 3 × 3 matrix or higher, see www.mathworld.com.

8.1.4. Matrix transposition

See
www.mathworld.com/Transpose.html

planetmath.org/encyclopedia/Transpose.html
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• As we saw above, the transpose of a matrix is what you get when you swap all
elements aij with aji.

• (AT)T ≡ A

• (cA)T ≡ cAT where c is a constant

• If A is invertible, then TT AA )()( 11 −− ≡

• TTT BABA +≡+ )(

Pretty obvious: C = A + B if cij = aij + bij for all i and j. Therefore, CT has cji =
aij + bij. But AT has members aji and BT has members bji, so D = AT + BT has
members dij = aji + bji. Swap the letters i and j over, and the definition of D is

the same as that of CT; therefore, TTT BABA +≡+ )( .

• TTT ABAB ≡)( ; the transpose of a product is the product of the transposes in

reverse order. Proof:

T

TTTT
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AB
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kijk
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kjikij
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)()()(

≡

≡

≡

≡

≡

where Einstein summation has been used to sum over repeated indices implic-
itly; in Einstein’s notation, for example,

∑≡
i

iiii aaaa

and
∑≡
i

ijikijik aaaa

(see www.mathworld.com/EinsteinSummation.html).

• TTT ABBA )(≡  and TTT BAAB )(≡ . These follow directly from the preceding

results, since

TT

TTTT

A)(B

)(BABA

≡

≡

8.2. Calculus

8.2.1. Derivatives

Remember that a derivative of a function f(x), written in one of these ways:

)()(' xf
dx

d

dx

df
xf ≡≡

is the rate of change of f with respect to whatever parameters it may have (that is,
with respect to x). Formally,

h
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h
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→
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8.2.2. Simple, non-trigonometric derivatives
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8.2.3. Rules for differentiation

Derivatives of sums are equal to the sum of derivatives:

)(')(')()( xhxfxhxf
dx

d ++=++ ……

If c is a constant,

)(')( xcfxcf
dx

d =

The product rule:

)()(')(')()()( xgxfxgxfxgxf
dx

d +=

The chain rule:

du

dx
du

dy

dx

du

du

dy

dx

dy == .

8.2.4. Derivatives of a vector function

The derivative of a vector function
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is given by
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
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
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#
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1
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8.2.5. Partial derivatives

If a function has several parameters, such as f(x,y), we can define the partial deriva-
tive. This is the derivative when all parameters except the variable of interest are
held constant during the differentiation. The partial derivative of f(x,y) with respect
to x is written

xfyxf
xx

f ≡
∂
∂≡

∂
∂

),(

Formally,
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where ie
G

 is called the ‘standard basis vector’ of the ith variable (this is a vector with

a 1 in position i and zeros in every other position, I would infer). Calculating partial
derivatives with respect to x is easy: you treat everything except x as being a con-
stant. For example, if

zyyxyxf 322 2 +++=

then

3

2322

22
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f

zyyx
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++=
∂
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+=
∂
∂

8.2.6. The chain rule for partial derivatives

The general form of the chain rule, using partial derivatives, is:

∑
∂
∂=

i

i

i ds

dx

x

f

ds

df

See
planetmath.org/encyclopedia/Derivative2.html

planetmath.org/encyclopedia/PartialDerivative.html
www.mathworld.com/Derivative.html

phy.asu.edu/phy501-shumway/notes/lec1.pdf

8.2.7. Illustrations of partial derivatives

Suppose we have the function 232 xyxf += . Its partial derivatives with respect to x

and y are:

xy
y

f

y
x

f

6

32 2

=
∂
∂

+=
∂
∂

We can illustrate the whole function:
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Plot of 232 xyxf +=

and some partial derivatives:

232 y
x

f +=
∂
∂

, shown at y = –5, where 77=
∂
∂

x

f xy
y

f
6=

∂
∂

, shown at x = 0, where 0=
∂
∂

y

f

232 y
x

f +=
∂
∂

, shown at y = +3, where 29=
∂
∂

x

f
xy

y

f
6=

∂
∂

, shown at x = 7, where y
y

f
42=

∂
∂

If you’re wondering how you’d find the direction in which a ball would roll down
this slope (the direction in which the gradient is maximum), and the gradient in that
direction, that’s given by the vector gradient (‘grad’), denoted )(grad ff ≡∇ . De-

tails at www.mathworld.com/Gradient.html.
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8.3. Solving a GLM (an overdetermined system of equations) (advanced)

Solving a GLM is the the problem of solving eXby +=  for b so as to minimize the

sum of squares of the residuals, ∑ − )ˆ( YYi  or ∑ 2
ie . When this is solved, b contains

the correct regression coefficients. Note that we can write an expression for e:

Xbye

eXby

−=
+=

The error (residual) sum of squares can be written like this:
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error
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We can also write it like this:

XbXbyXbyy

XbXbyXbyXbyy

XbXbyXby)X(byy

XbXbyXby)((Xb)yy

XbXby(Xb)(Xb)yyy

XbyXby

XbyXby

ee

TTTTT

TTTTTTT

TTTTTTTT

TTTTTT

TTTT

TT

T

T

+−=

+−−=

+−−=

+−−=

+−−=

−−=

−−=
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)(

)(

))()((

)()(

SSerror

from definition of e above

using TTT BABA +≡+ )(

multiplying out

using TTT ABBA )(≡

using TTT ABAB ≡)(  twice

because each term in the sum is a
real number, and hence equal
to its transpose

To minimize the sum of squares, we solve so that the partial derivative of the sum
of squares with respect to the model parameters (b) is zero. To do this, we will need
to use an partial derivative analogue of the product rule for differentiation, which is

)()(')(')()()( xgxfxgxfxgxf
dx

d +=

The vector b is a set of parameters b1, b2, … bi … bn. We differentiate with respect
to each bi. The partial derivative of b with respect to bi is a vector with a 1 in the ith
position and 0 in every other position (see section on partial derivatives, and deriva-
tives of a vector function). We call that vector ie

G
 (the ‘standard basis vector’); I will

use this notation to avoid confusion with the error vector e.
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Similarly,
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TTb i
i

e
b

G=
∂
∂

Armed with this notation, we can obtain the partial derivative of SSerror, which we
wish to be equal to zero:
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Let’s do this in full.
← The first term (yTy) contains no

terms involving bi so is treated
as a constant. The second is
simple. The third has two
terms involving bi, namely bT

and b, so we use the product
rule, differentiating with re-
spect to each in turn.

For the expansion of the right-
hand term, we use

TTT ABAB ≡)(  in the form
TTTABAB )(≡ .

Next, from TTT ABBA )(≡  it

follows that XXX)(X TTT ≡ .

Each term is a real number, and
therefore equal to its transpose.

Rearranging:

yXXbX

yXXbX

XbXyX

TTTT
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ii
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ee
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=

=

=+−

22
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This says that the ith element of XbXT  is equal to the ith element of yXT . Since

that is true for all values of i, we have the equality

yXXbX TT =

These equations (since the things in the expression above are matrices, they repre-
sent more than one equation) are known as the normal equations of the linear least-

squares problem. If we can find the inverse of XXT , and remembering that matrix
multiplication is associative — A(BC) ≡ (AB)C ≡ ABC — we can derive this ex-
pression for b:

yXXXb

yXXXXbXXX
TT

TTTT

1

11

)(

)()(
−

−−

=

=

Therefore, our optimal model b that minimizes the SSerror is given by

yXXXb T1T −= )(

Magic. Of course, the solution can only be found if XXT  is invertible (which may
not be the case if your design matrix contains linearly dependent columns, as with
overparametrized design matrices).

For terse versions of these derivations, see
• www.me.psu.edu/sommer/workarea/least_squares.doc
• www.stat.wisc.edu/p/stat/course/st333-larget/public/html/matrix.pdf
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8.4. Singular value decomposition to solve GLMs (very advanced)

Singular value decomposition (SVD) is a method that can solve arbitrary GLMs —
ones in which we have more information that we need (as is the case in ANOVA),
and also ones in which we have exactly the right amount of information, and ones in
which we have insufficient information.

When we solve a GLM, we normally have more measurements than we’d need to
determine the values of our predictors — the model is eXby += , it’s overdeter-

mined (e ≠ 0), and we solve it by minimizing the sum of squares of the errors (eTe).

We can often solve it using the normal equations given above ( yXXbX TT = , or

yXX)(Xb T1T −= ).

When we solve a simple set of equations that are exactly determined, we solve
Xby =  (giving b = X–1y). This is equivalent to the method for an overdetermined

problem, except that e = 0 (our predictions are exact and there is no residual error).

What happens if we don’t have enough information? Then our model Xby =  is un-

derdetermined. Yet if we make assumptions about the world, we can still get useful
information out.

For example, suppose we’re performing a CT scan. We scan a single slice of the
body. We want to find a set of X-ray absorbances b, one absorbance per voxel. We
know which voxels each X-ray beam passes through (X), and we know the sum of
absorbances for each beam (y), assuming some radiation manages to get through (if
the X-ray beam is completely absorbed, the maths is harder, which may be why
metal causes funny streaky shadows on CT scans). I would guess that CT scans are
normally overdetermined, or perhaps exactly determined (though I reckon probably
not — it’d be easier to design a machine that made overdetermined scans and the re-
sults would probably better, although the price is a bit of time and a bit of unneces-
sary X-ray radiation). What happens if we had an undetermined situation — like
trying to interpret 3D structure from an antero-posterior (AP) and a lateral chest X-
ray only? Or like shooting a CT scan from too few directions?

We could assume that tissue is homogeneous unless we receive better information.

That corresponds to minimizing the sum of squares of b (∑ 2
ib ). A very simple ex-

ample: suppose 10=+ yx . This has an infinite number of solutions. But the one

that minimizes x2 + y2 is x = 5, y = 5. In general, we may wish to minimize both

∑ 2
ie  and ∑ 2

ib . A general technique for this is called singular value decomposi-
tion (SVD). I won’t present it in full, because I don’t understand it in full, but it goes
like this.

8.4.1. Eigenvectors and eigenvalues

If A is a matrix and if there is a column vector 0X ≠  such that

matrixidentity   theis    where0)(or  IXIA

XAX

R

RR

=−
=

λ
λ

for some scalar λ , then λ  is called the eigenvalue of A with the corresponding
(right) eigenvector XR. (German: ‘eigen’ = appropriate, innate, own, peculiar.) That
is, an eigenvector is a vector whose direction is unchanged by the transformation A;
it is merely stretched by a factor (the eigenvalue). For example, if the matrix repre-
sents rotation, it has no eigenvectors. If it represents reflection in a plane, then every
vector lying in that plane is an eigenvector, with eigenvalue 1, and any vector per-
pendicular to the plane will be an eigenvector with eigenvalue –1; these are the only
eigenvectors. If the matrix represents 2D reflection (reflection in a line), then vectors
lying along that line will be eigenvectors with eigenvalue 1, and vectors perpen-
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dicular to that line will be eigenvectors with eigenvalue –1; these are the only eigen-
vectors. If the matrix represents simultaneous enlargement parallel to the X axis by a
factor of a, parallel to the Y axis by a factor of b, and parallel to the Z axis by a fac-
tor of c, with a ≠ b ≠ c, so the matrix looks like

















c

b

a

00

00

00

then vectors along either the X axis, the Y axis, or the Z axis will be eigenvectors
(and these are the only eigenvectors), and their eigenvalues will be a, b, and c re-
spectively. To find eigenvalues, note that if RXIA )( λ−  and XR ≠ 0 then )( IA λ−
must be singular, so solve 0)(det =− IA λ  to get the eigenvalues, and thus the ei-

genvectors.

Less commonly used: The left eigenvector is a row vector that satisfies LL XAX λ=
or 0)( =− LXIA λ , where I is the identity matrix. The eigenvalues for the left and
right eigenvectors are the same, although the left and right eigenvectors themselves
need not be. When people use the term ‘eigenvector’ on its own they generally mean
‘right eigenvector’.

A square matrix A can often be decomposed (‘diagonalised’) into its eigenvalues
and eigenvectors, which are linearly independent. That is,

1PDPA −=

where P is a matrix of eigenvectors and D is a diagonal matrix of eigenvalues.

See
www.mathworld.com/Eigenvalue.html
www.mathworld.com/Eigenvector.html

www.mathworld.com/EigenDecomposition.html

8.4.2. Singular value decomposition

Any m × n matrix X can be decomposed into

TUSVX =

where

• U is an m × m orthogonal matrix (a matrix M is orthogonal if MMT = I, i.e. if
MT = M–1); the columns of U are the eigenvectors of AAT.

• V is an n × n orthogonal matrix; the columns of V are the eigenvectors of ATA.

• S is an m × n matrix containing a diagonal matrix (a matrix that has nonzero
elements along its major diagonal but only zeros elsewhere) with real, non-
negative elements iσ  (where i is from 1 to the minimum of m and n) in de-

scending order:

0),min(21 >>>> nmσσσ …

The iσ  elements themselves (the ‘singular values’) are square roots of eigen-

values from AAT or ATA. To create S, we first create a diagonal matrix ∑∑∑∑ con-
taining these iσ  elements:
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),min(

1

1

00

00

00

nmσ

σ
σ
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#%##
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Σ

Then we pad it with zeros to make S an m × n matrix:

[ ] nmnm <=≥







=   if    and    if  0ΣS

0

Σ
S

Once we’ve found the matrices such that TUSVX = , we can then solve our prob-
lem. Since U and V are orthogonal, their inverses are equal to their transposes. Since
S is diagonal, its inverse is the diagonal matrix whose elements are the reciprocal of
the elements of S.

T1111TT UVSUSVUSVX −−−−−− === )()( 11

where the diagonal elements of S–1 are 1/Si [that is, S–1 = diag(1/Si)]. Therefore,

since Xby = , we have yXb 1−=  and hence

yUVSb T1−=

It is possible to solve equations even if the matrices are singular or close to singular
using this technique: when you obtain S–1, by taking the values 1/Si, if Si is smaller
than a threshold value (the singularity threshold) you replace 1/Si with 0. That is,
SVD finds the least squares best compromise solution of the linear equation system.
For details and proof, see Press et al. (1992, pp. 59-70, 676-680) and

rkb.home.cern.ch/rkb/AN16pp/node265.html
www.mlahanas.de/Math/svd.htm

8.4.3. An underdetermined set of equations: the role of expectations

(RNC, April 2004.) Alternatively, we might have prior expectations — in our ra-
diological example, we expect to find a heart, we expect that ribs curve round the
side, and so on. We might say that we’d like to interpret the data to fit our expecta-
tions as far as possible. If our prior expectations are p, then this would correspond to
minimizing the sum of squares of (b – p). We can say that b = p + d, where d repre-
sents the deviation from prior expectations. Thus,

XdXpy

XdXp

d)X(p

Xby

=−
+=
+=

=

The usual singular value decomposition TUSVX =  is used to solve Xby =  for b,

minimizing the sum of squares of b when the system is underdetermined; the solu-

tion is given by yUVSb T1−= . In the present case, we use the same decomposition

of X and simply rewrite to solve for d, minimizing its sum of squares:

Xp)(yUVSd T1 −= −

and therefore since dpb += ,

Xp)(yUVSpb T1 −+= −
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8.5 Random variables, means, and variances

8.5.1 Summation

If we have n scores we could denote them x1, x2, … xn. Their sum can be written in
the following ways:

∑=

∑=+++
=

i
i

n

i
in

x

xxxx
1

21 …

The following are easily proved. If c is a constant, then

∑=∑ xccx

ncc
n

i
=∑

=1

The summation sign operates like a multiplier on quantities within parentheses. For
example:

∑−∑=∑ −
===

n

i
i

n

i
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n

i
ii yxyx

111
)(

∑ ∑ ∑++=∑ − xyyxyx 2)( 222

8.5.2 Random variables; definition of mean and variance

A random variable (RV) is a measurable or countable quantity that can take any of
a range of values and which has a probability distribution associated with it, i.e.
there is a means of giving the probability of the variable taking a particular value. If
the values an RV can take are real numbers (i.e. an infinite number of possibilities)
then the RV is said to be continuous; otherwise it is discrete. The probability that a
discrete RV X has the value x is denoted P(x). We can then define the mean or ex-
pected value:

∑= )(][ xxPXE

and the variance:

( )22
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∑ +−=

∑ −=

−=

and the standard deviation, σ:

][2 XVar=σ

8.5.3 Continuous random variables

For a continuous random variable X, the probability P(x) of an exact value x occur-
ring is zero, so we must work with the probability density function (PDF), f(x). This
is defined as

dxxfbxaP
b

a
∫=≤≤ )()(
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1)( =∫
∞

∞−
dxxf

0)(: ≥∀ xfx

( x∀  means ‘for all values of x’). The mean or expected value E[X] is defined as

dxxxfXE ∫=
∞

∞−
)(][

The variance, Var[X] is given by

22 ])[()(][ XEdxxfxXVar −∫=
∞

∞−

The cumulative distribution function (CDF, also known as the ‘distribution function’
or ‘cumulative density function’), F(a), is given by

dxxfaF
a

∫=
∞−

)()(

i.e.
)()( axPaF ≤=

)()()( aFbFbxaP −=≤≤

8.5.4 Expected values

If X is a random variable and c is a constant, E(X) denotes the expected value of X.

ccE =)(

)()( XcEcXE =

E() acts like a multiplier. For example:

)(2)()(])[(

)()()()(

)()()(

222 XYEYEXEYXE
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YEXEYXE

++=+

+=+=+
+=+

If X and Y are independently distributed, then

)()()( YEXEXYE =

8.5.5 The sample mean and SD are unbiased estimators of µ and σ2

We will use X to denote the random variable, x for an individual value of that ran-

dom variable, x  for the sample mean, 2
Xs  for the sample variance (sometimes writ-

ten 2ˆ Xσ ), Xµ  for the population mean, and 2
Xσ  for the population variance. First,

the mean:

µ===∑=∑=





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1
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)( XEXnE

n
XE

n
xE

nn

x
ExE

Now the standard deviation (Myers & Well, 1995, p. 592). Consider first the nu-
merator (the sum of squares) [N.B. line 3 uses the fact )()( µµ −=∑ − xnx ]:
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The average squared deviation of a quantity from its average is a variance; that is,
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and, by the Central Limit Theorem,
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8.5.6 Variance laws

If X and Y are two random variables with variances V(X) = 2
Xσ  and V(Y) = 2

Yσ , and

c is a constant, then
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where ρ is the correlation between X and Y; YXXY σσρ  is also known as the covari-

ance:

YXXYXY σσρ=cov

Therefore, if X and Y are independent,
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8.5.7 Distribution of a set of means: the standard error of the mean

See Frank & Althoen (1994, pp. 281-289). Let X1, X2, … XN be a set of sample
means. Then X  is the mean of all those sample means. First we derive the density
function of X .
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If we sample n values from a random variable, calling them x1, x2… xn, then
their mean is

n

x
x

n

i
i∑

= =1

or

)(
1

21 nxxx
n

x +++= "

Likewise, for a set of n random variables X1, X2… Xn,
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X
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W
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then

nWWWX +++= "21

If X1, X2… Xn are independent and identically distributed, as when observations are
independent, then W1, W2… Wn are likewise independent and identically distributed.
The mean X can therefore be expressed as the sum of n independent, identically
distributed random variables, Wi.

The Central Limit Theorem tells us that if W1, W2, … Wn are independent, identi-
cally distributed random variables and Y = W1 + W2 + … + Wn, then the probability
density function of Y approaches the normal distribution

2

2

2
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1
Y

yy

Y

e σ
µ
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−−

as n → ∞.

Next we derive the expected value of the sample mean, )(XE . (We saw one deriva-

tion above; this is a fuller version.) Since

)(
1

21 nXXX
n

X +++= "

it follows that
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1

From the Algebra of Expectations, the expected value of a sum is equal to the sum
of the expected values. So if E(X1) = µ1, E(X2) = µ2, E(Xn) = µn, etc., then

( ) ( )nE
n

XE µµµ +++= "21
1

Let us suppose the population mean is µ. Since the distributions of X1, X2, … Xn are
all identical to the population distribution, it follows that all n random variables have
the same expected value:

µµµµ ==== n"21
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So

( ) ( ) µµµµµ ==+++= n
n

E
n

XE
11 "

So the expected value of the sample mean (the mean of a set of sample means) is
equal to the population mean.

How about the variance of X ?
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When you factor a constant out of a variance, it’s squared:

( ) ( )nXXXV
n

XV +++= "212

1

The variance of a sum of n independent random variables is the sum of the individ-

ual variances. If ( ) 2
11 σ=XV , ( ) 2

22 σ=XV , …, ( ) 2
nnXV σ= , then

( ) 22
2

2
121 nnXXXV σσσ +++=+++ ""

so

( ) ( )22
2

2
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1
n

n
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and since the variables representing our n observations all have the same distribution
as the parent population, they must all have the same variance, namely σ2, the popu-
lation variance. So

( ) ( )
n

N
n

XV
2

2
2

1 σσ ==

So for samples of n independent observations, the variance of the sample means is
equal to the population variance divided by the sample size:

nX

2
2 σσ =

and so the standard deviation of the sample means (the standard error of the mean)
is

n
X

σσ =

8.6 The harmonic mean

The harmonic mean of n observations x1, x2, … xn is

n

h

xxx

n
X
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…
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9 Glossary

Symbols:

⇒ implies
≡ is equivalent to
x mean of a set of values of x
ε error
ε̂ Greenhouse–Geisser correction (see p. 25)

ε~ Huynh–Feldt correction (see p. 25)

µ mean
ρ population correlation
r sample correlation

xyr  or yxr . correlation between x and y

cbayr ,,. multiple correlation between y and (a, b, c)

)|.( zxyr semipartial correlation between y and x, having partialled out z (see
p. 100)

zxyr |. partial correlation between y and x, having partialled out z (see p.
100)

∑ sum of (see p. 209)

Xσ population standard deviation of X
sX sample standard deviation of X
2
Xσ population variance of X
2
X

s sample variance of X

• Additive model. In within-subjects ANOVA, a structural model that assumes
the effects of within-subjects treatments are the same for all subjects.

• ANCOVA. Analysis of covariance: an ANOVA that uses a covariate as a pre-
dictor variable.

• ANOVA. Analysis of variance. See p. 8→ for an explanation of how it works.
• A priori tests. Tests planned in advance of obtaining the data; compare post hoc

tests.
• Balanced ANOVA. An ANOVA is said to be balanced when all the cells have

equal n, when there are no missing cells, and if there is a nested design, when
the nesting is balanced so that equal numbers of levels of the nested factor ap-
pear in the levels of the factor(s) that they are nested within. This greatly simpli-
fies the computation.

• Between-subjects (factor or covariate). If each subject is only tested at a single
level of an independent variable, the independent variable is called a between-
subjects factor. Compare within-subjects.

• Carryover effects. See within-subjects.
• Categorical predictor variable. A variable measured on a nominal scale,

whose categories identify class or group membership, used to predict one or
more dependent variables. Often called a factor.

• Continuous predictor variable. A continuous variable used to predict one or
more dependent variables. Often called a covariate.

• Covariance matrix. If you have three variables x, y, z, the covariance matrix,

denoted ∑, is 
















=Σ

2

2

2

covcov

covcov

covcov

zyzxz

yzyxy

xzxyx

z

y

x

zyx

σ
σ

σ
 where covxy is the covariance of

x and y (= ρxyσxσy where ρxy is the correlation between x and y and σx is the vari-

ance of x). Obviously, 2cov xxx σ= . It is sometimes used to check for compound
symmetry of the covariance matrix, which is a fancy way of saying
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222
zyx σσσ ==  (all numbers on the leading diagonal the same as each other). and

xzyzxy covcovcov ==  (all numbers not on the leading diagonal the same as

each other). If there is compound symmetry, there is also sphericity, which is
what’s important when you’re running ANOVAs with within-subjects factors.
On the other hand, you can have sphericity without having compound symme-
try; see p. 25→.

• Conservative. Apt to give p values that are too large.
• Contrast. See linear contrast.
• Covariate. A continuous variable (one that can take any value) used as a pre-

dictor variable.
• Degrees of freedom (df). Estimates of parameters can be based upon different

amounts of information. The number of independent pieces of information that
go into the estimate of a parameter is called the degrees of freedom (d.f. or df).
Or, the number of observations free to vary. For example, if you pick three
numbers at random, you have 3 df — but once you calculate the sample mean,
x , you only have two df left, because you can only alter two numbers freely;
the third is constrained by the fact that you have ‘fixed’ x . Or, the number of
measurements exceeding the amount absolutely necessary to measure the ‘ob-
ject’ (or parameter) in question. To measure the length of a rod requires 1
measurement. If 10 measurements are taken, then the set of 10 measurements
has 9 df. In general, the df of an estimate is the number of independent scores
that go into the estimate minus the number of parameters estimated from those
scores as intermediate steps. For example, if the population variance σ2 is esti-
mated (by the sample variance s2) from a random sample of n independent
scores, then the number of degrees of freedom is equal to the number of inde-
pendent scores (n) minus the number of parameters estimated as intermediate
steps (one, as µ is estimated by x ) and is therefore n – 1.

• Dependent variable. The variable you measure, but do not control. ANOVA is
about predicting the value of a single dependent variable using one or more
predictor variables.

• Design matrix. The matrix in a general linear model that specifies the experi-
mental design — how different factors and covariates contribute to particular
values of the dependent variable(s).

• Doubly-nested design. One in which there are two levels of nesting (see nested
design). Some are described on p. 159→.

• Error term. To test the effect of a predictor variable of interest with an
ANOVA, the variability attributable to it (MSvariable) is compared to variability
attributed to an appropriate ‘error term’ (MSerror), which measures an appropri-
ate error variability. The error term is valid if the expected mean square for the
variable, E(MSvariable), differs from E(MSerror) only in a way attributable solely to
the variable of interest.

• Error variability (or error variance, 2
eσ ). Variability among observations that

cannot be attributed to the effects of the independent variable(s). May include
measurement error but also the effects of lots of irrelevant variables that are not
measured or considered. It may be possible to reduce the error variability by ac-
counting for some of them, and designing our experiment accordingly. For ex-
ample, if we want to study the effects of two methods of teaching reading on
children’s reading performance, rather than randomly assigning all our students
to teaching method 1 or teaching method 2, we could split our children into
groups with low/medium/high intelligence, and randomly allocate students
from each level of intelligence to one of our two teaching methods. If intelli-
gence accounts for some of the variability in reading ability, accounting for it in
this way will reduce our error variability. Within-subjects designs take this prin-
ciple further (but are susceptible to carryover effects).

• Expected mean square (EMS). The value a mean square (MS) would be ex-
pected to have if the null hypothesis were true.

• F ratio. The ratio of two variances. In ANOVA, the ratio of the mean square
(MS) for a predictor variable to the MS of the corresponding error term.
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• Factor. A discrete variable (one that can take only certain values) used as a
predictor variable. A categorical predictor. Factors have a certain number of
levels.

• Factorial ANOVA. An ANOVA using factors as predictor variables. The term
is often used to refer to ANOVAs involving more than one factor (compare one-
way ANOVA). Factorial designs range from the completely randomized design
(subjects are randomly assigned to, and serve in only one of several different
treatment conditions, i.e. completely between-subjects design), via mixed de-
signs (both between-subjects and within-subjects factors) to completely within-
subjects designs, in which each subject serves in every condition.

• Fixed factor. A factor that contains all the levels we are interested in (e.g. the
factor ‘sex’ has the levels male and female). Compare random factor and see p.
31.

• Gaussian distribution. Normal distribution.
• General linear model. A general way of predicting one or more dependent

variables from one or more predictor variables, be they categorical or continu-
ous. Subsumes regression, multiple regression, ANOVA, ANCOVA, MA-
NOVA, MANCOVA, and so on.

• Greenhouse–Geisser correction/epsilon. If the sphericity assumption is vio-
lated in an ANOVA involving within-subjects factors, you can correct the df for
any term involving the WS factor (and the df of the corresponding error term)
by multiplying both by this correction factor. Often written ε̂ , where 0 < ε̂  ≤
1. Originally from Greenhouse & Geisser (1959).

• Heterogeneity of variance. Opposite of homogeneity of variance. When vari-
ances for different treatments are not the same.

• Hierarchical design. One in which one variable is nested within a second,
which is itself nested within a third. A doubly-nested design (such as the split-
split plot design) is the simplest form of hierarchical designs. They’re complex.

• Homogeneity of variance. When a set of variances are all equal. If you per-
form an ANOVA with a factor with a levels, the homogeneity of variance as-

sumption is that 222
2

2
1 ea σσσσ ==== … , where 2

eσ  is the error variance.

• Huynh–Feldt correction/epsilon. If the sphericity assumption is violated in an
ANOVA involving within-subjects factors, you can correct the df for any term
involving the WS factor (and the df of the corresponding error term) by multi-
plying both by this correction factor. Often written ε~ , where 0 < ε~  ≤ 1. Origi-
nally from Huynh & Feldt (1970).

• Independent variable. The variables thought to be influencing the dependent
variable(s). In experiments, independent variables are manipulated. In correla-
tional studies, independent variables are observed. (The advantage of the ex-
periment is the ease of making causal inferences.)

• Interaction. There is an interaction between factors A and B if the effect of
factor A depends on the level of factor B, or vice versa. For example, if your
dependent variable is engine speed, and your factors are ‘presence of spark
plugs (Y/N)’ (A) and ‘presence of petrol (Y/N)’ (B), you will find an interac-
tion such that factor A only influences engine speed at the ‘petrol present’ level
of B; similarly, factor B only influences engine speed at the ‘spark plugs pres-
ent’ level of B. This is a binary example, but interactions need not be. Compare
main effect, simple effect.

• Intercept. The contribution of the grand mean to the observations. See p. 65.
The F test on the intercept term (MSintercept/MSerror) tests the null hypothesis that
the grand mean is zero.

• Level (of a factor). One of the values that a discrete predictor variable (factor)
can take. For example, the factor Weekday might have five levels — Monday,
Tuesday, Wednesday, Thursday, Friday. We might write the factor as Weekday5

in descriptions of ANOVA models (as in ‘Tedium = Drowsiness2 × Weekday5 ×
S’), or write the levels themselves as Weekday1 …Weekday5.

• Levene’s test (for heterogeneity of variance). Originally from Levene (1960).
Tests the assumption of homogeneity of variance. If Levene’s test produces a
‘significant’ result, the assumption of homogeneity of variance cannot be made
(this is generally a Bad Thing and suggests that you might need to transform
your data to improve the situation; see p. 34).
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• Liberal. Apt to give p values that are too small.
• Linear contrasts. Comparisons between linear combinations of different

groups, used to test specific hypotheses. See p. 75→.
• Linear regression. Predicting Y from X using the equation of a straight line:

abXY +=ˆ . May be performed with regression ANOVA.
• Logistic regression. See Howell (1997, pp. 548-558). A logistic function is a

sigmoid (see www.mathworld.com). If your dependent variable is dichotomous
(categorial) but ordered (‘flight on time’ versus ‘flight late’, for example) and
you wish to predict this (for example, by pilot experience), a logistic function is
often better than a straight line. It reflects the fact that the dichotomy imposes a
cutoff on some underlying continuous variable (e.g. once your flight delay in
seconds — continuous variable — reaches a certain level, you classify the flight
as late — dichotomous variable). Dichotomous variables can be converted into
variables suitable for linear regression by converting the probability of falling
into one category, P(flight late), into the odds of falling into that category, using

)(

)(
odds

AP

AP

¬
= , and then into the log odds, using the natural (base e) logarithm

loge(odds) = ln(odds). The probability is therefore a logistic function of the log

odds: 
)oddsln(

)oddsln(

1
yprobabilit

e

e

+
= , so performing a linear regression on the log

odds is equivalent to performing a logistic regression on probability. This is
pretty much what logistic regression does, give or take some procedural wrin-
kles. Odds ratios (likelihood ratios), the odds for one group divided by the odds
for another group, emerge from logistic regression in the way that slope esti-
mates emerge from linear regression, but the statistical tests involved are differ-
ent. Logistic regression is a computationally iterative task; there’s no simple
formula (the computer works out the model that best fits the data iteratively).

• Main effect. A main effect is an effect of a factor regardless of the other fac-
tor(s). Compare simple effect; interaction.

• MANCOVA. Multivariate analysis of covariance; see MANOVA and ANCOVA.
• MANOVA. Multivariate ANOVA — ANOVA that deals with multiple de-

pendent variables simultaneously. Not covered in this document. For example,
if you think that your treatment has a bigger effect on dependent variable Y2

than on variable Y1, how can you see if that is the case? Certainly not by making
categorical decisions based on p values (significant effect on Y1, not significant
effect on Y2 — this wouldn’t mean that the effect on Y1 and Y2 were signifi-
cantly different!). Instead, you should enter Y1 and Y2 into a MANOVA.

• Mauchly’s test (for sphericity of the covariance matrix). Originally from
Mauchly (1940). See sphericity, covariance matrix, and p. 25.

• Mean square (MS). A sum of squares (SS) divided by the corresponding num-
ber of degrees of freedom (df), or number of independent observations upon
which your SS was based. This gives you the mean ‘squared deviation from the
mean’, or the ‘mean square’. Effectively, a variance.

• Mixed model. An ANOVA model that includes both between-subjects and
within-subjects predictor variables. Alternatively, one that includes both fixed
and random factors. The two uses are often equivalent in practice, since Sub-
jects is usually a random factor.

• Multiple regression. Predicting a dependent variable on the basis of two or
more continuous variables. Equivalent to ANOVA with two or more covariates.

• Nested design. An ANOVA design in which variability due to one factor is
‘nested’ within variability due to another factor. For example, if one were to
administer four different tests to four school classes (i.e. a between-groups fac-
tor with four levels), and two of those four classes are in school A, whereas the
other two classes are in school B, then the levels of the first factor (four differ-
ent tests) would be nested in the second factor (two different schools). A very
common example is a design with one between-subjects factor and one within-
subjects factor, written A × (U × S); variation due to subjects is nested within
variation due to A (or, for short-hand, S is nested within A), because each sub-
ject is only tested at one level of the between-subjects factor(s). We might write
this S/A (‘S is nested within A’); SPSS uses the alternative notation of S(A).
See also doubly-nested design.
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• Nonadditive model. In within-subjects ANOVA, a structural model that allows
that the effects of within-subjects treatments can differ across subjects.

• Null hypothesis. For a general discussion of null hypotheses, see handouts at
www.pobox.com/~rudolf/psychology. In a one-way ANOVA, when you test
the main effect of a factor A with a levels, your null hypothesis is that µ1 = µ2 =
… = µa. If you reject this null hypothesis (if your F ratio is large and signifi-
cant), you conclude that the effects of all a levels of A were not the same. But if
there are >2 levels of A, you do not yet know which levels differed from each
other; see post hoc tests.

• One-way ANOVA. ANOVA with a single between-subjects factor.
• Order effects. See within-subjects.
• Overparameterized model. A way of specifying a general linear model design

matrix in which a separate predictor variable is created for each group identified
by a factor. For example, to code Sex, one variable would be created in which
males score 1 and females score 0, and another variable would be created in
which males score 0 and females score 1. These two variables contain mutually
redundant information: there are more predictor variables than are necessary to
determine the relationship of a set of predictors to a set of dependent variables.
Compare sigma-restricted model.

• Planned contrasts. Linear contrasts run as a priori tests.
• Polynomial ANCOVA. An ANCOVA in which a nonlinear term is used as a

predictor variable (such as x2, x3…, rather than the usual x). See Myers & Well
(1995, p. 460).

• Post hoc tests. Statistical tests you run after an ANOVA to examine the nature
of any main effects or interactions you found. For example, if you had an
ANOVA with a single between-subjects factor with three levels,
sham/core/shell, and you found a main effect of this factor, was this due to a
difference between sham and core subjects? Sham and shell? Shell and core?
Are all of them different? There are many post hoc tests available for this sort of
purpose. However, there are statistical pitfalls if you run many post-hoc tests;
you may make Type I errors (see handouts at
www.pobox.com/~rudolf/psychology) simply because you are running lots of
tests. Post hoc tests may include further ANOVAs of subsets of your original
data — for example, after finding a significant Group × Difficulty interaction,
you might ask whether there was a simple effect of Group at the ‘easy’ level of
the Difficulty factor, and whether there was a simple effect of Group at the ‘dif-
ficult’ level of the Difficulty factor (see pp. 20, 39→).

• Power of an ANOVA. Complex to work out. But things that increase the ex-
pected F ratio for a particular term if the null hypothesis is false increase power,

and 
predictorerror

errorpredictor

error

predictor

SS

SS

MS

MS

df

df
F

×
×

== . Bigger samples contribute to a larger

df for your error term; this therefore decreases MSerror and increases the ex-
pected F if the null hypothesis is false, and this therefore increases your power.
The larger the ratio of E(MStreatment) to E(MSerror), the larger your power. Some-
times two different structural models give you different EMS ratios; you can use
this principle to find out which is more powerful for detecting the effects of a
particular effect (see p. 73→). For references to methods of calculating power
directly, see p. 102.

• Predictor variable. Factors and covariates: things that you use to predict your
dependent variable.

• Pseudoreplication. What you do when you analyse correlated data without ac-
counting for the correlation. A Bad Thing — entirely Wrong. For example, you
could take 3 subjects, measure each 10 times, and pretend that you had 30 inde-
pendent measurements. No, no, no, no, no. Account for the correlation in your
analysis (in this case, by introducing a Subject factor and using an appropriate
ANOVA design with a within-subjects factor).

• Random factor. A factor whose levels we have sampled at random from many
possible alternatives. For example, Subjects is a random factor — we pick our
subjects out of a large potential pool, and if we repeat the experiment, we may
use different subjects. Compare fixed factor and see p. 31.
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• Regression ANOVA. Performing linear regression using ANOVA. A simple
linear regression is an ANOVA with a single covariate (i.e. ANCOVA) and no
other factors.

• Repeated measures. Same as within-subjects. ‘Repeated measures’ is the more
general term — within-subjects designs involve repeated measurements of the
same subject, but things other than subjects can also be measured repeatedly. In
general, within-subjects/repeated-measures analysis is to do with accounting
for relatedness between sets of observations above that you’d expect by chance.
Repeated measurement of a subject will tend to generate data that are more
closely related (by virtue of coming from the same subject) than data from dif-
ferent subjects.

• Robust. A test that gives correct p values even when its assumptions are vio-
lated to some degree (‘this test is fairly robust to violation of the normality as-
sumption…’).

• Sequence effects. See within-subjects.
• Sigma-restricted model. A way of specifying a general linear model in which

a categorical variable with k possible levels is coded in a design matrix with k –
1 variables. The values used to code membership of particular groups sum to
zero. For example, to code Sex, one variable would be created in which males
score +1 and females –1. Compare overparameterized model.

• Simple effect. An effect of one factor considered at only one level of another
factor. A simple effect of A at level 2 of factor B is written ‘A at B2’ or ‘A/B2’.
See main effect, interaction, and pp. 20, 39→.

• Source of variance (SV). Something contributing to variation in a dependent
variable. Includes predictor variables and error variability.

• Sphericity assumption. An important assumption applicable to within-subjects
(repeated measures) ANOVA. Sphericity is the assumption of homogeneity of
variance of difference scores. Suppose we test 5 subjects at three levels of A.
We can therefore calculate three sets of difference scores (A3 – A2), (A2 – A1),
and (A3 – A1), for each subject. Sphericity is the assumption that the variances
of these difference scores are the same. See p. 25→.

• Standard deviation. The square root of the variance.
• Structural model. An equation giving the value of the dependent variable in

terms of sources of variability including predictor variables and error variabil-
ity.

• Sum of squares (SS). In full, the sum of the squared deviations from the mean.
See variance. Sums of squares are used in preference to actual variances in
ANOVA, because sample sums of squares are additive (you can add them up
and they still mean something) whereas sample variances are not additive unless
they’re based on the same number of degrees of freedom.

• t test, one-sample. Equivalent to testing MSintercept/MSerror with an ANOVA

with no other factors (odd as that sounds). 2
,1 kk tF =  and kk Ft ,1= . See inter-

cept.
• t test, two-sample, paired. Equivalent to ANOVA with one within-subjects

factor with two levels. 2
,1 kk tF =  and kk Ft ,1= .

• t test, two-sample, unpaired. Equivalent to ANOVA with one between-

subjects factor with two levels. 2
,1 kk tF =  and kk Ft ,1= .

• Variance. To calculate the variance of a set of observations, take each observa-
tion and subtract it from the mean. This gives you a set of deviations from the
mean. Square them and add them up. At this stage you have the sum of the
squared deviations from the mean, also known as the sum of squares (SS). Di-
vide by the number of independent observations you have (n for the population
variance; n–1 for the sample variance; or, in general, the number of degrees of
freedom) to get the variance. See the Background Knowledge handouts at
www.pobox.com/~rudolf/psychology.

• Within-subjects (factor or covariate). See also repeated measures. If a score is
obtained for every subject at each level of an independent variable, the inde-
pendent variable is called a within-subjects factor. See also between-subjects.
The advantage of a within-subjects design is that the different treatment condi-
tions are automatically matched on many irrelevant variables — all those that
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are relatively unchanging characteristics of the subject (e.g. intelligence, age).
However, the design requires that each subject is tested several times, under dif-
ferent treatment conditions. Care must be taken to avoid order, sequence or car-
ryover effects — such as the subject getting better through practice, worse
through fatigue, drug hangovers, and so on. If the effect of a treatment is per-
manent, it is not possible to use a within-subjects design. You could not, for ex-
ample, use a within-subjects design to study the effects of parachutes (versus no
parachute) on mortality rates after falling out of a plane.
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10 Further reading

• A very good statistics textbook for psychology is Howell (1997).
• Abelson (1995) examines statistics as an technique of argument and is very

clear on the logical principles and some of the philosophy of statistics.
• Keppel (1991) is a fairly hefty tome on ANOVA techniques. Winer (1991) is

another monster reference book. Neither are for the faint-hearted.
• Myers & Well (1995) is another excellent one. Less fluffy than Howell (1997)

but deals with the issues head on.

There is also an excellent series of Statistics Notes published by the British Medical
Journal, mostly by Bland and Altman. A list is available at

www.mbland.sghms.ac.uk/pbstnote.htm

and the articles themselves are available online from

www.bmj.com

This series includes the following:

• The problem of the ‘unit of analysis’ (Altman & Bland, 1997). Correlation and
regression when repeated measurements are taken, and the problem of pseu-
doreplication (Bland & Altman, 1994a). The approach one should take to meas-
ure correlation within subjects (Bland & Altman, 1995a) and correlation be-
tween subjects (Bland & Altman, 1995b).

• Why correlation is utterly inappropriate for assessing whether two ways of
measuring something agree (Bland & Altman, 1986).

• Generalization and extrapolation (Altman & Bland, 1998).
• Why to randomize (Altman & Bland, 1999b), how to randomize (Altman &

Bland, 1999a), and how to match subjects to different experimental groups
(Bland & Altman, 1994b).

• Blinding (Day & Altman, 2000; Altman & Schulz, 2001).
• Absence of evidence is not evidence of absence — about power (Altman &

Bland, 1995).
• Multiple significance tests: the problem (Bland & Altman, 1995c).
• Regression to the mean (Bland & Altman, 1994e; Bland & Altman, 1994d).
• One-tailed and two-tailed significance tests (Bland & Altman, 1994c).
• Transforming data (Bland & Altman, 1996b) and how to calculate confidence

intervals with transformed data (Bland & Altman, 1996c; Bland & Altman,
1996a).

• ANOVA, briefly (Altman & Bland, 1996), and the analysis of interaction ef-
fects (Altman & Matthews, 1996; Matthews & Altman, 1996a; Matthews &
Altman, 1996b).

• Comparing estimates derived from separate analyses (Altman & Bland, 2003).
• Dealing with differences in baseline by ANCOVA (Vickers & Altman, 2001).

Finally, there’s an excellent on-line textbook (StatSoft, 2002):

www.statsoft.nl/textbook/stathome.html
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